
도움말 안내

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

본 안내는 ILME-FR7 / ILME-FR7K Interchangeable Lens Digital Camera의 구성 및 작동에 대해 설명합니다.

필요에 따라 본 설명서 및 관련 장치의 사용 설명서를 참조하십시오.

개요

일반적인 사용 애플리케이션

시스템 구성

제공된 적외선 리모컨을 사용하여 단일 기기 제어

태블릿 또는 컴퓨터를 사용하여 단일 기기 제어

외부 원격 제어기를 사용하여 단일 기기 제어

외부 원격 제어기를 사용하여 다중 기기 제어

부품 위치 및 기능

전면 보기

후면 보기

커넥터 블록

측면 보기

상단 보기

하단 보기

렌즈 지지대

적외선 리모컨(제공됨) 부분의 위치 및 기능

웹 앱 화면

웹 앱 화면 개요

화면의 공통 영역 구조

라이브 작동 화면의 구조

재생 작동 화면의 구조

설정 화면의 구조
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준비

카메라 메뉴

카메라 화면 표시

기기 장착

고정된 위치에 수직으로 장착

높고 고정된 위치에 수직으로 장착

천장에 장착

렌즈 부착/제거

렌즈 부착/제거 시 주의사항

렌즈 스위치 확인

줌 렌즈 사용 시 주의사항

렌즈 부착

렌즈 제거

케이블 연결

유선 연결을 통해 기기를 네트워크 장치에 연결

전원 공급 장치 연결

AC 전원 사용

PoE++ 전원 사용

팬/틸트 재설정

촬영 전 구성

웹 앱을 사용하여 기기 초기화

웹 브라우저에서 웹 앱 액세스

기기 초기화

기본 작동 구성

메모리 카드 준비

지원되는 메모리 카드

메모리 카드 삽입

메모리 카드 꺼내기
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촬영

메모리 카드 포맷(초기화)

남은 녹화 시간 확인

메모리 카드 복원

기본 작동

녹화 시작/중지

메모리 카드 사이 전환

오디오 확인

시간 데이터 지정

녹화 검토(Rec Review)

프레이밍 조정

프레이밍 조정 화면

촬영 방향 조정

웹 앱을 사용하여 촬영 방향 조정

팬/틸트 작동 속도 설정

팬/틸트 작동 가속 설정

제공된 적외선 리모컨을 사용하여 촬영 방향 조정

줌 조정

줌 유형 설정

웹 앱을 사용하여 줌 조정

줌 작동 속도 설정

제공된 적외선 리모컨을 사용하여 줌 조정

카메라 팬/틸트/줌 위치 저장/복원(사전 설정 위치)

E-mount 렌즈 보정

웹 앱을 사용하여 팬/틸트, 줌 위치 및 초점 설정 저장/복원

웹 앱을 사용하여 사전 설정 위치 이름 바꾸기

웹 앱을 사용하여 저장된 사전 설정 위치를 새로운 위치로 교체

웹 앱을 사용하여 저장된 사전 설정 위치 삭제

사전 설정 위치 복원 시 팬/틸트 작동 및 줌/초점 작동 동기화
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사전 설정 위치 복원 시 전환 속도(팬-틸트/줌/초점) 변경

제공된 적외선 리모컨을 사용하여 팬/틸트 및 줌 위치 저장/복원

카메라 프레이밍 작업 녹화/재생(PTZ 추적)

웹 앱을 사용하여 카메라 프레이밍 작업 녹화

웹 앱을 사용하여 카메라 프레이밍 작업 재생

웹 앱을 사용하여 카메라 녹화 프레이밍 작업 삭제

제공된 적외선 리모컨을 사용하여 카메라 프레이밍 작업 녹화

제공된 적외선 리모컨을 사용하여 카메라 프레이밍 작업 재생

초점 조정

초점 조정 화면

초점을 수동으로 조정(Manual Focus)

웹 앱을 사용하여 수동으로 조정

제공된 적외선 리모컨을 사용하여 수동으로 조정

초점 위치를 지정하여 초점 맞추기(Spot Focus)

임시로 자동 초점 사용(Push Auto Focus(AF))

단일 촬영 자동 초점 사용(Push Auto Focus (AF-S))

초점을 자동으로 조정(Auto Focus)

웹 앱을 사용하여 자동으로 조정

제공된 적외선 리모컨을 사용하여 자동으로 조정

자동 초점 영역/위치 설정(Focus Area)

초점 영역을 빠르게 바꾸기(Focus Setting)

터치 조작으로 초점 영역 프레임 이동(터치 초점 영역)

자동 초점 동작 조정(AF 전환 속도, AF 피사체 이동 감도)

웹 앱을 사용하여 수동으로 자동 초점 대상 설정(AF Assist)

제공된 적외선 리모컨을 사용하여 자동 초점 중 수동으로 초점 맞추기

자동 초점 중 임시로 수동 초점 사용(Push Manual Focus)

얼굴 및 눈 감지를 사용하여 추적하기(Face/Eye Detection AF)

지정된 피사체 추적하기(Realtime Tracking AF)

밝기 조정
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유용한 기능

밝기 조정 화면

기본 감도 설정

자동 밝기 조정을 위한 목표 레벨 설정

조리개 조정

조리개를 자동으로 조정

조리개를 수동으로 조정

게인 조정

게인을 자동으로 조정

게인을 수동으로 조정

셔터 조정

셔터를 자동으로 조정

셔터를 수동으로 조정

조도 조정(ND Filter)

ND 필터 정보

사전 설정 모드에서 조정

가변 모드에서 자동으로 조정

가변 모드에서 수동으로 조정

자연색 조정(화이트 밸런스)

화이트 밸런스 조정 화면

화이트 밸런스를 자동으로 조정

화이트 밸런스를 수동으로 조정

자동 화이트 밸런스 실행

녹음할 오디오 구성

오디오 구성 화면

오디오 입력 장치 선택

오디오 녹음 레벨을 자동으로 조정

오디오 녹음 레벨을 수동으로 조정

다이렉트 메뉴 작동
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할당 가능 버튼

Slow & Quick Motion

간헐적으로 비디오 녹화(Interval Rec)

픽처 캐시 녹화(Picture Cache Rec)

메모리 카드 A 및 B에 동시에 녹화(2-slot Simul Rec)

비디오 신호 모니터

클립 플래그

브리딩 보정

프록시 녹화

프록시 녹화 개요

프록시 녹화

원하는 보기로 촬영

보기 개요

보기 선택

원하는 기본 보기 가져오기

보기 사용자 지정

보기 저장

기본 보기 삭제

포스트 프로덕션에서 보기 조정으로 촬영

포스트 프로덕션에서 보기 조정으로 촬영

HDMI 출력 및 스트리밍에 LUT 적용

LUT 변경

녹화된 이미지에서 어두운 영역과 밝은 영역의 분포 변경

RAW 녹화

RAW 비디오 녹화

Slow & Quick Motion 모드에서 RAW 비디오 녹화

보케 조정(보케 제어 기능)

보케 제어 기능 켜기/끄기
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네트워크 기능

썸네일 화면

카메라 메뉴 및 세부 설정

보케 정도 조정하기

구성 데이터 저장 및 로드

구성 데이터 저장 및 로드 개요

ALL 파일 저장

ALL 파일 로드

파일 전송

파일 전송 정보

파일 전송 대상 등록

파일 선택 및 업로드

썸네일 화면에서 메모리 카드의 프록시 파일 업로드

썸네일 화면에서 메모리 카드의 원본 파일 업로드

파일 전송 상태 확인

보안 FTP를 사용하여 업로드

스트리밍 구성

스트리밍 정보

스트리밍 형식 설정

스트리밍용 비디오 코덱 설정

스트리밍용 오디오 코덱 설정

스트리밍 시작/중지

썸네일 화면

클립 재생 및 기타 클립 작업

녹화된 클립 재생

녹화된 클립에 대한 작업

카메라 메뉴 구성

카메라 메뉴 조작

카메라 메뉴 조작
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문자열 입력

User 메뉴

User

Edit User 메뉴

Edit User

Shooting 메뉴

ISO/Gain/EI

ND Filter

Shutter

Iris

Auto Exposure

White

White Setting

Offset White

Focus

S&Q Motion

LUT On/Off

Noise Suppression

Flicker Reduce

SteadyShot

Project 메뉴

Base Setting

Rec Format

Cine EI/Flex.ISO Set

Simul Rec

Proxy Rec

Interval Rec

Picture Cache Rec
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SDI/HDMI Rec Control

Assignable Button

Paint/Look 메뉴

Scene File

Base Look

Reset Paint Settings

Black

Knee

Detail

Matrix

Multi Matrix

팬-틸트 메뉴

P/T Acceleration

TC/Media 메뉴

Timecode

TC Display

Users Bit

HDMI TC Out

Clip Name Format

Update Media

Format Media

Media Life

Monitoring 메뉴

Output Format

Display On/Off

Video Signal Monitor

Marker

Audio 메뉴
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Audio Input

Audio Output

Thumbnail 메뉴

Display Clip Properties

Set Clip Flag

Lock/Unlock Clip

Delete Clip

Transfer Clip

Transfer Clip (Proxy)

Filter Clips

Customize View

Technical 메뉴

Color Bars

Genlock

Tally

Rec Review

Zoom

Lens

APR

Network 메뉴

Wired LAN

File Transfer

Maintenance 메뉴

Language

Clock Set

Hours Meter

Shooting 메뉴 설정 및 기본값

ISO/Gain 설정 및 기본값
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웹 메뉴 및 세부 설정

AGC Limit 설정 및 기본값

각 촬영 모드에 저장된 이미지 품질 설정

웹 메뉴 구성

웹 메뉴 작업

Shooting 메뉴

Focus

Project 메뉴

Base Setting

Rec Format

Simul Rec

Proxy Rec

Interval Rec

Picture Cache Rec

All File

Paint/Look 메뉴

Base Look

팬-틸트 메뉴

P/T Speed

P/T Acceleration

P/T Range Limit

P/T Direction

P/T Preset

Monitoring 메뉴

Output Format

Output Display

Audio 메뉴

Audio Input
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Audio Output

Technical 메뉴

Tracking Data Output

Tally

IR Remote

RCP/MSU

Lens Controller

Network 메뉴

Camera Name

User

Wired LAN

File Transfer

FTP Server 1 ~ 3

SSL

Referer Check

Brute Force Attack Protection

스트림 메뉴

Stream

Video Stream

Audio Stream

Maintenance 메뉴

Language

Accessibility

Clock Set

Reset

Information

System Log

HTTP Access Log
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외부 장치 연결

부록

Service

EULA

Software

외부 모니터 및 녹화 장치 연결

RCP/MSU 연결(옵션)

RCP/MSU와의 연결

기기와 RCP 간의 일대일 연결

MSU/카메라 원격 제어 소프트웨어로 멀티 카메라 환경에서 기기 사용

지원되는 기능 목록

RM-IP500 원격 제어기(옵션)를 사용한 작업

RM-IP500 원격 제어기(옵션)을 사용한 작업 정보

RM-IP500 원격 제어기 연결

외부 장치와의 동기화

외부 장치와의 동기화 정보

비디오 신호의 위상 동기화(Genlock)

다른 장치에 타임코드 잠그기

외부 마이크 또는 외부 오디오 장치 연결

컴퓨터를 사용하여 클립 관리/편집

광섬유 신호 출력

기록 신호 연결

추적 데이터 출력(free-d)

렌즈 제어기 연결

렌즈 제어기를 사용하여 줌 조정

사용 주의 사항

출력 형식 및 제한

문제 해결

오류/경고 메시지
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5-041-958-23(1) Copyright 2022 Sony Corporation

메뉴 항목 목록

사전 설정 위치 저장 항목

블록 다이어그램

E-mount 렌즈 소프트웨어 업데이트

렌즈 분리 버튼 커버 부착

라이선스

사양

상표
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도움말 안내

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

시스템 구성

본 기기는 주변 장치와 결합하여 다양한 시스템 구성을 형성할 수 있습니다.

E-mount 렌즈1.

LA-EA3/LA-EA4 A-mount 어댑터2.

적외선 리모컨(제공됨)3.

CFexpress Type A 메모리 카드 / SDXC 메모리 카드4.

CFexpress Type A 카드 리더 / SD 카드 리더5.

ECM-680S, ECM-678*, ECM-674* 마이크6.
EC-0.5X3F5M 3핀 → 5핀 XLR 어댑터 케이블이 필요합니다.*

AC 어댑터(제공됨)7.

비디오 모니터8.

RM-IP500 원격 제어기9.
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도움말 안내

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

제공된 적외선 리모컨을 사용하여 단일 기기 제어

제공된 적외선 리모컨을 사용하여 단일 기기를 원격으로 제어할 수 있습니다.

 비디오 신호
 신호 흐름

5-041-958-23(1) Copyright 2022 Sony Corporation

적외선 리모컨(제공됨)1.

비디오 모니터2.
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도움말 안내

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

태블릿 또는 컴퓨터를 사용하여 단일 기기 제어

태블릿이나 컴퓨터를 기기에 연결한 다음 웹 브라우저를 사용하여 기기를 제어할 수 있습니다.

 비디오 신호
 리모컨 신호

  신호 흐름

5-041-958-23(1) Copyright 2022 Sony Corporation

비디오 모니터1.

태블릿2.

컴퓨터3.

액세스 포인트4.
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도움말 안내

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

외부 원격 제어기를 사용하여 단일 기기 제어

원격 제어기를 사용하여 기기를 원격으로 제어할 수 있습니다.

 비디오 신호
 리모컨 신호

  신호 흐름

5-041-958-23(1) Copyright 2022 Sony Corporation

비디오 모니터1.

RM-IP500 원격 제어기2.

19



도움말 안내

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

외부 원격 제어기를 사용하여 다중 기기 제어

단일 원격 제어기를 사용하여 최대 100대의 기기를 원격으로 제어할 수 있습니다.

 비디오 신호
 리모컨 신호
 기록/접점 신호

  신호 흐름

5-041-958-23(1) Copyright 2022 Sony Corporation

비디오 모니터1.

비디오 스위처2.

이더넷 허브3.

RM-IP500 원격 제어기4.
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도움말 안내

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

전면 보기

이 항목에서는 기기 전면에 있는 부품의 위치와 기능에 대해 설명합니다.

힌트

이 설명은 부착된 렌즈가 없는 기기의 그림을 나타냅니다.

카메라 헤드

참고 사항

카메라 헤드에 강한 충격을 가하지 마십시오.

1.

녹화/기록 램프
녹화 램프로 구성된 경우 메모리 카드에 녹화할 때 램프가 빨간색으로 켜집니다. 녹화 매체의 여유 공간이 부족하거나
오류가 발생하면 램프가 깜박입니다.

2.
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자세한 내용은 "오류/경고 메시지"를 참조하십시오.

기록 램프로 구성된 경우 외부 기록 신호에 따라 램프가 빨간색 또는 녹색으로 켜집니다.

자세한 내용은 "기록 신호 연결"을 참조하십시오.
이미지 센서

참고 사항

손으로 직접 만지지 마십시오.

3.

렌즈 분리 버튼
눌러서 렌즈를 제거합니다.

자세한 내용은 "렌즈 제거"를 참조하십시오.

4.

렌즈 신호 접점

참고 사항

손으로 직접 만지지 마십시오.

5.

POWER 램프6.

NETWORK 램프
기기의 상태는 POWER 램프 및 NETWORK 램프의 디스플레이 색상과 점등 상태(켜짐, 깜박임, 꺼짐)의 조합으로 표
시됩니다.

7.

POWER 램프
NETWORK 램
프

기기 상태

녹색 켜짐*1
녹색 켜짐 전원 켜짐(네트워크 연결됨)

꺼짐 전원 켜짐(네트워크 연결되지 않음)

녹색 깜박임 꺼짐 전원 켜기 프로세스 진행 중

주황색 켜짐 꺼짐 전원 대기 상태

노란색 깜박임 꺼짐 소프트웨어 업데이트 진행 중

주황색으로 천
천히 깜박임*2

녹색으로 천천히

깜박임*2

기기가 정상적으로 작동할 수 없습니다. 자세한 내용은 시스템 로그를 참조하
십시오. 기기를 대기 모드로 전환하거나 전원을 껐다가 다시 켠 후에도 문제가
지속되면 Sony 서비스 담당자에게 문의하십시오.

주황색으로 빠
르게 깜박임*3

녹색으로 빠르게

깜박임*3 기기에 오동작이 발생했습니다. Sony 서비스 담당자에게 문의하십시오.

제공된 적외선 리모컨에서 명령이 수신되면 녹색으로 깜박입니다.*1

천천히 깜박임: 초당 1회 깜박임*2

빠르게 깜박임: 초당 4회 깜박임*3

적외선 리모컨 센서
제공된 적외선 리모컨에서 제어 신호를 수신합니다.

8.

공기 흡입구

참고 사항

9.

22



관련 항목

오류/경고 메시지

기록 신호 연결

렌즈 제거

5-041-958-23(1) Copyright 2022 Sony Corporation

공기 흐름을 막지 마십시오. 오동작이 발생할 수 있습니다.
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도움말 안내

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

후면 보기

이 항목에서는 기기 후면에 있는 부품의 위치와 기능에 대해 설명합니다.

관련 항목

측면 보기

5-041-958-23(1) Copyright 2022 Sony Corporation

카메라 헤드 잠금 레버
카메라 헤드의 앞/뒤 움직임을 잠급니다.

참고 사항

렌즈를 변경하지 않을 때는 항상 잠금 위치로 설정하십시오.

기기를 운반할 때는 항상 렌즈를 제거하고 잠금 위치로 설정하십시오.

잠금 레버를 작동시키기 전에 기기의 전원을 끄고 팬/틸트 잠금 레버를 사용하여 카메라 헤드를 수평으로 잠가 손가락 끼임으
로 인한 부상을 방지하십시오. 팬/틸트 잠금 레버에 대한 자세한 내용은 "측면 보기"의 "팬/틸트 잠금 레버"를 참조하십시오.

1.

슬라이드 베이스2.
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도움말 안내

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

커넥터 블록

이 항목에서는 기기 커넥터 블록에 있는 부품의 위치와 기능에 대해 설명합니다.

 (접지) 연결
전원 콘센트의 접지 단자 또는 접지 막대에 연결하여 접지에 연결합니다.

1.

DC IN 커넥터(표준 DC 잭)
AC 어댑터에 연결합니다.

참고 사항

제공된 AC 어댑터 이외의 다른 AC 어댑터를 사용하지 마십시오. 다른 어댑터를 연결하면 화재 또는 오동작이 발생할 수 있습
니다.

2.

 LAN(네트워크) 커넥터(RJ-45)
네트워크 통신 및 PoE++* 전원 공급을 위한 네트워크 케이블(카테고리 5e 이상)을 연결합니다.

속도 LED 표시 상태
네트워크 연결 속도를 나타냅니다.

3.

PoE++: Power over Ethernet Plus Plus. IEEE802.3bt(Type 4 Class 8)를 준수합니다. 연결에 대한 자세한 내용은 전원 공급 장치의 사용 설명
서를 참조하십시오.

*
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링크/ACT LED 표시 상태
네트워크 연결 상태를 나타냅니다.

참고 사항

이 제품을 인터넷에 연결할 때는 라우터나 방화벽과 같은 보호 기능이 있는 시스템을 통해 연결하십시오. 이러한 보호 기능 없
이 연결하면 보안 문제가 발생할 수 있습니다.

표시  연결 속도

꺼짐
10Mbps 연결

100Mbps 연결

주황색 켜짐 1000Mbps 연결

표시  연결 상태

 꺼짐 링크 없음

녹색 깜박임 링크 설정됨, 데이터 활성

녹색 켜짐 활성 링크

TC IN 커넥터
외부 기준 타임코드 신호를 입력합니다.

자세한 내용은 "다른 장치에 타임코드 잠그기"를 참조하십시오.

4.

HDMI 커넥터
기기의 비디오를 HDMI 신호로 출력합니다.

자세한 내용은 "외부 모니터 및 녹화 장치 연결"의 "HDMI 커넥터(Type A 커넥터)"를 참조하십시오.

5.

HDMI 케이블 고정 플레이트 장착 나사
HDMI 케이블이 분리되지 않도록 하려면 제공된 장착 나사(M2.6×6)를 사용하여 제공된 HDMI 케이블 고정 플레이트를
부착하고 시중에서 판매되는 케이블 타이 또는 밴드를 사용하여 HDMI 케이블을 부착하십시오.

HDMI 케이블 고정 플레이트 부착에 대한 자세한 내용은 "케이블 연결"을 참조하십시오.

6.

OPTION 커넥터
외부 장치 또는 렌즈 제어기의 기록 신호를 연결하는 데 사용합니다.

자세한 내용은 "기록 신호 연결" 및 "렌즈 제어기 연결"을 참조하십시오.

7.

코드 클램퍼
AC 어댑터 코드를 고정하는 데 사용합니다.

8.

RESET 스위치
기기의 설정을 공장 기본값으로 재설정하려면 펜 끝이나 유사한 장치를 사용하여 5초 이상 누르십시오.
SETUP 스위치 1을 사용하여 네트워크 연결 설정만 재설정할지 아니면 모든 설정을 재설정할지 선택할 수 있습니다.

9.

OPTICAL 출력 커넥터
SFP+ 모듈(옵션)이 연결된 경우 광학 형식으로 변환된 SDI 신호를 출력합니다.

자세한 내용은 "광섬유 신호 출력"을 참조하십시오.

10.

SETUP 스위치11.
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다음 설정을 구성합니다.
스위치 1: RESET 스위치를 눌렀을 때 재설정되는 설정을 설정합니다.

스위치 2: 오디오 입력 장치가 연결된 경우 +48V 전원 공급 장치(팬텀 전원)를 켜거나 끌지 여부를 설정합니다. 설정은
즉시 적용됩니다.
이 기능은 카메라 메뉴에서 [Audio] > [Audio Input] > [AUDIO IN Select]가 [MIC]로 설정된 경우 활성화됩니다.

참고 사항

스위치 2를 ON 위치로 설정하고 +48V 소스와 호환되지 않는 마이크를 연결하면 연결된 장치가 손상될 수 있습니다. 장치를 연
결하기 전에 설정을 확인하십시오.

스위치 3: VISCA over IP 통신을 활성화/비활성화합니다. 카메라를 켜면 설정이 적용됩니다.
원격 제어기(RM-IP500)에 연결했을 때 기기를 사용하려면 ON 위치로 설정하십시오.

참고 사항

관리자 암호가 구성되지 않은 경우 스위치 설정에 관계없이 VISCA over IP 통신이 비활성화됩니다. 관리자 암호 구성에 대한
자세한 내용은 "기기 초기화"을 참조하십시오.

스위치 4: 적외선 리모컨에서 전송된 팬/틸트 작업의 속도를 변경합니다. 설정은 즉시 적용됩니다.

설정 설명

OFF(기본
값)

네트워크 연결 설정만 재설정합니다. 기기의 네트워크 설정, 보안 설정 및 사용자 정보(사용자 이름 및
암호)가 재설정됩니다.

ON 모든 설정을 공장 기본값으로 재설정합니다.

설정 설명

OFF(기본
값)

+48V 전원(팬텀 전원)을 공급하지 마십시오. 외부 오디오 장치(예: 믹서), 다이나믹 마이크 또는 내장
배터리가 있는 마이크를 사용할 때 이 설정을 구성하십시오.

ON
AUDIO IN 커넥터(CH-1 또는 CH-2)에 연결된 팬텀 전원 호환 마이크에 +48V 전원(팬텀 전원 공급 장
치)을 공급합니다.

설정 설명

OFF(기본값) VISCA over IP 명령에 응답하지 않습니다.

ON VISCA over IP 명령을 수락합니다.

설정 설명

OFF(기본값) 정상 속도로 작동합니다.

ON 최대 속도로 작동합니다.

SDI OUT 커넥터12.
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관련 항목

다른 장치에 타임코드 잠그기

외부 모니터 및 녹화 장치 연결

케이블 연결

기록 신호 연결

렌즈 제어기 연결

광섬유 신호 출력

기기 초기화

비디오 신호의 위상 동기화(Genlock)

외부 마이크 또는 외부 오디오 장치 연결

5-041-958-23(1) Copyright 2022 Sony Corporation

기기의 비디오를 12G/6G/3G/HD-SDI 신호로 출력합니다.
RAW 신호 출력을 위해 기기를 구성할 수도 있습니다.

자세한 내용은 "외부 모니터 및 녹화 장치 연결"의 "SDI OUT 커넥터(BNC 유형)"를 참조하십시오.
 적외선 리모컨 센서(후면)

제공된 적외선 리모컨용 적외선 센서.
13.

팬/공기 배출구
기기 내부에서 열을 방출합니다.

참고 사항

공기 배출구를 덮지 마십시오. 오동작이 발생할 수 있습니다.

공기 배출구 근처가 뜨거워질 수 있으므로 주의하십시오.

14.

GENLOCK 커넥터
외부 동기 신호를 입력할 때 사용합니다.

자세한 내용은 "비디오 신호의 위상 동기화(Genlock)"를 참조하십시오.

15.

AUDIO IN 커넥터(XLR 유형 5핀 커넥터)
외부 마이크 또는 오디오 장치의 신호를 입력하는 데 사용합니다.
AUDIO IN CH-1 커넥터 또는 AUDIO IN CH-2 커넥터로 기능합니다.

자세한 내용은 "외부 마이크 또는 외부 오디오 장치 연결"을 참조하십시오.

16.
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도움말 안내

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

측면 보기

이 항목에서는 기기 측면에 있는 부품의 위치와 기능에 대해 설명합니다.

힌트

이 설명은 부착된 렌즈가 없는 기기의 그림을 나타냅니다.

팬/틸트 잠금 레버
기기의 팬/틸트 메커니즘을 잠급니다. 다음과 같은 경우에 사용하십시오.

기기를 운반하거나 포장할 때.
렌즈를 부착하거나 제거할 때. 자세한 내용은 "렌즈 부착" 또는 "렌즈 제거"를 참조하십시오.
팬/틸트 작업을 지원하지 않는 렌즈를 사용하는 경우(예: Sony SEL100400GM / SEL200600G / SEL400F28GM /
SEL600F40GM 렌즈).
기기를 운반할 때는 항상 렌즈를 제거하고 잠금 위치로 설정하십시오.

힌트

1.
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관련 항목

렌즈 부착

렌즈 제거

메모리 카드 삽입

웹 브라우저에서 웹 앱 액세스

5-041-958-23(1) Copyright 2022 Sony Corporation

팬/틸트 이동은 다음 각도로 고정될 수 있습니다.

슬라이드 베이스2.

외부 장치용 나사 구멍(4곳)
최대 6 mm 길이의 M3 나사용.

참고 사항

6 mm보다 긴 나사를 사용하지 마십시오. 오동작이 발생할 수 있습니다.

3.

액세스 표시등 A4.

액세스 표시등 B
녹화 매체가 삽입되면 표시등이 켜지거나 깜박입니다.

자세한 내용은 "메모리 카드 삽입"을 참조하십시오.

5.

CFexpress Type A/SD 카드 슬롯 (A)6.

CFexpress Type A/SD 카드 슬롯 (B)
녹화 매체를 삽입할 때 사용합니다.

자세한 내용은 "메모리 카드 삽입"을 참조하십시오.

7.

네트워크 연결용 QR 코드
초기 설정을 구성할 때 사용합니다.

자세한 내용은 "웹 브라우저에서 웹 앱 액세스"를 참조하십시오.

8.
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도움말 안내

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

상단 보기

이 항목에서는 기기 상단에 있는 부품의 위치와 기능에 대해 설명합니다.

힌트

이 설명은 부착된 렌즈가 없는 기기의 그림을 나타냅니다.

5-041-958-23(1) Copyright 2022 Sony Corporation

외부 장치용 나사 구멍(2곳)
삼각대용 1/4-20 UNC 나사와 호환됩니다.
최대 길이는 6 mm입니다.

1.

ɸ(이미저 마크)
이미저 마크는 이미지 센서와 같은 면에 있습니다.
기기와 피사체 사이의 거리를 정확하게 측정하려면 이 이미저 마크를 기준점으로 사용합니다.

2.
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도움말 안내

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

하단 보기

이 항목에서는 기기 하단에 있는 부품의 위치와 기능에 대해 설명합니다.

힌트

이 설명은 부착된 렌즈가 없는 기기의 그림을 나타냅니다.

천장 브래킷 장착 나사 구멍(6곳, 유효 나사산 깊이 5.5 mm(7/32인치))
기기를 천장 또는 높은 위치의 선반에 설치할 경우 이 나사 구멍에 6개의 바디 브래킷 장착 나사를 사용하여 바디 브래
킷(옵션)을 기기 하단에 부착하십시오.

설치에 대한 자세한 내용은 "높고 고정된 위치에 수직으로 장착" 및 "천장에 장착"를 참조하십시오.

1.

삼각대 장착 나사(2곳)
카메라 삼각대에 기기를 장착할 때 사용합니다(옵션, 최대 5.5 mm(7/32인치) 길이의 1/4-20 UNC 나사).

참고 사항

2.
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관련 항목

높고 고정된 위치에 수직으로 장착

천장에 장착

5-041-958-23(1) Copyright 2022 Sony Corporation

5.5 mm(7/32인치)보다 긴 나사를 사용하지 마십시오. 오동작이 발생할 수 있습니다.
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도움말 안내

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

렌즈 지지대

이 항목에서는 기기의 렌즈 지지대 부품의 위치와 기능에 대해 설명합니다.

힌트

이 설명은 부착된 렌즈가 없는 기기의 그림을 나타냅니다.

렌즈 지지대 막대(2)
렌즈를 지지합니다.
일반 Ø15 막대 액세서리를 장착하는 데도 사용할 수 있습니다.

1.
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렌즈 지지대 장치
렌즈 지지대는 렌즈에 따라 앞/뒤로 슬라이드하여 고정할 수 있습니다.

2.

렌즈 지지대 받침대 부착 나사
렌즈 지지대 받침대에 부착합니다. 렌즈 지지대 받침대의 높이에 맞게 나사를 위/아래로 조정할 수 있습니다.

3.

렌즈 지지대 막대 클램프 레버(2곳)
렌즈 지지대 장치의 앞/뒤 위치를 고정합니다.

4.

렌즈 지지대 받침대 부착 나사 클램프 레버
렌즈 지지대 받침대 부착 나사의 수직 위치를 고정합니다.

힌트

클램프 레버가 돌리기 어려운 위치에 있는 경우 클램프 레버를 풀고 조작하기 쉬운 각도로 회전시키십시오. 원하는 위치에 있
으면 클램프 레버를 닫습니다.

A: 렌즈 지지대 받침대 부착 나사 클램프 레버
B: 렌즈 지지대 막대 클램프 레버

참고 사항

렌즈 지지대 장치가 팬/틸트 작동을 방해하는 것을 방지하기 위해 렌즈 지지대 장치를 사용하지 않을 때는 렌즈 지지대 장치를
카메라 헤드 쪽으로 옮기고 렌즈 지지대 받침대 부착 나사를 가장 높은 위치(렌즈에 가장 가까운 위치)로 옮기십시오.

5.
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도움말 안내

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

적외선 리모컨(제공됨) 부분의 위치 및 기능

이 항목에서는 적외선 리모컨(제공됨) 부분의 위치와 기능에 대해 설명합니다.

REC●(녹화 START/STOP) 버튼
녹화를 시작하거나 중지하려면 누릅니다.

1.

MENU 버튼
카메라 메뉴를 표시하거나 숨기려면 누릅니다.

2.

GUI 제어 버튼
카메라 메뉴, 버튼이 포함된 메시지 대화 상자 및 기타 화면 표시 기능에서 작업을 수행하려면 누릅니다.

3.

CANC./BACK 버튼
설정을 취소하거나 기기의 카메라 메뉴의 이전 화면으로 돌아가려면 누릅니다.

4.

팬 및 틸트 제어 버튼5.
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적외선 리모컨 배터리

적외선 리모컨에는 2개의 AA(LR6) 배터리가 필요합니다.
다음 그림과 같이 적외선 리모컨에 배터리를 삽입합니다.

화살표 버튼을 눌러 카메라의 팬/틸트를 제어합니다. HOME 버튼을 눌러 카메라의 방향이 정면을 향하도록 되돌립니
다.
사전 설정 위치 제어 버튼
PRESET 버튼을 누른 상태에서 1~3 버튼 중 하나를 눌러 누른 숫자 버튼에 카메라 방향, 줌, 초점 조정 상태를 저장합
니다.
설정이 저장된 숫자 버튼을 눌러 저장된 상태를 불러옵니다.

6.

초점 제어 버튼
초점을 조정하는 데 사용합니다.
초점을 자동으로 조정하려면 AF 버튼을 누릅니다.
초점을 수동으로 조정하려면 MF 버튼을 누른 다음 F(원거리) 버튼을 눌러 먼 피사체에 초점을 맞추거나 N(근거리) 버
튼을 눌러 가까운 피사체에 초점을 맞춥니다.

7.

할당 가능 버튼 1~3
카메라 메뉴를 사용하여 할당 가능 버튼에 할당된 기능을 실행합니다.
할당 가능 버튼에 [Direct Menu] 기능을 할당하면 GUI 제어 버튼을 사용하여 노출, 화이트 밸런스 및 기타 설정을 조절
할 수 있습니다.

카메라 메뉴를 사용한 할당에 대한 자세한 내용은 "할당 가능 버튼"을 참조하십시오.

다이렉트 메뉴에 대한 자세한 내용은 "다이렉트 메뉴 작동"을 참조하십시오.

8.

 (전원) 버튼
기기를 켜거나 전원 공급 장치를 대기 상태로 전환하려면 누릅니다.

9.

THUMBNAIL 버튼
기기의 메모리 카드에 녹화된 클립을 보여주는 썸네일 화면을 표시합니다.

썸네일 화면에 대한 자세한 내용은 "썸네일 화면"을 참조하십시오.

GUI 제어 버튼을 사용하여 썸네일 화면에서 클립을 선택하고 재생을 제어할 수 있습니다.

클립 선택 및 재생 제어에 대한 자세한 내용은 "녹화된 클립 재생" 및 "녹화된 클립에 대한 작업"을 참조하십시오.

10.

SLOT SEL(메모리 카드 슬롯 (A)/(B) 선택) 버튼
두 개의 메모리 카드가 삽입되어 있을 때 버튼을 눌러 녹화할 메모리 카드 사이를 전환합니다.
썸네일 화면이 표시된 상태에서 이 버튼을 누르면 볼 메모리 카드 간에 전환됩니다.

11.

P/T RESET(팬/틸트 재설정) 버튼
팬/틸트 기능을 재설정합니다. POWER 램프와 NETWORK 램프가 동시에 깜박이거나 웹 앱의 프레이밍 제어 패널에
[Execute Pan-Tilt Reset]이 표시될 때 버튼을 누릅니다.

12.

줌 제어 버튼
확대하려면 T(망원) 버튼을 누릅니다.
축소하려면 W(광각) 버튼을 누릅니다.

13.
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참고 사항

망간 또는 알카라인 배터리 이외의 배터리는 파열될 수 있으므로 사용하지 마십시오.

사용한 배터리는 해당 국가 또는 지역의 법규에 따라 폐기하십시오.

관련 항목

할당 가능 버튼

다이렉트 메뉴 작동

썸네일 화면

녹화된 클립 재생

녹화된 클립에 대한 작업

5-041-958-23(1) Copyright 2022 Sony Corporation
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도움말 안내

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

웹 앱 화면 개요

태블릿이나 컴퓨터를 연결하여 웹 브라우저에서 팬/틸트, 줌, 녹화, 녹화된 비디오 재생 및 기기 구성을 할 수 있습니다(이
하 이 기능을 "웹 앱"이라고 함).

웹 앱 실행에 대한 자세한 내용은 "웹 브라우저에서 웹 앱 액세스"를 참조하십시오.

참고 사항

웹 앱은 카메라 오디오 출력을 지원하지 않습니다.

웹 앱이 실행되면 다음과 같은 라이브 작동 화면이 나타납니다.

라이브 작동 화면

라이브 작동 화면에 대한 자세한 내용은 "라이브 작동 화면의 구조"를 참조하십시오.
라이브 작동 화면과 재생 작동 화면에 공통으로 사용할 수 있는 버튼과 아이콘이 화면 상단에 표시됩니다.

화면의 공통 영역에 대한 자세한 내용은 "화면의 공통 영역 구조"를 참조하십시오.
공통 영역의 화면 전환 탭을 눌러 화면을 전환할 수 있습니다.

39



재생 작동 화면

[Playback] 탭을 눌러 재생 작동 화면을 표시합니다.

재생 작동 화면에 대한 자세한 내용은 "재생 작동 화면의 구조"를 참조하십시오.

설정 화면

[Settings] 탭을 눌러 설정 화면(이하 웹 메뉴)을 표시합니다.
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참고 사항

웹 메뉴에서는 [OK] 버튼을 누를 때까지 설정이 적용되지 않습니다. [OK] 버튼이 있는 페이지에서 설정을 변경할 경우 반드시 [OK]
버튼을 눌러 주십시오.

설정 화면에 대한 자세한 내용은 "설정 화면의 구조"를 참조하십시오.
이 도움말 안내에서는 웹 앱의 설정 화면을 웹 메뉴라고 합니다.

관련 항목

웹 브라우저에서 웹 앱 액세스

라이브 작동 화면의 구조

화면의 공통 영역 구조

재생 작동 화면의 구조

설정 화면의 구조

5-041-958-23(1) Copyright 2022 Sony Corporation
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도움말 안내

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

화면의 공통 영역 구조

이 항목에서는 화면의 공통 영역 구조에 대해 설명합니다.

카메라 이름
카메라 이름을 표시합니다.
웹 메뉴의 [Network] > [Camera Name]을 사용하여 이름을 변경할 수 있습니다.
배경색은 외부 기록 신호에 따라 변경됩니다.

1.

전원 스위치
기기를 켜면 [Power ON]이 표시됩니다. 스위치를 누르고 [Power Standby]를 설정하여 기기의 전원을 대기 상태로 설
정할 수 있습니다.
[Power Standby]가 표시되면 스위치를 누르고 [Power ON]을 선택하여 기기의 전원을 켤 수 있습니다.

2.

작동 화면 전환 탭
탭을 눌러 해당 작동 화면을 표시합니다.
[Live] 탭: 라이브 작동 화면을 표시합니다.
[Playback] 탭: 재생 작동 화면을 표시합니다.
[Settings] 탭: 설정 화면(웹 메뉴)을 표시합니다.

3.

알림 마크
메시지가 도착하면 마크 표시가 아래와 같이 바뀝니다.

 (알림 켜짐)
카메라 이미지 패널에 표시된 메시지에 따라 필요한 조치를 취하십시오.

참고 사항

웹 메뉴에서 [Monitoring] > [Output Display] > [HDMI/Stream]이 [Off]로 설정된 경우 메시지가 표시되지 않습니다. [On]으로 설
정하여 메시지 내용을 확인합니다.

4.

 (카메라 상태) 버튼
카메라 녹화 영상/출력 영상 신호 정보, 렌즈 정보, 렌즈 제어기(옵션) 상태를 별도의 화면에 표시하려면 이 버튼을 누릅
니다.

5.
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렌즈 제어기(옵션) 관련 알림이 발생하면 표시가 아래와 같이 변경됩니다.

화면 작동 잠금 스위치
(작동 잠금 해제): 스위치를 왼쪽으로 설정하여 라이브 작동 화면 및 재생 작동 화면에서 작동을 제어합니다.
(작동 잠금): 스위치를 오른쪽으로 설정하여 라이브 작동 화면 및 재생 작동 화면에서 작동을 잠가 실수로 인한 오

동작을 방지합니다.

6.
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도움말 안내

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

라이브 작동 화면의 구조

이 항목에서는 라이브 작동 화면의 구조에 대해 설명합니다.

사전 설정 위치 제어 패널
썸네일을 사용하여 사전 설정의 등록된 위치를 표시합니다. 썸네일을 두 번 탭하여 사전 설정에 저장된 위치로 돌아갑
니다.

사전 설정 위치에 대한 자세한 내용은 "웹 앱을 사용하여 팬/틸트, 줌 위치 및 초점 설정 저장/복원"을 참조하십시오.
PTZ 추적에 대한 자세한 내용은 "웹 앱을 사용하여 카메라 프레이밍 작업 녹화"를 참조하십시오.

1.

카메라 이미지 패널
기기의 현재 카메라 이미지와 상태를 표시합니다.
HDMI 출력과 동일한 이미지를 표시합니다.
이미지 위에 다음 상태가 표시됩니다. 수신된 외부 기록 신호에 따라 이미지 주변에 빨간색 프레임 또는 녹색 프레임도
표시됩니다.

2.
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[Display] 버튼
이 버튼을 눌러 이미지에 카메라 정보를 표시합니다.
카메라 정보가 표시된 상태에서 다시 누르면 카메라 정보가 숨겨집니다.

마커 외에도 상태에 따라 일부 자동 초점 관련 표시 및 메시지가 표시되며 [Display] 버튼을 눌러 숨길 수 없습니다.

표시되는 카메라 정보에 대한 자세한 내용은 "카메라 화면 표시"를 참조하십시오.

실시간 추적 AF 중지 버튼
피사체 추적을 중지하려면 버튼을 누릅니다.

번
호

표시 설명

2-1 초점 모드 표시 "카메라 화면 표시"의 "초점 모드 표시"를 참조하십시오.

2-2
녹화 모드, 슬롯 A/B, Interval Rec
녹화 간격 표시

"카메라 화면 표시"의 "녹화 모드, 슬롯 A/B, Interval Rec 녹화 간격 표
시"를 참조하십시오.

2-3 스트리밍 상태 표시
스트리밍 중에 표시됨([Stream Setting]이 [RTMP] 또는 [SRT-Caller]로만
설정된 경우).

2-4 RAW 출력 작동 상태 표시
RAW 신호의 출력 상태를 표시합니다. RAW에 대한 자세한 내용은 "RAW
비디오 녹화"를 참조하십시오.

2-5 남은 매체 용량 표시 "카메라 화면 표시"의 "남은 매체 용량 표시"를 참조하십시오.

2-6 줌 위치 표시
"카메라 화면 표시"의 "줌 위치 표시"를 참조하십시오.
렌즈 제어기(옵션)가 연결된 경우 이 표시됩니다. 렌즈 제어기(옵션)에
오류가 발생하면 이 표시됩니다.

2-7 AE 모드/AE 레벨 표시 "카메라 화면 표시"의 "AE 모드/AE 레벨 표시"를 참조하십시오.
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자세한 내용은 "지정된 피사체 추적하기(Realtime Tracking AF)"를 참조하십시오.
녹화 START/STOP 버튼
녹화를 시작하려면 버튼을 누릅니다. 녹화 중에는 녹화 START/STOP 버튼이 빨간색으로 켜집니다.
녹화 중에 누르면 녹화가 중지됩니다.
녹화 START/STOP 버튼의 오동작을 방지하기 위해 Hold 스위치를 Hold 상태로 설정할 수 있습니다.

3.

카메라 기본 구성 패널
버튼에서 촬영에 필요한 기본 기능에 대한 설정을 표시합니다. 버튼을 누르면 아래의 카메라 기본 설정 조정 패널(5)에
서 각 기능에 해당하는 설정 화면이 나타납니다.

4-1 [FPS]
4-2 [ISO/Gain / Exposure Index]
4-3 [Shutter]
4-4 [Iris]
4-5 [ND Filter]
4-6 [Scene File / Base Look/LUT]
4-7 [White Balance]

자세한 내용은 각 기능의 설명을 참조하십시오.

4.

기능 참조

FPS "Slow & Quick Motion"

ISO/Gain "게인 조정"의 "기본 감도 설정," "게인을 자동으로 조정" 및 "게인을 수동으로 조정"

Exposure Index "기본 감도 설정" 및 "녹화된 이미지에서 어두운 영역과 밝은 영역의 분포 변경"

Shutter "셔터 조정"의 "셔터를 자동으로 조정" 및 "셔터를 수동으로 조정"

Iris "조리개 조정"의 "조리개를 자동으로 조정" 및 "조리개를 수동으로 조정"

ND Filter "조도 조정(ND Filter)"의 "ND 필터 정보"

Scene File "보기 개요" 및 "원하는 보기로 촬영"의 기타 항목

Base Look/LUT "포스트 프로덕션에서 보기 조정으로 촬영"

White Balance "화이트 밸런스 조정 화면"

할당 가능 버튼/카메라 기본 구성 조정 패널
정상 작동 중에 할당 가능 버튼을 표시합니다. 카메라 기본 구성 패널 버튼(항목 4)을 누르면 해당 설정 항목이 표시됩
니다. [X] 버튼을 누르거나 카메라 설정 패널 버튼을 다시 누르면 할당 가능 버튼 표시로 돌아갑니다.

5.
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할당 가능 버튼에 대한 자세한 내용은 "할당 가능 버튼"을 참조하십시오.
카메라 기본 구성 조정 패널에 대한 자세한 내용은 각 기능에 대한 설명을 참조하십시오.

프레이밍 제어 페널 / GUI 제어 패널
상단의 탭을 사용하여 프레이밍 제어 패널 / GUI 제어 패널 사이를 전환합니다.
화면 우측 상단의 (닫기) 버튼을 눌러 제어 패널을 숨겨 실수로 작동하지 않도록 할 수 있습니다. 제어 패널이 표시되
지 않으면 (열기) 버튼을 눌러 표시합니다.
프레이밍 제어 패널을 사용하여 프레이밍을 조정합니다.  (팬/틸트/줌) 탭을 눌러프레이밍 제어 패널을 표시합
니다.

조작에 대한 자세한 내용은 "프레이밍 조정"을 참조하십시오.

힌트

프레이밍 제어 패널의 조이스틱 부분은 팬/틸트 작업이 비활성화되고 팬/틸트 초기화가 필요한 경우 아래와 같이 표시됩니다.

팬/틸트 잠금 레버를 사용하여 팬/틸트 작업이 잠긴 경우

팬/틸트 작업이 초기화되지 않은 경우

팬/틸트 작업을 재설정해야 하는 경우

6.
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팬/틸트 작업이 비활성화된 경우

팬/틸트 작업이 초기화되지 않았거나 재설정이 필요한 경우 조이스틱 아래에 표시된 메시지를 눌러 카메라 제어 패널의
(팬/틸트 재설정) 버튼에 빠르게 액세스할 수 있습니다.

GUI 제어 패널을 사용하여 카메라 메뉴, 클립 재생 및 기타 기능을 조작합니다. (카메라 GUI) 탭을 눌러 GUI
제어 패널을 표시합니다.

조작에 대한 자세한 내용은 "카메라 메뉴 조작" 및 "녹화된 클립 재생"을 참조하십시오.
카메라 제어 패널
카메라 작동에 필요한 기능을 구성할 때 사용합니다.
상단의 탭을 사용하여 표시할 화면을 전환합니다.
화면 우측 상단의 (닫기) 버튼을 눌러 제어 패널을 숨겨 실수로 작동하지 않도록 할 수 있습니다. 제어 패널이 표시되
지 않으면 (열기) 버튼을 눌러 표시합니다.

자세한 내용은 각 기능에 대한 설명을 참조하십시오.

  (Main) 탭
자주 사용하는 기능에 대한 설정 항목을 표시합니다.
상단 및 하단 슬라이더 기능은 [▼] 버튼을 누르고 표시된 목록에서 선택하여 변경할 수 있습니다. 다음 기능을 선택할
수 있습니다.

ND Filter
Iris

7.
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ISO*

Gain*

Exposure Index*

AE Level
Zoom Speed
Pan-Tilt Speed

  (Focus) 탭
초점과 관련된 설정 항목을 표시합니다.

  (Audio) 탭

오디오와 관련된 설정 항목을 표시합니다.

메뉴 설정에 따라 표시됩니다.*
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 (Stream) 탭
스트리밍과 관련된 설정 항목을 표시합니다.
표시되는 항목은 스트리밍 형식 설정에 따라 다릅니다.
[RTMP] 또는 [SRT-Caller]로 설정하면 이 화면에서 스트리밍을 시작/중지할 수 있습니다.

자세한 내용은 "스트리밍 정보" 및 "스트리밍 구성"의 기타 항목을 참조하십시오.
연결 실패가 발생하면 오류 정보가 표시됩니다. 오류 정보에 대한 자세한 내용은 "오류/경고 메시지"를 참조하십시
오.

 (Others) 탭
기타 기능과 관련된 설정 항목을 표시합니다.
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관련 항목

웹 앱을 사용하여 팬/틸트, 줌 위치 및 초점 설정 저장/복원

웹 앱을 사용하여 카메라 프레이밍 작업 녹화

카메라 화면 표시

RAW 비디오 녹화

지정된 피사체 추적하기(Realtime Tracking AF)

Slow & Quick Motion

기본 감도 설정

게인을 자동으로 조정

게인을 수동으로 조정

녹화된 이미지에서 어두운 영역과 밝은 영역의 분포 변경

셔터를 자동으로 조정

셔터를 수동으로 조정

조리개를 자동으로 조정

조리개를 수동으로 조정

ND 필터 정보

보기 개요

포스트 프로덕션에서 보기 조정으로 촬영

화이트 밸런스 조정 화면

할당 가능 버튼

녹화된 클립 재생

카메라 메뉴 조작

스트리밍 정보

오류/경고 메시지

5-041-958-23(1) Copyright 2022 Sony Corporation

[Full Screen Display] 버튼을 누르면 웹 브라우저에서 새 탭이 열리고 카메라 이미지 패널 이미지가 전체 화면으로 표
시됩니다.
이미지만 표시되며 터치 AF 및 기타 기능은 사용할 수 없습니다.

참고 사항

원래 탭의 라이브 작동 화면은 계속 작동합니다. 작업이 필요하지 않은 경우 탭을 닫아 동시 연결 수를 줄이는 것이 좋습니다.

(렌즈 제어기 초기화) 버튼을 눌러 렌즈 제어기(타사 옵션)를 초기화합니다. 이 버튼은 웹 메뉴에서
[Technical] > [Lens Controller] > [Zoom] > [Setting]이 [On]으로 설정된 경우에만 활성화됩니다.
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도움말 안내

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

재생 작동 화면의 구조

이 항목에서는 재생 작동 화면의 구조에 대해 설명합니다.

카메라 이미지 패널
재생 이미지 및 관련 정보를 표시합니다. 재생이 중지되면 카메라 이미지 화면이 나타납니다.

1.
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1-1 촬영 일시
1-2 재생 상태 표시
1-3 재생 형식(사진 크기) 표시
1-4 재생 형식(코덱) 표시
1-5 클립 이름 표시
1-6 클립 번호/전체 클립 번호
1-7 LUT 이름 표시
1-8 스트리밍 상태 표시
1-9 재생 형식(프레임 속도 및 스캔 방식) 표시
1-10 녹화 보기 표시

재생 제어 패널

재생 제어 버튼을 표시합니다.

[Display] 버튼
이미지의 화면 표시 사이를 전환하려면 누릅니다.
[Thumbnail] 버튼
카메라 이미지 패널의 메모리 카드에 녹화된 클립을 썸네일로 표시합니다.

2.

버튼 기능

 (재생/일시 정지) 버튼 클립을 재생합니다. 재생 중 클립을 일시 정지합니다.

 (빨리 감기) 버튼,  (빨리 되감기)
버튼

고속으로 클립을 재생합니다. 버튼을 누르면 재생 속도가 3단계로 변
경됩니다.

 (다음) 버튼,  (이전) 버튼 클립의 시작 또는 이전/다음 클립으로 이동합니다.

 (중지) 버튼 재생을 중지합니다.
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관련 항목

썸네일 화면

할당 가능 버튼

녹화된 클립 재생

5-041-958-23(1) Copyright 2022 Sony Corporation

썸네일 화면 표시 중에 [Thumbnail] 버튼을 누르면 썸네일 화면이 닫히고 카메라 이미지로 돌아갑니다.

썸네일 화면에 대한 자세한 내용은 "썸네일 화면"을 참조하십시오.

[Slot Select] 버튼
대상 재생 매체를 전환합니다.

할당 가능 버튼
기기의 기능에 할당된 할당 가능 버튼을 표시합니다.

할당 가능 버튼에 대한 자세한 내용은 "할당 가능 버튼"을 참조하십시오.

3.

GUI 제어 패널
GUI 제어 패널을 사용하여 카메라 메뉴, 클립 재생 및 기타 기능을 조작합니다.

조작에 대한 자세한 내용은 "카메라 메뉴 조작" 및 "녹화된 클립 재생"을 참조하십시오.

4.
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도움말 안내

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

설정 화면의 구조

설정 화면을 사용하여 웹 메뉴를 통한 초기 설정, 네트워크 설정, 촬영/재생 설정을 포함한 기기의 다양한 설정 항목을 구성
합니다.

참고 사항

웹 메뉴에서는 일반적으로 [OK] 버튼을 누를 때까지 설정이 적용되지 않습니다. [OK] 버튼이 있는 페이지에서 설정을 변경할 경우
반드시 [OK] 버튼을 눌러 주십시오.

설정 화면에 대한 자세한 내용은 "웹 메뉴 및 세부 설정"을 참조하십시오.

5-041-958-23(1) Copyright 2022 Sony Corporation
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도움말 안내

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

카메라 메뉴

라이브 작동 화면 또는 재생 작동 화면의 GUI 제어 패널에서 [Menu] 버튼을 누르면 카메라 이미지 패널의 카메라 메뉴가
표시됩니다.

카메라 메뉴를 사용하여 촬영 및 재생에 필요한 설정을 구성할 수 있습니다.
카메라 메뉴가 표시된 상태에서 [Menu] 버튼을 눌러 카메라 메뉴를 숨깁니다.
카메라 메뉴는 GUI 제어 패널을 사용하여 작동됩니다.

카메라 메뉴에 대한 자세한 내용은 "카메라 메뉴 및 세부 설정"을 참조하십시오.

참고 사항

웹 메뉴에서 [Monitoring] > [Output Display] > [HDMI/Stream]이 Off로 설정되어 있으면(화면 표시에 정보 오버레이 비활성화) 카메
라 메뉴가 더 이상 카메라 이미지 패널에 표시되지 않습니다. 그러나 GUI 제어 패널의 메뉴 작업은 여전히 활성화되어 있습니다. 우
발적인 작동을 방지하려면 [HDMI/Stream]이 Off로 설정된 경우 GUI 제어 패널을 사용하여 메뉴 조작을 수행하지 않도록 주의하십
시오.

5-041-958-23(1) Copyright 2022 Sony Corporation
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도움말 안내

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

카메라 화면 표시

카메라의 출력 이미지에 기기의 상태와 설정을 겹쳐서 표시할 수 있습니다. 웹 메뉴의 [Monitoring] > [Output Display]를 사
용하여 화면 표시가 활성화된 출력을 설정할 수 있습니다.
[Display] 버튼을 사용하여 정보를 표시하거나 숨길 수 있습니다. 숨겨져 있더라도 다이렉트 메뉴 조작 중에는 화면에 표시
됩니다.
카메라 메뉴의 [Monitoring] > [Display On/Off]를 사용하여 항목을 개별적으로 표시하거나 숨길 수 있습니다.

촬영 중 화면에 표시되는 정보

업로드 표시/남은 파일 표시

파일 전송에 대한 자세한 내용은 "파일 전송 정보" 및 "파일 전송"의 기타 항목을 참조하십시오.

1.

초점 영역 표시
자동 초점용 초점 영역을 표시합니다.

자동 초점에 대한 자세한 내용은 "웹 앱을 사용하여 자동으로 조정" 및 "초점을 자동으로 조정(Auto Focus)"의 기타
항목을 참조하십시오.

2.

녹화 모드, 슬롯 A/B, Interval Rec 녹화 간격 표시

Interval Rec에 대한 자세한 내용은 "간헐적으로 비디오 녹화(Interval Rec)"를 참조하십시오.

3.

표시 의미

●Rec 녹화

Stby 녹화 대기

피사계 심도 표시4.

이미저 스캔 모드 표시5.
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렌즈의 이미지 서클 크기와 유효 영상 크기 이미저 스캔 모드 설정 사이에 일치하지 않는 부분이 있는 경우  (불일치)
마크가 표시됩니다.
Imager Scan Mode가 FF로 설정되면 화각이 좁은 모드에서 "C" 마크(크로핑)가 표시됩니다.
다음 모드에서 크로핑이 수행됩니다.

녹화 형식이 3840×2160이고 S&Q Motion 프레임 속도가 100 fps 또는 120 fps인 경우
[Codec]이 RAW 또는 RAW & XAVC-I로 설정되고 RAW 출력 형식이 3840×2160인 경우
이미저 스캔 모드에 대한 자세한 내용은 "기본 작동 구성"의 "이미저 스캔 모드 설정"을 참조하십시오.

RAW 출력 작동 상태 표시
RAW 신호의 출력 상태를 표시합니다.

RAW에 대한 자세한 내용은 "RAW 비디오 녹화"를 참조하십시오.

6.

Slow & Quick Motion 촬영 프레임 속도 표시

Slow & Quick Motion에 대한 자세한 내용은 "Slow & Quick Motion"을 참조하십시오.

7.

초점 위치 표시

초점 위치를 표시합니다.

8.

초점 모드 표시

얼굴/눈 감지 AF

얼굴/눈 감지 AF에 대한 자세한 내용은 "얼굴 및 눈 감지를 사용하여 추적하기(Face/Eye Detection AF)"를 참조하
십시오.

9.

표시 의미

Focus Hold Focus Hold 모드

MF MF 모드

AF AF 모드

 (실시간 추적 AF 모드) 실시간 추적 AF 모드

표시 의미

 (얼굴/눈 감지 AF) 얼굴/눈 감지 AF가 활성화되었음을 나타냄

 (얼굴/눈만 AF) 얼굴/눈만 AF가 활성화되었음을 나타냄

 (얼굴 추적 저장됨) 얼굴 추적이 저장되었음을 나타냄

 (AF 일시 정지됨) AF가 일시 정지되었음을 나타냄*

저장된 얼굴 추적이 없고 얼굴이 감지되지 않은 경우나 저장된 얼굴 추적이 있지만 추적 대상 얼굴이 감지되지 않은 경우에 표시됩니다.*

줌 위치 표시
범위 0(광각)~99(망원)의 줌 위치를 표시합니다(줌 위치 표시를 지원하는 렌즈가 부착된 경우).
카메라 메뉴의 [Technical] > [Lens] > [Zoom Position Display] 설정을 사용하여 표시를 막대 표시 또는 초점 거리 표시
로 변경할 수도 있습니다.
Clear Image Zoom이 활성화되면 디스플레이에 다음 항목이 추가됩니다.

10.
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줌에 대한 자세한 내용은 "줌 유형 설정" 및 "줌 조정"의 기타 항목을 참조하십시오.

표시 의미

 (Clear Image Zoom이 활성화됨) Clear Image Zoom이 활성화됨

배율 값 Clear Image Zoom을 사용할 때

이미지 안정화 모드 표시11.

SDI 출력/HDMI 출력 Rec Control 상태 표시
REC Control 신호의 출력 상태를 표시합니다.

자세한 내용은 "외부 모니터 및 녹화 장치 연결"을 참조하십시오.

12.

초점 표시

자세한 내용은 "초점 조정"의 "단일 촬영 자동 초점 사용(Push Auto Focus (AF-S))"을 참조하십시오.

13.

남은 매체 용량 표시
메모리 카드가 쓰기 보호 상태인 경우  (보호) 아이콘이 나타납니다.

14.

화이트 밸런스 모드 표시15.

표시 의미

 (ATW) 자동 모드

 (ATW Hold) 자동 모드 일시 중지

W:P 사전 설정 모드

W:A 메모리 A 모드

타임코드 외부 잠금 표시/시간 데이터 표시
외부 장치의 타임코드가 잠김 경우 "EXT-LK"가 표시됩니다.

타임코드에 대한 자세한 내용은 "시간 데이터 지정"를 참조하십시오.

16.

ND 필터 표시

ND 필터에 대한 자세한 내용은 "조도 조정(ND Filter)"을 참조하십시오.
보케 제어에 대한 자세한 내용은 "보케 조정(보케 제어 기능)"을 참조하십시오.

17.

표시 의미

 (A) 자동 모드

 (B) 보케 제어 모드

장면 파일 표시

장면 파일에 대한 자세한 내용은 "보기 개요" 및 "원하는 보기로 촬영"의 기타 항목을 참조하십시오.

18.

조리개 표시
조리개 위치(F 값)를 표시합니다(조리개 설정 표시를 지원하는 렌즈가 부착된 경우).

19.
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조리개에 대한 자세한 내용은 "조리개를 자동으로 조정" 및 "조리개를 수동으로 조정"를 참조하십시오.
비디오 레벨 경고 표시20.

게인 표시
Cine EI/Cine EI Quick 모드일때 EI 값을 표시합니다.

게인에 대한 자세한 내용은 "게인을 자동으로 조정" 및 "게인을 수동으로 조정"를 참조하십시오.
Cine EI/Cine EI Quick 모드에 대한 자세한 내용은 "기본 작동 구성"의 "촬영 모드 설정"을 참조하십시오.

21.

표시 의미

 (A) 자동 모드

L 사전 설정 L 모드

 (임시 조정 모드) 임시 조정 모드

 (B) 보케 제어 모드

클립 이름 표시
녹화 중이거나 다음에 녹화할 클립의 이름을 표시합니다.
깜박이면 녹화 매체의 마지막 클립과 [Camera ID] 또는 [Reel Number] 설정이 일치하지 않는 것입니다. 자세한 내용은
[Clip Name Format] > [Auto Naming] 설명을 참조하십시오.

22.

셔터 표시

셔터에 대한 자세한 내용은 "셔터를 자동으로 조정" 및 "셔터를 수동으로 조정"를 참조하십시오.

23.

AE 모드/AE 레벨 표시

자동 노출(AE)에 대한 자세한 내용은 "자동 밝기 조정을 위한 목표 레벨 설정"을 참조하십시오.

24.

수준기 표시
수평 레벨을 ±1° 단위로 최대 ±15°까지 표시합니다.

25.

오디오 레벨 미터
각 채널의 오디오 레벨을 표시합니다.

26.

비디오 신호 모니터
파형, 벡터스코프 및 히스토그램을 표시합니다.
주황색 선은 밝기 레벨 마커의 설정 값을 나타냅니다.
로그 촬영 모드에서는 모니터 대상 LUT 유형이 디스플레이 위에 표시됩니다.

자세한 내용은 "비디오 신호 모니터"를 참조하십시오.
로그 촬영 모드에 대한 자세한 내용은 "기본 작동 구성"의 "촬영 모드 설정"을 참조하십시오.

27.

Base Sensitivity 표시/Base ISO 표시
Custom 모드의 경우 카메라 기본 구성 패널의 [ISO/Gain / Exposure Index] 버튼 또는 카메라 메뉴의 [Shooting] >
[ISO/Gain/EI] > [Base Sensitivity]를 사용하여 설정한 기본 감도를 표시합니다.
로그 촬영 모드의 경우 Base ISO 감도(카메라 기본 구성 패널의 [ISO/Gain / Exposure Index] 버튼 또는 카메라 메뉴의
[Shooting] > [ISO/Gain/EI] > [Base ISO]를 사용하여 설정)를 표시합니다.

기본 감도에 대한 자세한 내용은 "기본 감도 선택"을 참조하십시오.
로그 촬영 모드에 대한 자세한 내용은 "기본 작동 구성"의 "촬영 모드 설정"을 참조하십시오.

28.

모니터링 보기 표시
로그 촬영 모드에서 모니터 LUT 설정을 표시합니다.

29.
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재생 중 화면에 표시되는 정보

다음 정보가 재생 영상에 겹쳐서 표시됩니다.

LUT 설정에 대한 자세한 내용은 "포스트 프로덕션에서 보기 조정으로 촬영" 및 관련 항목을 참조하십시오.
로그 촬영 모드에 대한 자세한 내용은 "기본 작동 구성"의 "촬영 모드 설정"을 참조하십시오.

기본 보기/녹화 보기 표시
기본 보기 설정을 표시합니다.
로그 촬영 모드에서 메모리 카드에 녹화하는 비디오 신호를 표시합니다 .

기본 보기에 대한 자세한 내용은 "원하는 보기로 촬영"의 "보기 개요"를 참조하십시오.
로그 촬영 모드에 대한 자세한 내용은 "기본 작동 구성"의 "촬영 모드 설정"을 참조하십시오.

30.

프록시 상태 표시31.

녹화 형식(코덱) 표시
메모리 카드의 녹화에 대한 형식 이름을 표시합니다.
웹 메뉴 또는 카메라 메뉴의 [Project] > [Rec Format] > [Codec]을 이용하여 녹화 형식(코덱)을 설정하십시오.

32.

녹화 형식(프레임 속도 및 스캔 방법) 표시33.

녹화 형식(영상 크기) 표시
메모리 카드의 녹화에 대한 영상 크기를 표시합니다.
웹 메뉴 또는 카메라 메뉴의 [Project] > [Rec Format] > [Codec]을 이용하여 녹화 형식(영상 크기)을 설정하십시오.

34.

기록 표시
수신된 외부 기록 신호에 따라 이미지 주변에 빨간색 프레임 또는 녹색 프레임이 표시됩니다.

35.

업로드 표시/남은 파일 표시1.

클립 번호2.

재생 상태 표시3.

재생 형식(프레임 속도 및 스캔 방법) 표시4.

재생 형식(영상 크기) 표시5.
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관련 항목

파일 전송 정보

웹 앱을 사용하여 자동으로 조정

간헐적으로 비디오 녹화(Interval Rec)

기본 작동 구성

RAW 비디오 녹화

Slow & Quick Motion

얼굴 및 눈 감지를 사용하여 추적하기(Face/Eye Detection AF)

줌 유형 설정

외부 모니터 및 녹화 장치 연결

단일 촬영 자동 초점 사용(Push Auto Focus (AF-S))

시간 데이터 지정

보기 개요

조리개를 자동으로 조정

조리개를 수동으로 조정

게인을 자동으로 조정

게인을 수동으로 조정

셔터를 자동으로 조정

셔터를 수동으로 조정

자동 밝기 조정을 위한 목표 레벨 설정

비디오 신호 모니터

포스트 프로덕션에서 보기 조정으로 촬영

Clip Name Format

5-041-958-23(1) Copyright 2022 Sony Corporation

재생 형식(코덱) 표시6.

매체 표시
메모리 카드가 쓰기 보호 상태인 경우  (보호) 아이콘이 나타납니다.

7.

시간 데이터 표시8.

클립 이름 표시9.

감마 표시 지원 표시10.

오디오 레벨 미터
재생 오디오 레벨을 표시합니다.

11.

기본 보기/녹화 보기 표시12.

기록 표시13.
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도움말 안내

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

고정된 위치에 수직으로 장착

이 항목에서는 기기를 데스크톱 또는 삼각대에 장착하는 방법에 대해 설명합니다.

설치 참고 사항

기기의 렌즈와 렌즈 커넥터 블록을 보호하기 위해 렌즈를 부착할 때까지 기기의 캡 및 커버를 부착된 상태로 유지하십
시오.
렌즈 고장을 방지하기 위해 작업 중 렌즈 부품을 잡지 마십시오.
기기 고장을 방지하기 위해 작업 중 카메라 헤드를 잡지 마십시오.

장착 공간을 확인하십시오.

데스크톱에 장착하는 경우
렌즈를 돌리는 데 필요한 공간과 기기 후면의 배선을 고려하여 평평한 표면에 기기를 장착하십시오.

참고 사항

진동의 영향을 받지 않는 안정적인 위치에 장착하십시오. 진동의 영향을 받는 위치는 이미지에 진동을 일으킬 수 있습니다.

기기를 경사면에 장착해야 하는 경우 수평에서 ±15° 이내로 유지하고 기기가 떨어지지 않도록 조치를 취하십시오.

삼각대에 장착하는 경우
삼각대를 하단의 삼각대 장착 나사 구멍에 부착합니다.
삼각대 장착 나사를 장착 표면에서 다음과 같이 돌출된 상태로 사용하고 드라이버로 조입니다.

A: 삼각대 장착 나사 1/4-20 UNC, ISO 1222(6.35mm)
B: 돌출부(4.5mm ~ 5.5mm)

1
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다음으로 렌즈를 부착합니다. "렌즈 부착/제거 시 주의사항", "렌즈 스위치 확인" 및 "줌 렌즈 사용 시 주의사항"의 정보를
고려하여 "렌즈 부착"을 참조하십시오.

관련 항목

렌즈 부착/제거 시 주의사항

렌즈 스위치 확인

줌 렌즈 사용 시 주의사항

렌즈 부착

5-041-958-23(1) Copyright 2022 Sony Corporation

높은 위치에 기기를 장착할 때 삼각대 나사를 사용하지 마십시오.

참고 사항

렌즈가 회전해도 뒤집히지 않는 삼각대를 선택하십시오.
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도움말 안내

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

높고 고정된 위치에 수직으로 장착

이 항목에서는 천장 브래킷(CIB-PCM1(옵션))을 사용하여 높은 위치에 기기를 수직으로 장착하는 절차에 대해 설명합니
다.

기기를 높은 위치에 장착하려면 전문 계약자에게 문의하십시오.
높은 위치에 장착할 경우 장착면과 장착 재료(액세서리 제외)가 200 kg 이상을 지탱할 수 있는지 확인하고 이 도움말
안내에 설명된 대로 기기를 장착하십시오. 충분히 견고하게 장착하지 않으면 기기가 떨어져 심각한 부상을 입을 수 있
습니다.
CIB-PCM1 천장 브래킷(옵션)에 제공된 낙하 방지 와이어 로프를 부착하여 기기가 떨어지지 않도록 합니다.
기기를 높은 위치에 장착하는 경우 장착이 헐거워지지 않았는지 1년에 한 번 확인하십시오. 사용 조건에 따라 점검 주
기를 단축하십시오.

설치 참고 사항

기기의 렌즈와 렌즈 커넥터 블록을 보호하기 위해 렌즈가 부착될 때까지 렌즈 캡과 커버를 씌워 두십시오.
렌즈 고장을 방지하기 위해 작업 중 렌즈 부품을 잡지 마십시오.
기기 고장을 방지하기 위해 작업 중 카메라 헤드를 잡지 마십시오.

높은 위치 장착 액세서리 및 장착 공간을 확인하십시오.

CIB-PCM1 천장 브래킷 키트(옵션)
시작하기 전에 다음 부품이 있는지 확인하십시오.

바디 브래킷 (1)
천장 브래킷 (1)
렌즈 분리 버튼 커버 (1)
낙하 방지 와이어 로프 (1)
+PSW M3×8 나사 (9)
+PSW M4×8 낙하 방지 와이어 로프용 스테인리스 스틸 나사 (1)

참고 사항

1
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낙하 방지 와이어 로프는 기기가 매달렸을 때 기기를 지지하도록 설계되었습니다. 기기의 하중 이외의 하중을 가하지 마십시
오.

장착 공간
렌즈를 돌리는 데 필요한 공간과 기기 후면의 배선을 고려하여 장착 위치와 방향을 결정할 때 다음 도면을 참조하십
시오.

A: 카메라 헤드의 이동 범위(예: SEL70200GM2(SEL20TC 장착 시): Ø370)
B: 천장 브래킷(장착면 측 구멍(Ø150))
C: 장착 정렬 구멍

참고 사항

진동의 영향을 받지 않는 안정적인 위치에 장착하십시오. 진동의 영향을 받는 위치는 이미지에 진동을 일으킬 수 있습니다.

기기를 경사면에 장착해야 하는 경우 수평에서 ±15° 이내로 유지하고 기기가 떨어지지 않도록 조치를 취하십시오.

팬/틸트 잠금 레버를 LOCK 위치로 밀어 카메라 헤드의 팬/틸트를 잠급니다.2
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참고 사항

잠금 레버가 LOCK 위치에 있을 때 카메라 헤드 팬/틸트가 잠기지 않으면 카메라 헤드가 제자리에 잠길 때까지 수동으로 옮기
십시오.

제공된 나사(M3×8) 6개를 사용하여 바디 브래킷을 기기 바닥에 부착합니다.3
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제공된 나사를 사용하십시오. 제공된 나사 이외의 나사를 사용하면 기기 내부가 손상될 수 있습니다.

낙하 방지 와이어 로프를 바디 브래킷에 부착합니다.4
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A: 제공된 와이어 로프　
B: 제공된 십자 나사(M4×8)
C: 와이어 로프 메탈 루프

제공된 나사를 사용하십시오. 제공된 나사 이외의 나사를 사용하면 와이어 로프 기능의 효율성이 떨어질 수 있습니
다.

선반과 같이 기기가 장착될 표면에 천장 브래킷을 부착하십시오.5
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A: 벽　
B: △ 표시(카메라 전방 방향)
C: 연결 케이블용 구멍
D: 선반 또는 기타 장착 표면

낙하 방지 와이어 로프를 장착면 근처에 부착하십시오.

M5(3/16인치) 육각 소켓 헤드 캡 나사(옵션)를 사용하여 선반이나 천장 브래킷이 부착되는 표면 근처의 물체에 부착
하십시오.

6

70



A: 와이어 로프　
B: 육각 소켓 헤드 캡 나사(M5, 3/16인치)

바디 브래킷 전면의 〇 나사 구멍을 천장 브래킷의 ◇ 구멍에 맞추고 기기를 삽입한 후 기기를 시계 방향으로 돌려 바
디 브래킷을 천장 브래킷에 임시로 고정합니다.

7
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A: 〇 구멍
B: ◇ 구멍

제공된 회전 잠금 나사(M3×8) 3개를 사용하여 바디 브래킷과 천장 브래킷을 부착합니다.8
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다음으로 렌즈를 부착합니다. "렌즈 부착/제거 시 주의사항", "렌즈 스위치 확인" 및 "줌 렌즈 사용 시 주의사항"의 정보를
고려하여 "렌즈 부착"을 참조하십시오.

참고 사항

렌즈를 부착한 후 렌즈가 단단히 부착되었는지 확인하십시오.
렌즈에는 낙하 방지 기능이 없습니다. Sony는 기기에서 렌즈가 떨어지는 것에 대해 책임을 지지 않습니다.

관련 항목

렌즈 부착/제거 시 주의사항

렌즈 스위치 확인

줌 렌즈 사용 시 주의사항

렌즈 부착

장착 상태를 확인하십시오.

구체적으로 다음 항목을 확인하십시오. 

장착 나사가 올바르게 부착되어 있습니다.
낙하 방지 와이어 로프가 올바르게 부착되어 있고 꼬이지 않았습니다.
기기가 수평으로 장착되었습니다(기울임 또는 흔들림 없음).
기기를 돌릴 때 자유롭게 회전하지 않습니다.

9

73



5-041-958-23(1) Copyright 2022 Sony Corporation

74



도움말 안내

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

천장에 장착

이 항목에서는 천장 브래킷(CIB-PCM1(옵션))을 사용하여 천장에 기기를 장착하는 절차를 설명합니다.

천장에 설치하려면 전문 계약자에게 문의하십시오.
천정에 장착할 경우 장착면과 장착 재료(액세서리 제외)가 200 kg 이상을 지탱할 수 있는지 확인하고 이 도움말 안내에
설명된 대로 기기를 장착하십시오. 충분히 견고하게 장착하지 않으면 기기가 떨어져 심각한 부상을 입을 수 있습니다.
CIB-PCM1 천장 브래킷(옵션)에 제공된 낙하 방지 와이어 로프를 부착하여 기기가 떨어지지 않도록 합니다.
기기를 천장에 장착하는 경우 장착이 헐거워지지 않았는지 1년에 한 번 확인하십시오. 사용 조건에 따라 점검 주기를
단축하십시오.

설치 참고 사항

기기의 렌즈와 렌즈 커넥터 블록을 보호하기 위해 렌즈가 부착될 때까지 렌즈 캡과 커버를 씌워 두십시오.
렌즈 고장을 방지하기 위해 작업 중 렌즈 부품을 잡지 마십시오.
기기 고장을 방지하기 위해 작업 중 카메라 헤드를 잡지 마십시오.

천장 장착 액세서리 및 장착 공간을 확인하십시오.

CIB-PCM1 천장 브래킷 키트(옵션)
시작하기 전에 다음 부품이 있는지 확인하십시오.

바디 브래킷 (1)
천장 브래킷 (1)
렌즈 분리 버튼 커버 (1)
낙하 방지 와이어 로프 (1)
+PSW M3×8 나사 (9)
+PSW M4×8 낙하 방지 와이어 로프용 스테인리스 스틸 나사 (1)

참고 사항

1
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낙하 방지 와이어 로프는 기기가 매달렸을 때 기기를 지지하도록 설계되었습니다. 기기의 하중 이외의 하중을 가하지 마십시
오.

장착 공간
렌즈를 돌리는 데 필요한 공간과 기기 후면의 배선을 고려하여 장착 위치와 방향을 결정할 때 다음 도면을 참조하십
시오.

A: 카메라 헤드의 이동 범위(예: SEL70200GM2(SEL20TC 장착 시): Ø370)
B: 천장 브래킷(천장측 구멍(Ø150))
C: 장착 정렬 구멍

참고 사항

충분한 강도로 천장(예: 콘크리트)에 장착하십시오.

강도가 부족한 천장에 기기를 장착하려면 충분한 보강을 제공해야 합니다.

진동의 영향을 받지 않는 안정적인 위치에 장착하십시오. 진동의 영향을 받는 위치는 이미지에 진동을 일으킬 수 있습니다.

기기를 경사면에 장착해야 하는 경우 수평에서 ±15° 이내로 유지하고 기기가 떨어지지 않도록 조치를 취하십시오.

천장 브래킷의 △ 구멍 반대편이 촬영 방향(카메라 전면)입니다.

팬/틸트 잠금 레버를 UNLOCK 위치로 밀어 팬/틸트의 잠금을 해제하고 카메라 헤드를 틸트 방향으로 180° 돌립니다.2

팬/틸트 잠금 레버를 LOCK 위치로 밀어 카메라 헤드의 팬/틸트를 잠급니다.3
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180° 회전된 카메라 헤드

참고 사항

잠금 레버가 LOCK 위치에 있을 때 카메라 헤드 팬/틸트가 잠기지 않으면 카메라 헤드가 제자리에 잠길 때까지 수동으로 옮기
십시오.

제공된 나사(M3×8) 6개를 사용하여 바디 브래킷을 기기 바닥에 부착합니다.4
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제공된 나사를 사용하십시오. 제공된 나사 이외의 나사를 사용하면 기기 내부가 손상될 수 있습니다.

천장 브래킷을 장착 플레이트(옵션)에 부착한 후 플레이트를 천장에 부착합니다.5
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A: 천장 브래킷
B: 천장
C: 장착 플레이트
D: △ 구멍
천장 브래킷의 방향에 따라 브래킷을 부착하십시오.
천장에 장착할 때 카메라 전면은 일반적인 수직 장착과 비교하여 천장 브래킷의 반대쪽에 있습니다. 장착 방향을 나
타내는 도표를 참조하여 올바르게 장착하십시오.

A: 수직 장착용 전면(△ 구멍 방향)
B: 천장 장착용 전면

참고 사항

장착 표면 재질은 고객의 책임입니다.

낙하 방지 와이어 로프를 천장에 부착합니다.6
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A: 천장 브래킷
B: 육각 소켓 헤드 캡 나사(M5, 3/16인치)
C: 와이어 로프(제공됨)
D: 장착 플레이트
E: 천장

낙하 방지 와이어 로프를 천장 브래킷 중앙에 있는 구멍으로 당겨서 바디 브래킷에 부착합니다.

낙하 방지 와이어 로프를 바디 브래킷의 와이어 로프 메탈 루프를 통해 연결하고 제공된 스테인리스 스틸 나사
(M4×8)를 사용하여 브래킷에 단단히 부착합니다.

A: 제공된 와이어 로프
B: 제공된 십자 나사(M4×8)
C: 와이어 로프 메탈 루프

7
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제공된 나사를 사용하십시오. 제공된 나사 이외의 나사를 사용하면 와이어 로프 기능의 효율성이 떨어질 수 있습니
다.

참고 사항

다음 그림과 같이 한 사람이 기기를 잡고 다른 사람이 기기를 장착하는 것이 좋습니다.

기기를 장착하는 동안 카메라 헤드나 렌즈 지지대를 잡지 마십시오. 기기가 떨어지거나 낙하하면 손상이나 부상의 위험이 있
습니다.

배선 시 전기 커넥터 및 케이블이 낙하 방지 와이어 로프에 의해 합선되지 않도록 주의하십시오.

마운트는 최대 8.8 kg(렌즈 포함)의 질량을 지탱할 수 있습니다. 기기의 낙하를 방지하기 위해 최대 예상 질량을 초과하지 마
십시오.

바디 브래킷의 나사 구멍(A)을 천장 브래킷의 ◇ 구멍(B)에 맞추고 기기를 삽입한 후 나사 구멍(A)과 나사 구멍(C)이
정렬될 때까지 시계 방향으로 약 60도 돌립니다.

8
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A: 바디 브래킷의 나사 구멍
B: 천장 브래킷의 나사 구멍(◇ 구멍)
C: 나사 구멍
D:천장
E: 장착 플레이트

제공된 회전 잠금 나사(M3×8) 3개를 사용하여 바디 브래킷과 천장 브래킷을 부착합니다.9
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다음으로 렌즈를 부착합니다. "렌즈 부착/제거 시 주의사항", "렌즈 스위치 확인" 및 "줌 렌즈 사용 시 주의사항"의 정보를
고려하여 "렌즈 부착"을 참조하십시오.

참고 사항

기기가 천장에 장착된 경우 팬/틸트를 올바르게 작동하려면 웹 메뉴에서 [Pan-Tilt] > [Direction] > [Ceiling]을 [On]으로 설정하십시
오.

렌즈를 부착한 후 렌즈가 단단히 부착되었는지 확인하십시오.
렌즈에는 낙하 방지 기능이 없습니다. Sony는 기기에서 렌즈가 떨어지는 것에 대해 책임을 지지 않습니다.

관련 항목

렌즈 부착/제거 시 주의사항

렌즈 스위치 확인

장착 상태를 확인하십시오.

구체적으로 다음 항목을 확인하십시오.

장착 나사가 올바르게 부착되어 있습니다.
낙하 방지 와이어 로프가 올바르게 부착되어 있고 꼬이지 않았습니다.
기기가 수평으로 장착되었습니다(기울임 또는 흔들림 없음).
기기를 돌릴 때 자유롭게 회전하지 않습니다.

10
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줌 렌즈 사용 시 주의사항

렌즈 부착

5-041-958-23(1) Copyright 2022 Sony Corporation
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도움말 안내

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

렌즈 부착/제거 시 주의사항

렌즈가 태양을 향하지 않게 하십시오. 직사광선이 렌즈를 통해 들어와 기기에 초점이 맞춰지면 화재가 발생할 수 있습니
다.

참고 사항

기기가 꺼져 있는 동안 렌즈를 부착하거나 제거하십시오.

렌즈는 정밀 부품입니다. 렌즈 장착면이 아래를 향하게 하여 표면에 렌즈를 놓지 마십시오. 제공된 렌즈 장착 캡을 부착하십시오.

힌트

기기에서 지원하는 렌즈에 대한 자세한 내용은 Sony 서비스 담당자에게 문의하십시오.

5-041-958-23(1) Copyright 2022 Sony Corporation
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도움말 안내

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

렌즈 스위치 확인

렌즈 유형에 따라 다음과 같은 확인 및 설정이 필요합니다.

초점 모드 스위치가 있는 렌즈의 경우

스위치를 AF/MF 또는 AF로 설정합니다.
스위치가 MF 또는 Full MF로 설정된 경우 초점은 렌즈 링만 사용하여 조정할 수 있습니다.

참고 사항

A-mount 렌즈를 사용하는 경우 리모컨 장치에서 수동 조정을 사용하지 못할 수 있습니다.

줌 스위치가 있는 렌즈의 경우

스위치를 SERVO로 설정합니다.
스위치가 MANUAL로 설정된 경우 줌 링을 통해서만 줌을 조정할 수 있습니다. 기기의 줌 제어는 효과가 없습니다.

Auto Iris 스위치가 있는 렌즈의 경우

스위치를 AUTO로 설정합니다.
AUTO로 설정되지 않은 경우 조리개는 렌즈 링만 사용하여 조정할 수 있습니다. 기기에서 조리개를 조작해도 효과가 없습
니다.

손 떨림 방지 스위치가 있는 렌즈의 경우

스위치를 OFF로 설정합니다.
스위치가 ON으로 설정된 경우 팬/틸트 작업 중에 예기치 않은 동작이 발생할 수 있습니다.

SELP28135G

A: 초점 링을 앞으로 옮깁니다(AF/MF 모드).
B: ZOOM 스위치를 SERVO 위치로 설정합니다.
C: 조리개 링을 "A"로 설정하고 IRIS LOCK 스위치를 LOCK 위치로 설정합니다.
D: 손 떨림 방지 스위치를 OFF로 설정합니다.
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도움말 안내

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

줌 렌즈 사용 시 주의사항

파워 줌 렌즈 이외의 줌 렌즈를 사용하는 경우, 장착 환경에 따라 줌 위치가 변경될 수 있습니다. 사용 목적에 따라 테이프
를 사용하여 줌 링을 제자리에 고정하십시오.

플라스틱 필름 테이프: 471 BLA 50 또는 동급

5-041-958-23(1) Copyright 2022 Sony Corporation
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도움말 안내

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

렌즈 부착

이 항목에서는 E-mount 렌즈 또는 A-mount 렌즈를 부착하는 방법에 대해 설명합니다.

참고 사항

렌즈를 부착한 채로 기기를 운반하지 마십시오.

A-mount 렌즈를 사용할 때 조리개는 수동으로 설정되고 초점은 MF로 설정됩니다.

팬/틸트 잠금 레버를 LOCK 위치로 밀어 카메라 헤드의 팬/틸트를 잠급니다.

참고 사항

잠금 레버가 LOCK 위치에 있을 때 카메라 헤드 팬/틸트가 잠기지 않으면 카메라 헤드가 제자리에 잠길 때까지 수동으로 옮기
십시오.

1

렌즈 지지대 받침대 부착 나사용 클램프 레버를 시계 반대 방향으로 돌려 잠금을 푼 다음 렌즈 지지대 받침대 부착 나
사를 렌즈에 방해가 되지 않는 위치로 옮깁니다.

A: 올바른 위치

2
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B: 올바르지 않은 위치

카메라 헤드 잠금 레버를 화살표 방향으로 돌려 카메라 헤드의 잠금을 해제합니다.

참고 사항

카메라 헤드가 다시 잠길 때까지 카메라 헤드가 자체 무게로 인해 움직일 위험이 있습니다. 작업을 수행하는 동안 카메라 헤
드를 손으로 받칩니다.

3

카메라 헤드를 맨 앞 위치로 밉니다.4

카메라 헤드 잠금 레버를 화살표 방향으로 돌려 카메라 헤드를 잠급니다.5
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참고 사항

틸트 작업에 방해가 되지 않도록 카메라 헤드 잠금 레버가 다른 부품과 접촉하지 않도록 하십시오.

기기와 렌즈에서 캡과 커버를 벗깁니다.6

렌즈 장착 마크(흰색)를 기기에 맞추고 렌즈를 카메라 헤드에 조심스럽게 삽입한 다음 잠금 위치에서 딸깍 소리가 날
때까지 렌즈를 시계 방향으로 돌립니다.

A: 장착 마크(흰색)

참고 사항

A-mount 렌즈를 사용하려면 렌즈 장착 어댑터(옵션)를 기기에 부착한 다음 A-mount 렌즈를 부착합니다.

7

카메라 헤드 잠금 레버를 화살표 방향으로 돌려 카메라 헤드의 잠금을 해제합니다.8
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참고 사항

카메라 헤드가 다시 잠길 때까지 카메라 헤드가 자체 무게로 인해 움직일 위험이 있습니다. 작업을 수행하는 동안 카메라 헤
드를 손으로 받칩니다.

슬라이드 베이스가 수평이 되도록 카메라 헤드의 전후 균형을 유지합니다.

다음 렌즈 중 하나를 사용하는 경우 슬라이드 베이스의 눈금을 참조하여 기기와 렌즈의 대략적인 균형을 맞출 수 있
습니다.

9

눈금 위치 렌즈 이름

0.5 SEL70200GM(SEL20TC 부착)

1.7 SEL70200GM

2.0 SEL70200GM2(SEL20TC 부착)

3.0 SELP28135G, SEL70200GM2

3.5 SELP18110G

3.6 SELC1635G

4.3 SEL70200G
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참고 사항

슬라이드 베이스 눈금은 대략적인 균형을 위한 기준으로 사용하십시오.

렌즈를 부착하는 동안 기기가 앞뒤로 기울어지지 않도록 균형을 적절하게 조정하십시오.

수평면에서 균형을 조정합니다.

SELC1635G를 사용할 때 렌즈 지지대 장치를 제거하십시오.

눈금 위치 렌즈 이름

5.0 이상 SEL1224GM, SEL1635GM, SELP1635G, SELP18105G, SELP1020G

카메라 헤드 잠금 레버를 화살표 방향으로 돌려 카메라 헤드를 잠급니다.

참고 사항

틸트 작업에 방해가 되지 않도록 카메라 헤드 잠금 레버가 다른 부품과 접촉하지 않도록 하십시오.
확인 방법: 팬/틸트 잠금 장치를 UNLOCK 위치로 밀고 손으로 카메라 블록을 위를 향하도록 돌려 다른 부품과 접촉하지 않는
지 육안으로 확인합니다. 접촉이 있는 경우 카메라 헤드 잠금 레버를 다시 화살표 방향으로 돌립니다.

10

렌즈 지지대 클램프 레버를 시계 반대 방향으로 돌려 렌즈 지지대 장치를 풉니다.11
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A: 렌즈 지지대 막대 클램프 레버(2곳)
B: 렌즈 지지대 장치

렌즈 지지대 장치를 움직여 렌즈 지지대 받침대가 렌즈 지지대 받침대 부착 나사와 정렬되도록 한 다음 나사를 시계
방향으로 돌려 렌즈 지지대 받침대를 고정합니다.

참고 사항

렌즈 지지대 받침대가 렌즈 지지대 받침대 부착 나사와 수직이 되도록 한 다음 조입니다.

12

렌즈 지지대 받침대 부착 나사용 클램프 레버를 시계 방향으로 돌려 렌즈 지지대 받침대 부착 나사를 잠급니다.

A: 렌즈 지지대 받침대 부착 나사
B: 부착 나사 구멍
C: 렌즈 지지대 받침대 부착 나사 클램프 레버

힌트

클램프 레버가 돌리기 어려운 위치에 있는 경우 클램프 레버를 풀고 조작하기 쉬운 각도로 회전시키십시오. 원하는 위치에 있
으면 클램프 레버를 닫습니다.

A: 렌즈 지지대 받침대 부착 나사 클램프 레버
B: 렌즈 지지대 막대 클램프 레버

13

렌즈 지지대 막대 클램프 레버 2개를 시계 방향으로 돌려 렌즈 지지대 장치를 고정합니다.14
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관련 항목

E-mount 렌즈 보정

5-041-958-23(1) Copyright 2022 Sony Corporation

두 레버가 모두 조여져 있고 느슨하지 않은지, 렌즈가 올바르게 부착되어 있는지, 렌즈 스위치가 올바르게 설정되어
있는지 확인합니다.

레버가 헐거워지거나 렌즈가 제대로 부착되지 않으면 렌즈가 떨어져 파손될 수 있습니다.
E-mount 파워 줌 렌즈를 사용하는 경우 카메라에 저장된 줌 위치를 사전 설정 위치로 정확하게 복원하려면 렌즈
도 별도로 보정해야 합니다. 자세한 내용은 "E-mount 렌즈 보정"을 참조하십시오.

15
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도움말 안내

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

렌즈 제거

렌즈 부착의 역순으로 렌즈를 제거합니다.

참고 사항

렌즈가 떨어지지 않도록 손으로 렌즈를 단단히 잡습니다.

다른 렌즈를 즉시 부착하지 않는 경우 항상 바디 캡을 부착합니다.

관련 항목

렌즈 부착

5-041-958-23(1) Copyright 2022 Sony Corporation

팬/틸트가 잠겨 있는지 확인합니다.1

렌즈 지지대 받침대 부착 나사용 클램프 레버를 시계 반대 방향으로 돌려 잠금을 풉니다.2

렌즈 지지대 장치에 있는 렌즈 지지대 받침대 부착 나사를 제거하고 렌즈에 방해가 되지 않는 위치로 이동합니다.3

카메라 헤드의 잠금을 해제하고 카메라 헤드를 맨 앞 위치로 밉니다.

자세한 내용은 "렌즈 부착"의 3~5단계를 참조하십시오.

4

렌즈 분리 버튼을 누른 상태에서 렌즈를 지지하면서 렌즈를 시계 반대 방향으로 돌립니다.5

카메라의 장착 마크(흰색)와 렌즈가 정렬된 상태에서 렌즈를 앞쪽으로 당겨 빼냅니다.6
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도움말 안내

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

케이블 연결

이 항목에서는 케이블 연결에 대해 설명합니다.

5-041-958-23(1) Copyright 2022 Sony Corporation

필요한 케이블을 후면 패널의 커넥터에 연결합니다.

HDMI 케이블이 분리되지 않도록 커넥터 블록에서 HDMI 케이블 고정 플레이트 장착 나사(M2.6×6, 검정색)를 제거하
고 장착 나사를 사용하여 제공된 HDMI 케이블 고정 플레이트를 부착합니다. 시중에서 판매하는 케이블 타이 또는 밴
드를 사용하여 HDMI 케이블을 HDMI 케이블 고정 플레이트에 고정합니다.

A: HDMI 케이블 고정 플레이트 장착 나사(M2.6×6, 검정색)
B: 시중에서 판매되는 케이블 타이 또는 밴드
C: HDMI 케이블 고정 플레이트(제공됨)

1
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도움말 안내
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유선 연결을 통해 기기를 네트워크 장치에 연결

이 항목에서는 유선 연결을 통해 기기를 네트워크 장치에 연결하는 방법에 대해 설명합니다.

5-041-958-23(1) Copyright 2022 Sony Corporation

카테고리 5e 이상의 LAN 케이블을 사용하여 기기를 네트워크 장치(예: Wi-Fi 액세스 포인트 또는 스위칭 허브)에 연
결하십시오.

1
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AC 전원 사용

이 항목에서는 AC 전원을 사용하여 기기에 전원을 공급하는 절차에 대해 설명합니다.

팬/틸트 잠금 레버를 LOCK 위치로 밀어 카메라 헤드의 팬/틸트를 잠급니다.1

AC 어댑터(제공됨)를 기기의 DC IN 커넥터에 연결하고 전원 코드(제공됨)를 AC 전원에 연결합니다.

A: DC IN 커넥터
B: 전원 코드
C: AC 어댑터

2

코드가 분리되는 것을 방지하려면 코드 클램퍼를 사용하여 AC 어댑터 코드를 고정합니다.

코드 클램퍼의 잠금을 해제하고 아래 그림과 같이 클램퍼를 통해 코드를 연결한 다음 클램퍼를 잠급니다.

3
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참고 사항

기기와 함께 제공된 것 이외의 AC 어댑터나 전원 코드를 사용하지 마십시오. 다른 어댑터나 전원 코드를 연결하면 화재나 오동작이
발생할 수 있습니다.

벽과 가구 사이 등 좁고 사방이 막힌 공간에서 AC 어댑터에 연결해 사용하지 마십시오.

AC 어댑터 플러그의 금속 부품을 단락시키지 마십시오. 오동작이 발생할 수 있습니다.

AC 어댑터는 가장 가까이 있는 AC 전원에 연결하십시오. 작동 중 문제가 발생하면 즉시 AC 전원에서 전원 코드를 뽑으십시오.

장치에서 AC 어댑터를 분리할 때 플러그를 잡고 똑바로 당겨 뽑으십시오. 케이블을 잡고 당기면 오동작이 발생할 수 있습니다.

A: 코드 클램퍼
B: 코드 클램퍼 잠금
C: AC 어댑터 코드

기기 전면의 POWER 램프가 깜박이는 녹색에서 고정된 녹색으로 바뀌고 시작이 완료되었는지 확인하십시오.

기기가 정상적으로 시작되고 네트워크에 연결되면 NETWORK 램프가 녹색으로 켜집니다.

팬/틸트 작업을 지원하지 않는 렌즈를 사용하는 경우 팬/틸트 잠금 레버를 잠그고 다음 단계를 건너뜁니다. 팬/틸
트를 지원하는 렌즈에 대한 자세한 내용은 대리점이나 Sony 서비스 담당자에게 문의하십시오.

4

팬/틸트 잠금 레버를 UNLOCK 위치로 밀어 카메라 헤드의 팬/틸트 잠금을 해제합니다.5

팬/틸트를 재설정합니다.

자세한 내용은 "팬/틸트 재설정"을 참조하십시오.

6
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관련 항목

팬/틸트 재설정

5-041-958-23(1) Copyright 2022 Sony Corporation

101



도움말 안내

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

PoE++ 전원 사용

기기가 PoE++ 호환 전원 공급 장치에 연결되면 시중에서 판매되는 네트워크 케이블을 통해 기기에 전원이 공급됩니다.
이 방법을 사용하면 장착 위치 근처에 전원 공급 콘센트가 없는 환경에서 전원 공급 장치 배선 없이 기기에 전원을 공급할
수 있습니다.

팬/틸트 잠금 레버를 LOCK 위치로 밀어 카메라 헤드의 팬/틸트를 잠급니다.1

시중에서 판매하는 네트워크 케이블을 사용하여 기기와 PoE++ 호환 전원 공급 장치를 연결합니다.

A: 네트워크 케이블
B: PoE++ 호환 전원 공급 장치

2

기기 전면의 POWER 램프가 깜박이는 녹색에서 고정된 녹색으로 바뀌고 시작이 완료되었는지 확인하십시오.

기기가 정상적으로 시작되고 네트워크에 연결되면 NETWORK 램프가 녹색으로 켜집니다.

참고 사항

PoE++로 전원이 공급되면 시작이 완료될 때까지의 간격 동안 초기 인증이 수행됩니다.

3
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참고 사항

이 기기는 IEEE802.3bt Type 4 Class 8을 준수합니다. 검증되고 호환 가능한 PoE++ 전원 공급 장치에 대한 자세한 내용은 대리점
이나 Sony 서비스 담당자에게 문의하십시오.

기기는 소프트 인증(LLDP)을 준수하지만 네트워크 장치를 구성해야 할 수도 있습니다(IEEE802.3bt 준수).

소프트 인증(LLDP)이 활성화된 PoE++ 전원 공급을 사용할 때 AC 어댑터를 연결하지 마십시오.

AC 어댑터와 PoE++ 전원 공급 장치를 동시에 연결하면 AC 어댑터에서 전원이 공급됩니다.

PoE++를 통해 전원을 공급할 때는 카테고리 5e 이상의 네트워크 케이블을 사용하십시오.

PoE++를 통해 전원을 공급하는 경우 기기를 다시 켠 후 약 10초 동안 기다리십시오.

PoE++ 전원 공급을 사용하는 경우 접지 단자를 접지에 연결하십시오.

PoE++ 전원 공급 장치를 통해 연결하는 경우 야외에서 배선을 실행하지 마십시오.

관련 항목

팬/틸트 재설정

5-041-958-23(1) Copyright 2022 Sony Corporation

팬/틸트 작업을 지원하지 않는 렌즈를 사용하는 경우 팬/틸트 잠금 레버를 잠그고 다음 단계를 건너뜁니다. 팬/틸트를 지원하
는 렌즈에 대한 자세한 내용은 대리점이나 Sony 서비스 담당자에게 문의하십시오.

팬/틸트 잠금 레버를 UNLOCK 위치로 밀어 카메라 헤드의 팬/틸트 잠금을 해제합니다.4

팬/틸트를 재설정합니다.

자세한 내용은 "팬/틸트 재설정"을 참조하십시오.

5
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팬/틸트 재설정

예를 들어 렌즈를 교체할 때 다음 절차를 사용하여 팬/틸트를 재설정할 수 있습니다.

5-041-958-23(1) Copyright 2022 Sony Corporation

팬/틸트 잠금 레버를 UNLOCK 위치로 밀고 카메라 헤드의 팬/틸트 잠금이 해제되었는지 확인합니다.1

팬/틸트 재설정 기능을 실행합니다.

팬/틸트 재설정은 적외선 리모컨, 웹 앱 또는 RM-IP500 원격 제어기(옵션)에서 실행할 수 있습니다.

적외선 리모컨을 사용한 조작: P/T RESET 버튼을 누르십시오.
웹 앱을 이용한 조작: 라이브 작동 화면에서 카메라 제어 패널의 (Others) 탭에 있는 (팬/틸트 재설정)
버튼을 누릅니다.
RM-IP500을 사용한 조작: RM-IP500의 사용 설명서를 참조하십시오.

참고 사항

팬/틸트 재설정을 실행하면 카메라 헤드와 렌즈가 회전합니다. 실행하기 전에 렌즈가 막히지 않았는지 확인하십시오.

이 기기에는 팬/틸트 범위를 제한하는 기능이 있지만 기기가 켜져 있거나 팬/틸트 재설정이 실행되면 이 기능이 비활성화됩니
다.

힌트

팬/틸트 재설정이 완료되면 기기는 실행 전 위치로 돌아갑니다.

2
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웹 브라우저에서 웹 앱 액세스

기기를 태블릿이나 컴퓨터에 연결하여 웹 브라우저에서 기기를 작동하고 구성할 수 있습니다.

태블릿 또는 컴퓨터가 웹 앱 작업을 지원하는지 확인하십시오.

참고 사항

필요한 환경이 충족되지 않거나 태블릿/컴퓨터의 사용에 따라 웹 브라우저의 비디오 표시에 부정적인 영향을 미칠 수 있습니
다.

이 기기의 웹 앱은 JavaScript를 사용합니다. 태블릿/컴퓨터에서 바이러스 백신 소프트웨어를 사용하는 경우 웹 페이지가 올
바르게 표시되지 않을 수 있습니다.

1

항목 요건

표시
1080×810 픽셀 이상 권장
태블릿 디스플레이 크기: 10인치 이상 권장

지원되는 OS 및 웹 브라우저

Windows
OS Windows 10 이상

웹 브라우저 Google Chrome

Mac

OS macOS 10.15 이상

웹 브라우저
Google Chrome
Safari

iPad

OS iPadOS 15 이상

웹 브라우저
Google Chrome
Safari

Android
OS Android 12 이상

웹 브라우저 Google Chrome

기기, 태블릿 또는 컴퓨터, 주변 장치의 전원이 켜져 있는지 확인하십시오.2

기기와 태블릿 또는 컴퓨터가 Wi-Fi 또는 유선 LAN 로컬 영역 연결을 통해 연결되어 있는지 확인하십시오.3

태블릿 또는 컴퓨터의 웹 브라우저에서 기기에 연결합니다.

QR 코드를 사용하여 연결
태블릿의 카메라를 사용하여 기기 측면의 매체 커버에 인쇄된 QR 코드를 스캔합니다.

4
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참고 사항

HTTP 포트 번호가 80에서 변경된 경우 주소 표시줄에 "http://기기의 IP 주소:포트 번호"를 입력합니다.

QR 코드를 사용하여 연결하거나 웹 브라우저의 주소 표시줄에 URL을 입력하여 연결할 때 mDNS*를 지원하는 장치를 사용하십시
오.

힌트

이후 웹 브라우저의 북마크 기능을 사용하여 기기에 빠르게 액세스할 수 있습니다.

5-041-958-23(1) Copyright 2022 Sony Corporation

태블릿에 표시된 링크를 엽니다.
태블릿의 웹 브라우저가 실행되고 기기의 웹 앱 화면이 표시됩니다.

웹 브라우저의 주소 표시줄에 URL을 입력하여 연결
태블릿이나 컴퓨터에서 웹 브라우저를 실행하고 기기 측면의 매체 커버에 인쇄된 URL을 입력합니다.
웹 브라우저에 기기의 웹 앱 화면이 표시되어야 합니다.

웹 브라우저의 주소 표시줄에 기기의 IP 주소를 입력하여 연결
태블릿이나 컴퓨터에서 웹 브라우저를 실행하고 주소 표시줄에 "http://기기의 IP 주소"를 입력합니다.
웹 브라우저에 기기의 웹 앱 화면이 표시되어야 합니다.

mDNS: 로컬 네트워크의 호스트 이름에서 IP 주소를 결정하는 데 사용되는 통신 프로토콜입니다.*
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기기 초기화

기기를 처음 사용할 때 다음 절차에 따라 기기를 구성해야 합니다.

힌트

백업 배터리가 완전히 방전되면 초기 설정을 다시 구성해야 합니다.

태블릿이나 컴퓨터에서 기기에 연결하고 웹 앱을 시작합니다.

기기를 처음 사용하는 경우 웹 브라우저에 사용자 이름과 암호를 입력하라는 메시지가 표시됩니다. 다음 설정을 입력
합니다.

사용자 이름: admin
암호: (공백)

화면의 지침에 따라 초기 설정을 구성하십시오.

1

관리자(Administrator) 사용자 이름과 암호를 입력하고 [OK] 버튼을 누릅니다.

1: 관리자 사용자 이름을 입력합니다.
2: 관리자 암호를 설정합니다.
3: 확인을 위해 동일한 암호를 다시 입력합니다.

참고 사항

사용자 이름과 암호에는 다음 문자를 사용할 수 있습니다. 암호에는 적어도 1개의 대문자, 1개의 소문자, 1개의 숫자가 포함
되어야 하며 길이는 8~64자여야 합니다.

영숫자

2
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촬영 작업을 위한 라이브 화면이 나타납니다. 계속해서 작업 모드에 따라 기기의 기본 작업을 구성하십시오.

힌트

장치와 태블릿을 한 쌍으로 사용하는 경우와 같은 일부 경우에는 기기에 고정 IP 주소를 사용하는 것이 더 쉬울 수 있습니다.

고정 IP 주소를 설정하려면 먼저 웹 메뉴에서 [Network] > [Wired LAN] > [IPv4] > [DHCP](왼쪽 위치의 슬라이더 스위치)를 끄십시
오.

고정 IP 주소와 관련된 설정 항목이 나타납니다. 항목을 구성한 후 화면의 [OK] 버튼을 누릅니다.

기호(!$%`*+-./<=>?@[]^_{|}~)

웹 브라우저가 다시 로드되고 사용자 이름과 암호를 입력하라는 메시지가 표시됩니다.

2단계에서 구성한 사용자 이름과 암호를 입력합니다.

언어 및 시계 설정 화면이 나타납니다.

3

다음 항목을 지정하고 [OK] 버튼을 누릅니다.

[Language]
웹 앱 및 카메라 화면 표시에 사용할 언어를 선택합니다. 언어를 변경하면 웹 앱 표시 언어가 변경됩니다.
[Date & Time Format]
다음 옵션에서 날짜 및 시간 표시 형식을 선택합니다.
[yyyy-mm-dd hh:mm:ss], [mm-dd-yyyy hh:mm:ss], [dd-mm-yyyy hh:mm:ss]
"yyyy"는 연도, "mm"은 월, "dd"는 일, "hh"는 시, "mm"은 분, "ss"는 초를 나타냅니다.
[12 h/24 h]
시간 표시로 [12 h](12시간제) 또는 [24 h](24시간제)를 선택합니다.
[Time Setting]
날짜/시간 설정 방법을 선택합니다.
[Synchronize with PC]: 컴퓨터 또는 태블릿의 날짜/시간과 동기화합니다.
[Manual setting]: 수동으로 설정합니다. 이 방법을 선택하면 날짜 및 시간 입력 필드가 나타납니다.
[Time Zone]
시간대를 선택합니다.

4
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도움말 안내

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

기본 작동 구성

이 항목에서는 기본 작동을 위해 기기를 구성하는 방법에 대해 설명합니다.

촬영 모드 설정

작업 흐름에 맞게 기기의 촬영 모드를 선택할 수 있습니다.

Custom 모드: 촬영 중에 유연하게 이미지를 생성할 수 있습니다.
로그 촬영 모드: S-Log 내용을 기록합니다.

Flexible ISO 모드: 노출 설정은 촬영 중인 장면에 맞게 ISO 값을 조정하여 설정됩니다.
Cine EI 모드/Cine EI Quick 모드: 포스트 프로덕션에서 푸티지를 개발하여 필름 카메라와 유사하게 기기를 작동합
니다(촬영 시 이미지를 완전히 생성하지 않음).

Cine EI Quick 모드에서는 노출 지수 설정에 적합한 기본 감도가 자동으로 선택됩니다.
웹 메뉴 또는 카메라 메뉴의 [Project] > [Base Setting] > [Shooting Mode]를 사용하여 촬영 모드를 전환합니다.

Custom 모드

비디오 표준을 선택할 수 있습니다.
웹 메뉴 또는 카메라 메뉴의 [Project] > [Base Setting] > [Target Display]를 사용하여 전환합니다.

[SDR(BT.709)]: HD 방송 표준에 따라 촬영
[HDR(HLG)]: 차세대 4K 방송 표준에 따라 촬영

자세한 내용은 "보기 개요" 및 "원하는 보기로 촬영"의 기타 항목을 참조하십시오.

로그 촬영 모드
(Flexible ISO 모드/Cine EI 모드/Cine EI Quick 모드)
로그 촬영 모드에서는 촬영된 신호와 출력 신호에 대한 기본 색공간을 선택합니다. 여기서 선택한 색공간은 [LUT On/Off]
설정이 [MLUT Off]로 설정되었을 때의 비디오 출력 색공간입니다.
카메라 메뉴의 [Project] > [Cine EI/Flex.ISO Set] > [Color Gamut]을 사용하여 색공간을 변경할 수 있습니다.

[S-Gamut3.Cine/SLog3]: 디지털 시네마(DCI-P3)의 색공간을 쉽게 조정할 수 있습니다.
[S-Gamut3/SLog3]: ITU-R BT.2020 색공간을 포괄하는 Sony 와이드 컬러 영역입니다.

자세한 내용은 "포스트 프로덕션에서 보기 조정으로 촬영"을 참조하십시오.
 
각 촬영 모드에서 지원되는 기능은 다음 표와 같습니다.
●: 지원됨, –: 지원되지 않음

Custom Flexible ISO Cine EI Cine EI Quick

ISO/Gain ● ● – –

AGC ● ● – –

Base Sensitivity ● – – –

Base ISO – ● ● ● (EI에 연결)

Exposure Index – – ● ●
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힌트

Cine EI Quick 모드 및 Cine EI 모드에서는 이미지 센서의 성능을 극대화하기 위해 게인을 사용하지 않고 기본 ISO 감도로 촬영합
니다. 밝기는 조명과 ND 필터를 사용하여 조정되어 이미지 센서에 도달하는 빛의 양을 조정합니다.

시스템 주파수 설정

웹 메뉴 또는 카메라 메뉴의 [Project] > [Rec Format] > [Frequency]를 사용하여 전환합니다. 선택된 값에 따라 전환 후 기
기가 자동으로 재부팅될 수 있습니다.

참고 사항

녹화 또는 재생 중에는 시스템 주파수를 전환할 수 없습니다.

이미저 스캔 모드 설정

이미지 센서의 유효 영상 크기와 해상도를 설정할 수 있습니다.
웹 메뉴 또는 카메라 메뉴의 [Project] > [Rec Format] > [Imager Scan Mode]를 사용하여 전환합니다.
[FF]: 전체 프레임 크기.
[S35]: Super 35mm 크기.

참고 사항

녹화 또는 재생 중에는 이미저 스캔 모드를 전환할 수 없습니다.

S35로 설정되면 비디오 형식이 1920×1080으로 제한됩니다.

코덱 설정

녹화할 코덱을 설정할 수 있습니다.
웹 메뉴 또는 카메라 메뉴의 [Project] > [Rec Format] > [Codec]를 사용하여 전환합니다.

참고 사항

녹화 또는 재생 중에는 코덱을 전환할 수 없습니다.

비디오 형식 설정

녹화할 비디오 형식과 카메라에서 출력할 출력 형식을 설정할 수 있습니다.

웹 메뉴 또는 카메라 메뉴의 [Project] > [Rec Format] > [Video Format]을 사용하여 녹화할 비디오 형식을 전환합니다.
웹 메뉴 또는 카메라 메뉴의 [Monitoring] > [Output Format]을 사용하여 SDI OUT 및 HDMI OUT 커넥터의 출력 형식을
전환합니다.

참고 사항

Custom Flexible ISO Cine EI Cine EI Quick

Auto Shutter ● ● – –

ATW ● ● – –

LUT On/Off – ● ● ●

Scene File ● – – –

Paint/Look
(Base Look 제외)

● – – –
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녹화 또는 재생 중에는 비디오 형식을 전환할 수 없습니다.

비디오 형식 설정에 따라 SDI OUT 및 HDMI OUT 커넥터의 신호에 제한이 적용될 수 있습니다.

관련 항목

보기 개요

포스트 프로덕션에서 보기 조정으로 촬영

5-041-958-23(1) Copyright 2022 Sony Corporation
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도움말 안내

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

지원되는 메모리 카드

본 기기는 카드 슬롯에 삽입된 CFexpress Type A 메모리 카드(별매) 또는 SDXC 메모리 카드(별매)에 오디오와 비디오를
기록합니다. 메모리 카드는 프록시 녹화에도 사용됩니다.

CFexpress Type A 메모리 카드

기기의 "권장 녹화 매체"에 나열된 Sony CFexpress Type A 메모리 카드*를 사용하십시오.
다른 제조업체의 매체를 사용하는 작업에 대한 자세한 내용은 매체의 사용 설명서를 참조하거나 제조업체의 정보를 확인
하십시오.

SDXC 메모리 카드

기기의 "권장 녹화 매체"에 나열된 SDXC 메모리 카드*를 사용하십시오.

권장 녹화 매체

보장된 작동 환경은 Rec Format 및 Recording 설정에 따라 달라집니다.

CFexpress Type A
VPG400 준수
기기의 모든 녹화 형식에 대해 지원됩니다.

SDXC
다음 표의 조건에서 지원됩니다. "●"는 작업이 확인되었음을 나타내고 "–"는 작업이 보장되지 않음을 나타냅니다.

RAW Out & XAVC-I, 4096×2160 Class 300, 일반 모드

RAW Out & XAVC-I, 3840×2160 Class 300, 일반 모드

도움말 안내에서는 "CFexpress 카드"라고 합니다.*

도움말 안내에서는 "SD 카드"라고 합니다.*

시스템 주파수 Class 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P – – – – – – ●

50P – – – – – – ●

29.97P – – – – – ● ●

25P – – – – – ● ●

24P – – – – – ● ●

23.98P – – – – – ● ●

시스템 주파수 Class 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P – – – – – – ●
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RAW Out & XAVC-I, 3840×2160 Class 300, S&Q(60 fps 이하)

RAW Out & XAVC-I, 3840×2160 Class 300, S&Q(100 fps, 120 fps)
확인된 매체를 사용할 수 없습니다.

XAVC-I, 4096×2160 Class 300, 일반 모드

XAVC-I, 4096×2160 Class 300, S&Q(60 fps 이하)

시스템 주파수 Class 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

50P – – – – – – ●

29.97P – – – – – ● ●

25P – – – – – ● ●

23.98P – – – – – ● ●

시스템 주파수 Class 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P – – – – – – ●

50P – – – – – – ●

29.97P – – – – – – ●

25P – – – – – – ●

23.98P – – – – – – ●

시스템 주파수 Class 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P – – – – – – ●

50P – – – – – – ●

29.97P – – – – – ● ●

25P – – – – – ● ●

24P – – – – – ● ●

23.98P – – – – – ● ●

시스템 주파수 Class 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P – – – – – – ●

50P – – – – – – ●

29.97P – – – – – – ●

25P – – – – – – ●

24P – – – – – – ●
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XAVC-I, 3840×2160 Class 300, 일반 모드

XAVC-I, 3840×2160 Class 300, S&Q(60 fps 이하)

XAVC-I, 3840×2160 Class 300, S&Q(100 fps, 120 fps)
확인된 매체를 사용할 수 없습니다.

XAVC-I, 1920×1080 Class 100, 일반 모드

XAVC-I, 1920×1080 Class 100, S&Q(60 fps 이하)

시스템 주파수 Class 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

23.98P – – – – – – ●

시스템 주파수 Class 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P – – – – – – ●

50P – – – – – – ●

29.97P – – – – – ● ●

25P – – – – – ● ●

23.98P – – – – – ● ●

시스템 주파수 Class 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P – – – – – – ●

50P – – – – – – ●

29.97P – – – – – – ●

25P – – – – – – ●

23.98P – – – – – – ●

시스템 주파수 Class 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P – – – – – ● ●

50P – – – – – ● ●

29.97P – – ● – ● ● ●

25P – – ● – ● ● ●

23.98P – – ● – ● ● ●

시스템 주파수 Class 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P – – – – – ● ●
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XAVC-I, 1920×1080 Class 100, S&Q(100 fps, 120 fps)

XAVC-I, 1920×1080 Class 100, S&Q(150 fps, 180 fps)
확인된 매체를 사용할 수 없습니다.

XAVC-I, 1920×1080 Class 100, S&Q(200 fps, 240 fps)
확인된 매체를 사용할 수 없습니다.

XAVC-L, 3840×2160 420, 일반 모드

XAVC-L, 3840×2160 420, S&Q(60 fps 이하)

시스템 주파수 Class 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

50P – – – – – ● ●

29.97P – – – – – ● ●

25P – – – – – ● ●

23.98P – – – – – ● ●

시스템 주파수 Class 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P – – – – – – ●

50P – – – – – – ●

29.97P – – – – – – ●

25P – – – – – – ●

23.98P – – – – – – ●

시스템 주파수 Class 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P – – ● – ● ● ●

50P – – ● – ● ● ●

29.97P – – ● – ● ● ●

25P – – ● – ● ● ●

23.98P – – ● – ● ● ●

시스템 주파수 Class 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P – – ● – ● ● ●

50P – – ● – ● ● ●

29.97P – – – – – ● ●

25P – – – – – ● ●
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XAVC-L, 3840×2160 420, S&Q(100 fps, 120 fps)

XAVC-L, 1920×1080 HD50, 일반 모드

XAVC-L, 1920×1080 HD50, S&Q(60 fps 이하)

XAVC-L, 1920×1080 HD50, S&Q(100 fps, 120 fps)

시스템 주파수 Class 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

23.98P – – – – – – ●

시스템 주파수 Class 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P – – – – – ● ●

50P – – – – – ● ●

29.97P – – – – – – ●

25P – – – – – – ●

23.98P – – – – – – –

시스템 주파수 Class 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P – – ● – ● ● ●

50P – – ● – ● ● ●

29.97P – – ● – ● ● ●

25P – – ● – ● ● ●

23.98P – – ● – ● ● ●

시스템 주파수 Class 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P ● ● ● ● ● ● ●

50P ● ● ● ● ● ● ●

29.97P – – ● – ● ● ●

25P – – ● – ● ● ●

23.98P – – ● – ● ● ●

시스템 주파수 Class 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P – – ● – ● ● ●

50P – – ● – ● ● ●

29.97P – – – – – ● ●

25P – – – – – ● ●
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XAVC-L, 1920×1080 HD50, S&Q(150 fps, 180 fps)

XAVC-L, 1920×1080 HD50, S&Q(200 fps, 240 fps)

XAVC-L, 1920×1080 HD35, 일반 모드

XAVC-L, 1920×1080 HD35, S&Q(60 fps 이하)

시스템 주파수 Class 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

23.98P – – – – – ● ●

시스템 주파수 Class 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P – – – – – ● ●

50P – – – – – ● ●

29.97P – – – – – – ●

25P – – – – – – ●

23.98P – – – – – – ●

시스템 주파수 Class 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P – – – – – ● ●

50P – – – – – ● ●

29.97P – – – – – – ●

25P – – – – – – ●

23.98P – – – – – – ●

시스템 주파수 Class 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P ● ● ● ● ● ● ●

50P ● ● ● ● ● ● ●

29.97P ● ● ● ● ● ● ●

25P ● ● ● ● ● ● ●

23.98P ● ● ● ● ● ● ●

시스템 주파수 Class 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P ● ● ● ● ● ● ●

50P ● ● ● ● ● ● ●

29.97P – – ● – ● ● ●

25P – – ● – ● ● ●
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XAVC-L, 1920×1080 HD35, S&Q(100 fps, 120 fps)

XAVC-L, 1920×1080 HD35, S&Q(150 fps, 180 fps)

XAVC-L, 1920×1080 HD35, S&Q(200 fps, 240 fps)

5-041-958-23(1) Copyright 2022 Sony Corporation

시스템 주파수 Class 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

23.98P – – ● – ● ● ●

시스템 주파수 Class 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P – – ● – ● ● ●

50P – – ● – ● ● ●

29.97P – – ● – ● ● ●

25P – – ● – ● ● ●

23.98P – – – – – ● ●

시스템 주파수 Class 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P – – ● – ● ● ●

50P – – ● – ● ● ●

29.97P – – – – – ● ●

25P – – – – – ● ●

23.98P – – – – – ● ●

시스템 주파수 Class 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P – – ● – ● ● ●

50P – – ● – ● ● ●

29.97P – – – – – ● ●

25P – – – – – ● ●

23.98P – – – – – – ●
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도움말 안내

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

메모리 카드 삽입

이 항목에서는 메모리 카드 삽입 시 주의사항에 대해 설명합니다.

카드 슬롯 섹션의 매체 커버를 엽니다.1

메모리 카드를 삽입합니다.

CFexpress 카드의 경우 라벨이 위쪽을 향합니다.

참고 사항

천장에 장착된 기기에서는 라벨이 아래쪽을 향합니다.

SD 카드의 경우 라벨이 아래쪽을 향합니다.

참고 사항

천장에 장착된 기기에서는 라벨이 위쪽을 향합니다.

액세스 표시등이 빨간색으로 켜진 다음 카드를 사용할 수 있을 때 녹색으로 바뀝니다.

2
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참고 사항

카드를 잘못된 방향으로 슬롯에 넣으면 메모리 카드, 메모리 카드 슬롯 및 메모리 카드의 이미지 데이터가 손상될 수 있습니다.

CFexpress Type A/SD 카드 슬롯 A 및 B에 모두 삽입된 매체에 녹화하는 경우 양쪽 슬롯에 녹화 형식으로 작업이 권장되는 매체를
삽입합니다.

5-041-958-23(1) Copyright 2022 Sony Corporation

참고 사항

액세스 표시등이 빨간색으로 계속 깜박이고 녹색으로 바뀌지 않으면 기기를 잠깐 끄고 메모리 카드를 제거한 다음 다시 삽입
합니다.

매체 커버를 닫습니다.3
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메모리 카드 꺼내기

카드 슬롯 섹션의 매체 커버를 열고 메모리 카드를 살짝 눌러 카드를 꺼냅니다.

참고 사항

메모리 카드를 액세스하는 동안 기기가 꺼지거나 메모리 카드를 제거하면 카드의 데이터 무결성을 보장할 수 없게 됩니다. 카드에
저장된 모든 데이터가 폐기될 수 있습니다. 기기를 끄거나 메모리 카드를 제거하기 전에 액세스 표시등이 녹색이거나 꺼져 있는지
항상 확인합니다.

녹화가 끝난 직후 메모리 카드를 제거하면 메모리 카드가 뜨거울 수 있지만 문제가 있는 것은 아닙니다.

5-041-958-23(1) Copyright 2022 Sony Corporation
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메모리 카드 포맷(초기화)

포맷되지 않은 메모리 카드나 다른 사양으로 포맷된 메모리 카드를 삽입하면 카메라 이미지 패널에 "Media Needs to be
Formatted"라는 메시지가 표시됩니다.
다음 절차를 통해 카드를 포맷합니다.

참고 사항

메모리 카드를 포맷하면 녹화된 비디오 데이터와 설정 파일을 포함하여 모든 데이터가 삭제됩니다.

포맷 프로세스 시간에 따라 메시지가 나타날 수 있습니다.

포맷에 실패하는 경우

기기가 지원하지 않는 메모리 카드는 포맷할 수 없습니다.
경고 메시지가 표시됩니다. 지침에 따라 카드를 지원되는 메모리 카드로 교체합니다.

기기에서 포맷된 카드를 다른 장치의 슬롯에 사용하려는 경우

먼저 카드를 백업한 다음 사용할 다른 장치에서 카드를 다시 포맷합니다.

5-041-958-23(1) Copyright 2022 Sony Corporation

카메라 메뉴의 [TC/Media] > [Format Media]를 선택합니다.1

Media(A) (슬롯 A) 또는 Media(B) (슬롯 B)를 선택한 다음 형식 지정 방법(Full Format 또는 Quick Format)을 선택
합니다.

확인 메시지가 나타납니다.
[Full Format]: 데이터 영역 및 데이터 관리 정보를 포함하여 매체를 완전히 초기화합니다.
[Quick Format]: 매체의 데이터 관리 정보만 초기화합니다.

2

[Execute]를 선택합니다.

포맷이 진행되는 동안 메시지가 표시되고 액세스 표시등이 빨간색으로 켜집니다.
포맷이 종료되면 완료 메시지가 나타납니다.

3
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남은 녹화 시간 확인

촬영(녹화/대기) 시 카메라 이미지 패널에서 슬롯 A/B 남은 매체 표시를 사용하여 각 슬롯에 있는 메모리 카드의 남은 용량
을 모니터링할 수 있습니다 .
남은 녹화 시간은 각 슬롯에 있는 매체의 남은 용량과 현재 녹화 형식(녹화 비트 전송률)에서 계산되고 분 단위로 표시됩니
다.

메모리 카드 교체 시기

두 메모리 카드에서 남은 총 녹화 시간이 5분 미만인 경우 "Media Near Full" 메시지가 나타나고 녹화/기록 램프가 깜박이
기 시작하여 해당 사실을 경고합니다.
여유 공간이 있는 매체로 교체합니다.
남은 총 녹화 시간이 0이 될 때까지 계속 녹화하면 메시지가 "Media Full"로 변경되면서 녹화가 중지됩니다.

참고 사항

하나의 메모리 카드에 클립을 약 600개까지 녹화할 수 있습니다.

5-041-958-23(1) Copyright 2022 Sony Corporation
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메모리 카드 복원

어떤 이유로든 메모리 카드에 오류가 발생하면 사용하기 전에 카드를 복원해야 합니다.
복원해야 할 메모리 카드를 로드하면 카메라 이미지 패널에 복원 여부를 묻는 메시지가 나타납니다.

카드를 복원하려면

GUI 제어 패널의 화살표 버튼을 이용하여 [Execute]를 선택하고 [Set] 버튼을 누릅니다.
포맷이 진행되는 동안 메시지와 진행 상태(%)가 표시되고 액세스 표시등이 빨간색으로 켜집니다.
복원이 종료되면 완료 메시지가 나타납니다.

복원에 실패하는 경우

메모리 오류가 발생한 메모리 카드는 복원할 수 없습니다. 경고 메시지가 표시됩니다. 지침에 따라 메모리 카드를 교체
합니다.
메모리 오류가 발생한 메모리 카드는 포맷하면 다시 사용할 수 있습니다.
경우에 따라 일부 클립은 복원되지만 다른 클립이 복원되지 못할 수 있습니다. 복원된 클립은 정상적으로 재생할 수 있
습니다.

참고 사항

이 기기로 녹화한 매체를 복원하려면 같은 기기를 사용해야 합니다.

이 기기가 아닌 다른 장치 또는 다른 버전(동일 모델이라도)의 기기로 녹화한 매체는 이 기기를 사용하여 복원할 수 있습니다.

2초보다 짧은 클립은 복원할 수 없습니다.

5-041-958-23(1) Copyright 2022 Sony Corporation
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녹화 시작/중지

이 항목에서는 녹화를 시작/중지하는 방법에 대해 설명합니다.

필요한 장치를 장착하고 본 기기 및 주변 장치의 전원이 공급되고 있는지 확인합니다.1

메모리 카드를 삽입합니다.2

웹 앱 화면 왼쪽 상단에서 기기의 전원 상태를 확인합니다.

전원 공급 장치가 켜져 있는 경우
기기가 켜져 있는 경우 웹 앱 화면 상단의 전원 스위치에 [Power ON]이 표시됩니다.

기기 전면에 POWER 램프가 켜지고 웹 앱의 라이브 작동 화면에 카메라 이미지가 나타납니다.

참고 사항

관리자 암호가 구성되지 않은 경우 암호를 구성하라는 화면이 나타납니다. "기기 초기화"를 참조하십시오.

전원 공급 장치가 대기 상태인 경우
기기의 전원 공급 장치가 대기 상태인 경우 웹 앱의 전원 스위치에 [Power Standby]가 표시됩니다.

이 상태에서 전원 스위치를 누르고 [Power ON]을 선택합니다. 기기가 켜지고 기기 전면에 POWER 램프가 녹색으로
켜진 다음 웹 앱의 라이브 작동 화면에 카메라 이미지가 나타납니다.

힌트

제공된 적외선 리모콘의 전원 버튼을 사용하여 기기를 켤 수도 있습니다.

3

녹화 START/STOP 버튼을 누릅니다.4
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기기의 전원 공급 장치를 대기 상태로 전환하려면

웹 앱에서 전원 스위치를 누르고 [Power Standby]를 선택하여 기기의 전원을 대기 상태로 설정합니다.

힌트

제공된 적외선 리모컨의 전원 버튼을 사용하여 전원 공급 장치를 대기 상태로 설정할 수도 있습니다.

관련 항목

기기 초기화

5-041-958-23(1) Copyright 2022 Sony Corporation

녹화가 시작되고 기기의 녹화/기록 램프(2곳)가 켜집니다.
녹화 중에는 녹화 START/STOP 버튼이 켜집니다. 또한 대상 녹화 매체의 아이콘과 [●Rec]가 표시됩니다.

녹화를 중지하려면 녹화 START/STOP 버튼을 다시 누릅니다.

녹화가 중지되고 기기의 녹화/기록 램프(2곳)가 꺼집니다.
녹화 대기 상태에서는 녹화 START/STOP 버튼에 불이 들어오지 않습니다. 또한 대상 녹화 매체의 아이콘과 [Stby]가
표시됩니다.

힌트

제공된 적외선 리모콘의 녹화 START/STOP 버튼을 사용하여 녹화를 시작/중지할 수도 있습니다.

5
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메모리 카드 사이 전환

두 개의 메모리 카드가 삽입된 경우 웹 앱의 재생 제어 패널에서 [Slot Select] 버튼을 눌러 메모리 카드를 전환할 수 있습니
다.

힌트

제공된 적외선 리모컨의 SLOT SEL(메모리 카드 슬롯(A)/(B) 선택) 버튼을 눌러 메모리 카드를 전환할 수도 있습니다.

릴레이 녹화 정보

녹화 시 기기는 첫 번째 메모리 카드에서 남은 용량이 0이 되기 전에 두 번째 메모리 카드로 녹화를 자동 전환합니다(릴레
이 녹화). 꽉 찬 메모리 카드를 새 메모리 카드로 교체하면 메모리 카드를 전환할 때 계속해서 녹화할 수 있습니다.

참고 사항

재생 모드 중에는 메모리 카드 사이를 전환할 수 없습니다. 또한 슬롯 A와 슬롯 B의 매체에 걸쳐 있는 클립의 연속 재생은 지원하지
않습니다.

녹화된 데이터 정보

녹화를 중지하면 녹화 시작부터 끝까지의 비디오, 오디오 및 관련 데이터가 메모리 카드에 단일 "클립"으로 저장됩니다.

녹화된 데이터의 클립 이름

기기에서 녹화된 각 클립의 이름은 카메라 메뉴의 [TC/Media] > [Clip Name Format]을 사용하여 자동으로 할당됩니다.

최대 클립 길이

클립당 최대 6시간입니다.
연속 녹화 최대 길이는 클립의 최대 길이와 동일합니다. 녹화 시간이 클립의 최대 길이를 초과한 경우 새 클립이 자동으로
생성되어 녹화가 계속됩니다. 새 클립은 썸네일 화면에서 별도의 클립으로 표시됩니다.
릴레이 녹화 중에는 연속으로 여러 개의 클립이 녹화되지만 약 24시간 후에는 녹화가 자동으로 중지됩니다.

참고 사항

녹화 중에는 메모리 카드를 꺼내지 마십시오. 녹화 중에는 슬롯 액세스 표시등이 꺼져 있는 슬롯에서만 메모리 카드를 교체하십시
오.

녹화 중인 메모리 카드의 남은 용량이 1분 미만이고 다른 슬롯에 녹화가 가능한 메모리 카드가 삽입되어 있는 경우 "Will Switch
Slots Soon" 메시지가 나타납니다. 메모리 카드 슬롯이 전환되면 메시지가 사라집니다.

남은 메모리 카드 용량이 1분 미만일 때 녹화가 시작되는 경우 릴레이 녹화가 작동하지 않을 수 있습니다. 올바른 릴레이 녹화를 위
해 녹화 시작 전에 남은 메모리 카드 용량이 1분 이상인지 확인하십시오.

기기의 릴레이 녹화 기능을 사용하여 만든 비디오는 기기에서 끊김 없이 재생할 수 없습니다.

기기의 릴레이 녹화 기능을 사용하여 생성한 비디오를 합치려면 "Catalyst Browse" 소프트웨어를 사용하십시오.

5-041-958-23(1) Copyright 2022 Sony Corporation
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오디오 확인

오디오는 기기의 SDI 및 HDMI 커넥터에서 출력됩니다. 카메라 메뉴의 [Audio] > [Audio Output] > [HDMI/Stream Output
CH]를 사용하여 HDMI 커넥터에서 출력되는 오디오 채널의 조합을 선택합니다.
CH1/CH2: CH1 및 CH2 조합
CH3/CH4: CH3 및 CH4 조합
웹 앱에서 오디오를 모니터링할 때 카메라 이미지의 오른쪽 하단에 있는 오디오 레벨 미터를 사용하십시오.

5-041-958-23(1) Copyright 2022 Sony Corporation
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시간 데이터 지정

이 항목에서는 시간 데이터를 설정하는 방법에 대해 설명합니다.

타임코드 설정

카메라 메뉴의 [TC/Media] > [Timecode]를 이용하여 녹화할 타임코드를 설정합니다.

사용자 비트 설정

8자리 16진수를 녹화된 이미지에 사용자 비트로 추가할 수 있습니다. 또한 현재 시간에 사용자 비트를 설정할 수도 있습니
다. 카메라 메뉴의 [TC/Media] > [Users Bit]를 사용하여 설정합니다.

시간 데이터 표시

카메라 메뉴의 [TC/Media] > [TC Display] > [Display Select]를 사용하여 녹화할 타임코드를 설정합니다.
[DURATION/TC/U-BIT]가 할당된 할당 가능 버튼을 누르면 타임코드, 사용자 비트 및 길이가 순서대로 화면에서 전환됩니
다.

5-041-958-23(1) Copyright 2022 Sony Corporation
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녹화 검토(Rec Review)

화면에서 마지막으로 녹화된 클립을 검토할 수 있습니다(녹화 검토).

참고 사항

클립을 녹화한 후 비디오 형식이 변경되면 Rec Review가 지원되지 않습니다.

Rec Review 시작 위치 설정

카메라 메뉴의 [Technical] > [Rec Review]를 사용하여 재생 시작 위치를 다음 중 하나로 설정할 수 있습니다.

클립의 마지막 3초
클립의 마지막 10초
클립 시작

힌트

여러 클립을 녹화한 후 특정 클립을 검토하려면 [Thumbnail] 버튼을 눌러 썸네일 화면을 표시하고 재생을 시작할 클립을 선택합니
다.

제공된 적외선 리모콘의 THUMBNAIL 버튼을 눌러 썸네일 화면을 표시할 수도 있습니다.

Rec Review 방법

사전에 기본 구성 조정 패널의 할당 가능 버튼 중 하나에 Rec Review 기능을 할당합니다.

할당에 대한 자세한 내용은 "유용한 기능"의 "할당 가능 버튼"을 참조하십시오.

녹화를 중지한 다음 Rec Review 기능이 할당된 할당 가능 버튼을 눌러 이전에 녹화된 클립의 재생을 시작합니다.
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클립이 마지막까지 재생되고 Rec Review가 종료되면 기기가 Stby(대기) 모드로 되돌아갑니다.

Rec Review를 중지하려면

Rec Review가 할당된 할당 가능 버튼을 누르거나 [Cancel/Back] 버튼을 누릅니다.

132



힌트

제공된 적외선 리모컨의 [Cancel/Back] 버튼을 눌러 Rec Review 기능을 중지할 수도 있습니다.

관련 항목

할당 가능 버튼

5-041-958-23(1) Copyright 2022 Sony Corporation
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프레이밍 조정 화면

프레이밍은 라이브 작동 화면의 다음 부분을 사용하여 조정됩니다.

참고 사항

카메라의 방향, 렌즈의 초점 거리, 줌 위치에 따라 커넥터 블록에 연결된 기기 또는 케이블의 일부가 보일 수 있습니다. 촬영하기 전
에 사용 중인 렌즈의 화각과 초점 거리를 확인하십시오. 웹 메뉴의 [Pan-Tilt] > [P/T Range Limit]을 사용하여 팬/틸트 범위를 제어할
수도 있습니다. 기기의 전원을 켜거나 팬/틸트 재설정을 실행하면 이 범위 제한 설정이 무시됩니다. 자세한 내용은 웹 메뉴의 [Pan-
Tilt] > [P/T Range Limit]을 참조하십시오.

힌트

제공된 적외선 리모컨을 사용하여 프레이밍을 제어할 수도 있습니다.

5-041-958-23(1) Copyright 2022 Sony Corporation

사전 설정 위치 제어 패널1.

 (Main) 탭 /  (Others) 탭2.

프레이밍 제어 패널3.
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웹 앱을 사용하여 촬영 방향 조정

카메라를 수평으로 움직이는 것을 패닝이라고 하고 수직으로 카메라를 움직이는 것을 틸팅이라고 합니다.
팬/틸트 작업을 사용하여 촬영 방향을 조정할 수 있습니다.

힌트

조이스틱 아래에 [Execute Pan-Tilt Reset]이 표시되면 기기의 팬/틸트 제어 원점 정보에 불일치가 발생한 것입니다. 팬/틸트 재설정
기능을 실행하여 원점 정보를 업데이트합니다. 자세한 내용은 "팬/틸트 재설정"을 참조하십시오.

카메라를 정면으로 향하게 하려면

카메라 제어 패널의 (Others) 탭에서  (팬/틸트 홈) 버튼을 누릅니다.

참고 사항

카메라의 방향, 렌즈의 초점 거리, 줌 위치에 따라 커넥터 블록에 연결된 기기 또는 케이블의 일부가 보일 수 있습니다. 촬영하기 전
에 사용 중인 렌즈의 화각과 초점 거리를 확인하십시오. 웹 메뉴의 [Pan-Tilt] > [P/T Range Limit]을 사용하여 팬/틸트 범위를 제어할
수도 있습니다. 기기의 전원을 켜거나 팬/틸트 재설정을 실행하면 이 범위 제한 설정이 무시됩니다. 자세한 내용은 웹 메뉴의 [Pan-
Tilt] > [P/T Range Limit]을 참조하십시오.

관련 항목

팬/틸트 재설정

5-041-958-23(1) Copyright 2022 Sony Corporation

프레이밍 제어 패널에서  (팬/틸트/줌) 탭을 눌러 조이스틱을 표시합니다.1

카메라 이미지 패널을 모니터링하면서 조이스틱의 중앙을 보고 싶은 방향으로 드래그합니다.

드래그 방향과 레벨에 따라 카메라의 방향과 속도가 변경됩니다.
조이스틱의 주변 영역을 눌러 팬/틸트를 보다 정확하게 조정할 수 있습니다.

2

135



도움말 안내

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

팬/틸트 작동 속도 설정

프레이밍 제어 패널의 조이스틱을 조작하여 카메라 제어 패널의 [Pan-Tilt Speed] 슬라이더를 사용함으로써 팬/틸트 작동
속도를 변경할 수 있습니다.

참고 사항

카메라의 동작 범위 내에 벽이나 기타 장애물이 있는 경우 팬/틸트 작동 중 카메라나 렌즈에 부딪히지 않도록 주의하십시오.

팬/틸트 가속은 렌즈의 무게 균형과 같은 물리적 특성에 따라 달라집니다. 웹 메뉴 또는 카메라 메뉴에서 [Pan-Tilt] > [P/T
Acceleration] > [Ramp Curve]를 이용하여 가속 설정을 변경할 수 있습니다.

5-041-958-23(1) Copyright 2022 Sony Corporation

카메라 제어 패널의  (Main) 탭을 누릅니다.1

목록에서 [Pan-Tilt Speed] 슬라이더를 선택합니다.

[Pan-Tilt Speed] 슬라이더가 표시되지 않으면 2개의 슬라이더 기능 선택 버튼 중 하나를 선택하여 슬라이더를 표시합
니다.

2

슬라이더 노브를 왼쪽 또는 오른쪽으로 움직입니다.

노브를 왼쪽으로 움직이면 작동 속도가 감소하고 노브를 오른쪽으로 움직이면 작동 속도가 증가합니다.

3
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팬/틸트 작동 가속 설정

웹 메뉴 또는 카메라 메뉴에서 [Pan-Tilt] > [P/T Acceleration] > [Ramp Curve]를 이용하여 가속 동작을 9단계로 설정할 수
있습니다. 속도를 더 빠르게 변경하려면 값을 늘리고 속도를 더 점진적으로 변경하려면 값을 줄이십시오.
팬/틸트 작동 시 응답성을 높이려면 7~9의 값을 선택하십시오.
사전 설정 위치로의 이동 시작/종료 시 위치 정확도를 높이려면 1~6 범위의 값을 사용하는 것이 좋습니다.

사전 설정 위치에 대한 자세한 내용은 "팬/틸트 및 줌 위치 저장/복원"을 참조하십시오.

참고 사항

값을 높게 설정하면 무거운 렌즈를 장착할 경우 기능이 제대로 작동하지 않을 수 있습니다. 실제 사용 전에 작동을 확인하십시오.

[Ramp Curve] 설정 및 팬/틸트 작동 간의 관계

팬/틸트가 작동할 경우

사전 설정 위치를 불러올 경우
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제공된 적외선 리모컨을 사용하여 촬영 방향 조정

제공된 적외선 리모컨의 팬/틸트 조작 버튼을 사용하여 촬영 방향을 조정할 수 있습니다.

카메라를 정면으로 향하게 하려면

HOME 버튼을 누릅니다.

참고 사항

카메라의 방향, 렌즈의 초점 거리, 줌 위치에 따라 커넥터 블록에 연결된 기기 또는 케이블의 일부가 보일 수 있습니다. 촬영하기 전
에 사용 중인 렌즈의 화각과 초점 거리를 확인하십시오. 웹 메뉴의 [Pan-Tilt] > [P/T Range Limit]을 사용하여 팬/틸트 범위를 제어할
수도 있습니다. 기기의 전원을 켜거나 팬/틸트 재설정을 실행하면 이 범위 제한 설정이 무시됩니다. 자세한 내용은 웹 메뉴의 [Pan-
Tilt] > [P/T Range Limit]을 참조하십시오.

5-041-958-23(1) Copyright 2022 Sony Corporation

화살표 버튼을 눌러 팬/틸트를 제어합니다.

카메라 이미지를 모니터링하면서 보고자 하는 방향의 화살표 버튼을 누릅니다.
짧은 거리를 이동하려면 화살표 버튼을 짧게 누릅니다.
먼 거리를 이동하려면 화살표 버튼을 길게 누릅니다.
대각선으로 이동하려면 (위쪽 화살표) 또는 (아래쪽 화살표) 버튼을 누른 상태에서 (왼쪽 화살표) 또는 (오
른쪽 화살표) 버튼을 누릅니다.

1
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줌 유형 설정

카메라 메뉴의 [Technical] > [Zoom] > [Zoom Type]를 사용하여 줌 유형을 설정합니다.
줌 유형은 부착된 렌즈 유형에 따라 달라집니다.

참고 사항

다음과 같은 경우 Clear Image Zoom을 사용할 수 없습니다.

[Shooting] > [S&Q Motion] > [Setting]이 On으로 설정되어 있고 카메라 메뉴의 [Frame Rate] 설정이 60 fps 이상인 경우
카메라 메뉴의 [Project] > [Rec Format] > [Codec]이 [RAW] 또는 RAW를 포함하는 옵션으로 설정된 경우

렌즈에서 SERVO/MANUAL 선택 스위치를 작동시키면 Clear Image Zoom의 배율이 1×로 재설정됩니다.

Clear Image Zoom 중에는 AF-S가 지원되지 않습니다.

Clear Image Zoom

기기에는 Clear Image Zoom이라고 하는 이미지 신호 처리를 사용하는 줌 기능이 장착되어 있습니다. Clear Image Zoom
이 활성화되면 고정 초점 렌즈에서도 줌이 지원됩니다. 또한 파워 줌 렌즈에서 광학 거리 이상으로 범위를 확장하는 데 사
용할 수도 있습니다.
Clear Image Zoom을 사용하는 최대 줌 비율은 녹화 해상도에 따라 달라집니다.

QFHD/4K 녹화 해상도: 1.5×
HD 녹화 해상도: 2×

5-041-958-23(1) Copyright 2022 Sony Corporation

부착된 렌즈의 유형
[Zoom Type] 설정

[Optical Zoom Only] [On(Clear Image Zoom)]

고정 초점 렌즈/수동 줌 렌즈 줌 조작이 지원되지 않습니다. Clear Image Zoom이 지원됩니다.

파워 줌 렌즈 광학 줌만 지원됩니다. 광학 줌과 Clear Image Zoom이 지원됩니다.
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웹 앱을 사용하여 줌 조정

광학 줌 또는 Clear Image Zoom을 사용하여 기기의 줌을 조정할 수 있습니다. 이 항목에서는 웹 앱을 사용하여 조정하는
방법에 대해 설명합니다. Clear Image Zoom에 대한 자세한 내용은 "줌 유형 설정"을 참조하십시오.

참고 사항

카메라의 방향, 렌즈의 초점 거리, 줌 위치에 따라 커넥터 블록에 연결된 기기 또는 케이블의 일부가 보일 수 있습니다. 촬영하기 전
에 사용 중인 렌즈의 화각과 초점 거리를 확인하십시오. 웹 메뉴의 [Pan-Tilt] > [P/T Range Limit]을 사용하여 팬/틸트 범위를 제어할
수도 있습니다. 기기의 전원을 켜거나 팬/틸트 재설정을 실행하면 이 범위 제한 설정이 무시됩니다. 자세한 내용은 웹 메뉴의 [Pan-
Tilt] > [P/T Range Limit]을 참조하십시오.

실제 줌 속도 및 정확도는 렌즈에 따라 다릅니다. 사용 전에 작동을 확인하십시오.

힌트

이 기기와 호환되는 렌즈 제어기(옵션)를 사용하여 수동 줌 렌즈의 줌을 제어할 수 있습니다. 자세한 내용은 "렌즈 제어기 연결" 및
"렌즈 제어기를 사용하여 줌 조정"을 참조하십시오.

관련 항목

줌 유형 설정

렌즈 제어기 연결

렌즈 제어기를 사용하여 줌 조정

5-041-958-23(1) Copyright 2022 Sony Corporation

프레이밍 제어 패널에서 (팬/틸트/줌) 탭을 눌러 팬/틸트 제어 패널을 표시합니다.1

[Zoom] 슬라이더 노브를 [T](망원) 방향 또는 [W](광각) 방향으로 밀어 줌을 조정합니다.

줌 속도는 슬라이더의 움직임에 따라 다릅니다.

2
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줌 작동 속도 설정

프레이밍 제어 패널에서 [Zoom] 슬라이더의 줌 작동 속도를 변경할 수 있습니다(카메라 제어 패널의 [Zoom Speed] 슬라
이더 사용).

참고 사항

실제 줌 속도 및 정확도는 렌즈에 따라 다릅니다. 사용 전에 작동을 확인하십시오.

5-041-958-23(1) Copyright 2022 Sony Corporation

카메라 제어 패널의  (Main) 탭을 누릅니다.1

목록에서 [Zoom Speed] 슬라이더를 선택합니다.

[Zoom Speed] 슬라이더가 표시되지 않으면 2개의 슬라이더 기능 선택 버튼 중 하나를 선택하여 슬라이더를 표시합
니다.

 

2

[Zoom Speed] 슬라이더 노브를 왼쪽 또는 오른쪽으로 움직입니다.

노브를 왼쪽으로 움직이면 작동 속도가 감소하고 노브를 오른쪽으로 움직이면 작동 속도가 증가합니다.

3
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제공된 적외선 리모컨을 사용하여 줌 조정

광학 줌 또는 Clear Image Zoom을 사용하여 기기의 줌을 조정할 수 있습니다. 이 항목에서는 제공된 적외선 리모컨을 사
용하여 조정하는 방법에 대해 설명합니다. Clear Image Zoom에 대한 자세한 내용은 "줌 유형 설정"을 참조하십시오.

참고 사항

카메라의 방향, 렌즈의 초점 거리, 줌 위치에 따라 커넥터 블록에 연결된 기기 또는 케이블의 일부가 보일 수 있습니다. 촬영하기 전
에 사용 중인 렌즈의 화각과 초점 거리를 확인하십시오. 웹 메뉴의 [Pan-Tilt] > [P/T Range Limit]을 사용하여 팬/틸트 범위를 제어할
수도 있습니다. 기기의 전원을 켜거나 팬/틸트 재설정을 실행하면 이 범위 제한 설정이 무시됩니다. 자세한 내용은 웹 메뉴의 [Pan-
Tilt] > [P/T Range Limit]을 참조하십시오.

힌트

이 기기와 호환되는 렌즈 제어기(옵션)를 사용하여 수동 줌 렌즈의 줌을 제어할 수 있습니다. 자세한 내용은 "렌즈 제어기 연결" 및
"렌즈 제어기를 사용하여 줌 조정"을 참조하십시오.

관련 항목

줌 유형 설정

렌즈 제어기 연결

렌즈 제어기를 사용하여 줌 조정

5-041-958-23(1) Copyright 2022 Sony Corporation

줌 버튼을 눌러 줌을 조정합니다.

화면을 모니터링하는 동안 T(망원) 또는 W(광각) 버튼을 눌러 줌을 조정합니다.
확대하려면 T 버튼을 누릅니다.
축소하려면 W 버튼을 누릅니다.

1
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도움말 안내

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

E-mount 렌즈 보정

보정 기능은 E-mount 파워 줌 렌즈 사용 시 개별 렌즈의 차이로 인한 줌 위치의 차이를 수정합니다.
줌 위치를 정확하게 계산하려면 다음 절차에 따라 렌즈의 개별 차이를 수정하도록 렌즈를 보정합니다.

보정 데이터

최대 5개의 렌즈에 대한 보정 데이터를 기기에 저장할 수 있습니다. 6번째 이후의 렌즈를 보정할 때 가장 오래된 데이
터를 덮어씁니다.
웹 앱 화면의 공통 영역에서  (카메라 상태) 버튼을 누른 후, [Lens] > [Calibration Data]를 선택하면 부착된 렌즈의
보정 데이터 사용 가능 여부를 확인할 수 있습니다.

5-041-958-23(1) Copyright 2022 Sony Corporation

렌즈에 SERVO/MANUAL 스위치가 있는 경우 SERVO 위치로 설정합니다.

참고 사항

스위치가 MANUAL로 설정되어 있으면 렌즈가 기기에서 줌 지침을 수신할 수 없습니다.

1

카메라 메뉴의 [Technical] > [Lens] > [Lens Calibration]을 사용하여 보정을 실행합니다.

보정 중에는 줌 렌즈가 자동으로 움직여 측정됩니다.

2
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도움말 안내

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

웹 앱을 사용하여 팬/틸트, 줌 위치 및 초점 설정 저장/복원

팬/틸트, 줌 위치 및 초점 설정을 저장하고 필요할 때 웹 앱(사전 설정 위치 기능)을 사용하여 불러올 수 있습니다.

저장/복원할 수 있는 항목에 대한 자세한 내용은 "사전 설정 위치 저장 항목"을 참조하십시오.

참고 사항

Clear Image Zoom 비율이 1배를 초과하면 사전 설정 위치를 저장할 수 없습니다.

웹 메뉴의 [Pan-Tilt] > [P/T Direction] >[Ceiling] 설정이 변경되면 저장된 사전 설정 위치가 모두 삭제됩니다.

사전 설정 위치 제어 패널 상단의 드롭다운 목록에서 PTZ 보조 모드를 [Pos.]로 설정합니다.1

팬/틸트 및 줌 작업을 사용하여 저장하려는 위치를 결정합니다.2

사전 설정 위치 제어 패널에서 [+] 버튼을 누릅니다.

저장된 위치를 가진 이미지가 사전 설정 위치 제어 패널에 표시됩니다.

힌트

사전 설정 위치 제어 패널이 표시되지 않으면 (열기) 버튼을 눌러 표시합니다.

위치는 [Preset1]부터 순서대로 저장됩니다.

일련의 사전 설정 내에 사용되지 않은 사전 설정이 있는 경우, 사용되지 않은 사전 설정부터 시작하여 위치가 사전 설정에 저
장됩니다. 예를 들어 사전 설정 위치가 [Preset1]과 [Preset3]에 저장되고 [Preset2]에는 저장되지 않은 경우 다음 사전 설정 위
치는 [Preset2]에 저장된 다음 [Preset4]에 저장됩니다.

최대 100개의 사전 설정 위치를 저장할 수 있습니다.

3
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사전 설정 위치 복원 작업을 취소하려면

사전 설정 위치 복원 동작 중 사전 설정 위치 제어 패널에 표시된 (복원 취소) 버튼을 누르면 복원 동작이 취소됩니다. 조
이스틱과 [Zoom] 슬라이더를 사용하여 프레이밍을 조정합니다.

관련 항목

사전 설정 위치 저장 항목

웹 앱을 사용하여 사전 설정 위치 이름 바꾸기

사전 설정 위치 복원 시 전환 속도(팬-틸트/줌/초점) 변경

각 사전 설정 위치의 이름을 바꿀 수 있습니다. 자세한 내용은 "웹 앱을 사용하여 사전 설정 위치 이름 바꾸기"를 참조하십시
오.

저장된 위치를 복원합니다.

사전 설정 위치 제어 패널에서 복원하려는 위치 썸네일을 두 번 누르면 해당 위치가 복원됩니다.

힌트

이미지를 누르고 나타나는  (사전 설정 위치 메뉴) 버튼을 누른 후 [Recall]을 선택하여 위치를 복원할 수도 있습니다.

저장된 위치로의 전환 속도는 위치가 저장되었을 때 웹 메뉴의 [Pan-Tilt] > [P/T Preset] > [Pan-Tilt] > [Pan-Tilt Speed for
Common] 설정에 의해 결정됩니다. 저장 후 전환 속도를 변경할 수도 있습니다. 자세한 내용은 "사전 설정 위치 복원 시 전환
속도(팬-틸트/줌/초점) 변경"을 참조하십시오.

사전 설정 위치로 이동할 때 팬/틸트 위치의 변화 정도는 전환 속도 및 [Ramp Curve] 설정을 사용하여 조정할 수 있습니다. 자
세한 내용은 "사전 설정 위치 복원 시 전환 속도(팬-틸트/줌/초점) 변경" 및 "팬/틸트 작동 가속 설정"을 참조하십시오.

사전 설정 재생 중에 다른 사전 설정을 불러오면 첫 번째로 불러온 사전 설정의 작동이 중지되고 다음에 불러온 사전 설정의
작동이 시작됩니다.

참고 사항

사전 설정 위치를 저장한 시점과 재생하는 시점 사이에 환경 온도가 크게 변한 경우 프레이밍 편차가 발생할 수 있습니다.

사전 설정 위치가 복원되는 동안에는 사전 설정 위치를 복원하거나 취소하는 것 이외의 다른 작업을 수행할 수 없습니다.

4

146



팬/틸트 작동 가속 설정

5-041-958-23(1) Copyright 2022 Sony Corporation
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도움말 안내

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

웹 앱을 사용하여 사전 설정 위치 이름 바꾸기

저장된 사전 설정 위치의 이름을 바꿀 수 있습니다.

5-041-958-23(1) Copyright 2022 Sony Corporation

사전 설정 위치 제어 패널 상단의 드롭다운 목록에서 PTZ 보조 모드를 [Pos.]로 설정합니다.1

이름을 바꾸려는 사전 설정 위치를 누릅니다.

(사전 설정 위치 메뉴) 버튼이 이미지의 우측 상단에 나타납니다.

2

 (사전 설정 위치 메뉴) 버튼을 누르고 표시된 메뉴에서 [Rename]을 선택합니다.3

새 사전 설정 이름을 입력합니다.4
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도움말 안내

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

웹 앱을 사용하여 저장된 사전 설정 위치를 새로운 위치로 교체

저장된 사전 설정 위치를 새로운 위치로 교체할 수 있습니다.

5-041-958-23(1) Copyright 2022 Sony Corporation

사전 설정 위치 제어 패널 상단의 드롭다운 목록에서 PTZ 보조 모드를 [Pos.]로 설정합니다.1

팬/틸트 및 줌 작업을 사용하여 저장하려는 위치를 결정합니다.2

사전 설정 위치 제어판에서 교체하려는 위치 이미지를 누릅니다.

(사전 설정 위치 메뉴) 버튼이 이미지의 우측 상단에 나타납니다.

3

 (사전 설정 위치 메뉴) 버튼을 누르고 표시된 메뉴에서 [Replace]을 선택합니다.

새로운 위치가 현재 설정을 대체합니다.

4
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도움말 안내

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

웹 앱을 사용하여 저장된 사전 설정 위치 삭제

저장된 사전 설정 위치를 삭제할 수 있습니다.

5-041-958-23(1) Copyright 2022 Sony Corporation

사전 설정 위치 제어 패널 상단의 드롭다운 목록에서 PTZ 보조 모드를 [Pos.]로 설정합니다.1

사전 설정 위치 제어 패널에서 삭제하려는 위치 이미지를 누릅니다.

(사전 설정 위치 메뉴) 버튼이 이미지의 우측 상단에 나타납니다.

2

 (사전 설정 위치 메뉴) 버튼을 누르고 표시된 메뉴에서 [Delete]을 선택합니다.

저장된 위치가 삭제됩니다.

3
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도움말 안내

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

사전 설정 위치 복원 시 팬/틸트 작동 및 줌/초점 작동 동기화

저장된 사전 설정 위치를 복원할 때 원활한 프레이밍을 위해 팬/틸트 작동과 줌 작동을 동기화할 수 있습니다.

힌트

사전 설정 위치를 등록하는데 사용되는 설정을 미리 지정할 수 있습니다. 웹 메뉴에서 [Pan-Tilt] > [P/T Preset] > [Default] > [Zoom
Sync]를 [On] 으로 설정합니다.

[Pan-Tilt] > [P/T Preset] > [Speed Select]가 [Common]으로 설정되면 [Pan-Tilt] > [P/T Preset] > [Common Speed]를 사용하여 설정
된 속도로 모든 사전 설정 위치가 복원됩니다.

줌 이동이 완료되면 카메라는 저장된 초점 위치로 이동합니다.

이동이 완료되면 [AF Transition Speed]가 원래 설정으로 돌아갑니다.

5-041-958-23(1) Copyright 2022 Sony Corporation

사전 설정 위치 제어 패널 상단의 드롭다운 목록에서 PTZ 보조 모드를 [Pos.]로 설정합니다.1

전환 속도를 변경하려는 사전 설정 위치의 이미지를 누릅니다.

(사전 설정 위치 메뉴) 버튼이 이미지의 우측 상단에 나타납니다.

2

 (사전 설정 위치 메뉴) 버튼을 누르고 표시된 메뉴에서 [Edit…]을 선택합니다.

선택한 사전 설정 위치의 설정 화면이 나타납니다.

3

[Zoom Sync] 스위치를 오른쪽으로 밀어서 기능을 켜고 [OK] 버튼을 누릅니다.

다음에 저장된 위치가 복원되면 카메라가 구성된 속도로 움직입니다.

4
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도움말 안내

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

사전 설정 위치 복원 시 전환 속도(팬-틸트/줌/초점) 변경

저장된 사전 설정 위치를 복원할 때 전환 속도(팬/틸트 작동, 줌 작동, 초점 작동)를 변경할 수 있습니다.

힌트

[Pan-Tilt] > [P/T Preset] > [Speed Select]가 [Common]으로 설정되면 [Pan-Tilt] > [P/T Preset] > [Common Speed]를 사용하여 모든
위치가 설정 속도로 복원됩니다.

줌 이동이 완료되면 카메라는 저장된 초점 위치로 이동합니다.

이동이 완료되면 [AF Transition Speed]가 원래 설정으로 돌아갑니다.

웹 메뉴에서 [Pan-Tilt] > [P/T Preset] > [Speed Select]를 [Separate]로 설정합니다.1

사전 설정 위치 제어 패널 상단의 드롭다운 목록에서 PTZ 보조 모드를 [Pos.]로 설정합니다.2

전환 속도를 변경하려는 사전 설정 위치의 이미지를 누릅니다.

(사전 설정 위치 메뉴) 버튼이 이미지의 우측 상단에 나타납니다.

3

 (사전 설정 위치 메뉴) 버튼을 누르고 표시된 메뉴에서 [Edit…]을 선택합니다.

선택한 사전 설정 위치의 설정 화면이 나타납니다.

4

슬라이더를 이용하여 변경하려는 전환 속도(팬-틸트/줌/초점)를 설정하거나 값을 직접 입력한 후 [OK] 버튼을 누릅니
다.

다음에 저장된 위치가 복원되면 카메라가 구성된 속도로 움직입니다.

5
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도움말 안내

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

제공된 적외선 리모컨을 사용하여 팬/틸트 및 줌 위치 저장/복원

팬/틸트 및 줌 위치를 저장하고 필요할 때 제공된 적외선 리모컨을 사용하여 불러올 수 있습니다.

관련 항목

사전 설정 위치 복원 시 전환 속도(팬-틸트/줌/초점) 변경

5-041-958-23(1) Copyright 2022 Sony Corporation

카메라의 팬/틸트 및 줌을 조정합니다.1

사전 설정 위치 제어 패널 상단의 드롭다운 목록에서 PTZ 보조 모드를 [Pos.]로 설정합니다.2

PRESET 버튼을 누른 상태에서 1~3 버튼 중 하나를 누릅니다.

위치가 저장됩니다.

3

저장된 위치를 복원합니다.

1~3 버튼 중 하나를 눌러 사전 설정 위치를 복원합니다.

힌트

사전 설정 위치를 복원할 때의 전환 속도는 웹 메뉴의 저장된 [Pan-Tilt] > [P/T Preset] > [Pan-Tilt Speed] 값에 의해 결정됩니
다. 값을 저장 한 후 전환 속도를 변경할 수 있습니다. 자세한 내용은 "사전 설정 위치 복원 시 전환 속도(팬-틸트/줌/초점) 변
경"을 참조하십시오.

4
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도움말 안내

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

웹 앱을 사용하여 카메라 프레이밍 작업 녹화

웹 앱을 사용하여 카메라 프레이밍 작업을 녹화할 수 있습니다.

카메라의 작동 시작 위치를 조정합니다.1

사전 설정 위치 제어 패널 상단의 드롭다운 목록에서 PTZ 보조 모드를 [Trace]로 설정합니다.2

사전 설정 위치 제어 패널에서 [+] 버튼을 누릅니다.

썸네일이 추가되고 카메라가 녹화 대기 상태로 전환됩니다.

힌트

썸네일의 (닫기) 버튼을 눌러 녹화 대기 상태를 종료하고 정상 작동으로 돌아갈 수 있습니다.

3

155



힌트

녹화하는 동안 카메라 이미지 패널 상단에 남은 녹화 시간이 표시됩니다.

참고 사항

천장 장착으로 전환하면 녹화된 프레이밍 작업이 삭제됩니다

시스템 주파수를 전환하면 녹화된 프레이밍 작업이 삭제될 수 있습니다.

렌즈 제어기가 연결되어 있으면 줌 작동이 녹화되지 않습니다.

단일 프레이밍 작업을 녹화하는 최대 기간은 3분입니다. 녹화 기간이 3분에 도달하면 녹화가 자동으로 중지됩니다.

Clear Image Zoom 비율이 1배보다 큰 경우 프레이밍 작업 녹화를 시작할 수 없습니다.

프레이밍 작업을 녹화하는 동안 카메라가 다른 장치에서 작동하는 경우 다른 장치의 작업도 녹화됩니다. 타사 원격 제어기를 사용
한 녹화 작업에 대한 자세한 내용은 해당 제조업체에 문의하십시오.

초점 및 이미지 품질 설정은 이 기능에 의해 녹화되지 않습니다.

프레이밍 작업을 녹화할 때 녹화된 팬/틸트/줌 작업은 프레이밍 재생 중에 정확히 재현할 수 없습니다.

프레이밍 작업을 녹화한 후 웹 메뉴에서 [Pan-Tilt] > [P/T Range Limit]을 사용하여 팬/틸트 범위 제한을 설정하면 프레이밍 재생 중
에 팬/틸트 범위 제한이 적용되지 않습니다. 프레이밍 작업과 팬/틸트 제한 기능을 함께 사용하려면 프레이밍 작업을 녹화하기 전에
팬/틸트 범위 제한을 설정하십시오.

RAW 비디오 출력을 선택하면 녹화된 프레이밍 작업을 다시 재생할 수 없습니다.

조이스틱과 [Zoom] 슬라이더를 사용하여 프레이밍 작업을 시작합니다.

녹화는 프레이밍 작업이 시작되는 순간부터 시작됩니다.

4

썸네일에서 (녹화 중지) 버튼을 눌러 녹화를 중지합니다.5
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비디오 신호가 SDI 출력 커넥터에서 출력되지 않는 경우 녹화된 프레이밍 작업을 다시 재생할 수 없습니다.

5-041-958-23(1) Copyright 2022 Sony Corporation
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도움말 안내

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

웹 앱을 사용하여 카메라 프레이밍 작업 재생

웹 앱을 사용하여 녹화된 카메라 프레이밍 작업을 재생할 수 있습니다.

사전 설정 위치 제어 패널 상단의 드롭다운 목록에서 PTZ 보조 모드를 [Trace]로 설정합니다.1

재생하려는 프레이밍 작업이 포함된 썸네일을 선택합니다.

(준비) 버튼이 썸네일에 나타납니다.

2

(준비) 버튼을 누릅니다.

카메라가 프레이밍 작업 시작 위치로 이동하고 재생 대기 상태로 전환됩니다.

3

썸네일에서 (재생) 버튼을 누릅니다.4
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힌트

재생 대기 상태와 재생 중에 다음 작업 중 하나를 수행하여 재생을 취소하고 정상 작동으로 돌아갈 수 있습니다.

썸네일 또는 사전 설정 위치 제어 패널에서 (정지) 버튼을 누릅니다.
조이스틱을 조작합니다.
[Zoom] 슬라이더를 조작합니다.

재생 중 카메라 이미지 패널 상단에 경과된 재생 시간이 표시됩니다.

참고 사항

Clear Image Zoom 설정이 프레이밍 작업의 녹화와 재생 사이에 다를 경우 예기치 않은 동작이 발생할 수 있습니다.

렌즈 제어기가 연결되어 있는 경우에는 줌 작동 재생이 지원되지 않습니다. 줌을 작동하면 프레이밍 작업의 재생이 중지됩니다.

프레이밍 작업 재생 중에 웹 메뉴에서 [Pan-Tilt] > [P/T Range Limit]을 사용하여 팬/틸트 범위 제한을 변경해도 효과가 없습니다. 프
레이밍 작업을 녹화하기 전에 팬/틸트 범위 제한을 설정합니다.

5-041-958-23(1) Copyright 2022 Sony Corporation

프레이밍 재생이 시작됩니다.
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도움말 안내

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

웹 앱을 사용하여 카메라 녹화 프레이밍 작업 삭제

웹 앱을 사용하여 카메라 녹화 프레이밍 작업을 삭제할 수 있습니다.

5-041-958-23(1) Copyright 2022 Sony Corporation

사전 설정 위치 제어 패널 상단의 드롭다운 목록에서 PTZ 보조 모드를 [Trace]로 설정합니다.1

삭제하려는 프레이밍 작업이 포함된 썸네일을 선택합니다.

(추적 메뉴) 버튼이 썸네일에 나타납니다.

2

(추적 메뉴) 버튼을 누릅니다.

메뉴가 나타납니다.

3

표시된 메뉴에서 [Delete]를 선택합니다.

선택한 프레이밍 작업이 삭제됩니다.

4
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도움말 안내

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

제공된 적외선 리모컨을 사용하여 카메라 프레이밍 작업 녹화

제공된 적외선 리모컨을 사용하여 카메라 프레이밍 작업을 녹화할 수 있습니다.

녹화된 프레이밍 작업 재생에 대한 자세한 내용은 "제공된 적외선 리모컨을 사용하여 카메라 프레이밍 작업 재생"을 참조
하십시오.

참고 사항

단일 프레이밍 작업을 녹화하는 최대 기간은 3분입니다. 녹화 기간이 3분에 도달하면 녹화가 자동으로 중지됩니다.

프레이밍 작업을 녹화하는 동안 카메라가 다른 장치에서 작동하는 경우 다른 장치의 작업은 프레이밍 작업의 일부로 녹화됩니다.

프레이밍 작업을 녹화하는 동안 이미지 품질이 조정되는 경우 해당 변경 사항은 녹화되지 않습니다.

관련 항목

제공된 적외선 리모컨을 사용하여 카메라 프레이밍 작업 재생

5-041-958-23(1) Copyright 2022 Sony Corporation

웹 앱의 라이브 작동 화면에 접속합니다.1

사전 설정 위치 제어 패널 상단의 드롭다운 목록에서 PTZ 보조 모드를 [Trace]로 설정합니다.2

적외선 리모컨을 사용하여 카메라의 작동 시작 위치를 조정합니다.3

PRESET 버튼을 누른 상태에서 POSITION1 ~ 3 버튼 중 하나를 누릅니다.

카메라가 녹화 대기 상태로 전환됩니다.

4

녹화하려는 프레임 작업을 수행합니다.5

녹화를 끝내려면 PRESET 버튼을 누른 상태에서 4단계에서 선택한 POSITION 버튼을 누릅니다.6
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도움말 안내

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

제공된 적외선 리모컨을 사용하여 카메라 프레이밍 작업 재생

제공된 적외선 리모컨을 사용하여 녹화된 카메라 프레이밍 작업을 재생할 수 있습니다.

참고 사항

카메라의 팬/틸트/줌을 조작하면 재생이 중지됩니다.

관련 항목

제공된 적외선 리모컨을 사용하여 카메라 프레이밍 작업 녹화

5-041-958-23(1) Copyright 2022 Sony Corporation

웹 앱의 라이브 작동 화면에 접속합니다.1

사전 설정 위치 제어 패널 상단의 드롭다운 목록에서 PTZ 보조 모드를 [Trace]로 설정합니다.2

프레이밍 작업이 기록된 POSITION1~3 버튼 중 하나를 선택하고 누릅니다.

카메라의 팬/틸트/줌이 재생 시작 위치로 이동합니다.

3

카메라가 재생 시작 위치로 이동한 후 동일한 POSITION 버튼을 다시 누릅니다.

재생이 시작됩니다.

4
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도움말 안내

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

초점 조정 화면

초점은 라이브 작동 화면의 다음 부분을 사용하여 조정됩니다.

5-041-958-23(1) Copyright 2022 Sony Corporation

카메라 이미지 패널
카메라 이미지를 터치하여 초점을 조정할 수 있습니다. 카메라 제어 패널의  (Focus) 탭에서 [Touch Focus] 스위치
를 끄면 웹 앱의 터치 조작을 비활성화할 수 있습니다.

1.

카메라 제어 패널 –  (Focus) 탭2.

GUI 제어 패널3.
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도움말 안내

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

웹 앱을 사용하여 수동으로 조정

예를 들어 다음과 같은 경우 초점을 수동으로 조정할 수 있습니다.

물방울에 의해 부분적으로 가려진 피사체
배경과의 콘트라스트가 낮은 피사체
가까운 피사체보다 멀리 있는 피사체

참고 사항

줌 작동이 진행되는 동안 웹 앱에서 수동 초점을 제어할 수 없습니다.

힌트

수동 조정이 기본 작동 방법이더라도 자동 초점을 사용할 수도 있습니다. 자세한 내용은 "웹 앱을 사용하여 수동으로 자동 초점 대
상 설정(AF Assist)"을 참조하십시오.

관련 항목

렌즈 스위치 확인

웹 앱을 사용하여 수동으로 자동 초점 대상 설정(AF Assist)

5-041-958-23(1) Copyright 2022 Sony Corporation

렌즈에 초점 선택 스위치가 있는 경우 스위치를 "AF/MF" 또는 "AF" 위치로 설정합니다.

참고 사항

스위치를 "Full MF" 또는 "MF" 위치로 설정하면 기기에서 렌즈 초점을 맞출 수 없습니다. "렌즈 스위치 확인"의 "초점 모드 스
위치가 있는 렌즈의 경우"을 참조하십시오.

1

[Auto Focus] 스위치를 카메라 제어판의 왼쪽 위치로 밀어 자동 초점을 끕니다.

수동 초점 모드가 활성화됩니다.

 (MF)

2

 (Focus) 탭 하단의 슬라이더를 사용하여 조정합니다.3
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도움말 안내

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

제공된 적외선 리모컨을 사용하여 수동으로 조정

제공된 적외선 리모컨을 사용하여 수동으로 초점을 조정할 수 있습니다.

힌트

수동 조정이 기본 작동 방법이더라도 자동 초점을 사용할 수도 있습니다. 자세한 내용은 "제공된 적외선 리모컨을 사용하여 자동 초
점 중 수동으로 초점 맞추기"을 참조하십시오.

관련 항목

제공된 적외선 리모컨을 사용하여 자동 초점 중 수동으로 초점 맞추기

5-041-958-23(1) Copyright 2022 Sony Corporation

적외선 리모컨의 MF 버튼을 누릅니다.1

F(원거리) 버튼과 N(근거리) 버튼을 사용하여 수동으로 초점을 조정합니다.

먼 피사체에 초점을 맞추려면 F 버튼을 누릅니다.
가까운 피사체에 초점을 맞추러면 N 버튼을 누릅니다.

2
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도움말 안내

Interchangeable Lens Digital Camera
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초점 위치를 지정하여 초점 맞추기(Spot Focus)

수동 초점 모드에서는 카메라 이미지 패널에서 초점을 조정할 위치를 지정할 수 있습니다.

참고 사항

렌즈가 수동 초점으로 설정된 경우 스팟 초점 기능이 작동하지 않습니다.

힌트

스팟 초점 모드에서 [Push AF/MF]가 할당된 할당 가능 버튼을 눌러 스팟 초점을 일시 정지하고 버튼을 누르는 동안 자동 초점을 활
성화할 수 있습니다. 버튼에서 손을 떼면 초점이 수동 초점으로 되돌아갑니다.

5-041-958-23(1) Copyright 2022 Sony Corporation

웹 메뉴 또는 카메라 메뉴에서 [Shooting] > [Focus] > [Touch Function in MF]를 [Spot Focus]로 설정합니다.1

 (Focus) 탭의 [Touch Focus] 스위치를 오른쪽으로 밀어 켭니다.2

 (Focus) 탭의 [Auto Focus] 스위치를 왼쪽으로 밀어 끕니다.3

초점 위치를 지정합니다.

스팟 초점 마커가 나타나고 해당 위치에 초점이 맞도록 이미지가 조정됩니다.

터치 조작으로 위치를 지정하는 예

4
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도움말 안내

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

임시로 자동 초점 사용(Push Auto Focus(AF))

수동 초점 모드에서 [Push AF/MF] 버튼을 누른 상태에서 자동으로 초점을 맞추면 자동 초점을 사용하여 임시로 초점을 조
정할 수 있습니다.
이는 수동 초점 중에 한 피사체에서 다른 피사체로 초점을 천천히 옮기려고 할 때 유용합니다.

참고 사항

렌즈가 수동 초점으로 설정된 경우 푸시 자동 초점 기능이 작동하지 않습니다.

힌트

[Push AF/MF]가 할당된 할당 가능 버튼을 사용하여 동일한 작업이 지원됩니다.

5-041-958-23(1) Copyright 2022 Sony Corporation

카메라 메뉴에서 [Shooting] > [Focus] > [Push AF Mode]를 [AF]로 설정합니다.1

 (Focus) 탭의 [Auto Focus] 스위치를 왼쪽으로 밀어 끕니다.2

[Push AF/MF] 버튼을 누릅니다.

버튼을 누르고 있는 동안 자동 초점이 활성화됩니다.

푸시 자동 초점이 해제되고 버튼에서 손을 떼면 초점이 수동 초점으로 돌아갑니다.

3
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도움말 안내

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

단일 촬영 자동 초점 사용(Push Auto Focus (AF-S))

고속 상태에서 자동으로 초점을 맞추려면 수동 초점 모드에서 [Push AF/MF] 버튼을 누릅니다.
이 기능은 촬영하기 전에 피사체에 초점을 맞출 때 편리합니다.

참고 사항

렌즈가 수동 초점으로 설정된 경우 푸시 자동 초점 기능이 작동하지 않습니다.

[Display] 버튼을 사용하면 초점 영역 프레임이 숨겨지지 않습니다.

Clear Image Zoom 동작 도중 [Focus Area (AF-S)] 프레임 위치를 설정할 수 없습니다. 푸시 자동 초점 동작 도중 AF 동작은 중앙 부
분을 우선합니다.

웹 메뉴 또는 카메라 메뉴에서 [Shooting] > [Focus] > [Push AF Mode]를 [Single-shot AF(AF-S)]로 설정합니다.1

카메라 메뉴의 [Shooting] > [Focus] > [Focus Area (AF-S)]를 사용하여 초점을 조정할 위치를 지정합니다.

힌트

[Focus Setting]이 할당된 할당 가능 버튼을 눌러 초점 영역 주위에 주황색 프레임을 표시하고 터치 조작으로 위치를 선택하
여 위치를 변경할 수 있습니다.

2

 (Focus) 탭의 [Auto Focus] 스위치를 왼쪽으로 밀어 끕니다.3

[Push AF/MF] 버튼을 누릅니다.

포커싱이 완료되기 전에 버튼을 놓으면 푸시 자동 초점이 멈춥니다.

푸시 자동 초점 중에는 초점 표시에 초점 상태가 표시됩니다.
켜짐: 초점이 초점 위치에 고정되어 있습니다.
깜박임: 초점이 맞지 않습니다. 기기가 자동으로 초점을 맞추지 않으므로 구도 및 초점 설정을 변경하여 초점을 맞춥
니다.
버튼에서 손을 떼면 초점이 수동 초점으로 되돌아갑니다.

4
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힌트

[Push AF/MF]가 할당된 할당 가능 버튼을 사용하여 동일한 작업이 지원됩니다.

[Push AF Mode]를 할당 가능 버튼에 할당할 수도 있습니다.

[Focus Area (AF-S)]를 할당 가능 버튼에 할당할 수도 있습니다.

카메라 메뉴의 [Monitoring] > [Display On/Off] > [Focus Area Ind.(AF-S)]를 사용하여 초점 영역 프레임을 표시하거나 숨길 수 있습
니다.

5-041-958-23(1) Copyright 2022 Sony Corporation
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도움말 안내

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

웹 앱을 사용하여 자동으로 조정

기기는 고속 초점에 위상 감지 AF를 사용하고 고정밀 초점에 콘트라스트 AF를 사용합니다.
이 두 가지 AF 방법을 조합하여 고속 및 고정밀 자동 초점을 제공합니다.

참고 사항

자동 초점을 지원하는 렌즈가 필요합니다.

촬영 조건에 따라 원하는 정확도로 맞추지 못할 수 있습니다.

A-mount 렌즈에서는 초점을 자동으로 조정할 수 없습니다.

힌트

자동 초점 모드에서 카메라 제어 패널의 Focus 슬라이더를 사용하여 초점을 조정할 수 있습니다. 자세한 내용은 "웹 앱을 사용하여
수동으로 자동 초점 대상 설정(AF Assist)"을 참조하십시오.

관련 항목

렌즈 스위치 확인

웹 앱을 사용하여 수동으로 자동 초점 대상 설정(AF Assist)

5-041-958-23(1) Copyright 2022 Sony Corporation

렌즈에 초점 선택 스위치가 있는 경우 스위치를 "AF/MF" 또는 "AF" 위치로 설정합니다.

참고 사항

스위치를 "Full MF" 또는 "MF" 위치로 설정하면 기기에서 렌즈 초점을 맞출 수 없습니다. "렌즈 스위치 확인"의 "초점 모드 스
위치가 있는 렌즈의 경우"을 참조하십시오.

1

[Auto Focus] 스위치를 카메라 제어 패널의 오른쪽 위치로 밀어 켭니다.

자동 초점 모드가 활성화됩니다.

 (AF)

2
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도움말 안내

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

제공된 적외선 리모컨을 사용하여 자동으로 조정

제공된 적외선 리모컨을 사용하여 자동으로 초점을 조정할 수 있습니다.

참고 사항

수동 조정이 기본 작동 방법이더라도 자동 초점을 사용할 수도 있습니다. 자세한 내용은 "제공된 적외선 리모컨을 사용하여 자동 초
점 중 수동으로 초점 맞추기"을 참조하십시오.

관련 항목

제공된 적외선 리모컨을 사용하여 자동 초점 중 수동으로 초점 맞추기

5-041-958-23(1) Copyright 2022 Sony Corporation

적외선 리모컨의 AF 버튼을 누릅니다.

피사체의 초점이 자동으로 조정됩니다.

1
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도움말 안내

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

자동 초점 영역/위치 설정(Focus Area)

자동 초점의 대상 영역을 설정하고 해당 영역의 초점을 조정할 수 있습니다.

GUI 제어 패널의 [Menu] 버튼을 눌러 카메라 메뉴를 엽니다.1

카메라 메뉴의 [Shooting] > [Focus] > [Focus Area]를 사용하여 자동 초점 대상 영역을 설정합니다.

[Wide]:
초점을 맞출 때 이미지의 광각에서 피사체를 검색합니다. 프레임은 표시되지 않습니다.

[Zone]:
지정된 존 내에서 초점 위치를 자동으로 검색합니다.
선택 후 GUI 제어 패널의 화살표 버튼을 사용하여 위치를 지정합니다.

[Set] 버튼을 길게 누르면 가운데 위치로 돌아갈 수 있습니다.
[Flexible Spot]:
이미지에서 지정된 위치에 초점을 맞춥니다.
선택 후 GUI 제어 패널의 화살표 버튼을 사용하여 위치를 지정합니다.

2
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참고 사항

카메라 이미지 패널에서 [Display] 버튼을 사용할 때 초점 영역 프레임이 숨겨지지 않습니다.

Clear Image Zoom 중에는 초점 영역이 [Wide](고정)로 설정됩니다.

힌트

카메라 메뉴의 [Monitoring] > [Display On/Off] > [Focus Area Indicator]를 사용하여 초점 영역 프레임을 표시하거나 숨길 수 있습니
다.

5-041-958-23(1) Copyright 2022 Sony Corporation

[Set] 버튼을 길게 누르면 가운데 위치로 돌아갈 수 있습니다.
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도움말 안내

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

초점 영역을 빠르게 바꾸기(Focus Setting)

[Focus Setting]을 할당 가능 버튼에 할당하여 촬영 중에 자동 초점 영역의 위치와 크기를 빠르게 바꿀 수 있습니다.

할당 가능 버튼에 대한 자세한 내용은 "할당 가능 버튼"을 참조하십시오.

작동은 초점 영역 설정에 따라 달라집니다.

카메라 메뉴에서 [Shooting] > [Focus] > [Focus Area]가 [Flexible Spot] 또는 [Zone]으로 설정된
경우

[Focus Setting]이 할당된 할당 가능 버튼을 누르고 GUI 제어 패널의 화살표 버튼으로 조정하여 초점 영역의 위치를 변
경할 수 있습니다. 위치를 조정하는 동안 [Set] 버튼을 눌러 초점 영역의 위치를 가운데로 되돌릴 수 있습니다.
[Focus Setting]이 할당된 할당 가능 버튼을 계속 눌러 초점 영역의 크기를 변경할 수 있습니다. 크기를 변경한 후 [Set]
버튼을 눌러 초점 영역의 위치를 변경할 수 있습니다. 완료되면 [Focus Setting]이 할당된 할당 가능 버튼을 눌러 원래
화면으로 되돌아갑니다.

카메라 메뉴에서 [Shooting] > [Focus] > [Focus Area]가 [Wide]로 설정된 경우

[Focus Setting]이 할당된 할당 가능 버튼을 계속 눌러 초점 영역의 크기만 변경할 수 있습니다. 먼저 유형을 [Flexible Spot]
또는 [Zone]으로 변경하여 위치를 변경할 수도 있습니다.

힌트

카메라 메뉴에서 [Shooting] > [Focus] > [Push AF Mode]가 모두 [Single-shot AF(AF-S)]로 설정되어 있고 [Auto Focus] 스위치가 꺼
짐 위치(수동 초점 모드)로 설정되어 있으면 [Focus Area (AF-S)] 초점 영역 위치를 변경할 수 있습니다.

초점 영역 위치를 변경할 수 있는 경우 초점 영역 프레임이 주황색으로 표시됩니다.

관련 항목

할당 가능 버튼

5-041-958-23(1) Copyright 2022 Sony Corporation
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도움말 안내

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

터치 조작으로 초점 영역 프레임 이동(터치 초점 영역)

초점 영역 표시를 주황색으로 바꾸기 위해 [Focus Setting]이 할당된 할당 가능 버튼을 누르고 카메라 이미지 패널의 터치
조작으로 초점 영역 프레임을 이동하여 초점 영역 위치를 변경할 수 있습니다.
화면을 탭하여 초점 영역을 옮기고 초점 영역을 탭한 위치의 가운데에 배치합니다. 화면을 끌어 초점 영역을 손가락으로
추적한 위치로 옮깁니다.

힌트

[Focus Setting]이 할당된 할당 가능 버튼을 사용하여 촬영 화면에서 터치 초점 영역을 활성화하거나 비활성화할 수 있습니다.

아무 위치나 탭합니다.

탭한 위치가 초점 영역의 중심이 됩니다.

1

손가락 위치를 추적하면서 초점 영역을 끌어 위치를 옮깁니다.2
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참고 사항

위치를 탭하거나 설정 범위를 벗어나는 위치로 초점 영역을 끄는 경우 초점 영역이 설정 범위의 위쪽/아래쪽/왼쪽/오른쪽 가장자리
로 설정됩니다.

이 기능은 다음과 같은 상황에서는 사용할 수 없습니다.

카메라 제어 패널에서 [Touch Focus] 스위치가 꺼져 있는 경우
초점 영역 프레임이 회색으로 표시되거나 전혀 표시되지 않는 경우

5-041-958-23(1) Copyright 2022 Sony Corporation
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도움말 안내

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

자동 초점 동작 조정(AF 전환 속도, AF 피사체 이동 감도)

전환 속도와 피사체 이동 감도를 변경하여 자동 초점 동작을 조정할 수 있습니다.

AF 전환 속도 설정

카메라 제어 패널의 [AF Transition Speed] 버튼을 사용하여 피사체가 변경될 때 초점 드라이브 속도를 설정할 수 있습니
다.

[Speed 1](느림) ~ [Speed 7](빠름) 범위에서 1 단위로 속도를 선택합니다. < 버튼을 눌러 값을 낮추거나(느리게) > 버튼을
눌러 값을 높입니다(빠르게).
저속으로 설정하면 초점을 맞출 피사체가 바뀔 때 초점이 천천히 움직여 인상적인 이미지 표현으로 촬영할 수 있습니다.
고속으로 설정하면 초점이 피사체 사이를 빠르게 전환합니다. 아래 예에서 초점은 배경에 있는 건물에서 전경을 걷고 있는
사람으로 빠르게 변경됩니다. 프레임에 들어오는 피사체에 즉시 초점이 맞춰지므로 이 설정은 초점을 빠르게 맞추어야 하
는 다큐멘터리 촬영에 안성맞춤입니다.

AF 피사체 이동 감도

카메라 제어 패널의 [AF Subj. Shift Sens.] 버튼을 사용하여 피사체 간 변화 감도를 설정할 수 있습니다.
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[Sens 1](Locked On) ~ [Sens 5](Responsive) 범위에서 1 단위로 감도를 선택합니다. < 버튼을 눌러 값을 낮추거나(느리게
변경) > 버튼을 눌러 값을 높입니다(빠르게 변경).
감도를 낮게 설정하면 다른 피사체가 초점이 맞춰진 피사체 앞으로 이동하더라도 초점이 쉽게 옮겨지지 않습니다.

감도를 높게 설정하면 앞쪽으로 움직이는 피사체에 우선적으로 초점이 옮겨집니다.

힌트

[AF Speed/Sens.]가 할당 가능 버튼에 할당된 경우 버튼을 누를 때마다 값을 조정하는 레벨 막대가 다음과 같은 순서로 카메라 이
미지 패널에 표시되어 AF 전환 속도 및 AF 피사체 이동 감도 설정을 변경할 수 있습니다.
AF 전환 속도 → AF 피사체 이동 감도 → 표시되지 않음 …

5-041-958-23(1) Copyright 2022 Sony Corporation

178



도움말 안내

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

웹 앱을 사용하여 수동으로 자동 초점 대상 설정(AF Assist)

초점을 수동으로 이동 및 조정한 후 자동 초점으로 초점 제어를 전달하여 미세 초점 조정을 할 수 있습니다.

참고 사항

AF 보조 상태에서는 카메라 메뉴의 [Shooting] > [Focus] > [AF Subj. Shift Sens.] 설정과 관계없이 초점 이동이 어려워집니다.

다음과 같은 경우 AF 보조 상태가 취소됩니다.

[Focus] 슬라이더를 사용하여 초점을 맞춘 피사체가 더 이상 보이지 않을 때
수동 초점으로 전환할 때
실시간 추적 AF가 시작되었을 때

힌트

[Push AF/MF]가 할당된 할당 가능 버튼을 사용하여 AF 보조 상태를 빠르게 취소할 수 있습니다.

[Focus] 슬라이더를 조작하면 실시간 추적 AF가 정지됩니다.

Face/Eye Only AF 모드에서 자동 초점은 [Focus] 슬라이더의 초점 위치와 가장 가까운 얼굴에 초점을 맞춥니다.

카메라 메뉴에서 [Shooting] > [Focus] > [AF Assist]를 [On]으로 설정합니다.1

웹 메뉴에서 [Shooting] > [Focus] > [AF Assist Control]를 [On]로 설정합니다.2

[Auto Focus] 스위치를 카메라 제어 패널의 오른쪽 위치로 밀어 켭니다.

자동 초점 모드가 활성화됩니다.

3

카메라 제어 패널의 [Focus] 슬라이더를 사용하여 초점 대상을 설정합니다.

[Near]: 가까운 피사체에 초점을 맞춥니다.
[Far]: 먼 피사체에 초점을 맞춥니다.

AF 보조 상태에서 [Focus] 슬라이더로 설정한 거리에 있는 피사체에 자동으로 초점이 맞춰집니다.

4
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도움말 안내

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

제공된 적외선 리모컨을 사용하여 자동 초점 중 수동으로 초점 맞추기

카메라 메뉴에서 [Shooting] > [Focus] > [AF Assist]가 [On]으로 설정된 경우 자동 초점 중에도 제공된 적외선 리모컨의
F(원거리) 버튼 및 N(근거리) 버튼을 사용하여 피사체에 초점을 맞출 수 있습니다.

5-041-958-23(1) Copyright 2022 Sony Corporation
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도움말 안내

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

자동 초점 중 임시로 수동 초점 사용(Push Manual Focus)

버튼을 누른 상태에서 수동으로 초점을 맞추려면 자동 초점 모드에서 [Push AF/MF] 버튼을 누릅니다. 버튼에서 손을 떼면
초점이 자동 초점으로 되돌아갑니다.
이렇게 하면 촬영 대상이 아닌 피사체 같은 물체가 피사체 앞을 지나갈 때 일시적으로 자동 초점을 중지하고 수동으로 초
점을 맞출 수 있습니다.

힌트

[Push AF/MF]가 할당된 할당 가능 버튼을 사용하여 동일한 작업이 지원됩니다.

5-041-958-23(1) Copyright 2022 Sony Corporation
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도움말 안내

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

얼굴 및 눈 감지를 사용하여 추적하기(Face/Eye Detection AF)

기기는 추적할 대상으로 사람의 얼굴과 눈을 감지할 수 있으며 초점 영역 내 얼굴과 눈에서 초점을 조정합니다.
얼굴이 감지되면 회색 얼굴/눈 감지 프레임이 표시됩니다. 자동 초점 맞추기가 가능한 경우 프레임이 흰색으로 바뀌고 추
적이 시작됩니다. 눈이 감지되고 초점이 조정되면 얼굴/눈 감지 프레임이 눈에 표시됩니다. 여러 명이 감지되는 경우 주 피
사체가 자동으로 결정됩니다.
이 기능은 초점 모드가 AF 모드이거나 푸시 자동 초점 중에만 사용할 수 있습니다.

힌트

초점 영역이 [Zone]이나 [Flexible Spot]으로 설정되고 지정된 초점 영역 내에서 얼굴이나 눈이 겹치는 경우 얼굴/눈 감지 프레임이
흰색으로 바뀌고 기기가 해당 얼굴/눈에 자동으로 초점을 맞춥니다.

푸시 자동 초점(AF-S)이 사용되면 초점의 얼굴/눈에 대한 얼굴/눈 감지 프레임이 녹색으로 바뀝니다.

카메라 제어 패널에서 [Face/Eye Detection AF] 버튼을 사용한 설정

[Face/Eye Detection AF] 버튼을 눌러 얼굴/눈 감지 AF 동작을 설정합니다.

[Face/Eye Only AF]: 카메라가 피사체(사람)의 얼굴/눈을 감지하고 해당 얼굴/눈에만 초점을 맞추고 추적합니다. 얼굴이
나 눈이 감지되지 않으면 AF가 일시적으로 중지되고 (Face/Eye Only AF 모드 자동 초점 일시 중지) 아이콘이 표시됩니
다. 이 모드는 얼굴/눈에만 자동 초점을 맞추고 추적하고자 할 때 효과적입니다.
[Face/Eye Priority AF]: 카메라가 피사체(사람)의 얼굴/눈을 감지하고 얼굴/눈에 우선적으로 초점을 맞추고 추적합니다.
얼굴이나 눈이 감지되지 않으면 초점은 AF 모드(기본 설정)에 위치합니다.
[AF]: 얼굴/눈 감지 AF 기능이 비활성화됩니다.

참고 사항

푸시 자동 초점 작동 중에는 현재 [Face/Eye Only AF]가 선택된 경우에도 [Face/Eye Priority AF]가 활성화됩니다.

[Auto Focus] 스위치가 꺼짐 위치로 설정되면 얼굴/눈 감지 AF가 비활성화됩니다(푸시 자동 초점 작동 중에는 제외).

[Face/Eye Only AF]가 선택되었을 때 캠코더를 끄면 다음에 캠코더를 켰을 때 모드가 자동으로 [Face/Eye Priority AF]로 전환됩니
다.

힌트

카메라 메뉴의 [Shooting] > [Focus] > [Face/Eye Detection AF]를 사용하여 얼굴/눈 감지 AF 동작을 설정할 수 있습니다.
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얼굴/눈 감지 프레임을 숨기려면

카메라 메뉴의 [Monitoring] > [Display On/Off] > [Face/Eye Detection Frame]를 사용하여 얼굴/눈 감지 프레임 표시하거나
숨길 수 있습니다.

참고 사항

푸시 자동 초점(AF-S)을 사용하여 초점을 맞춘 얼굴과 눈에 녹색 얼굴/눈 감지 프레임이 표시되고 이 프레임은 [Display] 버튼을 사
용하거나 [Face/Eye Detection Frame]이 [Off]일 때 숨겨지지 않습니다.

할당 가능 버튼을 사용하여 얼굴/눈 감지 AF 동작을 전환하려면

[Face/Eye Detection AF]를 할당 가능 버튼에 할당합니다. 그런 다음 버튼을 누를 때마다 얼굴/눈 감지 AF 동작을
[Face/Eye Priority AF], [Face/Eye Only AF] 및 [AF] 순서로 전환할 수 있습니다.

다이렉트 메뉴를 사용하여 설정

다이렉트 메뉴를 사용하여 얼굴/눈 감지 AF 동작을 설정할 수도 있습니다.

다이렉트 메뉴에 대한 자세한 내용은 "다이렉트 메뉴 작동"을 참조하십시오.

관련 항목

다이렉트 메뉴 작동

5-041-958-23(1) Copyright 2022 Sony Corporation
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도움말 안내

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

지정된 피사체 추적하기(Realtime Tracking AF)

카메라 제어 패널에서 터치 동작 또는 얼굴 감지 프레임 선택을 통해 피사체를 지정하여 피사체에 대한 초점을 유지할 수
있습니다.
피사체가 선택되면 하얀색 추적 프레임이 표시되고 추적이 시작됩니다.

힌트

추적은 초점 영역 설정과 무관하게 전체 이미지 영역에서 이루어집니다.

웹 메뉴 또는 카메라 메뉴에서 [Shooting] > [Focus] > [Touch Function in MF]가 [Tracking AF]로 설정되어 있으면 초점 모드가 MF
모드일 때도 실시간 추적 AF가 지원됩니다.

얼굴/눈 감지 AF 작동 모드 설정에 따라 추적 대상에 대해 다음과 같은 동작이 일어납니다.

[Face/Eye Only AF] 또는 [Face/Eye Priority AF]: 지정된 피사체의 초점 및 추적.
추적 대상이 사람이고 얼굴/눈이 감지된 경우 카메라가 해당되는 얼굴/눈에 초점을 맞춥니다.
추적 대상 얼굴/눈이 감지되면 추적 대상 얼굴이 저장됩니다. 저장되면  (얼굴 추적 저장됨 아이콘)이 표시됩니다.

참고 사항

수동 초점 도중 추적 AF가 시작되면 추적 대상 얼굴이 저장되지 않습니다.

[AF]: 지정된 피사체의 초점 및 추적에 사용합니다. 추적 대상이 사람인 경우에도 얼굴/눈 감지가 이루어지지 않습니다.

참고 사항

렌즈가 수동 초점으로 설정된 경우 실시간 추적 AF 기능이 작동하지 않습니다.

실시간 추적 AF 시작

특정 피사체가 추적 대상으로 지정되면 대상 추적이 시작됩니다.

터치 동작으로 지정하려면

카메라 제어 패널의  (Focus) 탭에서 [Touch Focus] 스위치를 올바른 위치로 밀어 켜고 다음 상태에서 대상 피사체를 탭
하여 추적합니다.
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수동 초점 중 또는 푸시 수동 초점 중, 웹 메뉴 또는 카메라 메뉴에서 [Shooting] > [Focus] > [Touch Function in MF]가
[Tracking AF]로 설정된 경우
자동 초점 중 또는 푸시 자동 초점(AF) 중

얼굴 감지 프레임 선택을 통해 지정하려면

GUI 제어 패널의 화살표 버튼을 사용하여 얼굴 선택 커서(주황색 밑줄)를 대상 피사체로 이동한 다음 [Set] 버튼을 누릅니
다.

A: 얼굴 감지 프레임(회색)
B: 추적 프레임
C: 얼굴 선택 커서(주황색)

참고 사항

수동 초점 도중 얼굴 감지 프레임 선택으로 추적을 시작할 수 없습니다.

힌트

실시간 추적 AF 도중 추적 대상을 변경할 수도 있습니다.

실시간 추적 AF 중지

(실시간 추적 AF 중지) 버튼을 누릅니다.

힌트

다음과 같은 경우 실시간 추적 AF가 중지됩니다.

[Auto Focus] 스위치 또는 렌즈의 AUTO/MANUAL 제어가 전환된 경우
초점 모드가 변경된 경우
AF Assist가 실행된 경우
초점 영역 설정 또는 얼굴/눈 감지 AF 동작이 변경된 경우
[Push AF/MF]가 할당된 할당 가능 버튼을 누른 경우
추적 대상이 촬영 화면 내에 있지 않거나 피사체가 몇 초 동안 초점에서 벗어난 경우
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얼굴 추적이 저장된 경우( (얼굴 추적 저장됨 아이콘) 표시) 저장된 얼굴 추적이 이미지 영역에 들어오면 실시간 추적 AF가 재개
됩니다. 얼굴 추적을 지우려면 위에서 설명한 것과 같이 실시간 추적 AF를 중지합니다.

5-041-958-23(1) Copyright 2022 Sony Corporation
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도움말 안내

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

밝기 조정 화면

웹 앱 라이브 작동 화면의 다음 제어판에서 조리개, 게인, 셔터 속도를 조정하고 ND 필터를 사용하여 조도를 조정하여 밝
기를 조정할 수 있습니다. 밝기를 자동으로 조정할 수도 있습니다.

참고 사항

[Shooting Mode]가 [Cine EI Quick] 또는 [Cine EI]로 설정되어 있으면 게인을 조정할 수 없습니다. 또한 [Cine EI Quick] 또는 [Cine
EI]로 설정되어 있으면 셔터 속도를 사용하여 밝기를 자동으로 조정할 수 없습니다. 조리개와 ND 필터를 사용한 밝기 자동 조정이
지원됩니다.

힌트

카메라 제어 패널 –  (Main) 탭1.

카메라 기본 구성 패널
버튼에서 촬영에 필요한 기본 기능의 설정 상태를 표시합니다. 버튼을 누르면 아래의 카메라 기본 설정 조정 패널에서
각 기능에 해당하는 설정 화면이 나타납니다.

2.

카메라 기본 구성 조정 패널
카메라 기본 구성 패널에서 선택한 설정 항목에 대한 조정 패널을 표시합니다.

3.
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Cine EI 모드는 이미지 센서의 성능을 극대화하기 위해 게인을 사용하지 않고 기본 감도로 촬영하는 모드입니다. 밝기는 조명과
ND 필터를 사용하여 조정되어 이미지 센서에 도달하는 빛의 양을 조정합니다. Exposure Index(EI)에 대한 자세한 내용은 "녹화된
이미지에서 어두운 영역과 밝은 영역의 분포 변경"을 참조하십시오.

관련 항목

녹화된 이미지에서 어두운 영역과 밝은 영역의 분포 변경

5-041-958-23(1) Copyright 2022 Sony Corporation

189



도움말 안내

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

기본 감도 설정

밝기 조정을 시작하기 전에 기본 감도를 설정할 수 있습니다.

[Shooting Mode]가 [Custom]으로 설정된 경우

카메라 기본 설정 패널에서 [ISO/Gain] 버튼을 누르고 ISO/게인 조정 패널의 [Base Sensitivity]를 [High] 또는 [Low]로 설정
합니다.
정상 조명 조건에서 [Low]를 선택하고 낮은 조명 조건에서 [High]를 선택합니다.
[AGC]가 꺼져 있을 때의 화면

[AGC]가 켜져 있을 때의 화면

[Shooting Mode]가 [Flexible ISO] 또는 [Cine EI]로 설정된 경우

카메라 기본 구성 패널에서 [Base ISO/Exposure Index] 버튼을 누르고 [Base ISO](Base ISO/Exposure Index 조정 패널에
위치)를 [ISO 12800] 또는 [ISO 800]으로 설정합니다.
정상 조명 조건에서 [ISO 800]를 선택하고 낮은 조명 조건에서 [ISO 12800]를 선택합니다.

힌트
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카메라 제어판의  (Main) 탭에서도 설정할 수 있습니다.

카메라 메뉴의 [Shooting] > [ISO/Gain/EI] > [Base Sensitivity] 또는 [Base ISO]를 사용하여 설정할 수도 있습니다.

[Base ISO/Sensitivity]를 할당 가능 버튼에 할당할 수도 있습니다.

[Cine EI Quick] 촬영 모드에서 기본 감도는 노출 지수 설정에 따라 자동으로 설정됩니다.

5-041-958-23(1) Copyright 2022 Sony Corporation
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도움말 안내

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

자동 밝기 조정을 위한 목표 레벨 설정

자동 밝기 조정의 목표 레벨은 카메라 제어 패널의 [AE Level] 슬라이더를 사용하여 설정합니다.

5-041-958-23(1) Copyright 2022 Sony Corporation

카메라 제어 패널의  (Main) 탭을 누릅니다.

[AE Level] 슬라이더가 표시되지 않으면 2개의 슬라이더 기능 선택 버튼 중 하나를 선택하고 목록에서 [AE Level] 슬
라이더를 선택합니다.

[AE Level] 슬라이더가 나타납니다.

1

슬라이더를 사용하여 목표 레벨을 설정합니다.

슬라이더 노브를 왼쪽으로 움직여 이미지를 더 어둡게 만듭니다. 슬라이더 노브를 오른쪽으로 움직여 이미지를 더 밝
게 만듭니다.

힌트

카메라 메뉴의 [Shooting] > [Auto Exposure] > [Level]을 사용하여 설정할 수도 있습니다.

2
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도움말 안내

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

조리개를 자동으로 조정

피사체에 따라 밝기를 자동으로 조정할 수 있습니다. 호환되는 렌즈가 필요합니다.

참고 사항

A-mount 렌즈에서는 조리개를 자동으로 조정할 수 없습니다.

힌트

[Auto Iris]를 할당 가능 버튼에 할당할 수도 있습니다.

5-041-958-23(1) Copyright 2022 Sony Corporation

Auto Iris 스위치가 있는 렌즈가 부착된 경우 스위치를 AUTO로 설정합니다.1

카메라 기본 구성 패널에서 [Iris] 버튼을 누릅니다.

[Iris] 버튼의 프레임이 주황색으로 바뀝니다.

Iris 조정 패널이 나타납니다.

2

[Auto] 스위치를 오른쪽으로 밀어 켭니다.

조리개가 자동 조정 모드로 전환됩니다. 자동 조정된 조리개 값은 스위치 오른쪽에 표시됩니다.

3
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도움말 안내

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

조리개를 수동으로 조정

밝기를 수동으로 조정할 수 있습니다.

임시로 조리개를 자동으로 조정하려면

또한 Iris 조정 패널에서 [Push Auto] 버튼을 눌러 버튼을 누르고 있는 동안 조리개를 자동으로 조정할 수도 있습니다.

Auto Iris 스위치가 있는 렌즈가 부착된 경우 스위치를 AUTO로 설정합니다.

참고 사항

렌즈의 Auto Iris 스위치가 MANUAL로 설정된 경우 기기의 [Auto Iris] 및 [Push Auto Iris] 기능이 작동하지 않습니다. 기기에서
수동 조리개 조정도 작동하지 않습니다.

1

카메라 기본 구성 패널에서 [Iris] 버튼을 누릅니다.

[Iris] 버튼의 프레임이 주황색으로 바뀝니다.

Iris 조정 패널이 나타납니다.

2

[Auto] 스위치를 왼쪽으로 밀어 끕니다.

조리개가 수동 조정 모드로 전환됩니다.

3

[Iris] 슬라이더 또는 [Iris] 조정 버튼을 사용하여 조리개를 조정합니다.

힌트

슬라이더와 조정 버튼 설정은 연결되어 있습니다.

카메라 제어 패널의  (Main) 탭에서 슬라이더에 조리개를 할당할 수도 있습니다.

4
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힌트

[Push Auto Iris] 기능이 할당된 할당 가능 버튼을 눌러 버튼을 누르고 있는 동안 조리개를 자동으로 조정할 수 있습니다.
버튼에서 손을 떼면 조리개가 수동 모드로 되돌아갑니다.

5-041-958-23(1) Copyright 2022 Sony Corporation
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도움말 안내

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

게인을 자동으로 조정

[Shooting Mode]가 [Custom] 또는 [Flexible ISO]로 설정된 경우 게인 설정을 사용하여 밝기를 자동으로 조정할 수 있습니
다.

5-041-958-23(1) Copyright 2022 Sony Corporation

웹 메뉴 또는 카메라 메뉴에서 [Project] > [Shooting Mode]를 [Custom]으로 설정합니다.1

카메라 기본 구성 패널에서 [ISO/Gain] 버튼을 누릅니다.

[ISO/Gain] 버튼의 프레임이 주황색으로 바뀝니다.

ISO/Gain 조정 패널이 나타납니다.

2

[AGC] 스위치를 오른쪽으로 밀어 켭니다.

게인이 자동 조정 모드로 전환됩니다. 자동 조정된 게인 값은 스위치 오른쪽에 표시됩니다.

힌트

카메라 메뉴에서 [Shooting] > [Auto Exposure] > [AGC]를 [On]으로 설정하여 동일한 동작을 수행할 수도 있습니다.

[AGC]를 할당 가능 버튼에 할당할 수도 있습니다.

3
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도움말 안내

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

게인을 수동으로 조정

[Shooting Mode]가 [Custom] 또는 [Flexible ISO]로 설정된 경우 게인 설정을 사용하여 밝기를 수동으로 조정할 수 있습니
다.
고정된 조리개 설정을 사용하면서 노출을 조정하거나 AGC로 인해 게인이 증가되는 것을 차단하기 위해 게인을 제어할 수
있습니다.

임시로 게인을 수동으로 조정하려면

카메라 제어 패널의 (Main) 탭에 있는 슬라이더 기능 선택 버튼에 [ISO/Gain]을 할당하고 슬라이더를 사용하여 임시로
게인을 조정할 수도 있습니다.
이는 피사계 심도를 변경하지 않고 노출을 한 단계씩 조정하려는 경우에 유용합니다.
조정 결과는 다음 작업 중 하나를 수행한 후 [ISO/Gain<L>]을 사용하여 구성된 사전 설정 값으로 돌아갑니다.

ISO/Gain 조정 항목 변경

웹 메뉴 또는 카메라 메뉴에서 [Project] > [Shooting Mode]를 [Custom]으로 설정합니다.1

카메라 기본 구성 패널에서 [ISO/Gain] 버튼을 누릅니다.

[ISO/Gain] 버튼의 프레임이 주황색으로 바뀝니다.

ISO/Gain 조정 패널이 나타납니다.

2

[AGC] 스위치를 왼쪽으로 밀어 끕니다.

게인이 수동 조정 모드로 전환됩니다.

3

[ISO/Gain] 슬라이더 또는 [ISO/Gain] 조정 버튼을 사용하여 게인을 조정합니다.

힌트

슬라이더와 조정 버튼 설정은 연결되어 있습니다.

4
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기본 감도 전환
AGC 스위치를 On 위치로 설정
기기의 전원 공급 장치를 대기 상태로 전환

할당 가능 버튼을 사용하여 임시로 게인을 자동으로 조정하려면

[Push AGC] 기능이 할당된 할당 가능 버튼을 눌러 버튼을 누르고 있는 동안 게인을 자동으로 조정할 수 있습니다.
버튼에서 손을 떼면 게인이 수동 모드로 되돌아갑니다.
조정 결과는 다음 작업 중 하나를 수행한 후 [ISO/Gain<L>]을 사용하여 구성된 사전 설정 값으로 돌아갑니다.

ISO/Gain 조정 항목 변경
기본 감도 전환
AGC 스위치를 On 위치로 설정
기기의 전원 공급 장치를 대기 상태로 전환

참고 사항

이 기능은 카메라 메뉴에서 [Shooting] > [Iris] > [Bokeh Control]이 [On]으로 설정되어 있을 때 실행할 수 없습니다.

5-041-958-23(1) Copyright 2022 Sony Corporation
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Interchangeable Lens Digital Camera
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셔터를 자동으로 조정

이미지의 밝기에 따라 셔터를 자동으로 조정할 수 있습니다.

5-041-958-23(1) Copyright 2022 Sony Corporation

카메라 기본 구성 패널에서 [Shutter] 버튼을 누릅니다.

[Shutter] 버튼의 프레임이 주황색으로 바뀝니다.

Shutter 조정 패널이 나타납니다.

1

[Shutter Type] 버튼을 눌러 목록에서 [Auto]를 선택합니다.

힌트

카메라 메뉴에서 [Shooting] > [Auto Exposure] > [Auto Shutter]를 [On]으로 설정하여 동일한 동작을 수행할 수도 있습니다.

[Auto Shutter]를 할당 가능 버튼에 할당할 수도 있습니다.

2
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Interchangeable Lens Digital Camera
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셔터를 수동으로 조정

셔터를 수동으로 조정할 수 있습니다.

카메라 기본 구성 패널에서 [Shutter] 버튼을 누릅니다.

[Shutter] 버튼의 프레임이 주황색으로 바뀝니다.

Shutter 조정 패널이 나타납니다.

1

[Shutter Type] 버튼을 눌러 목록에서 [Speed]를 선택합니다.2

[Speed] 슬라이더 또는 [Speed] 조정 버튼을 사용하여 셔터를 조정합니다.

프레임 간격과 일치하도록 노출 시간을 조정하려면 2단계에서 [Off]를 선택합니다. [ECS](주파수)를 사용하여 고정
값을 설정하거나 [Auto]를 사용하여 자동으로 조정할 수도 있습니다.
예: [ECS](주파수)를 사용하여 설정

힌트

슬라이더와 조정 버튼 설정은 연결되어 있습니다.

[Speed] 또는 [Off] 대신 [Angle]을 사용하려면 카메라 메뉴에서 [Shooting] > [Shutter] > [Mode]를 [Angle]로 설정합니다.

3
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Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

ND 필터 정보

조명이 너무 밝은 조건에서는 ND 필터를 변경하여 적절한 밝기를 설정할 수 있습니다.
밝은 피사체를 촬영할 때 조리개를 너무 많이 닫으면 회절 흐림 현상이 발생하여 이미지 초점이 맞지 않게 될 수 있습니다
(카메라에서 발생하는 일반적인 현상). ND 필터를 사용하면 이 효과가 억제되어 더 나은 촬영 결과를 얻을 수 있습니다.
본 기기에는 다음과 같은 ND 필터 모드가 있습니다.
사전 설정 모드

"사전 설정 모드에서 조정"을 참조하십시오.

가변 모드(자동 조정)

"가변 모드에서 자동으로 조정"을 참조하십시오.

가변 모드(수동 조정)

"가변 모드에서 수동으로 조정"을 참조하십시오.

관련 항목

사전 설정 모드에서 조정

가변 모드에서 자동으로 조정

가변 모드에서 수동으로 조정

5-041-958-23(1) Copyright 2022 Sony Corporation
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Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

사전 설정 모드에서 조정

3개의 ND 필터 투과율 값을 미리 선택하고 촬영 시 빠르게 전환할 수 있습니다.

힌트

[ND Filter Position]이 할당된 할당 가능 버튼을 누르면 ND 필터가 [Clear] → [Preset1] → [Preset2] → [Preset3] → [Clear]의 순서로
변경됩니다.

5-041-958-23(1) Copyright 2022 Sony Corporation

카메라 메뉴에서 [Shooting] > [ND Filter] > [Mode]를 [Preset]으로 설정합니다.1

카메라 기본 구성 패널에서 [ND Filter] 버튼을 누릅니다.

[ND Filter] 버튼의 프레임이 주황색으로 바뀝니다.

ND Filter 조정 패널이 나타납니다.

2

[ND Filter] 버튼을 누르고 목록에서 다음 중 하나를 선택합니다.

[Clear]: ND 필터가 없습니다.
[Preset1]: 카메라 메뉴의 [Shooting] > [ND Filter] > [Preset1]에서 설정한 투과율입니다.
[Preset2]: 카메라 메뉴의 [Shooting] > [ND Filter] > [Preset2]에서 설정한 투과율입니다.
[Preset3]: 카메라 메뉴의 [Shooting] > [ND Filter] > [Preset3]에서 설정한 투과율입니다.

ND 필터에 대해 [Preset1] ~ [Preset3] 중 하나를 선택하면 투과율 값이 ND 필터 이름 옆에 표시됩니다.

3
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도움말 안내

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

가변 모드에서 자동으로 조정

ND 필터를 사용하여 자동 노출 조정을 활성화할 수 있습니다.

참고 사항

촬영 중에 ND 필터가 [Clear]로 전환되거나 [Clear]에서 전환되면 ND 필터 프레임이 이미지에 표시되고 작동 사운드가 방출됩니다.

힌트

또한 [Auto ND Filter]를 할당 가능 버튼에 할당하고 해당 버튼을 눌러 [Auto]와 [Manual] 사이에서 전환할 수 있습니다.

5-041-958-23(1) Copyright 2022 Sony Corporation

카메라 메뉴에서 [Shooting] > [ND Filter] > [Mode]를 [Variable]으로 설정합니다.1

카메라 기본 구성 패널에서 [ND Filter] 버튼을 누릅니다.

[ND Filter] 버튼의 프레임이 주황색으로 바뀝니다.

ND Filter 조정 패널이 나타납니다.

2

[ND Filter] 버튼을 눌러 목록에서 [Auto]를 선택합니다.

자동으로 조정된 ND 필터 투과율 값이[ND Filter] 버튼 옆에 표시됩니다.

3

204
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Interchangeable Lens Digital Camera
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가변 모드에서 수동으로 조정

ND 필터를 사용하여 수동 노출 조정을 수행할 수 있습니다.

임시로 자동으로 조정하려면

[Push Auto ND]를 할당 가능 버튼에 할당하고 버튼을 누르는 동안 임시로 자동 ND 필터를 켤 수 있습니다. 버튼에서 손을
떼면 자동 ND 필터가 다시 Off로 설정됩니다.
ND 필터를 [Manual]로 설정합니다.

참고 사항

촬영 중에 ND 필터가 [Clear]로 전환되거나 [Clear]에서 전환되면 ND 필터 프레임이 이미지에 표시되고 작동 사운드가 방출됩니다.

힌트

카메라 메뉴에서 [Shooting] > [ND Filter] > [Mode]를 [Variable]으로 설정합니다.1

카메라 기본 구성 패널에서 [ND Filter] 버튼을 누릅니다.

[ND Filter] 버튼의 프레임이 주황색으로 바뀝니다.

ND Filter 조정 패널이 나타납니다.

2

[ND Filter] 버튼을 눌러 목록에서 [Manual]를 선택합니다.3

[ND Filter] 슬라이더 또는 [ND Filter] 조정 버튼을 사용하여 ND 필터의 투과율을 조정합니다.

힌트

슬라이더와 조정 버튼 설정은 연결되어 있습니다.

카메라 제어 패널의  (Main) 탭에서도 ND 필터를 조정할 수 있습니다.

4
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또한 [ND Filter Position]를 할당 가능 버튼에 할당하고 해당 버튼을 눌러 [Manual]와 [Clear] 사이에서 전환할 수 있습니다.

또한 ND Filter 조정 패널에서 [Push Auto] 버튼을 눌러 버튼을 누르고 있는 동안 자동 ND 필터를 자동으로 조정할 수도 있습니다.

5-041-958-23(1) Copyright 2022 Sony Corporation
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화이트 밸런스 조정 화면

웹 앱의 라이브 작동 화면을 사용하여 화이트 밸런스를 조정함으로써 이미지를 보다 자연스럽게 보이게 하는 화이트 밸런
스를 얻을 수 있습니다.

5-041-958-23(1) Copyright 2022 Sony Corporation

카메라 기본 구성 패널1.

카메라 기본 구성 조정 패널
카메라 기본 구성 패널에서 선택한 설정 항목에 대한 조정 패널을 표시합니다.

2.
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Interchangeable Lens Digital Camera
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화이트 밸런스를 자동으로 조정

ATW(자동 추적 화이트 밸런스)를 사용하여 항상 적절하게 조정된 화이트 밸런스를 얻을 수 있습니다.
ATW가 활성화되면 광원의 색온도가 변경될 때 화이트 밸런스가 자동으로 조정됩니다.

참고 사항

[Shooting Mode]가 [Cine EI] 또는 [Cine EI Quick]으로 설정되어 있으면 ATW를 사용할 수 없습니다.

조명 및 피사체 조건에 따라 ATW를 사용하여 적절한 색상으로 조정하지 못할 수 있습니다.
예:

하늘, 바다, 땅 또는 꽃과 같이 단일 색상이 피사체의 대부분을 차지하는 경우.
색온도가 지나치게 높거나 낮은 경우.

ATW 자동 추적 속도가 느리거나 적절한 효과를 얻을 수 없는 경우 [WB SET] 버튼을 눌러 자동 화이트 밸런스를 실행합니다.

힌트

카메라 메뉴의 [Shooting] > [White Setting] > [ATW Speed]를 사용하여 ATW 모드일 때 응답 속도를 5단계(1, 2, 3, 4, 5)로 선택할
수 있습니다. 숫자가 낮을수록 응답 속도가 빠릅니다.

[ATW Hold] 기능을 할당 가능 버튼에 할당하고 할당 가능 버튼을 눌러 ATW 모드 중 ATW를 일시적으로 중지함으로써 현재 화이트
밸런스 설정을 고정시킬 수 있습니다.

5-041-958-23(1) Copyright 2022 Sony Corporation

카메라 기본 구성 패널에서 [White Balance] 버튼을 누릅니다.

[White Balance] 버튼의 프레임이 주황색으로 바뀝니다.

White Balance 조정 패널이 나타납니다.

1

[White Mode] 버튼을 눌러 목록에서 [ATW]를 선택합니다.2
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화이트 밸런스를 수동으로 조정

화이트 밸런스를 수동으로 조정할 수 있습니다.

카메라 기본 구성 패널에서 [White Balance] 버튼을 누릅니다.

[White Balance] 버튼의 프레임이 주황색으로 바뀝니다.

White Balance 조정 패널이 나타납니다.

1

[White Mode] 버튼을 누르고 목록에서 다음 중 하나를 선택합니다.

[Memory A(T/T)]

[Memory A(R/B)]

[Preset]

2

슬라이더 또는 조정 버튼을 사용하여 화이트 밸런스를 조정합니다.

힌트

슬라이더와 조정 버튼 설정은 연결되어 있습니다.

[Memory A(T/T)]와 [Memory A(R/B)]의 차이점은 조정 축은 다르지만 조정 결과는 연결된다는 점입니다.

[Memory A(T/T)]의 경우
이 모드는 색온도(Temp)와 Tint를 조정하여 메모리 A에 저장된 화이트 밸런스를 조정합니다.
2000 K~5600 K 범위에서 20 K 증분으로 색온도를 설정할 수 있습니다. 5600 K 이상의 값은 5580 K에서 5600 K까지
의 색상 변경(미레드) 양과 동일한 간격으로 설정할 수 있습니다.
[Temp] 또는 [Tint] 우측의 [Reset] 버튼을 누르면 해당 설정이 기본값으로 복원됩니다.

3
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[Memory A(R/B)]의 경우
이 모드는 R Gain 및 B Gain을 조정하여 메모리 A에 저장된 화이트 밸런스를 조정합니다.
[Reset] 버튼을 누르면 해당 게인 설정이 기본값으로 복원됩니다.
[Preset]의 경우
이 모드는 색온도를 사전 설정 값으로 조정합니다.
100 K 단위로 값을 설정할 수 있습니다.
사전 설정 모드에서 [Preset White Select]를 할당 가능 버튼에 할당하고 버튼을 눌러 사전 구성된 사전 설정 값으로
변경할 수도 있습니다.
[Custom]: 3200 K → 4300 K → 5600 K → 6300 K → 3200 K…
[Flexible ISO], [Cine EI], [Cine EI Quick]: 3200 K → 4300 K → 5500 K → 3200 K…
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자동 화이트 밸런스 실행

메모리 A 모드에서는 저장할 화이트 밸런스가 자동으로 조정됩니다.

카메라 기본 구성 패널에서 [White Balance] 버튼을 누릅니다.

[White Balance] 버튼의 프레임이 주황색으로 바뀝니다.

White Balance 조정 패널이 나타납니다.

1

[White Mode] 버튼을 눌러 목록에서 [Memory A(T/T)] 또는 [Memory A(R/B)]를 선택합니다.

[Memory A(T/T)]

[Memory A(R/B)]

2

피사체와 광원 및 조건이 동일한 위치에서 흰색 종이(또는 기타 물질)를 놓고 종이를 확대하여 화면에 흰색을 표시합
니다.

3

밝기를 조정합니다.

"조리개를 수동으로 조정"의 절차를 사용하여 조리개를 조정합니다.

4

화이트 밸런스 조정 패널에서 [WB SET] 버튼을 누릅니다.

[Memory A(T/T)]

[Memory A(R/B)]

5
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참고 사항

조정에 실패하면 화면에 약 3초 동안 오류 메시지가 표시됩니다. 화이트 밸런스 설정을 반복해서 시도해도 오류 메시지가 지속되면
Sony 서비스 담당자에게 문의하십시오.

힌트

ATW 모드에서도 실행할 수 있습니다. ATW 작동 중 화이트 밸런스를 빠르게 조정하려는 경우 사용할 수 있습니다. 조정 후 모드는
일반 ATW 작동으로 돌아갑니다.

관련 항목

조리개를 수동으로 조정

5-041-958-23(1) Copyright 2022 Sony Corporation

자동 화이트 밸런스가 메모리 모드에서 실행되면 자동 조정 결과가 메모리 A에 저장됩니다.
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오디오 구성 화면

웹 앱의 라이브 작동 화면에서 기기에서 녹음할 오디오 레벨을 조정할 수 있습니다. 기기의 커넥터 블록에 있는 스위치를
구성하고 카메라 메뉴 또는 웹 메뉴를 사용하여 오디오를 구성합니다.

5-041-958-23(1) Copyright 2022 Sony Corporation

카메라 제어 패널 –  (Audio) 탭1.

213



도움말 안내

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

오디오 입력 장치 선택

AUDIO IN 커넥터에 연결된 장치에 따라 다음 스위치를 설정합니다.

참고 사항

Interval Rec 모드나 Slow & Quick Motion 모드에서는 오디오가 녹음되지 않습니다.

5-041-958-23(1) Copyright 2022 Sony Corporation

마이크가 연결되면 기기 후면의 커넥터 블록에 SETUP 스위치 2를 설정합니다.

CH-1과 CH-2에는 공통 설정이 있습니다.

1

설정 설명

OFF(기본
값)

동적 마이크 또는 배터리 작동 마이크를 사용할 때 선택합니다. 이렇게 하면 +48V 팬텀 전원 공급 장
치가 꺼지고 LINE 또는 MIC 입력이 CH-1 및 CH-2 오디오 소스로 설정됩니다.

ON
+48V 팬텀 전원 공급 장치 호환 마이크를 사용할 때 선택합니다. 이렇게 하면 +48V 팬텀 전원 공급 장
치가 켜지고 팬텀 전원 공급 장치 호환 마이크가 CH-1 및 CH-2 오디오 소스로 설정됩니다.

카메라 메뉴의 [Audio] > [Audio Input] > [AUDIO IN Select]를 사용하여 연결된 장치 유형을 설정합니다.2

웹 또는 카메라 메뉴의 [Audio] > [Audio Input] > [CH1 Input Select] ~ [CH4 Input Select]를 사용하여 오디오 입
력을 선택합니다.

3
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오디오 녹음 레벨을 자동으로 조정

오디오 녹음 레벨을 자동으로 조정하려는 채널을 웹 메뉴의 [Audio] 페이지에서 [Auto]로 설정하거나 카메라 메뉴에서
[Audio] > [Audio Input] > [CH1 Level Control] ~ [CH4 Level Control]을 사용하여 설정합니다.
자동 조정으로 지정된 채널은 라이브 작동 화면의 (Audio) 탭에서 해당 채널 옆에 (Auto) 아이콘으로 표시됩니다.

5-041-958-23(1) Copyright 2022 Sony Corporation
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오디오 녹음 레벨을 수동으로 조정

오디오 녹음 레벨을 수동으로 조정할 수 있습니다.

5-041-958-23(1) Copyright 2022 Sony Corporation

오디오 녹음 레벨을 수동으로 조정하려는 채널을 웹 메뉴의 [Audio] 페이지에서 [Manual]로 설정하거나 카메라 메뉴
에서 [Audio] > [Audio Input] > [CH1 Level Control] ~ [CH4 Level Control]을 사용하여 설정합니다.

1

카메라 제어 패널의  (Audio) 탭을 누릅니다.2

카메라 제어 패널의 [Audio] 화면에서 수동으로 오디오 녹음 레벨을 설정하려는 채널의 슬라이더 또는 조정 버튼을
사용하여 오디오 녹음 레벨을 설정합니다.

참고 사항

(Auto) 아이콘이 표시된 채널은 자동으로 조정됩니다. 슬라이더나 버튼을 사용한 값 변경은 녹음된 오디오에 적용되지 않
습니다.

힌트

각 행의 슬라이더와 조정 버튼 설정은 연결되어 있습니다.

촬영 화면의 오디오 레벨 미터 표시를 통해 오디오 입력 레벨을 실시간으로 확인할 수 있습니다.

3
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다이렉트 메뉴 작동

카메라 이미지에 오버레이되어 표시되는 기기의 상태 및 설정을 확인하고, 적외선 리모컨의 GUI 제어 버튼을 사용하여 설
정을 선택 및 변경할 수 있습니다.
다음 항목을 구성할 수 있습니다.
[Face/Eye Detection AF]
[SteadyShot]
[White Mode]
[Color Temp]
[Scene File]
[ND Filter Position]
[Auto ND Filter]
[ND Filter] 값
[Auto Iris]
[Iris] 값
[AGC]
[Gain] 값
[ISO] 값
[Exposure Index]
[Shutter Type]
[Auto Shutter]
[Shutter] 값
[Auto Exposure Mode]
[Auto Exposure Level]
[S&Q Motion] 및 [Frame Rate]

힌트

할당 가능 버튼과 웹 앱의 GUI 제어 패널을 사용하여 동일한 기능을 수행할 수도 있습니다.

적외선 리모컨에서 [Direct Menu]가 할당된 할당 가능 버튼을 누릅니다.

[Direct Menu] 버튼은 공장 기본값으로 할당 가능 버튼 1에 할당되어 있습니다.
다이렉트 메뉴를 사용하여 구성할 수 있는 화면의 항목만 주황색 커서로 선택할 수 있습니다.

1

GUI 제어 패널의 화살표 버튼을 사용하여 설정하고자 하는 항목으로 커서를 이동한 후 [Set] 버튼을 눌러 설정을 적
용합니다.

흰색 배경에 메뉴가 표시되거나 항목이 표시됩니다.

2

화살표 버튼을 사용하여 설정을 선택한 후 [Set] 버튼을 누릅니다.

메뉴나 흰색 배경이 사라지고 새 설정이 주황색 커서와 함께 표시됩니다.
[Direct Menu]가 할당된 할당 가능 버튼을 다시 누르거나 아무 동작도 하지 않고 3초 동안 기다려 다이렉트 메뉴를 종
료합니다.

3
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할당 가능 버튼

기기의 웹 앱에는 기능을 할당할 수 있는 10개의 할당 가능 버튼이 있습니다.
할당 가능 버튼은 라이브 작동 화면과 재생 작동 화면에 표시됩니다.

참고 사항

라이브 작동 화면의 카메라 기본 작동 패널에서 설정을 구성할 때 할당 가능 버튼 목록이 표시되지 않습니다. 작업을 종료하려면 조
정 패널의 오른쪽 상단에 있는 [X] 버튼을 누릅니다.

공장 기본값으로 다음 기능이 버튼에 할당되어 있습니다.
버튼 1: [Direct Menu]
버튼 2: [Focus Setting]
버튼 3: [Rec Review]

버튼 1~3은 제공된 적외선 리모컨의 동일한 숫자 버튼과 동일합니다.

버튼 4: [Push Auto ND]
버튼 5: [Crop Select]
버튼 6: [Marker]
버튼 7: [Video Signal Monitor]
버튼 8: [Clip Flag OK]
버튼 9: [Color Bars]
Focus Hold 버튼: [Focus Hold]

Focus Hold 버튼은 E-mount 렌즈의 Focus Hold 버튼과 동일합니다.

버튼 기능을 변경하려면

카메라 메뉴의 [Project] > [Assignable Button]을 사용합니다.
할당을 변경하면 할당 가능 버튼 목록의 표시가 변경됩니다.
할당 가능한 기능에 대한 자세한 내용은 "카메라 메뉴 및 세부 설정"의 "Assignable Button"을 참조하십시오.

관련 항목

Assignable Button

5-041-958-23(1) Copyright 2022 Sony Corporation

219
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Slow & Quick Motion

녹화 형식이 다음 값으로 설정되면 촬영 프레임 속도와 재생 프레임 속도에 대해 다른 값을 지정할 수 있습니다.
다음 표는 구성 가능한 프레임 속도를 보여줍니다.

시스템 주파수: 59.94/50/29.97/25/23.98, 이미저 스캔 모드: FF

시스템 주파수: 59.94/50/29.97/25/23.98, 이미저 스캔 모드: S35

시스템 주파수: 24, 이미저 스캔 모드: FF

참고 사항

Slow & Quick Motion은 녹화, 재생 또는 썸네일 화면이 표시되어 있는 동안에는 설정할 수 없습니다.

Slow & Quick Motion 모드에서는 오디오 녹음이 지원되지 않습니다.

Slow & Quick Motion에서는 자동 조리개 기능 및 자동 셔터 기능이 비활성화됩니다.

자동 초점은 Slow & Quick Motion 모드에서 다음과 같은 제한 사항을 갖습니다.

렌즈 모델, 시스템 주파수 및 촬영 프레임 속도로 인한 제한 사항

코덱 비디오 형식 구성 가능한 프레임 속도

RAW 3840×2160P 1–60, 100, 120

RAW & XAVC-I 3840×2160P 1–60, 100, 120

XAVC-I

4096×2160P 1–60

3840×2160P 1–60, 100, 120

1920×1080P 1–60, 100, 120, 150, 180, 200, 240

XAVC-L
3840×2160P 1–60, 100, 120

1920×1080P 1–60, 100, 120, 150, 180, 200, 240

코덱 비디오 형식 구성 가능한 프레임 속도

XAVC-I 1920×1080P 1–60, 100, 120

XAVC-L 1920×1080P 1–60, 100, 120

코덱 비디오 형식 구성 가능한 프레임 속도

XAVC-I 4096×2160P 1–60

Sony 렌즈 시스템 주파수 AF 가용성

SEL16F28 외 – 7 fps 이상 지원
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조리개가 F18 이상으로 설정되면 자동 초점 기능이 일시적으로 비활성화됩니다.

RAW 출력 사용에 대한 자세한 내용은 "RAW 비디오 녹화"를 참조하십시오.

관련 항목

RAW 비디오 녹화

5-041-958-23(1) Copyright 2022 Sony Corporation

Sony 렌즈 시스템 주파수 AF 가용성

SEL16F28

59.94/29.97/23.98 30, 60, 120, 240 fps 지원

50.00/25.00 25, 50, 100, 200 fps 지원

24.00 지원되지 않음
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간헐적으로 비디오 녹화(Interval Rec)

기기의 Interval Rec 기능을 사용하면 기기의 내부 메모리에 간헐적으로 비디오를 캡처할 수 있습니다. 이 기능은 느리게
움직이는 피사체를 촬영할 때 효과적입니다.
녹화를 시작하면 기기를 지정된 시간 간격(Interval Time)으로 지정된 프레임 수(Number of Frames)를 자동으로 녹화합니
다.

A: 촬영 간격(Interval Time)
B: 한 번의 촬영 프레임 수(Number of Frames)

참고 사항

Interval Rec 녹화와 같은 특수 녹화 기능은 한 번에 하나만 사용할 수 있습니다.

Interval Rec가 사용 중일 때 다른 특수 녹화 모드가 활성화되면 Interval Rec가 자동으로 해제됩니다.

비디오 형식과 같은 시스템 설정이 변경되면 Interval Rec 모드가 자동으로 해제됩니다.

Interval Rec 설정은 녹화, 재생 또는 썸네일 화면이 표시되어 있는 동안에는 변경할 수 없습니다.

녹화 중 제한 사항

오디오는 녹음되지 않습니다.
녹화 검토(Rec Review)는 수행할 수 없습니다.

녹화 중 기기가 꺼진 경우

기기의 전원 공급 장치가 대기 상태로 설정되면 몇 초 동안 매체를 액세스하여 그 시간까지 메모리에 저장된 영상을 녹
화한 다음 기기가 자동으로 대기 상태로 전환됩니다.
DC 전원 코드가 분리되거나 AC 어댑터에서 전원이 꺼지거나 PoE++ 전원 공급이 끊어지면 해당 시점까지 촬영된 장
면이 손실될 수 있습니다(최대 10초). 주의를 기울여야 합니다.

프레임 수 및 촬영 간격 설정

웹 메뉴에서 [Project] > [Interval Rec] > [Setting]을 [On]으로 설정하고 [Number of Frames] 및 [Interval Time]을 설정합니
다.
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기기의 전원이 꺼지면 Interval Rec 모드가 종료되지만 [Number of Frames] 및 [Interval Time] 설정은 유지됩니다. 다음에
Interval Rec 모드에서 촬영할 때 다시 설정할 필요가 없습니다.

힌트

카메라 메뉴의 [Project] > [Interval Rec]을 사용하여 설정할 수도 있습니다.

촬영 시작

녹화를 시작하려면 녹화 START/STOP 버튼을 누릅니다. "Int●Rec" 및 "Int●Stby"가 교대로 나타납니다.

촬영 중지

녹화를 중지합니다.
촬영이 종료되면 그 시점까지 메모리에 저장된 비디오 데이터가 매체에 기록됩니다.
Interval Rec 모드를 종료하려면 다음 중 하나를 수행합니다.

기기의 전원 공급 장치를 대기 상태로 전환합니다.
녹화 대기 모드에서 [Project] > [Interval Rec] > [Setting]을 [Off]로 설정합니다.

또한 기기를 다시 부팅하면 Interval Rec 모드가 자동으로 해제됩니다.

5-041-958-23(1) Copyright 2022 Sony Corporation
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픽처 캐시 녹화(Picture Cache Rec)

Picture Cache Rec 기능을 사용하여 촬영 시 지정된 시간의 내부 캐시 메모리를 유지하여 녹화를 시작할 때 소급적으로 비
디오를 캡처할 수 있습니다.

캐시 크기 설정

웹 메뉴에서 [Project] > [Picture Cache Rec] > [Setting]을 [On]으로 설정하고 [Cache Size]를 사용하여 캐시 크기를 설정합
니다.

참고 사항

Picture Cache Rec는 Interval Rec, 2슬롯 동시 녹화 또는 프록시 녹화와 조합하여 사용할 수 없습니다. Picture Cache Rec가 On으
로 설정된 경우 다른 특수 녹화 모드가 강제로 Off로 설정됩니다.

녹화 중이거나 Rec Review가 진행 중인 경우 Picture Cache Rec 모드를 선택할 수 없습니다.

Picture Cache Rec가 On으로 설정되어 있으면 타임코드는 [Regen] 또는 [Rec Run]으로 설정되어 있어도 [Free Run] 모드로 녹화
됩니다.

[Output Format] 설정은 Picture Cache Rec 모드에서 구성할 수 없습니다. 이 경우 Picture Cache Rec를 임시로 Off로 설정한 다음
설정을 변경합니다.

힌트

녹화 형식에 따라 캐시 시간이 더 짧을 수 있습니다. 웹 메뉴의 [Project] > [Picture Cache Rec] > [Cache Rec Time]에 표시되는 시
간을 확인합니다.

카메라 메뉴의 [Project] > [Picture Cache Rec]을 사용하여 설정할 수도 있습니다.

할당 가능 버튼을 사용하여 [Picture Cache Rec]을 On과 Off 사이에서 전환할 수도 있습니다.

Picture Cache Rec 시작하기

[Picture Cache Rec]이On으로 설정된 경우 "●Cache" (●은 녹색)가 나타납니다.
녹화 START/STOP 버튼을 누르면 녹화가 시작되고 캐시 메모리에 저장된 비디오부터 시작해 비디오를 메모리 카드에 쓰
게 됩니다.

참고 사항

녹화 형식 또는 기본 보기를 변경하면 해당 시점까지 캐시 메모리에 저장된 비디오가 삭제되고, 새 비디오 캐시가 시작됩니다. 결과
적으로 형식 변경 직후에 녹화를 시작하더라도 형식 변경 전에 픽처 캐시 녹화는 가능하지 않습니다.

메모리 카드 삽입 직후 Picture Cache Rec가 On 또는 Off로 설정되는 경우 캐시 데이터가 카드에 기록될 수 없습니다.

[Cache Size] 설정 캐시 시간(근사치)

[Short] 5초

[Medium] 10초

[Long] 20초

[Max] 각 녹화 형식의 최댓값
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Picture Cache Rec 기능이 On으로 설정되면 비디오가 캐시 메모리에 저장됩니다. 기능이 On으로 설정되기 전의 비디오는 캐시되
지 않습니다.

메모리 카드가 액세스되는 도중(예: 재생, Rec Review 또는 썸네일 화면 디스플레이)에는 비디오가 캐시 메모리에 저장되지 않습
니다. 이 간격 도중에는 비디오의 픽처 캐시 녹화가 가능하지 않습니다.

Picture Cache Rec 취소하기

웹 메뉴에서 [Project] > [Picture Cache Rec] > [Setting]을 [Off]로 설정하거나 [Picture Cache Rec] 기능이 할당된 할당 가
능 버튼을 누릅니다.

5-041-958-23(1) Copyright 2022 Sony Corporation
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메모리 카드 A 및 B에 동시에 녹화(2-slot Simul Rec)

웹 메뉴 또는 카메라 메뉴에서 [Project] > [Simul Rec] > [Setting]을 [On]으로 설정하여 메모리 카드 A 및 메모리 카드 B에
동시에 녹화할 수 있습니다.

메모리 카드 A와 메모리 카드 B에 별도로 녹화하기

녹화 START/STOP 버튼이나 (Others) 탭의 [2nd Rec START/STOP] 버튼을 사용하여 각 메모리 카드에 독립적으로 녹
화를 시작/중지할 수 있습니다.
공장 기본 설정상 두 버튼 모두 메모리 카드 A와 B 모두에 대한 동시 녹화를 시작/중지하도록 설정됩니다.
버튼이 각 메모리 카드에 대한 녹화를 제어하도록 설정되면 [SDI/HDMI Rec Control] 녹화 시작/중지 제어는 슬롯 A의 녹화
상태를 따릅니다.

설정 변경

카메라 메뉴의 [Project] > [Simul Rec] > [Rec Button Set]를 사용하여 다음을 설정합니다.

5-041-958-23(1) Copyright 2022 Sony Corporation

[Rec Button Set]
설정

버튼 및 메모리 카드

Rec Button:<Slot
A> <Slot B>
2nd Rec Button:
<Slot A> <Slot B>

버튼 중 하나를 사용하여 메모리 카드 A와 B에 대해 동시에 녹화를 시작/중지합니다.

Rec Button:<Slot
A>
2nd Rec Button:
<Slot B>

녹화 START/STOP 버튼을 누르면 메모리 카드 A에 대해 녹화를 시작/중지하고 (Others) 탭의
[2nd Rec START/STOP] 버튼을 누르면 메모리 카드 B에 대해 녹화를 시작/중지합니다.

Rec Button:<Slot
B>
2nd Rec Button:
<Slot A>

녹화 START/STOP 버튼을 누르면 메모리 카드 B에 대해 녹화를 시작/중지하고, (Others) 탭의
[2nd Rec START/STOP] 버튼을 누르면 메모리 카드 A에 대해 녹화를 시작/중지합니다.
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비디오 신호 모니터

카메라 메뉴의 [Monitoring] > [Video Signal Monitor] > [Setting]을 사용하여 카메라 이미지 패널에 표시할 비디오 신호 유
형을 파형, 벡터스코프 또는 히스토그램으로 설정할 수 있습니다.
주황색 선은 [Level Marker 1] 및 [Level Marker 2]의 설정 값을 나타냅니다.
[Video Signal Monitor] 기능을 할당 가능 버튼에 할당할 수도 있습니다.

모니터링 대상 표시

로그 촬영 모드에서 색공간 설정 또는 모니터 LUT 설정 정보가 비디오 신호 모니터 오른쪽 상단에 표시되어 모니터링 대상
을 나타냅니다.

5-041-958-23(1) Copyright 2022 Sony Corporation
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클립 플래그

[Clip Flag OK] 기능이 할당된 할당 가능 버튼을 누르고 [Add OK]를 선택하여 [OK] 클립 플래그를 클립에 추가할 수 있습니
다.
버튼을 두 번 누르고 [Delete Clip Flag]를 선택하여 [OK] 클립 플래그를 삭제할 수 있습니다.

힌트

카메라 메뉴의 [Thumbnail] > [Set Clip Flag]을 사용하여 클립 플래그를 추가할 수도 있습니다.

썸네일 화면은 클립 플래그 유형별로 정렬되어 표시될 수 있습니다(필터링된 클립 썸네일 화면). 자세한 내용은 "썸네일 화면"의
"녹화된 클립에 대한 작업"을 참조하십시오.

관련 항목

녹화된 클립에 대한 작업

5-041-958-23(1) Copyright 2022 Sony Corporation
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브리딩 보정

카메라 메뉴의 [Technical] > [Lens] > [Breathing Compensation]에서 렌즈에 대한 브리딩 보정을 수행할지 여부를 설정할
수 있습니다.
이 기능은 초점 위치가 변할 때 화각 변화가 발생하는 현상을 교정합니다.
브리딩 보정이 실행되면 브리딩 현상이 나타나지 않도록 일정한 화각을 유지하기 위해 이미지의 부분이 전자 방식으로 잘
립니다.

참고 사항

브리딩 보정이 활성화되면 화각과 이미지 품질이 다소 변할 수 있습니다.

렌즈에 따라 브리딩 보정이 활성화할 때 화각의 변화를 교정하는 것이 가능하지 않을 수 없습니다.

브리딩 보정을 지원하지 않는 렌즈가 부착된 경우 보정이 가능하지 않습니다.

다음과 같은 경우 이 기능은 Off(고정됨)로 설정됩니다.

카메라 메뉴에서 [Technical] > [Lens] > [Distortion Comp.]가 [Off]로 설정된 경우
웹 메뉴 또는 카메라 메뉴에서 [Shooting] > [S&Q Motion] > [Setting]이 [On]으로 설정된 경우
웹 메뉴 또는 카메라 메뉴에서 [Project] > [Rec Format] > [Codec]이 [RAW] 또는 [RAW & XAVC-I]로 설정된 경우

5-041-958-23(1) Copyright 2022 Sony Corporation
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프록시 녹화 개요

이 기능을 사용하면 고해상도 원본 데이터 비디오 녹화와 동시에 저해상도 프록시 데이터를 녹화할 수 있습니다.

지원되는 메모리 카드, 메모리 카드 포맷 및 남은 용량 확인에 대한 자세한 내용은 "메모리 카드 준비"의 "지원되는 메
모리 카드"를 참조하십시오.

녹화된 파일 정보

파일 이름 확장자는 ".mp4"입니다.
타임코드도 동시에 녹화됩니다.

녹화된 파일의 저장 대상

녹화된 파일은 다음 디렉터리에 저장됩니다.

파일 이름 정보

파일 이름은 메모리 카드에 녹화된 클립 이름과 "S03" 접미사로 구성됩니다.
클립 이름의 경우 카메라 메뉴의 [TC/Media] > [Clip Name Format]을 참조하십시오.

관련 항목

지원되는 메모리 카드

5-041-958-23(1) Copyright 2022 Sony Corporation

녹화 매체 폴더 경로

SDXC /PRIVATE/XDROOT/Sub

CFexpress Type A /XDROOT/Sub
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프록시 녹화

프록시 녹화가 활성화되면 녹화를 시작할 수 있습니다.

촬영을 중지하려면

녹화를 중지합니다.

프록시 녹음용 오디오 채널을 설정하려면

카메라 메뉴의 [Project] > [Proxy Rec] > [Audio Channel]을 사용하여 프록시 데이터 녹음용 오디오 채널을 설정합니다.

5-041-958-23(1) Copyright 2022 Sony Corporation

웹 메뉴 또는 카메라 메뉴에서 [Project] > [Proxy Rec] > [Setting]를 [On]로 설정합니다.1

CFexpress Type A/SD 카드 슬롯에 메모리 카드를 삽입합니다.

CFexpress 카드의 경우 라벨이 위쪽을 향하도록 삽입합니다.
SD 카드의 경우 라벨이 아래쪽을 향하도록 삽입합니다.

참고 사항

Proxy Rec는 S&Q Motion 또는 Interval Rec와 동시에 On으로 설정할 수 없습니다. Proxy Rec가 On으로 설정되면 다른 녹화
모드는 Off로 강제 설정됩니다.

2

녹화 START/STOP 버튼을 누릅니다.

프록시 녹화가 시작됩니다.

참고 사항

메모리 카드를 액세스하는 동안 기기가 꺼지거나 메모리 카드를 제거하면 카드의 데이터 무결성을 보장할 수 없게 됩니다.
메모리 카드에 저장된 모든 데이터가 폐기될 수 있습니다. 기기를 끄거나 메모리 카드를 제거하기 전에 메모리 카드 액세스
표시등이 꺼져 있는지 항상 확인합니다.

메모리 카드를 삽입하거나 제거할 때 튀어나오지 않도록 합니다.

3
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보기 개요

기기가 Custom 모드일 때 검정, 매트릭스 또는 기타 매개 변수에 조정을 추가하여 기본 보기를 기반으로 "보기"를 만들 수
있습니다.

또한 장면 파일에 다양한 설정 조합을 저장하여 다른 보기를 빠르게 선택할 수 있습니다.
본 기기는 총 7개의 사전 설정 보기를 제공합니다.

5-041-958-23(1) Copyright 2022 Sony Corporation
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보기 선택

이 항목에서는 보기를 선택하는 방법에 대해 설명합니다.

웹 메뉴 또는 카메라 메뉴에서 [Project] > [Base Setting] > [Shooting Mode]이 [Custom]으로 설정되어 있는지 확
인하십시오.

힌트

[Custom] 모드에서 카메라 기본 구성 패널에 [ISO/Gain] 버튼 및 [Scene File] 버튼이 표시됩니다.

1

카메라 기본 구성 패널에서 [Scene File] 버튼을 누릅니다.

[Scene File] 버튼의 프레임이 주황색으로 바뀝니다.

Scene File 조정 패널이 나타납니다.

2

조정 패널의 [Scene File] 버튼을 누르고 목록에서 원하는 보기의 장면 파일을 선택합니다.

공장 기본값으로 다음과 같은 사전 설정이 구성됩니다.

힌트

카메라 메뉴의 [Paint/Look] > [Scene File] > [Recall]을 사용하여 보기를 선택할 수도 있습니다. [Scene File] > [Preset Recall]
을 사용하여 사전 설정 보기를 불러올 수도 있습니다.

3

[Target Display] [SDR(BT.709)] [HDR(HLG)]

장면 파일 1 [S-Cinetone] [HLG Live]

장면 파일 2 [Standard] [HLG Natural]

장면 파일 3 [Still] (등록되지 않음)

장면 파일 4 [ITU709] (등록되지 않음)

장면 파일 5 [709tone] (등록되지 않음)

장면 파일 6~16 (등록되지 않음) (등록되지 않음)
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참고 사항

장면 파일 5 사전 설정은 소프트웨어 버전 2.0 이상에서 [709tone]으로 설정됩니다. 웹 메뉴의 [Maintenance]> [Reset] >
[Factory Default]가 실행된 경우:표시됩니다.
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원하는 기본 보기 가져오기

컴퓨터나 다른 장치에서 만든 3D LUT 파일을 기본 보기로 가져올 수 있습니다. 16개 파일까지 가져올 수 있습니다.
파일 형식: Catalyst Browse, RAW Viewer 또는 DaVinci Resolve*(Blackmagic Design Pty. Ltd. 제공)를 사용하여 만든 17
그리드 또는 33그리드 3D LUT용 CUBE 파일(*.cube).

입력 색공간/감마: [S-Gamut3.Cine/S-Log3] 또는 [S-Gamut3/S-Log3]

노출 부족을 조정하려면

Resolve V9.0, V10.0 및 V11.0으로 확인했습니다.*

웹 앱을 실행하는 장치에 3D LUT 파일을 저장합니다.1

웹 메뉴에서 [Paint/Look] > [Base Look]을 엽니다.

등록된 기본 보기 목록이 나타납니다.

2

파일을 가져올 행에서 [Import] 버튼을 누릅니다.

파일 선택 대화 상자가 나타납니다.

3

준비된 3D LUT 파일을 선택합니다.

가져온 3D LUT 파일이 기기의 기본 보기가 됩니다.

4

카메라 메뉴의 [Paint/Look] > [Base Look] > [Select]를 이용하여 불러온 3D LUT 파일을 선택합니다.5

카메라 메뉴의 [Paint/Look] > [Base Look] > [Input] 및 [Output]을 불러온 3D LUT 파일의 속성과 일치하도록 설정
합니다.

6
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가져온 기본 보기를 사용할 때 자동 노출을 선택했는데 노출이 부족한 것 같아 보이면 웹 메뉴에서 [Paint/Look] > [Base
Look] > [AE Level Offset]을 사용하여 보기를 조정합니다.

참고 사항

3D LUT 파일을 가져오는 것만으로는 이미지에 영향을 주지 않습니다. 카메라 메뉴의 [Paint/Look] > [Base Look] > [Select]를 이용
하여 불러온 3D LUT 파일을 로드합니다.

[Input]이 올바르게 설정되지 않으면 올바른 보기를 얻을 수 없습니다.

[Input], [Output] 및 [AE Level Offset] 메뉴 항목 설정이 [Select]를 사용하여 선택한 기본 보기에 적용됩니다. 여러 개의 3D LUT 파
일을 가져온 경우 [Select]를 사용하여 각 3D LUT 파일을 선택하고 각 파일에 [Input], [Output] 및 [AE Level Offset]을 개별적으로 구
성합니다.

구성된 [Input], [Output] 및 [AE Level Offset] 설정은 각 3D LUT 파일에 저장됩니다.

가져온 3D LUT 파일에 대한 기본 보기/LUT 선택 옵션은 [SDR(BT.709)], [HDR(HLG)] 및 로그 촬영 모드에 공통이지만 이러한 모드
에 따라 색공간과 감마 변환이 수행되지 않습니다.

웹 메뉴에서[Maintenance] > [Reset] > [All Reset (except for Network Settings)]이 실행되면 3D LUT 파일이 삭제되지 않습니다.

[Base Look Name] 디스플레이 앞에 표시되는 (3D LUT 파일 첨부 오류)는 로그 촬영 모드로 녹화된 클립에 3D LUT 파일을 첨부
할 수 없음을 나타냅니다. 3D LUT 파일을 다시 가져옵니다.

5-041-958-23(1) Copyright 2022 Sony Corporation
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보기 사용자 지정

카메라 기본 구성 패널의 Scene File 조정 패널에서 [Master Black], [R Black] 및 [B Black] 슬라이더와 카메라 메뉴의
[Paint/Look] > [Matrix] 및 기타 설정 항목을 사용하여 기본 보기에 따라 보기를 사용자 지정할 수 있습니다.
기기를 TV나 모니터에 연결하고 TV 또는 모니터 화면에서 영상을 관찰하면서 화질을 조정합니다.

1: [R Black] 슬라이더/조정 버튼
2: [B Black] 슬라이더/조정 버튼
3: [Master Black] 슬라이더/조정 버튼

참고 사항

3D LUT 파일을 가져와 이미지에 적용할 때 [Paint/Look] > [Matrix] 및 카메라 메뉴에서 기본 보기 설정이 아닌 설정을 변경하면 3D
LUT 파일에 정의된 원하는 보기를 얻을 수 없습니다.

카메라 메뉴의 [Paint/Look] > [Reset Paint Settings] > [Reset without Base Look]를 사용하여 항목을 개별적으로 표시하거나 숨길
수 있습니다.

5-041-958-23(1) Copyright 2022 Sony Corporation
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보기 저장

카메라 메뉴의 [Paint/Look] > [Scene File] > [Store]를 사용하여 현재 보기를 내부 장면 파일로 저장할 수 있습니다.
Scene File 조정 패널을 사용하거나 다이렉트 메뉴 작동을 사용하여 저장된 보기를 빠르게 불러올 수 있습니다.

참고 사항

현재 보기를 저장하지 않고 다른 보기를 선택하면 현재 보기가 폐기됩니다.

힌트

사전 설정 장면 파일을 덮어쓸 수 있습니다. 사전 설정 장면 파일을 복원하려면 카메라 메뉴의 [Paint/Look] > [Scene File] > [Preset
Recall]을 사용하여 복원하려는 보기를 불러온 다음 [Scene File] > [Store]를 사용하여 장면 파일을 저장합니다.

저장된 보기를 삭제하려면

카메라 메뉴의 [Paint/Look] > [Scene File] > [Delete]를 사용하여 내부 메모리에 저장된 장면 파일을 삭제할 수 있습니다.

힌트

삭제하면 더 이상 Scene File 조정 패널이나 다이렉트 메뉴에 표시되지 않습니다.

5-041-958-23(1) Copyright 2022 Sony Corporation
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기본 보기 삭제

카메라 메뉴의 [Paint/Look] > [Base Look] > [Delete]를 사용하여 가져온 3D LUT 파일을 개별적으로 삭제할 수 있습니다.
카메라 메뉴의 [Paint/Look] > [Base Look] > [Delete All]을 사용하여 불러온 3D LUT 파일을 모두 삭제할 수 있습니다.

참고 사항

삭제하기 전 기본 보기가 다른 장면 파일에 사용되고 있지 않은지 확인합니다. 사용 중인 기본 보기를 삭제하면 해당 장면 파일의
보기가 정확하지 않게 됩니다.

웹 메뉴에서[Maintenance] > [Reset] > [All Reset (except for Network Settings)]이 실행되면 가져온 3D LUT 파일이 삭제되지 않습
니다.

삭제된 기본 보기는 로그 촬영 모드에서 더 이상 LUT로 사용되지 않습니다.

5-041-958-23(1) Copyright 2022 Sony Corporation
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포스트 프로덕션에서 보기 조정으로 촬영

로그 촬영 모드*1에서 기기를 사용하고 어두운 영역에서 밝은 영역까지 균일하게 그라데이션을 적용하며 녹화하면 포스트
프로덕션에서 어두운 영역과 밝은 영역의 로컬로 복원하는 등 미세 조정을 수행할 수 있습니다.
그러나 기존 모니터에서 녹화된 이미지를 볼 때 전반적으로 콘트라스트가 낮게 나타나므로 초점과 노출 조정이 어렵습니
다.
촬영 도중 다양한 조정을 지원하기 기기의 모니터 대상에 LUT를 적용할 수 있습니다. 또한 재생 시 자동으로 촬영할 때 사
용된 LUT를 적용하여 완성된 결과를 빠르게 확인할 수도 있습니다.
다음 시스템에서 LUT가 적용됩니다. 그러나 하나의 LUT만 적용할 수 있습니다.

SDI 출력
HDMI 출력 및 스트리밍
녹화 매체에서 녹화된 프록시 클립
녹화 매체에서 녹화된 고해상도(메인) 클립

5-041-958-23(1) Copyright 2022 Sony Corporation

Flexible ISO 모드/Cine EI 모드/Cine EI Quick 모드의 총칭*1
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HDMI 출력 및 스트리밍에 LUT 적용

HDMI 출력 및 스트리밍에 LUT를 적용할 수 있습니다.

참고 사항

웹 앱 카메라 이미지 패널의 이미지는 스트리밍 이미지에도 포함됩니다.

힌트

카메라 메뉴의 [Shooting] > [LUT On/Off] > [HDMI/Stream]을 사용하여 설정할 수도 있습니다.

SDI 출력도 같은 방법으로 설정할 수 있습니다.

녹화 매체의 비디오의 경우 카메라 메뉴의 [Shooting] > [LUT On/Off] > [Internal Rec] 및 [Proxy]를 사용하여 설정할 수 있습니다.

[Base Look/LUT] 디스플레이 앞에 표시되는 (3D LUT 파일 첨부 오류)는 로그 촬영 모드로 녹화된 클립에 3D LUT 파일을 첨부할
수 없음을 나타냅니다. 3D LUT 파일을 다시 가져옵니다.
일시적인 처리 정체로 인해 첨부에 실패한 경우에도 이 아이콘이 표시됩니다.

5-041-958-23(1) Copyright 2022 Sony Corporation

웹 메뉴 또는 카메라 메뉴에서 [Project] > [Base Setting] > [Shooting Mode]가 [Flexible ISO], [Cine EI] 또는
[Cine EI Quick]으로 설정되어 있는지 확인합니다.

힌트

로그 촬영 모드에서 [Base ISO/Exposure Index] 버튼 및 [Base Look/LUT] 버튼은 카메라 기본 구성 패널에 표시됩니다.

1

카메라 기본 구성 패널에서 [Base Look/LUT] 버튼을 누릅니다.

[Base Look/LUT] 버튼의 프레임이 주황색으로 바뀝니다.

Base Look/LUT 조정 패널이 나타납니다.

2

[HDMI/Stream] > [MLUT]를 선택합니다.3
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LUT 변경

적용할 LUT를 변경할 수 있습니다.

힌트

본 기기는 [s709], [709(800%)] 및 [S-Log3]을 사전 설정된 LUT로 제공합니다.

3D LUT 파일을 가져와 적용할 수도 있습니다. 자세한 내용은 "원하는 기본 보기 가져오기" 및 "기본 보기 삭제"를 참조하십시오.

카메라 메뉴의 [Paint/Look] > [Base Look] > [Select]을 사용하여 설정할 수도 있습니다.

관련 항목

원하는 기본 보기 가져오기

기본 보기 삭제

5-041-958-23(1) Copyright 2022 Sony Corporation

카메라 기본 구성 패널에서 [Base Look/LUT] 버튼을 누릅니다.

[Base Look/LUT] 버튼의 프레임이 주황색으로 바뀝니다.

Base Look/LUT 조정 패널이 나타납니다.

1

[Base Look/LUT] 버튼을 눌러 적용할 기본 보기를 선택합니다.2
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녹화된 이미지에서 어두운 영역과 밝은 영역의 분포 변경

Cine EI 및 Cine EI Quick 촬영 모드에서는 어두운 영역과 밝은 영역의 분포를 변경할 수 있습니다. 예를 들어 기본 감도에
서 Exposure Index를 변경하여 밝은 영역보다 어두운 영역의 톤을 우선시할 수 있습니다.

카메라 기본 구성 패널에서 [Base Look/LUT] 버튼을 누릅니다.

[Base Look/LUT] 버튼의 프레임이 주황색으로 바뀝니다.

Base Look/LUT 조정 패널이 나타납니다.

1

[HDMI/Stream] > [MLUT]를 선택합니다.

LUT는 HDMI 출력 및 스트리밍에 적용됩니다.

2

카메라 기본 구성 패널에서 [Base ISO/Exposure Index] 버튼을 누릅니다.

[Base ISO/Exposure Index] 버튼의 프레임이 주황색으로 바뀝니다.

Base ISO/Exposure Index 조정 패널이 나타납니다.

3

[Exposure Index] 슬라이더 또는 [Exposure Index] 조정 버튼을 사용하여 원하는 어두운 영역과 밝은 영역 분포에
따라 노출 색인을 조정합니다.

[Cine EI]의 경우

[Cine EI Quick]의 경우
기본 감도는 지정된 노출 지수에 따라 자동으로 설정됩니다.

4
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힌트

카메라 메뉴의 [Shooting] > [ISO/Gain/EI] > [Exposure Index]을 사용하여 설정할 수도 있습니다.

SDI 출력도 같은 방법으로 사용할 수 있습니다.

설정의 두 번째 숫자 값은 밝은 영역(18% 회색보다 높은 밝기)에 할당된 밝기 정보의 단계 수를 나타냅니다. 이보다 밝은 영역은 과
다 노출입니다.
예: "400EI/5.0E"에서 밝은 면에 5.0 단계가 할당됩니다.

촬영 중에 어둡고 밝은 영역의 톤을 확인하기 위한 가이드로 이를 사용할 수도 있습니다. 노출을 확인했으면 원래 EI 값으로 되돌아
가야 합니다. 또한 Cine EI Quick 모드에서는 기본 감도에 부정적인 영향을 미치지 않도록 주의하십시오.

5-041-958-23(1) Copyright 2022 Sony Corporation

[HDMI/Stream]의 카메라 이미지 출력이 적절한 노출을 갖도록 조명 및/또는 ND 필터를 조정합니다.5
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RAW 비디오 녹화

기기의 SDI OUT 커넥터에서 지원되는 외부 레코더로 출력되는 RAW 비디오 신호를 녹화할 수 있습니다.
지원되는 RAW 출력 형식은 다음과 같습니다.

시스템 주파수 [Codec] [RAW Output Format]

59.94 / 50 / 29.97 / 25 / 23.98

RAW 4096×2160

RAW 3840×2160

RAW & XAVC-I 4096×2160

RAW & XAVC-I 3840×2160

24
RAW 4096×2160

RAW & XAVC-I 4096×2160

외부 RAW 레코더를 기기의 SDI OUT 커넥터에 연결합니다.1

웹 또는 카메라 메뉴에서 [Project] > [Base Setting] > [Shooting Mode]를 [Cine EI], [Cine EI Quick] 또는
[Flexible ISO]로 설정합니다.

2

웹 메뉴 또는 카메라 메뉴의 [Project] > [Rec Format] > [Imager Scan Mode]를 사용하여 화각(FF 전용)을 설정합
니다.

3

웹 메뉴 또는 카메라 메뉴에서 [Project] > [Rec Format] > [Codec]을 [RAW]로 설정합니다.

[RAW & XAVC-I]를 선택하면 비디오는 외부 RAW 레코더에 녹화되고 비디오는 기기의 메모리 카드에 녹화됩니다.

4

웹 메뉴 또는 카메라 메뉴의 [Project] > [Rec Format] > [RAW Output Format]을 사용하여 해상도를 설정합니다.5

외부 레코더가 켜져 있는지 확인한 다음 라이브 작동 화면에서 녹화 START/STOP 버튼을 누릅니다.

RAW 비디오 녹화 상태는 카메라 이미지 패널에 아이콘으로 표시됩니다.

6
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참고 사항

라이브 작동 화면에서 녹화 START/STOP 버튼을 사용하지 않고 외부 레코더에서 녹화를 시작하면 클립이 올바르게 녹화되지 않을
수 있습니다.

5-041-958-23(1) Copyright 2022 Sony Corporation

참고 사항

녹화 제어 신호가 기기의 SDI OUT 커넥터에서 출력되지만 외부 레코더의 상태를 가져올 수 없습니다. 따라서 기기는 외부 레
코더가 실제로 녹화하지 않을 때 RAW 비디오 녹화가 진행 중임을 나타낼 수 있습니다. 올바른 작동 상태를 확보하려면 외부
레코더에서 표시등을 확인하십시오.
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Slow & Quick Motion 모드에서 RAW 비디오 녹화

Slow & Quick Motion 모드에서 RAW 비디오를 녹화할 수 있습니다.

촬영에 지원되는 프레임 속도에 대한 자세한 내용은 "Slow & Quick Motion"을 참조하십시오.

관련 항목

Slow & Quick Motion

5-041-958-23(1) Copyright 2022 Sony Corporation
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보케 제어 기능 켜기/끄기

ND 필터와 게인을 조리개 조작과 연결하여 보케 정도를 손쉽게 조정할 수 있습니다.

보케 제어 기능 켜기/끄기

이 기능은 수동으로 노출을 조정할 때만 활성화할 수 있습니다. ND 필터를 가변 모드로 설정한 다음 조리개, 게인, 셔터 및
ND 필터를 수동 조정으로 설정하십시오.
카메라 메뉴의 [Shooting] > [Iris] > [Bokeh Control]을 사용하여 보케 제어 기능을 켜거나 끌 수 있습니다.
보케 제어 기능이 On으로 설정되면  (B) 아이콘이 ND 필터와 게인 표시에 표시됩니다.

참고 사항

이 기능은 장치와 통신이 가능한 E-mount 렌즈에서만 활성화할 수 있습니다.

Sony E-mount 렌즈를 사용하면 이 기능의 최대 효과를 발휘할 수 있습니다.

다음 동작이 수행되면 보케 제어 기능이 Off로 설정됩니다.

기기가 꺼진 경우
조리개, 게인, 셔터 또는 ND 필터가 Auto로 설정된 경우
촬영 모드가 전환된 경우
ND 필터가 클리어 또는 사전 설정 모드로 설정된 경우
렌즈가 제거된 경우
기기가 재부팅된 경우(예: 주파수 전환 이후)

힌트

[Bokeh Control] 기능을 할당 가능 버튼에 할당하고 버튼을 사용하여 보케 제어 기능을 On과 Off로 전환할 수도 있습니다.

5-041-958-23(1) Copyright 2022 Sony Corporation
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보케 정도 조정하기

필요에 따라 2~4단계의 설정을 조정합니다.

참고 사항

동작 속도, 렌즈, 촬영 설정, 피사체에 따라 모습이 다를 수 있으며 밝기 또한 변할 수 있습니다. 촬영 전에 카메라 테스트를 실시하
는 것이 좋습니다.

조리개를 닫은 후 열거나 연 이후 닫는 것과 같이 조리개 동작 지시가 변경되면 밝기가 변할 수 있습니다. 이 경우 필요한 것보다 조
금 더 많이 조정한 다음 조금씩 되돌리면서 밝기를 점검하고 촬영을 시작하십시오. 예를 들어 조리개를 F8로 열고 배경을 흐리게
처리하고자 하는 경우 우선 F8을 넘어서 조리개를 닫은 다음 F8로 돌아오고, 밝기를 점검하고, 촬영을 시작하십시오.

천천히 보케 제어 동작을 수행합니다. 동작 속도를 높여야 하는 경우 이미지 변화를 확인하면서 점진적으로 조정해 보십시오.

힌트

보케 제어 기능이 On으로 설정되면 ND 필터와 게인이 함께 작동하여 조리개 조정으로 인한 노출의 변화를 상쇄하고, 보케 정도를
변경할 수 있습니다.

보케 제어는 우선 조리개 동작에 반응하여 ND 필터에 연결됩니다. ND 필터가 더 이상 변경될 수 없는 경우 게인이 연결됩니다.

MF 모드에서 우선 조리개를 연 다음 초점을 조정하는 것이 좋습니다.

보케 제어 기능 대신 자동 ND 필터를 사용하는 경우 ND 필터가 피사체의 밝기 변화를 따라 변합니다.

게인 연결 동작 도중 디스플레이

보케 제어 기능이 On으로 설정되면 조리개 조정에 따라 게인이 변할 수 있습니다.
게인 연결이 활성 상태이고 게인이 변하는 경우 화면 상단에 메시지가 표시되고 게인 표시에서  (B) 아이콘이 깜박입니
다.

5-041-958-23(1) Copyright 2022 Sony Corporation

보케 제어 기능을 On으로 설정합니다.1

조리개를 완전히 엽니다.2

ND 필터를 1/128로 설정합니다.3

게인을 0dB로 설정하고 조명을 사용하여 올바른 노출을 얻습니다.4

초점을 조정합니다.5

조리개를 조정합니다.

보케의 정도가 변경됩니다.

6

249



도움말 안내

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

구성 데이터 저장 및 로드 개요

웹 앱을 사용하여 기기의 설정을 구성 데이터로 저장할 수 있습니다. 이를 통해 현재 상황에 적합한 메뉴 설정 모음을 빠르
게 불러올 수 있습니다.
본 기기를 사용하면 다음 참고 사항을 제외하고 카메라 기능과 관련된 거의 모든 설정을 ALL 파일(모든 설정이 포함된 파
일)로 저장할 수 있습니다.

참고 사항

네트워크 기능 설정 및 인증 정보는 저장되지 않습니다. 저장 항목에 대한 자세한 내용은 "메뉴 항목 목록"을 참조하십시오.

관련 항목

메뉴 항목 목록

5-041-958-23(1) Copyright 2022 Sony Corporation

250



도움말 안내

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

ALL 파일 저장

이 항목에서는 ALL 파일을 저장하는 방법에 대해 설명합니다.

5-041-958-23(1) Copyright 2022 Sony Corporation

웹 메뉴에서 [Project] > [All File]을 엽니다.1

[Save All File] > [Save] 버튼을 누릅니다.

웹 브라우저는 all-file.ALL이라는 파일을 잠시 다운로드합니다.

2

다운로드한 all-file.ALL 파일의 위치와 파일 이름을 지정하고 파일을 저장합니다.

파일 작업에 대한 자세한 내용은 장치의 사용 설명서를 참조하십시오.

3
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ALL 파일 로드

이 항목에서는 ALL 파일을 로드하는 방법에 대해 설명합니다.

참고 사항

장치는 구성 데이터를 로드한 후 자동으로 재부팅됩니다. 재부팅 후 웹 브라우저에서 페이지를 다시 로드합니다.

5-041-958-23(1) Copyright 2022 Sony Corporation

웹 메뉴에서 [Project] > [All File]을 엽니다.1

[Load All File] > [Load] 버튼을 누릅니다.

웹 앱을 실행하는 장치에 파일 열기 대화 상자가 나타납니다.

2

로드하려는 파일을 엽니다.

파일 작업에 대한 자세한 내용은 장치의 사용 설명서를 참조하십시오.

3

파일 이름 로드 확인 화면이 나타나면 [OK] 버튼을 누릅니다.4

실행 결과 화면이 나타나면 [OK] 버튼을 누릅니다.5

기기가 재부팅될 때까지 기다린 다음 웹 앱을 다시 연결합니다.6
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파일 전송 정보

기기에 녹화된 프록시 파일이나 원본 파일을 인터넷의 서버 또는 로컬 네트워크의 서버에 업로드할 수 있습니다.

참고 사항

전원 공급 장치가 대기 상태로 설정되면 기기에 전원이 계속 켜져 있어도 파일 전송이 보류됩니다.

5-041-958-23(1) Copyright 2022 Sony Corporation
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파일 전송 대상 등록

파일 전송을 시작하기 전에 전송 대상 서버를 등록할 수 있습니다.

웹 메뉴에서 [Network] > [File Transfer] > [Default Upload Server] > [Server Settings1](또는 [Server
Settings2], [Server Settings3])을 선택합니다.

힌트

선택 옵션의 이름은 다음 단계에서 구성한 [Display Name]에 따라 변경됩니다.

1

웹 메뉴에서 [Network] > [FTP Server 1] ~ [FTP Server 3]에 대해 다음 항목을 구성합니다.

[Display Name]
전송 대상 서버를 선택할 때 전송 작업 목록에 표시할 서버 이름을 입력합니다.
[Service]
서버 유형을 표시합니다.
[FTP]: FTP 서버
[Host Name]
서버 주소 또는 호스트 이름을 입력합니다.
[Port]
연결할 서버의 포트 번호를 입력합니다.
[User Name]
사용자 이름을 입력합니다.
[Password]
암호를 입력합니다.
[Passive Mode]
패시브 모드를 켜거나 끕니다.
[Destination Directory]
대상 서버에서 디렉터리의 이름을 입력합니다.

참고 사항

대상 서버에 유효하지 않은 문자를 [Destination Directory]에 입력한 경우 파일이 사용자의 홈 디렉터리로 전송됩니다. 유효하
지 않은 문자는 서버에 따라 다릅니다.

[Using Secure Protocol]
보안 FTP 전송을 수행할지 여부를 설정합니다.
[Root Certificate]
인증서를 로드하거나 지웁니다.
[Load]: CA 인증서를 로드합니다. PEM 형식 인증서를 로드합니다.
[Clear]: CA 인증서를 지웁니다.
[None]:인증서를 로드하거나 지우지 않습니다.

참고 사항

CA 인증서를 로드하기 전에 기기의 시계를 정확한 시간으로 설정합니다.

XAVC-I 4096×2160P/3840×2160P 59.94/50P로 녹화하는 경우 [Load]를 선택할 수 없습니다.

[Root Certificate Status]: 인증서의 로드 상태를 표시합니다.

2
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[Reset]: Server Settings 설정을 기본값으로 재설정합니다.
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썸네일 화면에서 메모리 카드의 프록시 파일 업로드

썸네일 화면에서 메모리 카드의 프록시 파일을 개별적으로 업로드할 수 있습니다.

참고 사항

200개 적송 작업까지 가져올 수 있습니다.

5-041-958-23(1) Copyright 2022 Sony Corporation

웹 앱의 라이브 작동 화면에서 [Thumbnail] 버튼을 누릅니다.

디스플레이가 카메라 이미지에서 썸네일 화면으로 변경됩니다.

1

카메라 메뉴에서 [Thumbnail] > [Transfer Clip (Proxy)] > [Select Clip]을 선택합니다.

모든 프록시 파일을 동시에 전송하려면 [Transfer Clip (Proxy)] > [All Clips]를 선택합니다.
클립은 썸네일 화면 또는 필터링된 클립 썸네일 화면에서 전송할 수 있습니다.

2

[Set] 버튼을 사용하여 전송할 클립을 선택한 후, [Menu] 버튼을 누릅니다.

전송 확인 화면이 나타납니다.

3

[Execute]를 선택합니다.

선택한 클립에 해당하는 프록시 파일이 전송 작업으로 등록되고 업로드가 시작됩니다.
전송 작업이 성공적으로 등록되면 전송 결과 화면이 나타납니다.

4

[OK] 버튼을 누릅니다.5
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썸네일 화면에서 메모리 카드의 원본 파일 업로드

썸네일 화면에서 메모리 카드의 원본 파일을 업로드할 수 있습니다.

참고 사항

200개 적송 작업까지 가져올 수 있습니다.

5-041-958-23(1) Copyright 2022 Sony Corporation

웹 앱의 라이브 작동 화면에서 [Thumbnail] 버튼을 누릅니다.

디스플레이가 카메라 이미지에서 썸네일 화면으로 변경됩니다.

1

카메라 메뉴에서 [Thumbnail] > [Transfer Clip] > [Select Clip]을 선택합니다.

모든 원본 파일을 동시에 전송하려면 [Transfer Clip] > [All Clips]를 선택합니다.
클립은 썸네일 화면 또는 필터링된 클립 썸네일 화면에서 전송할 수 있습니다.

2

[Set] 버튼을 사용하여 전송할 클립을 선택한 후, [Menu] 버튼을 누릅니다.

전송 확인 화면이 나타납니다.

3

[Execute]를 선택합니다.

선택한 클립의 원본 파일이 전송 작업으로 등록되고 업로드가 시작됩니다.
전송 작업이 성공적으로 등록되면 전송 결과 화면이 나타납니다.

4

[OK] 버튼을 누릅니다.5
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도움말 안내

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

파일 전송 상태 확인

카메라 메뉴에서 [Network] > [File Transfer] > [View Job List]를 선택하여 파일 전송 상태를 확인할 수 있습니다.

참고 사항

200개 적송 작업까지 가져올 수 있습니다.

전송 작업은 기기가 대기 상태로 전환될 때에도 유지되지만 다른 방법으로 전원이 차단되면 최대 10분의 최근 진행 정보가 손실될
수 있습니다.

파일 전송 중 오류가 발생하면 전송 대상 서버의 설정 및 상태에 따라 전송된 클립과 동일한 이름의 클립 전송이 재개되지 않을 수
있습니다. 이러한 경우 전송 대상 서버 설정 및 상태를 확인합니다.

힌트

카메라 메뉴에서 [Network] > [File Transfer] > [Auto Upload (Proxy)]가 [On]으로 설정되고 네트워크 연결이 있는 경우 녹화 종료 시
[Default Upload Server]를 사용하여 지정된 서버에 프록시 파일이 자동으로 업로드됩니다.

5-041-958-23(1) Copyright 2022 Sony Corporation
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도움말 안내

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

보안 FTP를 사용하여 업로드

대상 파일 서버와의 연결을 위해 Explicit 모드(FTPES)에서 FTPS를 사용하여 암호화된 파일을 업로드할 수 있습니다.
보안 FTP 전송의 경우 대상 파일 서버에서 [Using Secure Protocol]을 [On]으로 설정하고 인증서를 가져옵니다.

구성에 관한 자세한 내용은 "파일 전송 대상 등록"을 참조하십시오.

관련 항목

파일 전송 대상 등록

5-041-958-23(1) Copyright 2022 Sony Corporation

259



도움말 안내

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

스트리밍 정보

본 기기는 HDMI 커넥터에서 출력되는 비디오와 오디오를 동시에 스트리밍할 수 있습니다.

참고 사항

스트리밍을 메인 비디오로 사용하려면 웹 메뉴에서 [Monitoring] > [Output Display] > [SDI]을 [On]으로, [HDMI/Stream]을 [Off]로 설
정하고 SDI 모니터에서 카메라 상태를 모니터링합니다.

HDMI 커넥터에 연결된 모니터가 웹 메뉴 또는 카메라 메뉴의 [Monitoring] 메뉴를 사용하여 구성된 HDMI 출력 형식을 지원하지 않
으면 카메라 이미지가 웹 앱으로 출력되지 않습니다. 스트리밍 비디오도 출력할 수 없습니다.

스트리밍 해상도는 HDMI 출력 신호 해상도보다 높게 설정할 수 없습니다.

여러 사용자가 볼 경우 코덱 설정에 따라 이미지가 왜곡될 수 있습니다.

본 기기는 다음 스트리밍 방법을 지원합니다. 선택 가능한 비디오 코덱이 괄호 안에 표시됩니다.

RTSP(H.264, H.265)
RTMP(H.264)*1

SRT-Caller(H.264)
SRT-Listener(H.264)
NDI|HX(H.264, H.265)

스트리밍 형식 설정, 비디오 코덱 설정, 오디오 코덱 설정을 순서대로 구성합니다.

●: 활성화됨, –: 비활성화됨

힌트

웹 앱 카메라 이미지 패널의 이미지도 스트리밍 시스템입니다.

스트리밍 형식
코덱 설정

Video Stream 1 Video Stream 2 Video Stream 3 Audio Stream

RTSP
●
video 1

●*2

video 2
– ●

RTMP ● – – ●*1

SRT ● – – ●

NDI|HX
●
Main

●
Sub

– ●

웹 앱 – – ● –

RTMP는 웹 메뉴에서 [Stream] > [Audio Stream]이 [On]으로 설정된 경우 선택됩니다.*1

시스템 주파수가 59.94 또는 50이고 HDMI 출력 형식이 3840×2160 이상인 경우 video 2 출력을 사용할 수 없습니다.*2
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스트리밍 형식 설정

웹 메뉴에서 [Stream] > [Stream] > [Stream Setting] > [Setting]을 사용하여 스트리밍 형식을 설정합니다.

[Setting]가 [RTSP]으로 설정된 경우

RTSP 스트리밍에서는 단일 카메라의 이미지를 최대 5명의 사용자가 동시에 볼 수 있습니다.
최대 2개의 비디오 코덱 모드를 설정할 수 있습니다.
[Port Number]
RTSP 스트리밍에 사용할 포트 번호를 설정합니다. 기본값은 554입니다.
설정을 변경하면 RTSP 서버가 재부팅됩니다.
[Time Out]
RTSP 스트리밍에 대한 Keep-Alive 명령의 시간 초과 시간을 지정합니다. 시간 초과 시간은 0~600초 범위에서 설정할 수
있습니다. 기본값은 60초입니다.
0초로 설정된 경우 Keep-Alive 명령으로 인한 시간 초과가 발생하지 않습니다.
[Authentication]
인증이 필요한지 여부를 설정합니다.
[Video Port Number 1], [Video Port Number 2]
RTSP 유니캐스트 스트리밍에 사용할 이미지 데이터 통신 포트 번호를 지정합니다. Video Port Number 1의 공장 기본값은
51000입니다. Video Port Number 2의 공장 기본값은 53000입니다. 1024~65534 범위에서 짝수를 지정합니다. 여기에서
설정한 번호와 1을 더하여 얻은 홀수가 이미지 데이터 통신 및 제어에 사용되는 2개의 포트 번호가 됩니다.
[Video Port Number 1] 및 [Video Port Number 2]는 [Stream] > [Video Stream] > [Video Stream 1] 및 [Video Stream 2]에
해당됩니다.
[Audio Port Number]
RTSP 유니캐스트 스트리밍에 사용되는 오디오 데이터 통신 포트 번호를 지정합니다. 기본값은 57000입니다.
1024~65534 범위에서 짝수를 지정합니다. 여기에서 설정한 번호와 1을 더하여 얻은 홀수가 오디오 데이터 통신 및 제어에
사용되는 2개의 포트 번호가 됩니다.

[Setting]가 [RTMP]으로 설정된 경우

RTMP에 사용할 수 있는 비디오 코덱 모드는 H.264뿐입니다. RTMP를 사용하려면 웹 메뉴에서 [Stream] > [Audio Stream]
을 [On]으로 설정해야 합니다.
[Server URL]
업로드 대상 URL을 설정합니다. "rtmp://" 또는 "rtmps://"로 시작하는 문자열을 지정합니다.
[Stream Key]
사용 중인 사이트에서 얻은 스트림 키를 입력합니다. [Clear] 버튼을 누르면 입력 내용이 지워집니다.

참고 사항

스트림 키를 다룰 때는 주의해야 합니다. 스트림 키를 제3자가 알고 있는 경우 스트림을 스푸핑할 위험이 있습니다.

[Root Certificate]
RTMPS 프로토콜을 사용하여 스트리밍에 필요한 루트 인증서를 가져옵니다. 루트 인증서를 가져오려면 [Load] 버튼을 누
르고 루트 인증서를 선택합니다. 파일 선택 대화 상자에서 [OK] 버튼을 눌러 선택한 파일을 기기로 가져옵니다. 기기에 가
져온 루트 인증서가 있는 경우 루트 인증서가 업데이트됩니다. 가져온 루트 인증서를 삭제하려면 설정 화면에서 [Delete]
버튼을 누릅니다. 루트 인증서 상태는 [Root Certificate Status]에 표시됩니다.

참고 사항

스트리밍 서비스에 필요한 루트 인증서를 가져옵니다.
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[Setting]가 [SRT-Caller] 또는 [SRT-Listener]로 설정된 경우

비디오 코덱 모드는 H.264 전용입니다.
[Destination]
스트리밍 모드가 [SRT-Caller]로 설정된 경우 표시됩니다. 연결 대상 URL을 설정합니다.
[Port Number]
스트리밍 모드가 [SRT-Listener]로 설정된 경우 표시됩니다. 수신 대기할 포트 번호를 설정합니다. 기본값은 4201입니다.
[Latency]
대기 시간을 20ms~8000ms 범위로 설정합니다. 기본값은 120입니다.
[TTL]
1~255 범위에서 TTL 값을 설정합니다. 기본값은 64입니다.
[Encryption]
암호화 방법을 선택합니다. Off, AES128 또는 AES256을 선택합니다. 기본값은 Off입니다.
[Passphrase]
암호화에 사용되는 암호 문구를 설정합니다. [Clear] 버튼을 누르면 구성된 암호 문구가 재설정됩니다.
[ARC]
Adaptive Rate Control 기능을 활성화하려면 On으로 설정합니다.
Adaptive Rate Control 기능이 활성화되면 통신선 혼잡으로 인한 이미지 중단을 줄일 수 있습니다.

[Setting]가 [NDI|HX]으로 설정된 경우

본 기기는 NewTek의 NDI|HX 버전 2를 준수합니다.
NDI|HX를 사용하려면 라이선스 키를 구입해야 합니다.
라이선스 키 구매
다음 NewTek URL에서 구매하십시오.
https://www.newtek.com/ndihx/products/upgrade/

참고 사항

최신 NDI|HX 드라이버를 다운로드하여 NewTek 제품에 설치합니다.

NDI|HX 등록 및 작동에 대한 자세한 내용은 NewTek 제품의 사용 설명서를 참조하십시오.

[License]
활성화된 라이선스에 대한 라이선스 정보를 표시합니다.
[Source Name]
소스 이름을 표시합니다.
[Group]
NDI 그룹화 기능을 활성화하려면 On으로 설정합니다.
[Group Name]: NDI 그룹 이름을 설정합니다. 여러 설정을 쉼표로 구분하여 구성할 수 있습니다.
[Discovery Server 1], [Discovery Server 2]
NDI 검색 서버 1 및 NDI 검색 서버 2를 설정합니다.
[Reliable UDP Mode]
Reliable UDP 모드를 활성화하려면 On으로 설정합니다.
[Multicast Mode]
멀티캐스트 스트리밍을 활성화하려면 On으로 설정합니다.
[Multicast Prefix]: 멀티캐스트 스트리밍에 사용할 접두사를 설정합니다.
[Multicast Netmask]: 멀티캐스트 주소 범위를 결정하는 넷마스크를 설정합니다.
[Multicast TTL]: 멀티캐스트 스트리밍의 TTL 값을 1~256 범위로 설정합니다. 기본값은 3입니다.
[Multi-TCP Mode]
Multi-TCP 모드를 활성화하려면 On으로 설정합니다.
[Unicast UDP Mode]
Unicast UDP 모드를 활성화하려면 On으로 설정합니다.

타사 서비스 및 소프트웨어 정보

다른 이용 약관이 적용될 수 있습니다.

서비스 및 소프트웨어 업데이트의 제공은 예고 없이 중단되거나 종료될 수 있습니다.
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서비스 및 소프트웨어에 대한 설명은 예고 없이 변경될 수 있습니다.
별도의 등록 및 가입이 필요할 수 있습니다.

Sony는 다른 회사의 서비스 및 소프트웨어 사용으로 인해 사용자 또는 제3자가 제기하는 청구에 대해 책임을 지지 않습니
다.

5-041-958-23(1) Copyright 2022 Sony Corporation
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스트리밍용 비디오 코덱 설정

웹 메뉴에서 [Stream] > [Video Stream]을 사용하여 비디오 코덱을 설정합니다.

[Video Stream 1], [Video Stream 2], [Video Stream 3]
최대 3개의 이미지 코덱 모드를 설정할 수 있습니다. 각 이미지 모드에 대해 다음 설정을 개별적으로 구성합니다.
[Video Stream 3]은 웹 앱 카메라 이미지 패널 표시에 사용됩니다.

참고 사항

[Stream] > [Stream Setting] > [Setting]이 [RTMP], [SRT-Caller], 또는 [SRT-Listener]로 설정된 경우, [Video Stream 1], [Video
Stream 2] 및 [Video Stream 3] 설정([Codec], [Size], [Frame Rate], [Bit Rate Compression Mode])의 일부는 기본값을 갖습니다.

[Codec 1], [Codec 2], [Codec 3]
[H.264], [H.265] 또는 [Off]를 선택합니다. [Codec 1]은 [Off]로 설정할 수 없습니다. 또한 [Codec 3]은 [JPEG](고정)로 설정
되어 있습니다.

참고 사항

[Codec 1], [Codec 2] 및 [Codec 3]의 사진 크기, 프레임 속도, 비트 전송률 등 다양한 설정의 조합에 따라 다음과 같은 증상이 나타
날 수 있습니다.

비디오 지연 시간 증가.
비디오 재생 중 프레임 건너뛰기.
간헐적인 오디오.
다양한 명령에 대한 느린 카메라 응답.
원격 제어기 조작에 대한 느린 카메라 응답.
느린 모니터 화면 표시 및 구성 작업.

이러한 증상이 나타나면 사진 크기, 프레임 속도 및 비트 전송률 매개변수의 값을 줄이거나 다른 설정 매개변수의 값을 변경하여 문
제를 해결합니다.

[Stream] > [Stream Setting] > [Setting]이 [RTMP], [SRT-Caller], 또는 [SRT-Listener]로 설정된 경우, [Codec 1]은 [H.264](고정)로
설정됩니다. [Codec 2]는 [Off](고정)로 설정됩니다.

HDMI 출력의 사진 크기나 시스템 주파수가 변경되면 [Codec 2]가 [Off]로 설정됩니다.

[Size 1], [Size 2], [Size 3]
카메라에서 스트리밍할 사진 크기를 선택합니다.
사용 가능한 사진 크기 옵션은 HDMI 출력의 사진 크기에 따라 다릅니다.

참고 사항

HDMI 출력의 화면 크기나 시스템 주파수가 변경되면 최대 화면 크기가 선택됩니다.

[Frame Rate 1], [Frame Rate 2], [Frame Rate 3]
이미지의 프레임 속도를 설정합니다.
"fps" 단위는 초당 스트리밍되는 프레임 수를 나타냅니다.
사용 가능한 프레임 속도 옵션은 HDMI 출력의 사진 크기에 따라 다릅니다.

참고 사항

HDMI 출력의 화면 크기나 시스템 주파수가 변경되면 최대 프레임 속도가 선택됩니다.
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[I-Picture Mode 1], [I-Picture Mode 2]
H.264 및 H.265에 대한 I-picture 삽입 간격을 지정하는 방법을 [Time] 또는 [Frame]으로 설정합니다.
[Codec 3]에 대해서는 설정할 수 없습니다.
[Time]: I-picture 삽입 간격을 시간으로 설정합니다.
[Frame]: I-picture 삽입 간격을 프레임 수로 설정합니다.
[I-Picture Interval 1], [I-Picture Interval 2]
I-picture 삽입 간격을 초 단위로 설정합니다. 1~5초 범위에서 값을 설정합니다. 기본값은 1초입니다.
[Codec 3]에 대해서는 설정할 수 없습니다.
[I-Picture Ratio 1], [I-Picture Ratio 2]
H.264 및 H.265에 대한 I-picture 삽입 간격을 15~300 범위의 프레임 수로 설정합니다. 기본값은 300프레임입니다.
[Codec 3]에 대해서는 설정할 수 없습니다.
[Profile 1], [Profile 2]
H.264 또는 H.265 이미지 코덱 프로필을 설정합니다.
[H.264]: [high], [main] 또는 [baseline] 프로필을 선택합니다.
[H.265]: [main] 또는 [main10] 프로필을 선택합니다. 두 개의 비디오 코덱이 활성화된 경우 [main] 프로필 선택 옵션만 사용
할 수 있습니다.
이미지 압축 효율은 [high], [main], [baseline] 순으로 증가합니다. 시스템에서 지원하는 프로필을 선택합니다.
[H.265]가 [main10]으로 설정된 경우 HDMI 출력이 YCrCb일 때 [main10], HDMI 출력이 RGB일 때 [main]에서 작동됩니다.
[Codec 3]에 대해서는 설정할 수 없습니다.
[Bit Rate Compression Mode 1], [Bit Rate Compression Mode 2]
[CBR] 또는 [VBR]을 선택합니다.
일정한 비트 전송률을 유지하려면 [CBR]을 선택합니다. 이미지 품질을 유지하려면 [VBR]을 선택합니다.
[Codec 3]에 대해서는 설정할 수 없습니다.

참고 사항

실제 스트리밍되는 프레임 속도 및 비트 전송률은 사진 크기, 촬영 장면, 네트워크 환경 및 기타 요인에 따라 설정된 값과 다를 수 있
습니다.

[Stream] > [Stream Setting] > [Setting]이 [RTMP], [SRT-Caller], 또는 [SRT-Listener]로 설정된 경우, [Bit Rate Compression Mode
1]은 [CBR](고정)로 설정됩니다.

[Bit Rate 1], [Bit Rate 2]
[Bit Rate Compression Mode]가 [CBR]로 설정된 경우 비디오 스트림당 비트 전송률을 설정할 수 있습니다. 높은 비트 전
송률을 설정하면 높은 이미지 품질의 비디오를 스트리밍할 수 있습니다.
[Codec 3]에 대해서는 설정할 수 없습니다.
[Quality 1], [Quality 2], [Quality 3]
1~10 범위에서 이미지 품질을 설정합니다. 값이 10이면 가장 높은 이미지 품질이 설정됩니다. 기본값은 6입니다.
[Quality 1] 및 [Quality 2]의 경우, [Bit Rate Compression Mode]를 [VBR]로, [Codec]을 [H.264]로 설정하여 H.264 이미지
품질을 설정할 수 있습니다. [Bit Rate Compression Mode]를 [VBR]로, [Codec]을 [H.265]로 설정하여 H.265 이미지 품질
을 설정할 수 있습니다.

5-041-958-23(1) Copyright 2022 Sony Corporation
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스트리밍용 오디오 코덱 설정

웹 메뉴에서 [Stream] > [Audio Stream]을 사용하여 오디오 코덱을 설정합니다.
[Setting]
오디오 스트리밍을 활성화하려면 On으로 설정합니다.

참고 사항

RTMP를 선택하려면 항상 미리 On으로 설정합니다.

[Codec]
오디오 스트리밍에 사용할 코덱 유형을 선택합니다.
[AAC (256kbps)]: 음질을 우선시하려면 선택합니다.
[AAC (128kbps)]: 데이터 용량을 우선시하려면 선택합니다.
이 설정은 본 기기에서 녹화한 클립 또는 HDMI/SDI 신호에 포함된 오디오 신호에 영향을 주지 않습니다.

5-041-958-23(1) Copyright 2022 Sony Corporation
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스트리밍 시작/중지

[RTSP], [SRT-Listener] 및 [NDI|HX]의 경우

기기는 스트리밍 배달 요청을 기다립니다.
스트리밍 보기용 클라이언트 애플리케이션을 실행하고 다음 표에 표시된 URL에 액세스합니다.
기기에 구성된 사용자 이름 및 암호 값을 입력합니다.

<camera_address>: 기기의 IP 주소
<Port>: [Port Number]를 사용하여 구성된 Listener 포트

참고 사항

모든 애플리케이션 또는 장치에서 재생이 보장되지는 않습니다.

[RTMP] 및 [SRT-Caller]의 경우

라이브 작동 화면의 (Stream) 탭에서 [Stream now] 버튼을 눌러 스트리밍을 시작합니다. 버튼이 [Stop stream]으로 변
경되고 카메라 이미지 패널 상단에 [Stream] 아이콘이 나타납니다.
스트리밍 중 [Stop stream] 버튼을 누르면 스트리밍이 중지됩니다. 버튼이 다시 [Stream now]로 변경되고 카메라 이미지
패널 상단의 [Stream] 아이콘이 사라집니다.

참고 사항

모든 애플리케이션 또는 장치에서 재생이 보장되지는 않습니다.

5-041-958-23(1) Copyright 2022 Sony Corporation

스트리밍 형식 URL

RTSP
Video Stream 1 rtsp://<camera_address>:<Port>/video1

Video Stream 2 rtsp://<camera_address>:<Port>/video2

SRT-Listener srt://<camera_address>:<Port>

NDI|HX NDI|HX 호환 클라이언트 장치의 사용 설명서를 참조하십시오.
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썸네일 화면

재생 작동 화면의 [Thumbnail] 버튼이나 적외선 리모컨의 THUMBNAIL 버튼을 누르면 메모리 카드에 녹화된 클립이 카메
라 이미지 창에 표시됩니다. 카메라 이미지 패널에 표시되는 이 표시를 썸네일 화면이라고 합니다.
썸네일 화면에서 클립을 선택하면 해당 클립 재생을 시작할 수 있습니다.
썸네일 화면 표시 중에 [Thumbnail] 버튼을 누르면 썸네일 화면이 닫히고 촬영 이미지 표시로 돌아갑니다.

참고 사항

현재 선택된 녹화 형식으로 녹화된 클립만 썸네일 화면에 표시됩니다. 예상된 녹화 클립이 표시되지 않으면 녹화 형식을 확인하십
시오. 매체를 포맷(초기화)하기 전에 이 사실에 특히 주의하십시오.

화면 레이아웃

선택된 클립의 썸네일이 주황색 배경으로 표시됩니다.
선택된 클립에 대한 정보가 화면 하단에 표시됩니다.
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선택된 메모리 카드
메모리 카드가 쓰기 보호 상태인 경우 오른쪽에 잠금 아이콘이 나타납니다.

1.

클립 번호/전체 클립 번호2.

썸네일(색인 사진)
클립의 색인 사진을 표시합니다. 클립이 녹화되면 첫 번째 프레임이 색인 사진으로 자동 설정됩니다.
클립/프레임 정보가 썸네일 아래 표시됩니다. 카메라 메뉴의 [Thumbnail] > [Customize View] > [Thumbnail Caption]을
사용하여 표시된 정보를 변경할 수 있습니다.

3.

클립 이름
선택한 클립 이름을 표시합니다.

4.

녹화 형식
선택한 클립 형식을 표시합니다.

5.

특수 녹화 정보
특수 녹화 모드를 사용하여 녹화된 클립인 경우 녹화 모드만 표시합니다.
Slow & Quick Motion 클립의 경우 프레임 속도가 오른쪽에 표시됩니다.

6.

클립 길이7.

생성 날짜8.
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녹화된 클립 재생

기기가 녹화 대기(Stby) 모드일 때 녹화된 클립을 재생할 수 있습니다.
이 항목에서는 GUI 제어 패널을 사용하여 녹화된 클립을 재생하는 방법에 대해 설명합니다.

재생할 메모리 카드를 삽입합니다.1

[Thumbnail] 버튼을 누릅니다.

클립 썸네일이 나타납니다.

2

GUI 제어 패널의 화살표 버튼을 사용하여 재생하려는 클립의 썸네일로 커서를 옮깁니다.3
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참고 사항

클립 사이 경계에서 일시적인 영상 끊김이나 스틸 이미지가 표시될 수 있습니다. 이 시간 동안에는 기기를 작동시킬 수 없습니다.

썸네일 화면에서 클립을 선택하고 재생을 시작하면 클립 시작 부분에서 일시적인 영상 왜곡이 발생할 수 있습니다. 왜곡 없이 클립
의 시작 부분을 보려면 재생을 일시 정지 후 (이전) 버튼을 눌러 클립의 시작 부분으로 돌아간 다음 다시 재생을 시작하십시오.

5-041-958-23(1) Copyright 2022 Sony Corporation

참고 사항

클립은 터치 조작으로 선택할 수 없습니다.

GUI 제어 패널에서 [Set] 버튼을 누릅니다.

선택된 클립의 시작 부분부터 재생이 시작됩니다.

4

필요에 따라 재생 제어 패널을 조작합니다.

힌트

GUI 제어 패널을 사용하여 작동을 제어할 수도 있습니다.

재생: [Set] 버튼을 누릅니다.
재생 일시 정지: 재생 중 [Set] 버튼을 누릅니다. 다시 누르면 정상 재생으로 되돌아갑니다.
클립의 시작/다음 클립의 시작으로 이동: 왼쪽 버튼/오른쪽 버튼을 누릅니다.
빨리 감기/되감기: 왼쪽 버튼/오른쪽 버튼을 길게 누릅니다. 버튼에서 손을 떼면 재생이 정상 속도로 돌아갑니다.
재생 중지: [Cancel/Back] 버튼을 누릅니다.

5

버튼 기능

 (재생/일시 정지) 버튼 클립을 재생합니다. 재생 중 클립을 일시 정지합니다.

 (빨리 감기) 버튼,  (빨리 되감기)
버튼

고속으로 클립을 재생합니다. 버튼을 누르면 재생 속도가 3단계로 변
경됩니다.

(이전) 버튼, (다음) 버튼 클립의 시작 또는 이전/다음 클립으로 이동합니다.

 (중지) 버튼 재생을 중지하고 촬영 화면으로 전환합니다.
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녹화된 클립에 대한 작업

썸네일 화면에서 카메라 메뉴의 [Thumbnail] 메뉴를 사용하여 클립으로 작업하거나 클립 속성을 확인할 수 있습니다.
재생 작동 화면에서 [Menu] 버튼을 누르면 카메라 이미지 패널에 카메라 메뉴가 표시됩니다.
카메라 메뉴의 [Thumbnail] 메뉴를 사용하여 다음 작업을 수행할 수 있습니다.
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힌트

라이브 작동 화면에서 [Menu] 버튼을 눌러 카메라 메뉴를 표시할 수도 있습니다.

카메라 메뉴의 [Thumbnail] 메뉴를 사용한 작업
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GUI 제어 패널의 화살표 버튼을 이용하여 작업할 기능을 선택하고 [Set] 버튼을 누릅니다.
이전 화면으로 되돌아가려면 [Cancel/Back] 버튼을 누릅니다.

참고 사항

메뉴가 표시된 상태에 따라 일부 항목을 선택할 수 없습니다.

클립 작업용 메뉴 항목

카메라 메뉴의 [Thumbnail] 메뉴에는 클립 작업과 관련된 다음과 같은 메뉴 항목이 있습니다.
[Display Clip Properties]
[Set Clip Flag]
[Lock/Unlock Clip]
[Delete Clip]
[Transfer Clip]
[Transfer Clip (Proxy)]
[Filter Clips]
[Customize View]

각 메뉴 항목에 대한 자세한 내용은 "[Thumbnail] 메뉴"를 참조하십시오.

클립 속성 화면을 표시하려면

카메라 메뉴에서 [Thumbnail] > [Display Clip Properties]를 선택하여 클립 속성 화면을 표시합니다.
(이전) 버튼 또는 (다음) 버튼을 눌러 이전/다음 클립으로 이동합니다.

클립 플래그를 추가하려면

클립에 클립 플래그(OK, NG 또는 KP 마크)를 추가하여 클립 플래그를 기준으로 클립 표시를 필터링할 수 있습니다.
클립 플래그를 추가하려는 클립의 썸네일을 선택한 다음 카메라 메뉴에서 [Thumbnail] > [Set Clip Flag]를 사용하여 클립
플래그를 선택합니다.

힌트

클립 플래그 기능이 할당된 할당 가능 버튼을 사용하여 클립 플래그를 추가할 수 있습니다.

필터링된 클립 썸네일 화면을 표시하려면

카메라 메뉴의 [Thumbnail] > [Filter Clips]를 선택하고 클립 플래그 유형을 선택하여 지정된 플래그가 있는 클립만 표시합
니다.
모든 클립을 표시하려면 [All]을 선택합니다.
[Display] 버튼을 눌러 썸네일 표시를 플래그별로 정렬할 수도 있습니다.

클립을 삭제하려면

메모리 카드에서 클립을 삭제할 수 있습니다.
카메라 메뉴에서 [Thumbnail] > [Delete Clip] > [Select Clip] 또는 [All Clips]를 선택합니다.
[Select Clip]: 선택한 클립을 삭제합니다. 클립을 여러 개 선택할 수 있습니다.
[All Clips]: 표시된 모든 클립을 삭제합니다.

썸네일 화면에 표시된 정보를 변경하려면

썸네일 아래 표시된 클립/프레임 정보를 변경할 수 있습니다.

설정 추가된 클립 플래그

[Add OK] OK

[Add NG] NG

[Add KEEP] KP
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카메라 메뉴에서 [Thumbnail] > [Customize View] > [Thumbnail Caption]을 선택한 후 표시할 정보를 선택합니다.
[Date Time]: 클립이 생성되고 마지막으로 수정된 날짜와 시간을 표시합니다.
[Time Code]: 타임코드를 표시합니다.
[Duration]: 클립 길이를 표시합니다.
[Sequential Number]: 각 썸네일의 순서 번호를 표시합니다.

5-041-958-23(1) Copyright 2022 Sony Corporation
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카메라 메뉴 구성

GUI 제어 패널의 [Menu] 버튼 또는 적외선 리모컨의 MENU 버튼을 누르면 카메라 이미지 패널에 촬영 및 재생에 필요한
다양한 설정을 구성하기 위한 카메라 메뉴가 표시됩니다.

메뉴는 다음 메뉴로 구성됩니다.

메뉴 구성

[User] 메뉴
사용자가 구성한 메뉴 항목을 포함합니다.
[Edit User Menu]를 사용하여 편집할 수 있습니다.
[Edit User] 메뉴
[User] 메뉴를 편집하기 위한 메뉴 항목을 포함합니다.
[Shooting] 메뉴
촬영과 관련된 설정이 포함되어 있습니다.
[Project] 메뉴
기본 프로젝트 설정이 포함되어 있습니다.
[Paint/Look] 메뉴
이미지 품질과 관련된 설정이 포함되어 있습니다.
[Pan-Tilt] 메뉴
팬/틸트와 관련된 설정이 포함되어 있습니다.
[TC/Media] 메뉴
타임코드 및 녹화 매체와 관련된 설정이 포함되어 있습니다.
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[Monitoring] 메뉴
비디오 출력 및 화면 표시와 관련된 설정이 포함되어 있습니다.
[Audio] 메뉴
오디오와 관련된 설정이 포함되어 있습니다.
[Thumbnail] 메뉴
썸네일 표시와 관련된 설정이 포함되어 있습니다.
[Technical] 메뉴
기술 항목에 대한 설정이 포함되어 있습니다.
[Network] 메뉴
네트워크와 관련된 설정이 포함되어 있습니다.
[Maintenance] 메뉴
시계 및 언어와 같은 장치 설정이 포함되어 있습니다.

카메라 메뉴 구성 및 계층

레벨 1 레벨 2

User
(공장 설정)

Base Setting

Focus

S&Q Motion

LUT On/Off

Simul Rec

Proxy Rec

Interval Rec

Picture Cache Rec

Assignable Button

Scene File

Base Look

P/T Acceleration

Clip Name Format

Format Media

Video Signal Monitor

Marker

Zoom

Lens

Edit User Menu
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레벨 1 레벨 2

Shooting

ISO/Gain/EI

ND Filter

Shutter

Iris

Auto Exposure

White

White Setting

Offset White

Focus

S&Q Motion

LUT On/Off

Noise Suppression

Flicker Reduce

SteadyShot

Project

Base Setting

Rec Format

Cine EI/Flex.ISO Set

Simul Rec

Proxy Rec

Interval Rec

Picture Cache Rec

SDI/HDMI Rec Control

Assignable Button

Paint/Look

Scene File

Base Look

Reset Paint Settings

Black

Knee

Detail

Matrix

Multi Matrix
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레벨 1 레벨 2

Pan-Tilt P/T Acceleration

TC/Media

Timecode

TC Display

Users Bit

HDMI TC Out

Clip Name Format

Update Media

Format Media

Media Life

Monitoring

Output Format

Display On/Off

Video Signal Monitor

Marker

Audio
Audio Input

Audio Output

Thumbnail

Display Clip Properties

Set Clip Flag

Lock/Unlock Clip

Delete Clip

Transfer Clip

Transfer Clip (Proxy)

Filter Clips

Customize View

Technical

Color Bars

Genlock

Tally

Rec Review

Zoom

Lens

APR
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레벨 1 레벨 2

Network
Wired LAN

File Transfer

Maintenance

Language

Clock Set

Hours Meter
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카메라 메뉴 조작

GUI 제어 패널의 [Menu] 버튼 또는 적외선 리모컨의 MENU 버튼을 누르면 카메라 이미지 패널에 촬영 및 재생에 필요한
다양한 설정을 구성하기 위한 카메라 메뉴가 표시됩니다.
메뉴는 GUI 제어 패널의 버튼을 사용하여 작동됩니다.

[Menu] 버튼: 눌러서 카메라 메뉴를 표시합니다. 카메라 메뉴가 표시된 상태에서 다시 눌러 메뉴를 숨깁니다.
화살표 버튼: 화살표 버튼을 누르면 카메라 메뉴에서 커서가 위쪽/아래쪽/왼쪽/오른쪽으로 이동하여 메뉴 항목이나 설정을
선택할 수 있습니다.
[Set] 버튼: 누르면 선택한 항목이 적용됩니다.
[Cancel/Back] 버튼: 누르면 이전 메뉴로 되돌아갑니다. 완료되지 않은 변경 사항은 취소됩니다.

참고 사항

메뉴가 표시된 상태에 따라 일부 항목을 선택할 수 없습니다.

설정 메뉴 항목

GUI 제어 패널의 화살표 버튼을 사용하여 설정하고자 하는 항목으로 커서를 이동한 후 [Set] 버튼을 눌러 설정을 적용합니
다.

메뉴 항목 선택 영역에는 최대 8줄이 표시됩니다. 항목에 사용할 수 있는 옵션을 동시에 표시할 수 없는 경우 커서를 위
아래로 움직여 디스플레이를 스크롤합니다.
설정 범위가 큰 하위 항목(예: −99~+99)의 경우 설정 영역이 표시되지 않습니다. 값을 변경할 수 있다는 것을 나타내기
위해 현재 설정이 강조 표시됩니다.
기능에 대해 [Execute]를 선택하면 해당 기능이 실행됩니다.
실행 전에 확인이 필요한 항목을 선택하면 메뉴가 일시적으로 숨겨지고 확인 메시지가 표시됩니다. 메시지를 확인한
후 기능을 실행할지, 취소할지를 선택합니다.

5-041-958-23(1) Copyright 2022 Sony Corporation
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문자열 입력

문자 입력이 필요한 파일 이름과 같은 항목을 선택하면 문자 입력 화면이 나타납니다.

5-041-958-23(1) Copyright 2022 Sony Corporation

GUI 제어 패널의 화살표 버튼을 눌러 문자 유형을 선택하고 설정을 적용합니다.

[ABC]: 대문자 알파벳
[abc]: 소문자 알파벳
[123]: 숫자
[!#$]: 특수 문자

1

문자를 선택하고 [Set] 버튼을 누르면 설정이 적용됩니다.

커서가 다음 필드로 이동합니다.
[Space]: 커서 위치에 공백 문자를 입력합니다.
[←] [→]: 커서 위치를 이동합니다.
[BS]: 커서 왼쪽에 있는 문자를 삭제합니다(백스페이스).

2

끝나면 [Done] 버튼을 눌러 설정을 적용합니다.

문자열이 확인되고 문자 입력 화면이 사라집니다.

3
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User

이 항목에서는 각 메뉴 항목의 기능과 설정을 설명합니다.

참고 사항

[Edit User] 메뉴를 사용하여 [User] 메뉴에서 메뉴 항목을 추가 및 제거할 수 있습니다. 최대 20개의 항목을 구성할 수 있습니다.

5-041-958-23(1) Copyright 2022 Sony Corporation

항목 설명

Base Setting Project > Base Setting 항목

Focus Shooting > Focus 항목

S&Q Motion Shooting > S&Q Motion 항목

LUT On/Off Shooting > LUT On/Off 항목

Simul Rec Project > Simul Rec 항목

Proxy Rec Project > Proxy Rec 항목

Interval Rec Project > Interval Rec 항목

Picture Cache Rec Project > Picture Cache Rec 항목

Assignable Button Project > Assignable Button 항목

Scene File Project > Scene File 항목

Base Look Paint/Look > Base Look 항목

P/T Acceleration Pan-Tilt > P/T Acceleration 항목

Clip Name Format TC/Media > Clip Name Format 항목

Format Media TC/Media > Format Media 항목

Video Signal Monitor Monitoring > Video Signal Monitor 항목

Marker Monitoring > Marker 항목

Zoom Technical > Zoom 항목

Lens Technical > Lens 항목

Edit User Menu Edit User 메뉴를 표시합니다.
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Edit User

[User] 메뉴에서 [Edit User Menu]를 선택하면 가장 위에 [Edit User] 메뉴가 표시됩니다.

5-041-958-23(1) Copyright 2022 Sony Corporation

항목
하위 항목 설

정
공장 기본

값
설명

Add Item
[User] 메뉴에 항목 추가

– – [User] 메뉴에 레벨 2 메뉴 항목을 추가합니다.

Customize Reset
[User] 메뉴에서 항목 재설정

– –
[User] 메뉴에 등록된 메뉴 항목을 공장 기본값으로 복원합
니다.

편집 도중 선택된 레벨 2 메뉴
항목

Delete – [User] 메뉴에서 등록된 레벨 2 메뉴 항목을 삭제합니다.

Move – [User] 메뉴 내에서 등록된 메뉴 항목을 다시 정렬합니다.

Edit Sub
Item

–
[User] 메뉴에서 등록된 레벨 3 메뉴의 하위 항목을 편집합
니다(등록/삭제).

285



도움말 안내

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

ISO/Gain/EI

게인 설정을 지정합니다.

항목 하위 항목 설정 공장 기본값 설명

Mode ISO/dB dB
게인 설정 모드를 선택합니
다.

ISO/Gain<L>

설정에 관한 자세한 내용은
"ISO/Gain 설정 및 기본값"을 참조
하십시오.

– <L> 게인 사전 설정 값을 설
정합니다.

Exposure
Index<L>

Base ISO가 ISO 800으로 설정된 경
우:
200EI / 4.0E
250EI / 4.3E
320EI / 4.7E
400EI / 5.0E
500EI / 5.3E
640EI / 5.7E
800EI / 6.0E
1000EI / 6.3E
1250EI / 6.7E
1600EI / 7.0E
2000EI / 7.3E
2500EI / 7.7E
3200EI / 8.0E
Base ISO가 ISO 12800으로 설정된
경우:
3200EI / 4.0E
4000EI / 4.3E
5000EI / 4.7E
6400EI / 5.0E
8000EI / 5.3E
10000EI / 5.7E
12800EI / 6.0E
16000EI / 6.3E
20000EI / 6.7E
25600EI / 7.0E
32000EI / 7.3E
40000EI / 7.7E
51200EI / 8.0E

Base ISO가 ISO 800으로
설정된 경우: 800EI / 6.0E
Base ISO가 ISO 12800으
로 설정된 경우: 12800EI /
6.0E

Exposure Index<L> 값을 설
정합니다.

Shockless Gain On / Off Off
충격 차단 게인 기능을 켜거
나 끕니다.

Base
Sensitivity

High / Low Low
Custom 모드의 기본 감도를
설정합니다.
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관련 항목

ISO/Gain 설정 및 기본값

5-041-958-23(1) Copyright 2022 Sony Corporation

항목 하위 항목 설정 공장 기본값 설명

Base ISO ISO 12800 / ISO 800 ISO 800
Cine EI/Flexible ISO 모드의
기본 ISO 감도를 설정합니다.
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ND Filter

ND 필터의 사전 설정 값을 설정합니다.

5-041-958-23(1) Copyright 2022 Sony Corporation

항목 하위 항목 설정 공장 기본값 설명

Mode Preset / Variable Variable ND 필터 모드를 선택합니다.

Preset1 1/4 / 1/8 / 1/16 / 1/32 / 1/64 / 1/128 1/4 ND 필터의 사전 설정 1 값을 설정합니다.

Preset2 1/4 / 1/8 / 1/16 / 1/32 / 1/64 / 1/128 1/16 ND 필터의 사전 설정 2 값을 설정합니다.

Preset3 1/4 / 1/8 / 1/16 / 1/32 / 1/64 / 1/128 1/64 ND 필터의 사전 설정 3 값을 설정합니다.
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Shutter

전자 셔터 작동을 설정합니다.
빠르게 움직이는 피사체를 선명하게 촬영할 때 사용합니다.

항목 하위 항목 설정 공장 기본값 설명

Mode Speed / Angle Speed
셔터 속도를 초 단위(Speed) 또
는 셔터 각도(Angle)로 설정하는
모드를 선택합니다.

Shutter
Speed
On/Off

On / Off Off

Speed 모드를 선택했을 때 노출
시간이 [Shutter Speed] 값을 따
를지, 아니면 전체 노출로 설정
할지를 지정합니다.

Shutter
Speed

64F~1/8000
사용 가능한 설정은 선택한 비디오 형식의 프레임 주
파수에 따라 달라집니다.
59.94P: 64F / 32F / 16F / 8F / 7F / 6F / 5F / 4F / 3F /
2F / 1/50 / 1/60 / 1/100 / 1/120 / 1/125 / 1/250 /
1/500 / 1/1000 / 1/2000 / 1/4000 / 1/8000
50P: 64F / 32F / 16F / 8F / 7F / 6F / 5F / 4F / 3F / 2F
/ 1/50 / 1/60 / 1/100 / 1/120 / 1/125 / 1/250 / 1/500 /
1/1000 / 1/2000 / 1/4000 / 1/8000
29.97P: 64F / 32F / 16F / 8F / 7F / 6F / 5F / 4F / 3F /
2F / 1/30 / 1/40 / 1/50 / 1/60 / 1/100 / 1/120 / 1/125 /
1/250 / 1/500 / 1/1000 / 1/2000 / 1/4000 / 1/8000
25P: 64F / 32F / 16F / 8F / 7F / 6F / 5F / 4F / 3F / 2F
/ 1/25 / 1/33 / 1/50 / 1/60 / 1/100 / 1/120 / 1/125 /
1/250 / 1/500 / 1/1000 / 1/2000 / 1/4000 / 1/8000
24P/23.98P: 64F / 32F / 16F / 8F / 7F / 6F / 5F / 4F /
3F / 2F / 1/24 / 1/32 / 1/48 / 1/50 / 1/60 / 1/96 / 1/100
/ 1/120 / 1/125 / 1/250 / 1/500 / 1/1000 / 1/2000 /
1/4000 / 1/8000

59.94P:
1/60
50P: 1/50
29.97P: 1/30
25P: 1/25
24P/23.98P:
1/24

Speed 모드가 선택되어 있을 경
우 셔터 속도를 설정합니다.

Shutter
Angle

64F / 32F / 16F / 8F / 7F / 6F / 5F / 4F / 3F / 2F /
360.0° / 300.0° / 270.0° / 240.0° / 216.0° / 210.0° /
180.0° / 172.8° / 150.0° / 144.0° / 120.0° / 90.0° /
86.4° / 72.0° / 45.0° / 30.0° / 22.5° / 11.25° / 5.6°

180.0°
Angle 모드가 선택되어 있을 경
우 셔터 각도를 설정합니다.

ECS On/Off On / Off Off
Extended Clear Scan 기능을 켜
거나 끕니다.
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항목 하위 항목 설정 공장 기본값 설명

ECS
Frequency

23.99 ~ 8000
사용 가능한 설정은 선택한 녹화 형식의 프레임 주파
수에 따라 달라집니다.

59.94P:
60.00
50P: 50.00
29.97P:
30.00
23.98P:
23.99
25P: 25.02
24P: 24.02

Mode가 ECS로 설정되었을 때
의 ECS 주파수를 설정합니다.
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Iris

조리개 설정을 지정합니다.

5-041-958-23(1) Copyright 2022 Sony Corporation

항목 하위 항목 설정 공장 기본값 설명

Bokeh Control On / Off Off 보케 제어 기능을 켜거나 끕니다.
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Auto Exposure

자동 노출 조정 설정을 지정합니다.

항목 하위 항목 설정
공장 기본

값
설명

Level

+3.0 / +2.75 / +2.5 / +2.25 / +2.0 / +1.75 / +1.5 /
+1.25 / +1.0 / +0.75 / +0.5 / +0.25 / ±0 / −0.25 /
−0.5 / −0.75 / −1.0 / −1.25 / −1.5 / −1.75 / −2.0 /
−2.25 / −2.5 / −2.75 / −3.0

±0
자동으로 감지된 노출의 밝기 수준을 설
정합니다.

Mode Backlight / Standard / Spotlight Standard

자동 노출 조정의 작동 모드를 설정합니
다.
Backlight: 백라이트 모드(피사체가 역
광을 받을 때 어두워지는 것을 줄이는
모드)
Standard: 표준 모드
Spotlight: 스포트라이트 모드(피사체
가 스포트라이트를 받을 때 더 하얗게
되는 부분을 줄이는 모드)

Speed −99~+99 ±0 자동 노출 조정의 조정 속도를 설정합니
다.

AGC On / Off Off
AGC(자동 게인 제어) 기능을 켜거나 끕
니다.

AGC Limit
설정에 관한 자세한 내용은 "AGC Limit 설정
및 기본값"을 참조하십시오. – AGC 기능의 최대 게인을 설정합니다.

AGC Point F2.8 / F4 / F5.6 F2.8
AGC 기능이 On일 때 AGC 작동을 시작
하는 조리개의 F-stop 값을 설정합니다.

Auto Shutter On / Off Off 자동 셔터 제어 기능을 켜거나 끕니다.

A.SHT Limit 1/100 / 1/150 / 1/200 / 1/250 / 1/2000 1/2000 자동 셔터 기능에서 가장 빠른 셔터 속
도를 설정합니다.

A.SHT Point F5.6 / F8 / F11 / F16 F11
자동 셔터 작동이 시작되는 조리개의 F-
stop 값을 설정합니다.

Clip High
light

On / Off Off
고휘도에서 더 평탄한 주파수 특성을 제
공하기 위해 가장 밝은 영역을 무시하는
기능을 켜거나 끕니다.

Detect
Window

1 / 2 / 3 / 4 / 5 / 6 / Custom 1

피사체의 밝기에 따라 노출을 자동으로
조정하기 위한 측광 범위를 설정합니다.
(노출을 수동으로 조정하는 경우에는
사용할 수 없음)
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관련 항목

AGC Limit 설정 및 기본값

5-041-958-23(1) Copyright 2022 Sony Corporation

항목 하위 항목 설정
공장 기본

값
설명

Detect
Window
Indication

On / Off Off 측광 범위 표시를 켜거나 끕니다.

Custom
Width

40~999 500 측광 범위 너비를 설정합니다.

Custom
Height

70~999 500 측광 범위 높이를 설정합니다.

Custom H
Position

−479~+479 ±0 측광 범위의 수평 위치를 설정합니다.

Custom V
Position

−464~+464 ±0 측광 범위의 수직 위치를 설정합니다.
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도움말 안내

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

White

화이트 밸런스 설정을 지정합니다.

5-041-958-23(1) Copyright 2022 Sony Corporation

항목 하위 항목 설정
공장 기
본값

설명

Preset
White

2000K~15000K 3200K 화이트 밸런스 사전 설정 값을 설정합니다.

Color Temp
<A>

2000K~15000K 3200K

메모리 A에 저장된 화이트 밸런스 색상 온도를 설정합니다.

참고 사항

Color Temp는 R Gain/B Gain 작동 중에 2000K 및 15000K로 클리핑되므로 R
Gain/B Gain 값에 대한 정확한 Color Temp 값을 표시하지 못할 수 있습니다.

Tint<A> −99~+99 ±0

흰색 메모리 A에 저장된 화이트 밸런스 색조 값을 설정합니다.

참고 사항

Tint는 R Gain/B Gain 작동 중에 +99로 클리핑되므로 R Gain/B Gain 값에 대
한 정확한 색조 값을 표시하지 못할 수 있습니다.

R Gain <A> −99.0~+99.0 ±0.0 메모리 A에 저장된 화이트 밸런스 R 게인 값을 설정합니다.

B Gain <A> −99.0~+99.0 ±0.0 메모리 A에 저장된 화이트 밸런스 B 게인 값을 설정합니다.
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도움말 안내

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

White Setting

화이트 밸런스 설정을 조정합니다.

5-041-958-23(1) Copyright 2022 Sony Corporation

항목
하위 항목 설

정
공장 기본

값
설명

Shockless
White

Off / 1 / 2 / 3 2

화이트 밸런스 모드로 전환할 때 화이트 밸런스 응답 속도를 설정합니
다.
Off: 즉시 전환됩니다.
1~3: 숫자가 클수록 더 느리게 전환됩니다.

ATW Speed 1 / 2 / 3 / 4 / 5 3
ATW 모드에서 응답 속도를 설정합니다.
가장 빠른 응답 속도는 1이고 가장 느린 응답 속도는 5입니다.
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도움말 안내

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Offset White

화이트 밸런스 오프셋 설정을 지정합니다.

5-041-958-23(1) Copyright 2022 Sony Corporation

항목
하위 항목
설정

공장 기
본값

설명

Offset White <A> On / Off Off
메모리 A에서 화이트 밸런스에 오프셋 값을 추가할지(On), 아니면 추
가하지 않을지를(Off) 선택합니다.

Offset Color
Temp<A>

−99~+99 ±0
[Offset White <A>]가 On으로 설정된 경우 메모리 A의 화이트 밸런스
에 추가할 색온도 오프셋을 설정합니다.

Offset Tint<A> −99~+99 ±0
[Offset White <A>]가 On으로 설정된 경우 메모리 A의 화이트 밸런스
에 추가할 색조 값 오프셋을 설정합니다.

Offset White<ATW> On / Off On
ATW 화이트 밸런스에 오프셋 값을 추가할지(On), 아니면 추가하지 않
을지를(Off) 선택합니다.

Offset Color
Temp<ATW>

−99~+99 ±0
[Offset White<ATW>]가 On으로 설정된 경우 ATW 화이트 밸런스에 추
가할 색온도 오프셋을 설정합니다.

Offset Tint<ATW> −99~+99 ±0
[Offset White<ATW>]가 On으로 설정된 경우 ATW 화이트 밸런스에 추
가할 색조 값 오프셋을 설정합니다.
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도움말 안내

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Focus

초점 설정을 지정합니다.

관련 항목

자동 초점 영역/위치 설정(Focus Area)

얼굴 및 눈 감지를 사용하여 추적하기(Face/Eye Detection AF)

항목 하위 항목 설정 공장 기본값 설명

AF Transition
Speed

1(Slow) / 2 / 3 / 4 / 5 /
6 / 7(Fast)

5
자동 초점 중에 피사체가 변경될 때 초점 구동 속도를 설정
합니다.

AF Subj. Shift
Sens.

1(Locked On) / 2 / 3 /
4 / 5(Responsive)

5(Responsive)
자동 초점 중에 피사체 초점 변경에 대한 감도를 설정합니
다.

Focus Area
Wide / Zone / Flexible
Spot

Wide

자동 초점 및 푸시 자동 초점(AF) 의 대상 영역을 설정합니
다.

"초점을 자동으로 조정(Auto Focus)" 및 "자동 초점 영
역/위치 설정(Focus Area)"을 참조하십시오.

Wide: 초점을 맞출 때 이미지의 광각에서 피사체를 검색합
니다.
Zone: 지정된 존 내에서 초점 포인트를 자동으로 검색합니
다.
Flexible Spot: 이미지에서 지정된 위치에 초점을 맞춥니
다.

Focus Area
(AF-S)

Flexible Spot Flexible Spot 푸시 자동 초점(AF-S)의 대상 영역을 설정합니다.

Face/Eye
Detection AF

Face/Eye Only AF /
Face/Eye Priority AF /
Off

Face/Eye
Priority AF

얼굴 인식 AF를 활성화하거나 비활성화합니다.

"얼굴 및 눈 감지를 사용하여 추적하기(Face/Eye
Detection AF)"를 참조하십시오.

Push AF
Mode

AF / Single-shot
AF(AF-S)

AF 푸시 자동 초점 모드를 설정합니다.

Touch
Function in
MF

Tracking AF / Spot
Focus

Tracking AF
MF 모드의 웹 앱 라이브 작동 화면에서 카메라 이미지를
터치했을 때의 작동을 설정합니다.

AF Assist On / Off On

On으로 설정되면 자동 초점이 일시적으로 무시되어 초점
을 수동으로 설정할 수 있습니다.

"웹 앱을 사용하여 수동으로 자동 초점 대상 설정(AF
Assist)" 및 "제공된 적외선 리모컨을 사용하여 자동 초
점 중 수동으로 초점 맞추기"를 참조하십시오.
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웹 앱을 사용하여 수동으로 자동 초점 대상 설정(AF Assist)

제공된 적외선 리모컨을 사용하여 자동 초점 중 수동으로 초점 맞추기

5-041-958-23(1) Copyright 2022 Sony Corporation
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도움말 안내

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

S&Q Motion

Slow & Quick Motion 모드 설정을 지정합니다( "Slow & Quick Motion" 참조).

관련 항목

Slow & Quick Motion

5-041-958-23(1) Copyright 2022 Sony Corporation

항목 하위 항목 설정
공장 기
본값

설명

Setting On / Off Off Slow & Quick Motion 모드를 켜거나 끕니다.

Frame
Rate

1fps~60fps / 100fps / 120fps / 150fps /
180fps / 200fps / 240fps

–

Slow & Quick Motion 촬영의 프레임 속도를 설정합
니다.

참고 사항

사용 가능한 설정은 선택한 시스템 주파수, 코덱
및 비디오 형식에 따라 달라집니다.
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도움말 안내

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

LUT On/Off

LUT 설정을 지정합니다.

5-041-958-23(1) Copyright 2022 Sony Corporation

항목 하위 항목 설정 공장 기본값 설명

SDI MLUT On / MLUT Off MLUT Off
SDI 출력 비디오에 Monitor LUT 적용 여부를 선
택합니다.

HDMI/Stream MLUT On / MLUT Off MLUT Off
HDMI 및 스트리밍 출력 비디오에 Monitor LUT
적용 여부를 선택합니다.

Proxy MLUT On / MLUT Off MLUT Off
프록시 녹화 영상에 모니터 LUT 적용 여부를 선
택합니다.

Internal Rec MLUT On / MLUT Off MLUT Off 메인 녹화 비디오에 Monitor LUT 적용 여부를
선택합니다.

LUT On/Off Button
Target

SDI / HDMI/Stream / SDI &
HDMI/Stream

HDMI/Stream
LUT On/Off가 할당된 할당 가능 버튼으로 제어
되는 대상 출력을 설정합니다.
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도움말 안내

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Noise Suppression

노이즈 억제 설정을 지정합니다.

힌트

[Setting(Custom)] 및 [Level(Custom)] 설정은 [Target Display] 설정에 반영되어 있습니다.

5-041-958-23(1) Copyright 2022 Sony Corporation

항목 하위 항목 설정 공장 기본값 설명

Setting(Custom) On / Off On Custom 모드에서 노이즈 억제 기능을 켜거나 끕니다.

Level(Custom) Low / Mid / High Mid Custom 모드에서 노이즈 억제 레벨을 설정합니다.

Setting (Cine EI/Flex. ISO) On / Off Off 로그 촬영 모드에서 노이즈 억제 기능을 켜거나 끕니다.

Level (Cine EI/Flex. ISO) Low / Mid / High Mid 로그 촬영 모드에서 노이즈 억제 레벨을 설정합니다.
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도움말 안내

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Flicker Reduce

깜박임 보정 설정을 지정합니다.

5-041-958-23(1) Copyright 2022 Sony Corporation

항목 하위 항목 설정 공장 기본값 설명

Mode Auto / On / Off Off 깜박임 보정 모드를 설정합니다.

Frequency 50Hz / 60Hz 60Hz 깜박임을 유발하는 조명에 전원을 공급하는 주파수를 설정합니다.
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도움말 안내

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

SteadyShot

손떨림 보정 설정을 지정합니다.
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항목 하위 항목 설정
공장 기본

값
설명

Setting
Active / Standard /
Off

Off

손떨림 보정 기능을 설정합니다.

참고 사항

호환되는 렌즈가 부착된 경우 활성화됩니다.

Active 또는 Standard로 설정된 경우 팬/틸트 작업 중에 예기치 않은 동작이
발생할 수 있습니다.

303



도움말 안내

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Base Setting

기본 설정을 지정합니다.

관련 항목

기본 작동 구성
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항목 하위 항목 설정 공장 기본값 설명

Shooting
Mode

Custom / Flexible ISO / Cine EI Quick /
Cine EI

Custom

촬영 모드를 설정합니다.

"기본 작동 구성"의 "촬영 모드 설정"을 참
조하십시오.

Target
Display

SDR(BT.709) / HDR(HLG) SDR(BT.709)
Custom 모드에서 녹화/출력의 색공간을 설정
합니다.
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도움말 안내

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Rec Format

녹화 형식 설정을 지정합니다.

[RAW Output Format] 설정

기본값은 굵은 글씨로 표시됩니다.
[RAW Output Format]을 설정할 수 없는 조건이 생략되었습니다.

[Video Format] 설정

항목 하위 항목 설정
공장 기
본값

설명

Frequency 59.94 / 50 / 29.97 / 25 / 24 / 23.98 59.94 시스템 주파수를 선택합니다.

Imager Scan
Mode

FF / S35 FF 이미저 크기를 선택합니다.

Codec
RAW / RAW & XAVC-I / XAVC-I /
XAVC-L

XAVC-I

클립 녹화/재생 코덱을 설정합니다.

참고 사항

[Imager Scan Mode]가 [S35]으로 설정된 경우,
[RAW] 및 [RAW & XAVC-I]를 선택할 수 없습니
다.

RAW Output
Format

사용 가능한 설정은 [Frequency] 설정에
따라 다릅니다.

아래의 "[RAW Output Format] 설
정"을 참조하십시오.

–

외부 RAW 레코더로 출력할 RAW 이미지의 크기
를 설정합니다.

참고 사항

[Codec]이 [RAW & XAVC-I]로 설정된 경우,
[Video Format] 설정이 [RAW Output Format]
설정과 연동되어 전환됩니다.

Video Format

사용 가능한 설정은 [Frequency],
[Imager Scan Mode] 및 [Codec] 설정에
따라 다릅니다.

아래의 "[Video Format] 설정"을 참
조하십시오.

– 이미지 크기와 비트 전송률을 설정합니다.

Frequency Imager Scan Mode Codec 설정

59.94 / 50 / 29.97 / 25 / 23.98 FF RAW / RAW & XAVC-I
4096×2160
3840×2160

24 FF RAW / RAW & XAVC-I 4096×2160
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기본값은 굵은 글씨로 표시됩니다.

5-041-958-23(1) Copyright 2022 Sony Corporation

Frequency Imager Scan Mode Codec 설정

59.94 / 50 / 29.97 / 25 / 23.98

FF

RAW –

RAW & XAVC-I
4096×2160P
3840×2160P

XAVC-I
4096×2160P
3840×2160P
1920×1080P

XAVC-L
3840×2160P
1920×1080P 50
1920×1080P 35

S35

XAVC-I 1920×1080P

XAVC-L
1920×1080P 50
1920×1080P 35

24 FF
RAW –

RAW & XAVC-I / XAVC-I 4096×2160P
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도움말 안내

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Cine EI/Flex.ISO Set

로그 촬영 모드 설정을 지정합니다("기본 작동 구성"의 "촬영 모드 설정" 참조).

관련 항목

기본 작동 구성

5-041-958-23(1) Copyright 2022 Sony Corporation

항목 하위 항목 설정 공장 기본값 설명

Color
Gamut

S-Gamut3/SLog3 / S-
Gamut3.Cine/SLog3

S-
Gamut3.Cine/SLog3

로그 촬영 모드([Flexible ISO], [Cine EI Quick],
[Cine EI])에 대한 색공간을 설정합니다.

Embed
LUT File

On / Off On
3D LUT 파일(CUBE 파일) 메타데이터 녹화를
켜거나 끕니다.
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도움말 안내

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Simul Rec

2슬롯 동시 녹화 모드 설정을 지정합니다("메모리 카드 A 및 B에 동시에 녹화(2-slot Simul Rec)" 참조).
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항목 하위 항목 설정 공장 기본값 설명

Setting On / Off Off
2슬롯 동시 녹화 모드
를 켜거나 끕니다.

Rec
Button
Set

Rec Button:<Slot A> <Slot B> 2nd Rec Button:<Slot A>
<Slot B> / Rec Button:<Slot A> 2nd Rec Button:<Slot
B> / Rec Button:<Slot B> 2nd Rec Button:<Slot A>

Rec Button:<Slot A>
<Slot B> 2nd Rec
Button:<Slot A> <Slot B>

각 녹화 매체를 제어
하는 데 사용되는 녹
화 버튼을 할당합니
다.
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도움말 안내

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Proxy Rec

프록시 녹화 모드 설정을 지정합니다("프록시 녹화" 참조).
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항목 하위 항목 설정 공장 기본값 설명

Setting On / Off Off 프록시 녹화 모드를 켜거나 끕니다.

Audio Channel CH1/CH2 / CH3/CH4 CH1/CH2 프록시 데이터로 녹음할 오디오 채널을 선택합니다.
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Interchangeable Lens Digital Camera
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Interval Rec

간격 녹화 모드를 설정합니다("간헐적으로 비디오 녹화(Interval Rec)" 참조).

5-041-958-23(1) Copyright 2022 Sony Corporation

항목 하위 항목 설정 공장 기본값 설명

Setting On / Off Off

간격 녹화 모드를 켜거나 끕니다.
(이 모드를 On으로 설정하면 다른
모든 특수 모드가 Off로 설정됩니
다.)

Interval
Time

1 / 2 / 3 / 4 / 5 / 6 / 7 / 8 / 9 / 10 / 15 /
20 / 30 / 40 / 50 (초)
1 / 2 / 3 / 4 / 5 / 6 / 7 / 8 / 9 / 10 / 15 /
20 / 30 / 40 / 50 (분)
1 / 2 / 3 / 4 / 6 / 12 / 24 (시간)

1
Interval Rec 녹화 모드에서 녹화
사이 간격을 설정합니다(Interval
Rec가 On으로 설정된 경우).

Number of
Frames

1frame / 2frames / 3frames / 6frames /
9frames / 12frames
사용 가능한 설정은 선택한 비디오 형
식의 프레임 주파수에 따라 다릅니다.
59.94P/50P: 2frames / 6frames /
12frames
29.97P/25P/24P/23.98P: 1frame /
3frames / 6frames / 9frames

59.94P/50P: 2frames
29.97P/25P/24P/23.98P:
1frame

Interval Rec 녹화 모드에서 촬영당
녹화할 프레임 수를 설정합니다
(Interval Rec가 On으로 설정된 경
우).
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Picture Cache Rec

픽쳐 캐시 녹화 모드 설정을 지정합니다("픽처 캐시 녹화(Picture Cache Rec)" 참조).

관련 항목

픽처 캐시 녹화(Picture Cache Rec)

5-041-958-23(1) Copyright 2022 Sony Corporation

항목 하위 항목 설정
공장 기본

값
설명

Setting On / Off Off 픽쳐 캐시 기능을 켜거나 끕니다.

Cache Size
Short / Medium / Long /
Max

Max
픽처 캐시 메모리에서 이미지의 누적 시간을 설정합니다(픽처
캐시 녹화 시간).

Cache Rec
Time

– –
픽처 캐시 메모리에서 이미지의 누적 시간을 표시합니다(픽처
캐시 녹화 시간).
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SDI/HDMI Rec Control

SDI/HDMI 녹화 제어 설정을 지정합니다.

5-041-958-23(1) Copyright 2022 Sony Corporation

항목 하위 항목 설정
공장
기본
값

설명

Setting
Off / SDI/HDMI
Remote I/F / Parallel
Rec

Off

SDI/HDMI 출력 신호를 통한 외부 연결 장치의 녹화 시작/중지 제어를 설정
합니다.
Off: 리모컨을 사용하지 않습니다.
SDI/HDMI Remote I/F: 기기에 삽입된 매체가 없을 때 외부 연결 장치의 녹
화 중지/시작을 제어합니다. 기기의 매체에 대한 프레임 정확도와 동기화되
지 않습니다.
Parallel Rec: 기기에 매체가 삽입될 때 외부 연결 장치의 녹화 중지/시작을
제어합니다. 기기의 매체에 대한 프레임 정확도와 동기화됩니다.

참고 사항

HDMI 출력 신호를 사용하여 제어하려면 카메라 메뉴에서 [TC/Media] >
[HDMI TC Out] > [Setting]을 [On]으로 설정합니다.
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Assignable Button

할당 가능 버튼(<1>~<9>) 및 [Focus Hold Button]으로의 기능 할당을 설정합니다.
다음 기능을 할당할 수 있습니다.
[Off]: 기능 할당이 없습니다.
[Base ISO/Sensitivity]: 이미지 센서의 기본 감도를 전환합니다.
[AGC]: AGC 기능을 켜거나 끕니다.
[Push AGC]: 버튼을 누르는 동안 AGC 기능을 활성화합니다.
[ND Filter]

가변 모드에서: ND 필터 투과율을 조정합니다. 길게 눌러 Clear/Manual/Auto 사이를 전환합니다.
사전 설정 모드에서: 길게 눌러 사전 설정을 전환합니다.

[ND Filter Position]: ND 필터를 전환합니다.
[Auto ND Filter]: 자동 ND 필터 기능을 켜거나 끕니다.
[Push Auto ND]: 버튼을 누르는 동안 자동 ND 필터 기능을 활성화합니다.
[Auto Iris]: 조리개 기능을 켜거나 끕니다.
[Push Auto Iris]: 버튼을 누르는 동안 자동 조리개 기능을 활성화합니다.
[Bokeh Control]: 보케 제어 모드를 켜거나 끕니다.
[Auto Shutter]: 자동 셔터 기능을 켜거나 끕니다.
[AE Level/Mode]: AE 레벨을 조정합니다. 길게 눌러 AE 모드를 전환합니다.
[Backlight]: Backlight 및 Standard 사이를 전환합니다.
[Spotlight]: Spotlight 및 Standard 사이를 전환합니다.
[Preset White Select]: 화이트 밸런스 사전 설정 모드 값을 전환합니다.
[ATW]: ATW 기능을 켜거나 끕니다.
[ATW Hold]: ATW 기능 작동을 일시 정지합니다.
[AF Speed/Sens.]: AF 전환 속도 설정 및 AF 피사체 이동 감도를 전환합니다.
[Focus Setting]: 초점 영역을 설정합니다.
[Face/Eye Detection AF]: 얼굴 감지 AF 설정을 전환합니다.
[Push AF Mode]: Push AF 모드 설정을 전환합니다.
[Push AF/MF]: MF 초점 모드에서 버튼을 누르는 동안 AF를 활성화합니다. AF 초점 모드에서 버튼을 누르는 동안 MF를
활성화합니다.
[Focus Hold]: AF 초점 모드에서 버튼을 누르는 동안 초점이 고정됩니다.
[S&Q Motion]: Slow & Quick Motion 기능을 켜거나 끕니다. 계속 누르면 촬영 프레임 속도를 설정합니다.
[LUT On/Off]: LUT 기능을 켜거나 끕니다. 전환 대상은 [Shooting] > [LUT On/Off] > [LUT On/Off Button Target]을 사용하
여 설정됩니다.
[SteadyShot]: Active, Standard 및 Off 사이를 전환합니다.
[Crop Select]: Imager Scan Mode를 전환합니다. 녹화 형식을 변경하지 않고 범위 내에서 전환이 활성화됩니다.
[Rec]: 녹화를 시작하거나 중지합니다.
[Picture Cache Rec]: 픽처 캐시 녹화 모드를 켜거나 끕니다.
[Rec Review]: 녹화 검토 기능을 켜거나 끕니다.
[Clip Flag OK]: Add OK를 실행합니다. 두 번 눌러 Delete Clip Flag를 실행합니다.
[Clip Flag NG]: Add NG를 실행합니다. 두 번 눌러 Delete Clip Flag를 실행합니다.
[Clip Flag Keep]: Add KEEP를 실행합니다. 두 번 눌러 Delete Clip Flag를 실행합니다.
[Slot Select]: 메모리 슬롯(A)와 (B) 사이를 전환합니다.
[Color Bars]: 컬러 바를 켜거나 끕니다.
[DURATION/TC/U-BIT]: Time Code, Users Bit 및 Duration 사이를 전환합니다.
[Display]: 화면 표시등을 켜거나 끕니다.
[Lens Info]: 피사체 심도 표시를 전환합니다.
[Video Signal Monitor]: 비디오 신호 모니터(예: 파형 모니터)를 전환합니다.
[Marker]: 마커 기능을 켜거나 끕니다.
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[Thumbnail]: 썸네일 화면을 표시하거나 종료합니다.
[Auto Upload (Proxy)]: 프록시 파일 자동 전송을 켜거나 끕니다.
[Direct Menu]: 다이렉트 메뉴를 표시하거나 종료합니다.
[User Menu]: User 메뉴를 표시하거나 종료합니다.

5-041-958-23(1) Copyright 2022 Sony Corporation
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Scene File

장면 파일과 관련된 설정을 지정합니다("원하는 보기로 촬영" 참조).

5-041-958-23(1) Copyright 2022 Sony Corporation

항목 하위 항목 설정
공장
기본
값

설명

Recall – –
내부 메모리에 저장된 장면 파일을
로드하고 설정을 현재 이미지 품질
설정으로 적용합니다.

Store – –
현재 이미지 품질 상태를 내부 메모
리에 장면 파일로 저장합니다.

Delete – –
내부 메모리에 저장된 장면 파일을
삭제합니다.

Preset
Recall

Shooting Mode가 Custom으로 설정되고 Target Display
가 SDR(BT.709)로 설정된 경우: S-Cinetone / Standard /
Still / ITU709/ 709tone
Shooting Mode가 Custom으로 설정되고 Target Display
가 HDR(HLG)로 설정된 경우: HLG Live / HLG Natural

–
사전 설정 이미지 품질 설정(다시 쓸
수 없음)을 현재 이미지 품질 설정으
로 적용합니다.
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Base Look

기본 보기와 관련된 설정을 지정합니다.

5-041-958-23(1) Copyright 2022 Sony Corporation

항목 하위 항목 설정 공장 기본값 설명

Select

Shooting Mode가 Custom으로 설정되고
Target Display가 SDR(BT.709)로 설정된 경
우: S-Cinetone / Standard / Still / ITU709 /
709tone / User1 ~ User16
Shooting Mode가 Custom으로 설정되고
Target Display가 HDR(HLG)로 설정된 경우:
HLG Live / HLG Natural / User1 ~ User16
Shooting Mode가 로그 촬영 모드로 설정된 경
우: s709 / 709(800) / S-Log3 / User1 ~ User16

Shooting Mode가 Custom으로 설
정되고 Target Display가
SDR(BT.709)로 설정된 경우: S-
Cinetone
Shooting Mode가 Custom으로 설
정되고 Target Display가
HDR(HLG)로 설정된 경우: HLG
Live
Shooting Mode가 로그 촬영 모드로
설정된 경우: s709

기본 보기를 선택합
니다.

Delete – –
선택된 기본 보기를
삭제합니다.

Delete
All

– –
모든 기본 보기를
삭제합니다.

Input S-Gamut3/SLog3 / S-Gamut3.Cine/SLog3 S-Gamut3.Cine/SLog3

[Select]를 사용하여
선택한 기본 보기의
입력 영역을 설정합
니다.

Output BT.709 / HLG BT.709

[Select]를 사용하여
선택한 기본 보기의
출력 색상 영역을
설정합니다.

AE
Level
Offset

0EV / 1/3EV / 2/3EV / 1EV / 4/3EV / 5/3EV /
2EV

0EV

[Select]를 사용하여
선택한 기본 보기의
노출 기준 값을 설
정합니다.
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Reset Paint Settings

기본 보기를 제외하고 [Paint/Look] 메뉴 설정을 재설정합니다.

5-041-958-23(1) Copyright 2022 Sony Corporation

항목 하위 항목 설정
공장 기본

값
설명

Reset without Base
Look

Execute /
Cancel

–
기본 보기를 제외하고 [Paint/Look] 메뉴 설정을 재설정합니
다.
Execute: 기능을 실행합니다.
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Black

검정 설정을 지정합니다.

5-041-958-23(1) Copyright 2022 Sony Corporation

항목 하위 항목 설정 공장 기본값 설명

Master Black −99.0~+99.0 ±0.0 마스터 검정 레벨을 설정합니다.

R Black −99.0~+99.0 ±0.0 R 검정 레벨을 설정합니다.

B Black −99.0~+99.0 ±0.0 B 검정 레벨을 설정합니다.
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Knee

Knee 보정 설정을 지정합니다.

5-041-958-23(1) Copyright 2022 Sony Corporation

항목 하위 항목 설정 공장 기본값 설명

Setting

Target Display가
SDR(BT.709)로 설정된 경
우: On / Off / ---
Target Display가
HDR(HLG)로 설정된 경우:
On / Off / ---

Target Display가
SDR(BT.709)로 설정된
경우: Off
Target Display가
HDR(HLG)로 설정된 경
우: Off

Knee 보정 기능을 켜거나 끕니다.

참고 사항

[Base Look] > [Select]가 [Standard], [ITU709],
[709tone], [HLG Live] 또는 [HLG Natural]로 설
정된 경우에만 활성화됩니다.

Auto
Knee

Target Display가
SDR(BT.709)로 설정된 경
우: On / Off / ---
Target Display가
HDR(HLG)로 설정된 경우:
On / Off / ---

Target Display가
SDR(BT.709)로 설정된
경우: On
Target Display가
HDR(HLG)로 설정된 경
우: Off

자동 Knee 기능을 켜거나 끕니다.

참고 사항

[Base Look] > [Select]가 [Standard], [ITU709]
또는 [709tone]으로 설정된 경우에만 활성화됩
니다.

Point 75% ~ 109% 90% Knee 포인트를 설정합니다.

Slope −99~+99 ±0 Knee 경사를 설정합니다.
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Detail

세부적인 조정 설정을 지정합니다.

5-041-958-23(1) Copyright 2022 Sony Corporation

항목 하위 항목 설정
공장 기
본값

설명

Setting On / Off On 세부적인 기능을 켜거나 끕니다.

Level −7~+7 ±0 세부적인 레벨을 설정합니다.

Manual
Setting

On / Off / --- Off 세부적인 수동 조정 기능을 켜거나 끕니다.

H/V Ratio −2~+2 ±0

세부적인 수동 조정을 위해 수평(H) 세부 정보와 수직(V) 세부 정보
사이의 균형을 설정합니다.

참고 사항

이 항목은 소프트웨어 버전에 따라 다릅니다.*1

B/W Balance
Type1 / Type2 /
Type3 / Type4 /
Type5

Type3
세부적인 수동 조정을 위해 저휘도 영역용 검정(B) 세부 정보 및 고
휘도 영역용 흰색(W) 세부 정보 사이의 균형을 설정합니다.

Limit 0~7 7 세부적인 수동 조정을 위한 세부 정보 제한 레벨을 설정합니다.

Crispening 0~7 0 세부적인 수동 조정을 위한 주름 레벨을 설정합니다.

High Light
Detail 0~4 0

세부적인 수동 조정을 위한 고휘도 영역의 세부 정보 레벨을 설정합
니다.

소프트웨어 버전 1.00에서 메뉴 항목은 [V/H Balance]입니다. 소프트웨어 버전 1.10 이상에서 메뉴 항목은 [H/V Ratio]입니다. 설정 범위는 -2 ~ 0
에서 +2로 변경되지 않았지만 이미지 품질에 미치는 영향은 다릅니다.
소프트웨어 버전 1.00: 설정 값이 높을수록 수평(H) 세부 정보가 높습니다.
소프트웨어 버전 1.10 이상: 설정 값이 높을수록 수직(V) 세부 정보가 높습니다.
소프트웨어 버전 1.00에서 1.10 이상으로 업데이트한 후 [All File], [Scene File] 및 기타 설정은 상속되지만 극성은 반전됩니다(사진 품질은 유지
됨).
[User] 메뉴에 [V/H Balance] 메뉴 항목을 등록한 경우 소프트웨어 업데이트 후 자동으로 [User] 메뉴의 [H/V Ratio] 메뉴 항목으로 대체됩니다.

*1

320



도움말 안내

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Matrix

매트릭스 보정 설정을 지정합니다.

5-041-958-23(1) Copyright 2022 Sony Corporation

항목 하위 항목 설정 공장 기본값 설명

User Matrix On / Off Off 사용자 매트릭스 보정 기능을 켜거나 끕니다.

User Matrix Level −99~+99 ±0 전체 이미지의 채도를 조정합니다.

User Matrix Phase −99~+99 ±0 전체 이미지의 색조(위상)를 조정합니다.

User Matrix R-G −99~+99 ±0 사용자 정의 R-G 사용자 매트릭스를 설정합니다.

User Matrix R-B −99~+99 ±0 사용자 정의 R-B 사용자 매트릭스를 설정합니다.

User Matrix G-R −99~+99 ±0 사용자 정의 G-R 사용자 매트릭스를 설정합니다.

User Matrix G-B −99~+99 ±0 사용자 정의 G-B 사용자 매트릭스를 설정합니다.

User Matrix B-R −99~+99 ±0 사용자 정의 B-R 사용자 매트릭스를 설정합니다.

User Matrix B-G −99~+99 ±0 사용자 정의 B-G 사용자 매트릭스를 설정합니다.
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Multi Matrix

멀티 매트릭스 보정 설정을 지정합니다.

5-041-958-23(1) Copyright 2022 Sony Corporation

항목 하위 항목 설정
공장 기
본값

설명

Setting On / Off Off
멀티 매트릭스 보정 기능을 켜거나 끕
니다.

Reset Execute / Cancel –
각 축 색상의 색조와 채도를 기본값으
로 재설정합니다.

Axis
B / B+ / MG− / MG / MG+ / R / R+ / YL− / YL / YL+ /
G− / G / G+ / CY / CY+ / B−

B 축을 선택합니다.

Hue −99~+99 ±0
멀티 매트릭스 보정에 사용되는 색상
의 색조를 설정합니다.

Saturation −99~+99 ±0
멀티 매트릭스 보정에 사용되는 색상
의 채도를 설정합니다.
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P/T Acceleration

팬/틸트 작동의 가속과 관련된 설정을 지정합니다.

5-041-958-23(1) Copyright 2022 Sony Corporation

항목
하위 항목 설

정
공장 기본

값
설명

Ramp
Curve

1~9 8
팬/틸트 작동의 가속/감속을 선택합니다. 숫자가 클수록 가속이 높아집니
다.
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Timecode

타임코드 설정을 지정합니다.

5-041-958-23(1) Copyright 2022 Sony Corporation

항목 하위 항목 설정 공장 기본값 설명

Mode Preset / Regen / Clock Preset

타임코드 실행 모드를 설정합니다.
Preset: 사전 설정 값에서 실행을 시작합니다.
Regen: 이전 클립의 종료 타임코드에서 실행을 시작합니다.
Clock: 내부 시계를 타임코드로 사용합니다.

Run Rec Run / Free Run Rec Run
Rec Run: 녹화 시에만 실행됩니다.
Free Run: 녹화 작동에 관계 없이 항상 실행됩니다.

Setting – – 타임코드를 임의의 값으로 설정합니다.
Set: 값을 설정합니다.

Reset Execute / Cancel –
타임코드를 00:00:00:00으로 재설정합니다.
Execute: 기능을 실행합니다.

TC Format DF / NDF DF
타임코드 형식을 설정합니다.
DF: 드롭 프레임
NDF: 비 드롭 프레임
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Interchangeable Lens Digital Camera
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TC Display

시간 데이터 표시 설정을 지정합니다.

5-041-958-23(1) Copyright 2022 Sony Corporation

항목 하위 항목 설정 공장 기본값 설명

Display Select Timecode / Users Bit / Duration Timecode 시간 데이터 표시를 전환합니다.
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Interchangeable Lens Digital Camera
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Users Bit

사용자 비트와 관련된 설정을 지정합니다.

5-041-958-23(1) Copyright 2022 Sony Corporation

항목 하위 항목 설정 공장 기본값 설명

Mode Fix / Time Fix
사용자 비트 모드를 설정합니다.
Fix: 사용자 비트에 임의의 고정 값을 사용합니다.
Time: 사용자 비트에 현재 시, 분, 초를 사용합니다.

Setting – – 사용자 비트를 임의의 값으로 설정합니다.
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도움말 안내
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HDMI TC Out

HDMI를 사용할 때 타임코드 출력과 관련된 설정을 지정합니다.

5-041-958-23(1) Copyright 2022 Sony Corporation

항목
하위 항목 설

정
공장 기본

값
설명

Setting On / Off Off
HDMI를 사용하여 다른 목적으로 장치에 타임코드를 출력할지 여부를 설정합
니다.
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Interchangeable Lens Digital Camera
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Clip Name Format

클립 이름 지정 및 삭제와 관련된 설정을 지정합니다.
[Auto Naming]이 [Cam ID + Reel#]로 설정된 경우 각 녹화 매체 대해 클립 이름의 처음 4자가 결정됩니다. 새 녹화 매체가
삽입되거나 녹화 매체의 마지막 클립이 [Camera ID] 또는 [Reel Number] 설정과 일치하지 않는 경우 클립 이름이 깜박여
이를 알려줍니다.
[Auto Naming]을 [Title]로 설정하면 임의의 문자열을 클립 이름의 첫 번째 부분으로 사용할 수 있습니다.

항목 하위 항목 설정
공장 기
본값

설명

Auto
Naming

Cam ID + Reel# / Title

클립 이름 지정 형식을 선택합니다.
Cam ID + Reel#: 카메라 ID + 릴 번호 + 촬영 번호 + 날짜 + 임의
문자열
Title: [Title Prefix] + 클립 번호로 지정된 임의 문자열

Camera ID A~Z A

클립 이름을 생성할 때 사용되는 카메라 ID를 설정합니다.

참고 사항

[Auto Naming]이 [Cam ID + Reel#]로 설정된 경우에만 구성 가능
합니다.

Reel
Number

001~999 001

클립 이름을 생성할 때 사용되는 릴 번호 부분을 설정합니다.

참고 사항

[Auto Naming]이 [Cam ID + Reel#]로 설정된 경우에만 구성 가능
합니다.

Camera
Position C / L / R C

클립 이름을 생성할 때 사용되는 촬영 번호의 첫 번째 문자 부분
을 설정합니다.

참고 사항

[Auto Naming]이 [Cam ID + Reel#]로 설정된 경우에만 구성 가능
합니다.

Title Prefix
nnn_(nnn은 일련 번호의
마지막 세 자리)
(최대 7자리 표시)

nnn

클립 이름의 제목 부분(4~46자)을 설정합니다.
문자열 입력 화면을 엽니다.

제목 설정 및 문자 입력 화면에 대한 자세한 내용은 아래의
"제목을 설정하려면" 및 "문자열 입력"을 참조하십시오.

참고 사항

[Auto Naming]이 [Title]로 설정된 경우에만 구성 가능합니다.
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[Title Prefix]를 설정하려면

관련 항목

문자열 입력

5-041-958-23(1) Copyright 2022 Sony Corporation

항목 하위 항목 설정
공장 기
본값

설명

Number Set 0001~9999 0001

클립 이름의 4자리 숫자 접미사를 설정합니다.

참고 사항

[Auto Naming]이 [Title]로 설정된 경우에만 구성 가능합니다.

GUI 제어 패널의 화살표 버튼을 이용하여 문자 선택 영역에서 [Title Prefix] 영역의 커서 위치에 삽입할 문자를 선택
하고(문자가 강조 표시됨) GUI 제어 패널의 [Set] 버튼을 누릅니다.

선택한 문자가 삽입되고 커서가 오른쪽으로 이동합니다.

1

1단계를 반복하여 제목을 설정합니다.

필요에 따라 [BS]를 사용합니다.

2

제목을 설정한 후 [Done] 버튼을 눌러 문자 입력 화면을 닫습니다.

문자 입력 화면에서의 조작에 대한 자세한 내용은 "문자열 입력"을 참조하십시오.

다음 문자를 선택할 수 있습니다.
!#$%()+,-.;=@[ ]^_~ 공백
0123456789
abcdefghijklmnopqrstuvwxyz
ABCDEFGHIJKLMNOPQRSTUVWXYZ

3
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Update Media

메모리 카드에서 관리 파일을 업데이트합니다("메모리 카드 복원" 참조).

관련 항목

메모리 카드 복원

5-041-958-23(1) Copyright 2022 Sony Corporation

항목 하위 항목 설정 공장 기본값 설명

Media(A) Execute / Cancel –
슬롯 A의 메모리 카드에서 관리 파일을 업데이트합니다.
Execute: 기능을 실행합니다.

Media(B) Execute / Cancel –
슬롯 B의 메모리 카드에서 관리 파일을 업데이트합니다.
Execute:기능을 실행합니다.
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Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Format Media

메모리 카드를 포맷(초기화)합니다("메모리 카드 포맷(초기화)" 참조).

관련 항목

메모리 카드 포맷(초기화)

5-041-958-23(1) Copyright 2022 Sony Corporation

항목 하위 항목 설정 공장 기본값 설명

Media(A) Full Format / Quick Format / Cancel – 슬롯 A에서 메모리 카드를 포맷합니다.

Media(B) Full Format / Quick Format / Cancel – 슬롯 B에서 메모리 카드를 포맷합니다.
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Interchangeable Lens Digital Camera
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Media Life

메모리 카드의 남은 수명을 표시합니다.

참고 사항

남은 매체 수명 표시를 지원하는 메모리 카드가 필요합니다.

5-041-958-23(1) Copyright 2022 Sony Corporation

항목 하위 항목 설정 공장 기본값 설명

Media(A) – – 슬롯 A에 있는 메모리 카드의 남은 수명을 표시합니다.

Media(B) – – 슬롯 B에 있는 메모리 카드의 남은 수명을 표시합니다.
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Interchangeable Lens Digital Camera
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Output Format

출력 형식 설정을 지정합니다.

관련 항목

출력 형식 및 제한

5-041-958-23(1) Copyright 2022 Sony Corporation

항목 하위 항목 설정
공장 기본

값
설명

SDI 설정에 대한 자세한 내용은 "출력 형식 및 제한"을 참조하
십시오.

– SDI 및 HDMI 출력 해상도를 설정합
니다.HDMI –
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Display On/Off

표시 항목 설정을 지정합니다.
표시 항목을 표시하려면 On을 선택합니다. 표시 항목을 숨기려면 Off를 선택합니다.

항목 하위 항목 설정 공장 기본값

File Transfer Status On / Off On

Rec/Play Status On / Off On

RAW Output Control Status On / Off On

Tally On / Off On

Focus Mode On / Off On

Focus Position On / Off On

Focus Area Indicator On / Off On

Focus Area Ind.(AF-S) On / Off On

Face/Eye Detection Frame On / Off On

Lens Info On / Off Off

Imager Scan Mode On / Off On

Rec Format On / Off On

Frame Rate On / Off On

Zoom Position On / Off On

SteadyShot On / Off On

Base Look/Rec Look On / Off On

SDI/HDMI Rec Control On / Off On

Monitoring Look On / Off On

Proxy Status On / Off On

Base ISO/Sensitivity On / Off On

Media Status On / Off On

Clip Name On / Off On

White Balance On / Off On

Scene File On / Off On

Focus Indicator On / Off On
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항목 하위 항목 설정 공장 기본값

Auto Exposure Mode On / Off On

Auto Exposure Level On / Off On

Timecode On / Off On

ND Filter On / Off On

Iris On / Off On

ISO/Gain/EI On / Off On

Shutter On / Off On

Level Gauge On / Off On

Audio Level Meter On / Off On

Video Level Warning On / Off On

Clip Number On / Off On

Notice Message On / Off On
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Video Signal Monitor

비디오 신호 모니터 설정을 지정합니다.

5-041-958-23(1) Copyright 2022 Sony Corporation

항목 하위 항목 설정 공장 기본값 설명

Setting Off / Waveform / Vector / Histogram Off 비디오 신호 모니터 유형을 설정합니다.

Level Marker 1 0% ~ 109% 70% 휘도 레벨 마커 1의 레벨을 설정합니다.

Level Marker 2 0% ~ 109% 100% 휘도 레벨 마커 2의 레벨을 설정합니다.
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Interchangeable Lens Digital Camera
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Marker

마커 표시 설정을 지정합니다.

항목 하위 항목 설정 공장 기본값 설명

Setting On / Off On 모든 마커 표시를 켜거나 끕니다.

Color
White / Yellow / Cyan / Green / Magenta
/ Red / Blue

White 마커 신호 색상을 선택합니다.

Center
Marker

1 / 2 / 3 / 4 / Off Off 중앙 마커를 선택합니다.

Safety Zone On / Off Off 안전 구역 마커를 켜거나 끕니다.

Safety Area 80% / 90% / 92.5% / 95% 90% 안전 구역 마커 크기를 선택합니다(전체 화면
크기의 백분율).

Aspect
Marker

Line / Mask / Off Off 종횡비 마커 유형을 선택합니다.

Aspect Mask 0~15 12 마커 외부 비디오 신호 레벨을 설정합니다.

Aspect
Safety Zone

On / Off Off 종횡비 안전 구역 마커를 켜거나 끕니다.

Aspect
Safety Area

80% / 90% / 92.5% / 95% 90%
종횡비 안전 구역 마커 크기를 선택합니다(전
체 화면 크기의 백분율).

Aspect
Select

1:1 / 4:3 / 13:9 / 14:9 / 15:9 / 16:9 / 17:9
/ 1.66:1 / 1.85:1 / 2.35:1 / 2.39:1 /
Custom

2.39:1 종횡비 마커를 표시할 때 모드를 설정합니다.

Custom
Aspect Ratio

임의의 값을 입력합니다. 01.00:01.00

종횡비를 임의의 값으로 설정합니다.

참고 사항

[Aspect Select]가 [Custom]으로 설정된 경
우 활성화됩니다.

Guide Frame On / Off Off 가이드 프레임 표시를 켜거나 끕니다.

100% Marker On / Off Off 100% 마커를 켜거나 끕니다.

User Box On / Off Off 사용자 박스 마커 표시를 켜거나 끕니다.

User Box
Width

3~479 240
사용자 박스 마커 너비를 설정합니다(가운데
에서 왼쪽 및 오른쪽 가장자리까지의 거리).

User Box
Height

3~269 135
사용자 박스 마커 높이를 설정합니다(가운데
에서 위쪽 및 아래쪽 가장자리까지의 거리).
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항목 하위 항목 설정 공장 기본값 설명

User Box H
Position

−476~+476 0
사용자 박스 마커 중앙의 수평 위치를 설정합
니다.

User Box V
Position

−266~+266 0
사용자 박스 마커 중앙의 수직 위치를 설정합
니다.
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Audio Input

오디오 입력 설정을 지정합니다.

항목 하위 항목 설정
공장 기본

값
설명

AUDIO IN
Select

MIC / LINE MIC AUDIO IN 커넥터에 연결된 장치 유형을 선택합니다.

Phantom
Power +48V

On / Off Off +48V 팬텀 전원 공급 장치의 상태를 표시합니다.

CH1 Input
Select

AUDIO IN CH1
AUDIO IN
CH1

채널 1에서 녹음용 입력 소스를 표시합니다.

CH2 Input
Select

AUDIO IN CH1 /
AUDIO IN CH2

AUDIO IN
CH2

채널 2에서 녹음용 입력 소스를 전환합니다.

CH3 Input
Select

Off / AUDIO IN CH1
AUDIO IN
CH1

채널 3에서 녹음용 입력 소스를 전환합니다.

CH4 Input
Select

Off / AUDIO IN CH1 /
AUDIO IN CH2

AUDIO IN
CH2

채널 4에서 녹음용 입력 소스를 전환합니다.

AUDIO IN CH1
MIC Ref.

−80dB / −70dB /
−60dB / −50dB /
−40dB / −30dB

−50dB
AUDIO IN CH1에서 XLR 마이크 입력의 기준 녹음 레벨을 설
정합니다.

AUDIO IN CH2
MIC Ref.

−80dB / −70dB /
−60dB / −50dB /
−40dB / −30dB

−50dB
AUDIO IN CH2에서 XLR 마이크 입력의 기준 녹음 레벨을 설
정합니다.

Line Input
Reference

+4dB / 0dB / −3dB /
EBUL

+4dB
[AUDIO IN Select]가 LINE으로 설정되었을 때 기준 입력 레벨
을 선택합니다.

Reference
Level

−20dB / −18dB /
−16dB / −12dB / EBUL

−20dB 1kHz 기준 톤 신호의 녹음 레벨을 선택합니다.

CH1 Wind Filter On / Off Off
채널 1 녹음에 대한 바람 감소 필터를 활성화하거나 비활성화
합니다.

CH2 Wind Filter On / Off Off
채널 2 녹음에 대한 바람 감소 필터를 활성화하거나 비활성화
합니다.

CH3 Wind Filter On / Off Off
채널 3 녹음에 대한 바람 감소 필터를 활성화하거나 비활성화
합니다.

CH4 Wind Filter On / Off Off
채널 4 녹음에 대한 바람 감소 필터를 활성화하거나 비활성화
합니다.

CH1 Level
Control

Auto / Manual Auto
녹음 채널 1에 대한 오디오 입력 레벨 자동 조정 또는 수동 조
정을 선택합니다.
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항목 하위 항목 설정
공장 기본

값
설명

CH2 Level
Control

Auto / Manual Auto
녹음 채널 2에 대한 오디오 입력 레벨 자동 조정 또는 수동 조
정을 선택합니다.

CH3 Level
Control

Auto / Manual Auto
녹음 채널 3에 대한 오디오 입력 레벨 자동 조정 또는 수동 조
정을 선택합니다.

CH4 Level
Control

Auto / Manual Auto
녹음 채널 4에 대한 오디오 입력 레벨 자동 조정 또는 수동 조
정을 선택합니다.

CH1 Input
Level

0~99 49 녹음 채널 1에 대한 입력 레벨을 설정합니다.

CH2 Input
Level

0~99 49 녹음 채널 2에 대한 입력 레벨을 설정합니다.

CH3 Input
Level

0~99 49 녹음 채널 3에 대한 입력 레벨을 설정합니다.

CH4 Input
Level

0~99 49 녹음 채널 4에 대한 입력 레벨을 설정합니다.

Master Input
Level

0~99 99 마스터 오디오 입력 레벨을 설정합니다.

Limiter Mode
Off / −6dB / −9dB /
−12dB / −15dB /
−17dB

Off
오디오 입력 레벨을 수동으로 조정할 때 큰 입력 신호에 대한
리미터 특성을 선택합니다.

CH1&2 AGC
Mode

Mono / Stereo Stereo
녹음 채널 1 및 채널 2에 대한 자동 레벨 조정 모드를 설정합니
다. Stereo로 설정되면 채널 사이에 AGC가 연결됩니다.

CH3&4 AGC
Mode

Mono / Stereo Stereo
녹음 채널 3 및 채널 4에 대한 자동 레벨 조정 모드를 설정합니
다. Stereo로 설정되면 채널 사이에 AGC가 연결됩니다.

AGC Spec
−6dB / −9dB / −12dB /
−15dB / −17dB

−6dB AGC 특성을 선택합니다.

1kHz Tone on
Color Bars

On / Off Off

컬러 바를 표시할 때 1kHz 기준 톤 신호를 켜거나 끕니다.

참고 사항

[On]으로 설정하면 [CH3 Input Select] 및 [CH4 Input Select]가
[Off]로 설정되더라도 채널 3 및 채널 4에서 녹음용으로 1kHz
기준 톤 신호가 설정됩니다.
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도움말 안내
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Audio Output

오디오 출력 설정을 지정합니다.
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항목 하위 항목 설정
공장 기본

값
설명

HDMI/Stream Output
CH

CH1/CH2 /
CH3/CH4

CH1/CH2
HDMI/스트리밍 출력에서 오디오 채널 조합을 설정합
니다.
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도움말 안내

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Display Clip Properties

클립 속성 화면을 표시합니다.
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항목 하위 항목 설정 공장 기본값 설명

Display Clip Properties – – 클립 속성 화면을 표시합니다.
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도움말 안내

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Set Clip Flag

클립 플래그 설정을 지정합니다.
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항목 하위 항목 설정 공장 기본값 설명

Add OK – – OK 플래그를 추가합니다.

Add NG – – NG 플래그를 추가합니다.

Add KEEP – – KEEP 플래그를 추가합니다.

Delete Clip Flag – – 모든 플래그를 삭제합니다.
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도움말 안내

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Lock/Unlock Clip

클립 보호 설정을 지정합니다.
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항목 하위 항목 설정 공장 기본값 설명

Select Clip – – 클립을 선택하고 잠그거나 잠금을 해제합니다.

Lock All Clips – – 모든 클립을 잠급니다.

Unlock All Clips – – 모든 클립 잠금을 해제합니다.
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도움말 안내

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Delete Clip

클립을 삭제합니다.
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항목 하위 항목 설정 공장 기본값 설명

Select Clip – – 선택한 클립을 삭제합니다.

All Clips – – 모든 클립을 삭제합니다.
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도움말 안내

Interchangeable Lens Digital Camera
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Transfer Clip

클립을 전송합니다.
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항목 하위 항목 설정 공장 기본값 설명

Select Clip – – 선택한 클립을 전송합니다.

All Clips – –

모든 클립을 전송합니다.

참고 사항

200개 적송 작업까지 가져올 수 있습니다.
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도움말 안내

Interchangeable Lens Digital Camera
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Transfer Clip (Proxy)

프록시 클립을 전송합니다.

5-041-958-23(1) Copyright 2022 Sony Corporation

항목 하위 항목 설정 공장 기본값 설명

Select Clip – – 선택한 클립에 해당하는 프록시 클립을 전송합니다.

All Clips – –

모든 클립에 해당하는 프록시 클립을 전송합니다.

참고 사항

200개 적송 작업까지 가져올 수 있습니다.
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도움말 안내

Interchangeable Lens Digital Camera
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Filter Clips

표시할 클립 설정을 지정합니다.
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항목 하위 항목 설정 공장 기본값 설명

OK – – OK 플래그가 있는 클립만 표시합니다.

NG – – NG 플래그가 있는 클립만 표시합니다.

KEEP – – KEEP 플래그가 있는 클립만 표시합니다.

None – – 플래그가 없는 클립만 표시합니다.

All – – 어떤 플래그가 있는지에 관계 없이 모든 클립을 표시합니다.
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도움말 안내

Interchangeable Lens Digital Camera
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Customize View

썸네일 화면 보기를 전환합니다.
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항목 하위 항목 설정
공장 기본

값
설명

Thumbnail
Caption

Date Time / Time Code / Duration / Sequential
Number

Time
Code

썸네일 아래에 표시된 정보를 전환
합니다.

349



도움말 안내

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Color Bars

컬러 바 설정을 지정합니다.
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항목 하위 항목 설정 공장 기본값 설명

Setting On / Off Off 컬러 바를 켜거나 끕니다.

Type ARIB / 100% / 75% / SMPTE ARIB 컬러 바 유형을 선택합니다.

350



도움말 안내

Interchangeable Lens Digital Camera
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Genlock

젠록 상태 표시를 구성합니다("비디오 신호의 위상 동기화(Genlock)" 참조).

관련 항목

비디오 신호의 위상 동기화(Genlock)
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항목 하위 항목 설정 공장 기본값 설명

Reference Internal / External(HD) / External(SD) – 젠록 기준 신호의 유형을 표시합니다.
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도움말 안내

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Tally

녹화/기록 램프 설정을 지정합니다("기록 신호 연결" 참조).

관련 항목

기록 신호 연결
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항목 하위 항목 설정
공장 기본

값
설명

Tally Lamp
Brightness

High / Low / Off High 녹화/기록 램프의 밝기를 설정합니다.

G Tally Lamp Enable / Disable Enable G 기록 램프를 활성화/비활성화합니다.

Tally Control
External /
Internal

Internal

기기의 녹화/기록 램프 제어 정보를 수락할 대상을 선택합니
다.
External: 카메라 외부에서 기록을 제어합니다.
Internal: 카메라 녹화 작업을 통해 제어합니다.
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도움말 안내

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Rec Review

녹화 검토 설정을 지정합니다("녹화 검토(Rec Review)" 참조).

관련 항목

녹화 검토(Rec Review)
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항목 하위 항목 설정 공장 기본값 설명

Setting 3s / 10s / Clip 3s 녹화 검토를 위해 방금 녹화한 클립의 재생 시간을 설정합니다.
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도움말 안내

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Zoom

줌 설정을 지정합니다("줌 조정").
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항목 하위 항목 설정 공장 기본값 설명

Zoom Type Optical Zoom Only / On(Clear Image Zoom) Optical Zoom Only 줌 유형을 설정합니다.
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도움말 안내

Interchangeable Lens Digital Camera
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Lens

렌즈와 관련된 설정을 지정합니다.

관련 항목

브리딩 보정
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항목 하위 항목 설정 공장 기본값 설명

Lens Calibration Execute / Cancel –
파워 줌 렌즈 사용 시 개별 렌즈의 차이로 인한 줌
위치의 차이를 보정하는 기능을 실행합니다.

Zoom Ring
Direction

Left(W)/Right(T) /
Right(W)/Left(T)

Left(W)/Right(T)

줌 링 작동 방향을 설정합니다.

참고 사항

줌 링 방향 전환을 지원하는 E-mount 렌즈를 사
용하는 경우에만 활성화됩니다.

Shading
Compensation Auto / Off Auto 자동 음영 보정을 설정합니다.

Chroma Aberration
Comp.

Auto / Off Auto 자동 색수차 보정을 설정합니다.

Distortion Comp. Auto / Off Auto 자동 왜곡 보정을 설정합니다.

Breathing
Compensation

Auto / Off Off
렌즈 브리딩 보정을 설정합니다.

"브리딩 보정"을 참조하십시오.

Distance Display Meter / Feet Meter
렌즈 정보 및 초점 위치에 대한 표시 단위를 설정합
니다.

Zoom Position
Display

Focal Length / Number /
Bar Focal Length 줌 위치의 표시 형식을 설정합니다.
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도움말 안내

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

APR

APR을 실행합니다.
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항목 하위 항목 설정
공장 기본

값
설명

APR
Execute /
Cancel –

이미지 센서 자동 조정을 위해 APR(Automatic Pixel Restoration)을 실행합니
다.
Execute: 기능을 실행합니다.

참고 사항

APR을 실행하기 전에 항상 렌즈 캡을 부착합니다.
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도움말 안내

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Wired LAN

유선 LAN 연결과 관련된 설정을 지정합니다.

5-041-958-23(1) Copyright 2022 Sony Corporation

항목 하위 항목 설정 공장 기본값 설명

HTTP Port – 80 HTTP 액세스 포트를 표시합니다.

Detail Settings

– – 유선 LAN 연결의 속성을 표시합니다.

DHCP
On / Off

On DHCP가 활성화되었는지(On) 비활성화되었는지(Off) 표시합니다.

IP Address – [DHCP]가 [Off]로 설정되었을 때 기기의 IP 주소를 표시합니다.

Subnet Mask – [DHCP]가 [Off]로 설정되었을 때 기기의 서브넷 마스크를 표시합니다.

Gateway – [DHCP]가 [Off]로 설정된 경우 기본 게이트웨이를 표시합니다.

DNS Auto
On / Off

On DNS 자동 획득 설정을 표시합니다.
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도움말 안내

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

File Transfer

파일 전송과 관련된 설정을 지정합니다.("파일 전송 정보" 참조).

관련 항목

파일 전송 정보
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항목 하위 항목 설정
공장
기본
값

설명

Auto Upload
(Proxy)

On / Off Off 프록시 파일 자동 업로드를 켜거나 끕니다.

Default Upload
Server

Server Settings1 ~ 3
> Display Name

–

파일의 업로드 서버를 선택합니다. 여기에서 선택한 서버는 프록시
파일의 자동 업로드 대상이 되고 썸네일 화면에서 파일의 업로드 대
상이 됩니다.
[Server Settings1~3]에 구성된 [Display Name] 설정을 표시합니다.

Clear
Completed
Jobs

Execute / Cancel –
목록에서 완료된 전송 작업을 지웁니다.
Execute: 기능을 실행합니다.

Clear All Jobs Execute / Cancel –
목록에서 모든 전송 작업을 지웁니다.
Execute: 기능을 실행합니다.

View Job List – – 전송 작업 목록을 표시합니다.
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도움말 안내

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Language

표시 언어를 설정합니다.

5-041-958-23(1) Copyright 2022 Sony Corporation

항목 하위 항목 설정 공장 기본값 설명

Select – –
표시 언어를 설정합니다.
Set: 값을 설정합니다.
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도움말 안내

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Clock Set

내부 시계 설정을 지정합니다.

참고 사항

카메라 메뉴에서 이 설정을 변경하면 기기의 전원 공급 장치를 끄고 기기를 다시 시작하십시오. 적외선 리모컨 또는 웹 앱을 사용하
여 전원 대기를 시작하면 예기치 않은 동작이 발생할 수 있습니다.
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항목 하위 항목 설정 공장 기본값 설명

Time Zone UTC − 12:00 ~ UTC + 14:00 – UTC와의 시차를 30분 단위로 설정합니다.

Date Mode YYMMDD / MMDDYY / DDMMYY YYMMDD

날짜 표시 형식을 선택합니다.
YYMMDD: 년, 월, 일
MMDDYY: 월, 일, 년
DDMMYY: 일, 월, 년

12H/24H 12H / 24H 24H
시계 표시 형식을 선택합니다.
12H: 12시간 모드
24H: 24시간 모드

Date – –
현재 날짜를 설정합니다.
Set: 값을 설정합니다.

Time – –
현재 시간을 설정합니다.
Set: 값을 설정합니다.
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도움말 안내

Interchangeable Lens Digital Camera
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Hours Meter

누적된 실행 시간을 표시합니다.
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항목 하위 항목 설정 공장 기본값 설명

Hours(System) – – 누적된 사용 시간을 표시합니다(재설정할 수 없음).

Hours(Reset) – – 누적된 사용 시간을 표시합니다(재설정할 수 있음).

Reset Execute / Cancel –
누적된 실행 시간을 0으로 재설정합니다.
Execute: 기능을 실행합니다.
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Interchangeable Lens Digital Camera
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ISO/Gain 설정 및 기본값

[ISO/Gain<L>] 설정 범위 및 기본값은 [Mode], [Base Look] > [Select] 및 [Base Sensitivity] 설정에 따라 다릅니다.
표의 기본값은 굵은 글씨로 표시됩니다.

[Mode]가 [ISO]으로 설정된 경우

[Base Look] > [Select]가 [S-Cinetone], [Standard], [ITU709], [709tone] 또는 [Still]로 설정된 경우

[Base Look] > [Select]가 [HLG Live] 또는 [HLG Natural]로 설정된 경우

[ISO/Gain/EI] > [Base Sensitivity]가 [Low]로 설정된 경
우

[ISO/Gain/EI] > [Base Sensitivity]가 [High]로 설정된 경
우

ISO 320
ISO 400
ISO 500
ISO 640
ISO 800
ISO 1000
ISO 1250
ISO 1600
ISO 2000
ISO 2500
ISO 3200
ISO 4000
ISO 5000
ISO 6400
ISO 8000
ISO 10000
ISO 12800
ISO 16000
ISO 20000
ISO 25600

ISO 5000
ISO 6400
ISO 8000
ISO 10000
ISO 12800
ISO 16000
ISO 20000
ISO 25600
ISO 32000
ISO 40000
ISO 51200
ISO 64000
ISO 80000
ISO 102400
ISO 128000
ISO 160000
ISO 204800
ISO 256000
ISO 320000
ISO 409600
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[Base Look] > [Select]가 [User1] ~ [User16]으로 설정된 경우

[Mode]가 [dB]으로 설정된 경우

-3dB~+30dB 범위의 값을 1dB 단위로 구성할 수 있습니다.
기본값은 0dB입니다.
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[ISO/Gain/EI] > [Base Sensitivity]가 [Low]로 설정된 경
우

[ISO/Gain/EI] > [Base Sensitivity]가 [High]로 설정된 경
우

ISO 800
ISO 1000
ISO 1250
ISO 1600
ISO 2000
ISO 2500
ISO 3200
ISO 4000
ISO 5000
ISO 6400
ISO 8000
ISO 10000
ISO 12800
ISO 16000
ISO 20000
ISO 25600

ISO 128000
ISO 16000
ISO 20000
ISO 25600
ISO 32000
ISO 40000
ISO 51200
ISO 64000
ISO 80000
ISO 102400
ISO 128000
ISO 160000
ISO 204800
ISO 256000
ISO 320000
ISO 409600

[ISO/Gain/EI] > [Base Sensitivity]가 [Low]로 설정된 경
우

[ISO/Gain/EI] > [Base Sensitivity]가 [High]로 설정된 경
우

ISO 800
ISO 1000
ISO 1250
ISO 1600
ISO 2000
ISO 2500
ISO 3200
ISO 4000
ISO 5000
ISO 6400
ISO 8000
ISO 10000
ISO 12800
ISO 16000
ISO 20000
ISO 25600

ISO 12800
ISO 16000
ISO 20000
ISO 25600
ISO 32000
ISO 40000
ISO 51200
ISO 64000
ISO 80000
ISO 102400
ISO 128000
ISO 160000
ISO 204800
ISO 256000
ISO 320000
ISO 409600
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AGC Limit 설정 및 기본값

[AGC Limit] 메뉴 설정 범위 및 기본값은 [Mode], [Base Look] > [Select] 및 [Base Sensitivity] 설정에 따라 다릅니다.
표의 기본값은 굵은 글씨로 표시됩니다.

[Mode]가 [ISO]으로 설정된 경우

[Base Look] > [Select]가 [S-Cinetone], [Standard], [ITU709], [709tone] 또는 [Still]로 설정된 경우

[Base Look] > [Select]가 [HLG Live] 또는 [HLG Natural]로 설정된 경우

[ISO/Gain/EI] > [Base Sensitivity]가 [Low]로 설정된 경
우

[ISO/Gain/EI] > [Base Sensitivity]가 [High]로 설정된 경
우

ISO 400
ISO 500
ISO 640
ISO 800
ISO 1000
ISO 1250
ISO 1600
ISO 2000
ISO 2500
ISO 3200
ISO 4000
ISO 5000
ISO 6400
ISO 8000
ISO 10000
ISO 12800
ISO 16000
ISO 20000
ISO 25600

ISO 6400
ISO 8000
ISO 10000
ISO 12800
ISO 16000
ISO 20000
ISO 25600
ISO 32000
ISO 40000
ISO 51200
ISO 64000
ISO 80000
ISO 102400
ISO 128000
ISO 160000
ISO 204800
ISO 256000
ISO 320000
ISO 409600
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[Base Look] > [Select]가 [User1] ~ [User16]으로 설정된 경우

[Mode]가 [dB]으로 설정된 경우

3dB / 6dB / 9dB / 12dB / 15dB / 18dB / 21dB / 24dB / 27dB / 30dB에서 선택합니다.
기본값은 15dB입니다.
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[ISO/Gain/EI] > [Base Sensitivity]가 [Low]로 설정된 경
우

[ISO/Gain/EI] > [Base Sensitivity]가 [High]로 설정된 경
우

ISO 1000
ISO 1250
ISO 1600
ISO 2000
ISO 2500
ISO 3200
ISO 4000
ISO 5000
ISO 6400
ISO 8000
ISO 10000
ISO 12800
ISO 16000
ISO 20000
ISO 25600

ISO 16000
ISO 20000
ISO 25600
ISO 32000
ISO 40000
ISO 51200
ISO 64000
ISO 80000
ISO 102400
ISO 128000
ISO 160000
ISO 204800
ISO 256000
ISO 320000
ISO 409600

[ISO/Gain/EI] > [Base Sensitivity]가 [Low]로 설정된 경
우

[ISO/Gain/EI] > [Base Sensitivity]가 [High]로 설정된 경
우

ISO 1000
ISO 1250
ISO 1600
ISO 2000
ISO 2500
ISO 3200
ISO 4000
ISO 5000
ISO 6400
ISO 8000
ISO 10000
ISO 12800
ISO 16000
ISO 20000
ISO 25600

ISO 16000
ISO 20000
ISO 25600
ISO 32000
ISO 40000
ISO 51200
ISO 64000
ISO 80000
ISO 102400
ISO 128000
ISO 160000
ISO 204800
ISO 256000
ISO 320000
ISO 409600
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각 촬영 모드에 저장된 이미지 품질 설정

이미지 품질과 관련된 구성 항목의 현재 상태는 다음 각 촬영 모드에 대해 저장됩니다. 촬영 모드를 변경하면 대상 촬영 모
드에 대해 저장된 해당 설정이 적용됩니다.

Custom 모드 SDR(BT.709) 대상 표시
Custom 모드 HDR(HLG) 대상 표시
로그 촬영(Cine EI, Cine EI Quick, Flexible ISO)

각 촬영 모드에 대해 저장된 이미지 품질과 관련된 구성 항목은 다음 표와 같습니다.
"예"는 저장된 설정을 나타내고 "아니오"는 저장되지 않은 설정을 나타냅니다. 여러 열에 걸쳐 있는 "예"는 공통 설정을 나
타냅니다.

항목

촬영 모드

Custom Flexible
ISO

Cine EI
Quick

Cine
EISDR(BT.709) HDR(HLG)

Shooting 메
뉴

ISO/Gain/EI

ISO/Gain 예1) 예 아니요

Exposure Index 아니요 아니요 예 예

Base Sensitivity 예 아니요

Base ISO 아니요 예4) 아니요3) 예4)

White
Preset White 예 예

위 이외 예

White Setting 예

Offset White 예 아니요

LUT On/Off 아니요 예

Noise
Suppression

Setting(Custom) 예 예 아니요

Level(Custom) 예 예 아니요

Setting (Cine
EI/Flex. ISO)

아니요 예

Level (Cine EI/Flex.
ISO)

아니요 예
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항목

촬영 모드

Custom Flexible
ISO

Cine EI
Quick

Cine
EISDR(BT.709) HDR(HLG)

Paint/Look
메뉴

Base Look

Select 예 예 예

Input2) 예

Output2) 예

AE 레벨 오프셋2) 예

Black 예 예 아니요

Knee
Auto Knee 예 아니요 아니요

위 이외 예 예 아니요

Detail 예 예 아니요

Matrix 예 예 아니요

Multi Matrix 예 예 아니요

Custom 모드 SDR(BT.709) 및 HDR(HLG) 모두에 대해 별도의 ISO 감도 설정이 저장됩니다.1)

설정은 각 기본 보기에 저장되며 촬영 모드에 따라 바뀌지 않습니다.2)

기본 ISO 감도는 노출 지수에 따라 변경됩니다.3)

Flexible ISO 및 Cine EI 촬영 모드의 공통 설정 값입니다.4)
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웹 메뉴 구성

[Settings] 작업 화면 전환 탭을 눌러 설정 화면을 표시합니다.
설정 화면을 사용하여 웹 메뉴를 통한 초기 설정, 네트워크 설정, 촬영/재생 설정을 포함한 기기의 다양한 설정 항목을 구성
합니다.

메뉴는 다음 메뉴로 구성됩니다.

메뉴 구성 및 계층

레벨 1 레벨 1 설명 레벨 2

Shooting 촬영과 관련된 설정이 포함되어 있습니다. Focus
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레벨 1 레벨 1 설명 레벨 2

Project 기본 프로젝트 설정이 포함되어 있습니다.

Base Setting

Rec Format

Simul Rec

Proxy Rec

Interval Rec

Picture Cache Rec

All File

Paint/Look 이미지 품질과 관련된 설정이 포함되어 있습니다. Base Look

Pan-Tilt 팬/틸트와 관련된 설정이 포함되어 있습니다.

P/T Speed

P/T Acceleration

P/T Range Limit

P/T Direction

P/T Preset

Monitoring 비디오 출력 및 화면 표시와 관련된 설정이 포함되어 있습니다.
Output Format

Output Display

Audio 오디오와 관련된 설정이 포함되어 있습니다. Audio

Technical 기술 항목에 대한 설정이 포함되어 있습니다.

Tracking Data Output

Tally

IR Remote

RCP/MSU

Lens Controller

Network 네트워크와 관련된 설정이 포함되어 있습니다.

Camera Name

User

Wired LAN

File Transfer

FTP Server 1

FTP Server 2

FTP Server 3

SSL

Referer Check

Brute Force Attack Protection
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참고 사항

[Accessibility]는 북미 지역에서 판매되는 모델에서만 사용할 수 있습니다.

5-041-958-23(1) Copyright 2022 Sony Corporation

레벨 1 레벨 1 설명 레벨 2

Stream 스트리밍과 관련된 설정이 포함되어 있습니다.

Stream

Video Stream

Audio Stream

Maintenance 시계 및 언어와 같은 장치 설정이 포함되어 있습니다.

Language

Accessibility

Clock Set

Reset

Information

System Log

HTTP Access Log

Service

EULA

Software
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웹 메뉴 작업

[Settings] 작업 화면 전환 탭을 눌러 설정 화면을 표시하여 웹 메뉴를 통한 초기 설정, 네트워크 설정, 촬영/재생 설정을 포
함한 기기의 다양한 설정 항목을 구성합니다.
터치 조작을 사용하는 태블릿 또는 마우스 조작을 사용하는 컴퓨터의 웹 메뉴에서 설정을 구성합니다.
구성하려는 항목의 메뉴를 눌러 설정 항목과 해당 메뉴의 설정을 표시합니다.

구성 방법

값 선택

항목의 라디오 버튼을 누릅니다. 선택한 항목의 라디오 버튼은 주황색으로 표시됩니다.

메뉴(레벨 1)1.

메뉴(레벨 2)2.

설정3.
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항목 켜기/끄기

스위치를 눌러 항목을 켜거나 끕니다. 스위치는 항목이 켜져 있을 때는 주황색이고 꺼져 있을 때는 흰색입니다.

목록에서 값 선택

드롭다운 버튼을 누르고 표시된 목록에서 항목을 선택합니다.

숫자 값 선택

< 또는 >를 눌러 숫자 값을 변경합니다. 숫자 값에 밑줄이 표시된 경우 숫자 값을 직접 입력할 수도 있습니다.

문자/숫자 입력

별도 화면에서 구성

버튼을 눌러 별도의 화면에서 설정 작업을 수행합니다.

안내 메시지

일부 설정을 구성하는 데 도움이 되는 정보와 사용자에게 주의를 환기시키는 메시지가 표시됩니다.

설정 저장

설정 구성이 끝나면 [OK] 버튼을 눌러 설정을 저장합니다.
[Cancel] 버튼을 눌러 설정 변경 사항을 취소하고 이전 설정으로 되돌립니다.
[Reload] 버튼을 눌러 화면 표시를 업데이트합니다.

참고 사항

설정을 저장하기 전에 [Reload] 버튼을 누르면 설정 변경 사항이 취소됩니다.

설정을 저장하기 전에 다른 페이지로 이동하면 설정 변경 사항이 취소됩니다.

5-041-958-23(1) Copyright 2022 Sony Corporation
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Focus

초점 설정을 지정합니다.

관련 항목

웹 앱을 사용하여 수동으로 자동 초점 대상 설정(AF Assist)

5-041-958-23(1) Copyright 2022 Sony Corporation

항목 하위 항목 설정
공장 기본

값
설명

Push AF Mode
AF / Single-shot
AF(AF-S)

AF 푸시 자동 초점 모드를 설정합니다.

Touch Function
in MF

Tracking AF / Spot
Focus

Tracking
AF

MF 모드에서 카메라 이미지 화면을 터치할 때의 동작을 설정합니
다.

AF Assist
Control

On / Off On

[On]으로 설정된 경우 자동 초점 동안 웹 앱의 초점 슬라이더를 사
용하여 초점 위치를 조정할 수 있습니다.

자세한 내용은 "웹 앱을 사용하여 수동으로 자동 초점 대상 설
정(AF Assist)"을 참조하십시오.

참고 사항

이 항목은 카메라 메뉴의 [AF Assist]가 [On]으로 설정된 경우에만
활성화됩니다.

373



도움말 안내

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Base Setting

기본 설정을 지정합니다.

관련 항목

기본 작동 구성

5-041-958-23(1) Copyright 2022 Sony Corporation

항목 하위 항목 설정 공장 기본값 설명

Shooting
Mode

Custom / Flexible ISO / Cine EI Quick /
Cine EI

Custom

촬영 모드를 설정합니다.

"기본 작동 구성"의 "촬영 모드"를 참조
하십시오.

Target
Display

SDR(BT.709) / HDR(HLG) SDR(BT.709)
Custom 모드에서 녹화/출력의 색공간을 설
정합니다.
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Rec Format

녹화 형식 설정을 지정합니다.

[RAW Output Format] 설정

항목 하위 항목 설정
공장 기
본값

설명

Frequency 59.94 / 50 / 29.97 / 25 / 24 / 23.98 59.94

시스템 주파수를 선택합니다.

참고 사항

주파수가 변경되면 카메라가 재부팅됩니다. 재
부팅 후 웹 브라우저에서 페이지를 다시 로드합
니다.

Imager Scan
Mode

FF / S35 FF 이미저 크기를 선택합니다.

Codec
RAW / RAW & XAVC-I / XAVC-I /
XAVC-L

XAVC-I

클립 녹화/재생 코덱을 설정합니다.

참고 사항

[Imager Scan Mode]가 [S35]으로 설정된 경우,
[RAW] 및 [RAW & XAVC-I]를 선택할 수 없습니
다.

RAW Output
Format

사용 가능한 설정은 [Frequency] 설정에
따라 다릅니다.

아래의 "[RAW Output Format] 설
정"을 참조하십시오.

–

외부 RAW 레코더로 출력할 RAW 이미지의 크기
를 설정합니다.

참고 사항

[Codec]이 [RAW & XAVC-I]로 설정된 경우,
[Video Format] 설정이 [RAW Output Format]
설정과 연동되어 전환됩니다.

Video Format

사용 가능한 설정은 [Frequency],
[Imager Scan Mode] 및 [Codec] 설정에
따라 다릅니다.

아래의 "[Video Format] 설정"을 참
조하십시오.

– 이미저 크기를 설정합니다.

Frequency Imager Scan Mode Codec 설정

59.94 / 50 / 29.97 / 25 / 23.98 FF RAW / RAW & XAVC-I
4096×2160
3840×2160

24 FF RAW / RAW & XAVC-I 4096×2160
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기본값은 굵은 글씨로 표시됩니다.
[RAW Output Format]을 설정할 수 없는 조건이 생략되었습니다.

[Video Format] 설정

기본값은 굵은 글씨로 표시됩니다.
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Frequency Imager Scan Mode Codec 설정

59.94 / 50 / 29.97 / 25 / 23.98

FF

RAW –

RAW & XAVC-I
4096×2160P
3840×2160P

XAVC-I
4096×2160P
3840×2160P
1920×1080P

XAVC-L
3840×2160P
1920×1080P 50
1920×1080P 35

S35

XAVC-I 1920×1080P

XAVC-L
1920×1080P 50
1920×1080P 35

24 FF
RAW –

RAW & XAVC-I / XAVC-I 4096×2160P
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Simul Rec

2슬롯 동시 녹화 모드 설정을 지정합니다("메모리 카드 A 및 B에 동시에 녹화(2-slot Simul Rec)" 참조).

관련 항목

메모리 카드 A 및 B에 동시에 녹화(2-slot Simul Rec)
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항목 하위 항목 설정
공장 기본

값
설명

Setting On / Off Off 동시 녹화 기능을 켜거나 끄고 녹화 대상 매체를 설정합니다.

Rec Button
Slot A / Slot B / Slot
A/Slot B

Slot A/Slot
B 각 녹화 매체에 대한 녹화 버튼 할당을 표시합니다.

카메라 메뉴에서 [Project] > [Simul Rec] > [Rec Button Set]을
설정합니다.2nd Rec

Button
Slot A / Slot B / Slot
A/Slot B

Slot A/Slot
B
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Proxy Rec

프록시 녹화 모드 설정을 지정합니다("프록시 녹화" 참조).

5-041-958-23(1) Copyright 2022 Sony Corporation

항목 하위 항목 설정 공장 기본값 설명

Setting On / Off Off 프록시 녹화 모드를 켜거나 끕니다.
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Interchangeable Lens Digital Camera
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Interval Rec

간격 녹화 모드를 설정합니다("간헐적으로 비디오 녹화(Interval Rec)" 참조).

관련 항목

간헐적으로 비디오 녹화(Interval Rec)

5-041-958-23(1) Copyright 2022 Sony Corporation

항목 하위 항목 설정 공장 기본값 설명

Setting On / Off Off

간격 녹화 모드를 켜거나 끕니다.
(이 모드를 On으로 설정하면 다른
모든 특수 모드가 Off로 설정됩니
다.)

Interval
Time

1 / 2 / 3 / 4 / 5 / 6 / 7 / 8 / 9 / 10 / 15 /
20 / 30 / 40 / 50 (초)
1 / 2 / 3 / 4 / 5 / 6 / 7 / 8 / 9 / 10 / 15 /
20 / 30 / 40 / 50 (분)
1 / 2 / 3 / 4 / 6 / 12 / 24 (시간)

1
Interval Rec 녹화 모드에서 녹화
사이 간격을 설정합니다(Interval
Rec가 On으로 설정된 경우).

Number of
Frames

1frame / 2frames / 3frames / 6frames /
9frames / 12frames
사용 가능한 설정은 선택한 비디오 형
식의 프레임 주파수에 따라 다릅니다.
59.94P/50P: 2frames / 6frames /
12frames
29.97P/25P/24P/23.98P: 1frame /
3frames / 6frames / 9frames

59.94P/50P: 2frames
29.97P/25P/24P/23.98P:
1frame

Interval Rec 녹화 모드에서 촬영당
녹화할 프레임 수를 설정합니다
(Interval Rec가 On으로 설정된 경
우).
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Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Picture Cache Rec

픽쳐 캐시 녹화 모드 설정을 지정합니다("픽처 캐시 녹화(Picture Cache Rec)" 참조).

관련 항목

픽처 캐시 녹화(Picture Cache Rec)

5-041-958-23(1) Copyright 2022 Sony Corporation

항목 하위 항목 설정
공장 기본

값
설명

Setting On / Off Off 픽쳐 캐시 기능을 켜거나 끕니다.

Cache Size
Short / Medium / Long /
Max

Max
픽처 캐시 메모리에서 이미지의 누적 시간을 설정합니다(픽처
캐시 녹화 시간).

Cache Rec
Time

– –
픽처 캐시 메모리에서 이미지의 누적 시간을 표시합니다(픽처
캐시 녹화 시간).
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Interchangeable Lens Digital Camera
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All File

ALL 파일 작업을 수행합니다("구성 데이터 저장 및 로드" 참조).

5-041-958-23(1) Copyright 2022 Sony Corporation

항목
하위 항목
설정

공장 기
본값

설명

Load All
File

– –

웹 앱을 실행하는 장치에서 기기로 ALL 파일을 로드합니다.

참고 사항

ALL 파일이 기기에 로드되면 기기가 재부팅됩니다. 재부팅 후 웹 브라우저에서 페
이지를 다시 로드합니다.

Save All
File

– – 기기의 설정을 웹 앱을 실행하는 장치에 ALL 파일로 저장합니다.
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Base Look

기본 보기를 기기에 로드할 수 있습니다.
사용 가능한 기본 보기 목록이 화면에 표시됩니다. 현재 적용된 기본 보기는 기본 보기 번호 왼쪽에 ● 마커로 표시됩니다.

[No.]: 기본 보기 번호
[Base Look Name]: 기본 보기 이름
[Input]: 기본 보기 입력 신호
[Output]: 기본 보기 출력 신호
[AE Level Offset]: 기본 보기 노출 기준 오프셋 값

기본 보기를 추가하려면

[Import] 버튼을 눌러 새로운 기본 보기를 가져옵니다. 화면의 지침을 따릅니다.
가져온 후 [Input], [Output] 및 [AE Level Offset]에 대해 적절한 값을 설정합니다. 자세한 내용은 "원하는 기본 보기 가져오
기"를 참조하십시오.

관련 항목

원하는 기본 보기 가져오기

5-041-958-23(1) Copyright 2022 Sony Corporation
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P/T Speed

팬/틸트 속도와 관련된 설정을 지정합니다.

5-041-958-23(1) Copyright 2022 Sony Corporation

항목
하위 항목 설

정
공장 기본

값
설명

Speed
Step

Normal /
Extended

Extended

팬/틸트 드라이브의 속도 단계 수를 설정합니다.
Normal: 24단계 범위를 사용하여 속도를 지정할 수 있습니다. 기존 Sony 원
격 카메라와의 호환성을 위해 이 설정을 사용하십시오.
Extended: 50단계 범위를 사용하여 속도를 지정할 수 있습니다.

Speed
Mode

Normal / Slow Normal

팬/틸트 드라이브의 속도 모드를 설정합니다.
[Speed Step]이 [Normal]로 설정된 경우에만 활성화됩니다.
Normal: 정상 속도 범위(최소~최대(60°/초))에서 작동합니다.
Slow: 저속 범위(최소~최대(40°/초))에서 작동합니다.
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Interchangeable Lens Digital Camera
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P/T Acceleration

팬/틸트 속도와 관련된 설정을 지정합니다.

5-041-958-23(1) Copyright 2022 Sony Corporation

항목
하위 항목 설

정
공장 기본

값
설명

Acceleration 1~9 8
팬/틸트 작동의 가속/감속을 선택합니다. 숫자가 클수록 가속이 높아집니
다.
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Interchangeable Lens Digital Camera
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P/T Range Limit

팬/틸트 작동 범위 제한과 관련된 설정을 지정합니다.
다음 화면을 사용하여 팬/틸트 작동 범위 제한을 설정합니다.

참고 사항

기기의 전원을 켜거나 팬/틸트 재설정을 실행하면 이 범위 제한 설정이 무시됩니다. 이 기능은 기기 근처의 장애물을 피하기 위해
사용할 수 없습니다.

[Setting] 스위치를 On 위치로 설정합니다.

팬-틸트 작동 범위 제한 기능이 활성화됩니다.

1

카메라의 팬/틸트 제어를 확인하여 이미지를 확인합니다.2

작동을 제한할 위치를 설정하려면 해당 위치에서 [Left], [Right], [Up], [Down] > [Set Current Value] 버튼을 누릅니
다.

[Left]: 카메라의 왼쪽
[Right]: 카메라의 오른쪽
[Up]: 카메라의 위쪽

3
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참고 사항

제한 위치를 벗어난 카메라 위치는 사전 설정으로 저장할 수 없습니다.

[Pan-Tilt] > [P/T Direction] > [Ceiling] 설정을 변경하면 구성된 제한 위치 설정이 공장 기본값으로 돌아갑니다.

재생 중, 썸네일 표시 중, 팬/틸트 오류가 발생한 경우, 팬/틸트가 초기화되지 않은 경우, 팬/틸트가 잠긴 경우 설정을 변경할 수 없습
니다.

5-041-958-23(1) Copyright 2022 Sony Corporation

[Down]: 카메라의 아래쪽

제한 위치가 설정되고 숫자 값(각도)으로 표시됩니다.
제한을 취소하려면 개별 위치에 대해 [Reset] 버튼을 누릅니다.

[OK] 버튼을 누릅니다.

팬/틸트 작동은 구성된 제한 위치 내에서 유지되도록 제한됩니다.

4
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P/T Direction

팬/틸트 방향과 관련된 설정을 지정합니다.

참고 사항

변경된 [Ceiling] 설정이 적용되면 팬/틸트 좌표가 반전되므로 모든 사전 설정 위치가 삭제됩니다.

팬/틸트 드라이브 범위는 [Ceiling] 설정에 따라 다음 그림과 같이 변경됩니다.

A: [Ceiling]이 [Off]로 설정된 경우
B: [Ceiling]이 [On]으로 설정된 경우

5-041-958-23(1) Copyright 2022 Sony Corporation

항목
하위 항목 설

정
공장 기
본값

설명

Ceiling On / Off Off
기기가 데스크톱에 장착된 경우 [Off]로 설정합니다. 기기가 천장에 장착된 경우
[On]으로 설정합니다. [Ceiling] [On]으로 설정된 경우, [Pan Direction]이 자동으
로 [Opposite]으로 설정됩니다.

Pan
Direction

Normal /
Opposite

Normal
팬 드라이브 방향을 설정합니다. 설정이 변경되면 드라이브 방향이 반대로 됩니
다.

Tilt
Direction

Normal /
Opposite

Normal 틸트 드라이브 방향을 설정합니다. 설정이 변경되면 드라이브 방향이 반대로 됩
니다.
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P/T Preset

카메라 사전 설정과 관련된 설정을 지정합니다.

Pan-Tilt
사전 설정의 속도를 설정합니다.

Default
사전 설정 위치를 저장할 때 구성되는 기본값을 설정합니다.

5-041-958-23(1) Copyright 2022 Sony Corporation

항목
하위 항목 설

정
공장 기본

값
설명

Pan-Tilt Speed
Setting Way

Separate /
Common

Separate
사전 설정 속도를 별도로 구성할지 또는 공통 설정을 사용할지 설정
합니다.

Pan-Tilt Speed
for Common

1~50 50

사전 설정의 공통 속도를 설정합니다.

참고 사항

[Pan-Tilt] > [P/T Speed] > [Speed Step]이 [Normal]로 설정되어 있을
때 값을 25 이상으로 설정하면 최대 드라이브 속도 24가 사용됩니다.

항목
하위 항목 설

정
공장 기본

값
설명

Pan-Tilt Speed for
Separate

1~50 50
사전 설정 속도 선택 방식이 [Separate]로 설정된 경우 사전 설정
의 속도를 설정합니다.

Zoom Sync On / Off On
사전 설정 위치 복원 시 팬/틸트 작동과 줌 작동의 동기화 여부를
설정합니다.

Zoom Speed 0~32767 32767 줌 속도를 설정합니다.

Focus Recall On / Off On 초점 설정 복원 여부를 설정합니다.

MF Speed 0~32767 32767 수동 초점의 초점 속도를 설정합니다.
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Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Output Format

출력 형식 설정을 지정합니다.

관련 항목

출력 형식 및 제한

5-041-958-23(1) Copyright 2022 Sony Corporation

항목 하위 항목 설정
공장 기본

값
설명

SDI 설정에 대한 자세한 내용은 "출력 형식 및 제한"을 참조하
십시오.

– SDI 및 HDMI 출력 해상도를 설정합
니다.HDMI –
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도움말 안내

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Output Display

출력 신호와 관련된 설정을 지정합니다.

5-041-958-23(1) Copyright 2022 Sony Corporation

항목
하위 항목
설정

공장 기
본값

설명

SDI On / Off Off 메뉴 및 상태가 SDI 출력 신호에 포함되는지 여부를 설정합니다.

HDMI/Stream On / Off On

메뉴 및 상태가 HDMI 출력 신호에 포함되는지 여부를 설정합니다.

참고 사항

이 설정은 HDMI 출력 신호 이미지, 스트리밍 출력 이미지 및 웹 앱 카메라 이미
지 패널의 이미지에도 적용됩니다.
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Interchangeable Lens Digital Camera
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Audio Input

CH1~CH4 오디오 입력과 관련된 설정을 지정합니다.

마스터 오디오 입력 레벨을 설정합니다. 마스터 오디오 입력 레벨은 모든 채널 1~4에 사용됩니다.

5-041-958-23(1) Copyright 2022 Sony Corporation

항목 하위 항목 설정 공장 기본값 설명

Level
Control

Auto / Manual Auto
오디오 입력 레벨 자동 조정 또는 수동 조정을
선택합니다.

Level 0~99 49 입력 레벨을 설정합니다.

Input
Select

AUDIO IN CH1 / AUDIO IN
CH2 / Off

CH1 및 CH3: AUDIO
IN CH1
CH2 및 CH4: AUDIO
IN CH2

오디오 입력 소스를 설정합니다.

참고 사항

CH1은 [AUDIO IN CH1](고정)로 설정되어
있습니다.

Wind Filter On / Off Off 바람 소음 감소 필터를 켜거나 끕니다.

항목 하위 항목 설정 공장 기본값 설명

Master 0~99 99 마스터 입력 레벨을 설정합니다.
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Interchangeable Lens Digital Camera
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Audio Output

오디오 입력과 관련된 설정을 지정합니다.

참고 사항

이 설정은 스트리밍 출력 오디오에도 적용됩니다.

5-041-958-23(1) Copyright 2022 Sony Corporation

항목 하위 항목 설정
공장 기본

값
설명

HDMI/Stream Output
CH

CH1/CH2 /
CH3/CH4

CH1/CH2
HDMI/스트리밍 출력에서 오디오 채널 조합을 설정합
니다.
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도움말 안내

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Tracking Data Output

추적 정보(free-d 프로토콜 준수) 출력과 관련된 설정을 지정합니다.

5-041-958-23(1) Copyright 2022 Sony Corporation

항목 하위 항목 설정
공장 기
본값

설명

Transfer Mode
Off / Always / On
Demand

Off 추적 정보 출력 방식을 선택합니다.

Camera ID 0~255 255 기기의 ID를 설정합니다.

Destination
Address

IPv4 주소 –
[Transfer Mode]가 [Always]로 설정된 경우 추적 정보 대상 IP 주소
를 설정합니다.

Destination
Port

1024~65534 40000 [Transfer Mode]가 [Always]로 설정된 경우 추적 정보 대상 포트 번
호를 설정합니다.

Listen Port 1024~65534 40000
[Transfer Mode]가 [On Demand]로 설정된 경우 클라이언트의 요
청을 수신하기 위해 기기의 포트 번호를 설정합니다.
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Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Tally

녹화/기록 램프 설정을 지정합니다("기록 신호 연결" 참조).

관련 항목

기록 신호 연결

5-041-958-23(1) Copyright 2022 Sony Corporation

항목 하위 항목 설정
공장 기본

값
설명

Tally Lamp
Brightness

High / Low / Off High 녹화/기록 램프의 밝기를 설정합니다.

G Tally Lamp Enable / Disable Enable G 기록 램프를 활성화/비활성화합니다.

Tally Control
External /
Internal

Internal
기기의 녹화/기록 램프 제어 정보를 수락할 대상을 선택합니
다.
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도움말 안내

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

IR Remote

적외선 리모컨과 관련된 설정을 지정합니다.

5-041-958-23(1) Copyright 2022 Sony Corporation

항목 하위 항목 설정 공장 기본값 설명

Setting On / Off On 적외선 리모컨에서 기기의 작동을 활성화/비활성화합니다.
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RCP/MSU

RCP/MSU(옵션)가 연결된 경우 설정을 구성합니다.
자세한 내용은 "RCP/MSU 연결(옵션)"을 참조하십시오.

참고 사항

필요에 따라 RCP/MSU의 설정을 구성합니다.

멀티 카메라 시스템에는 MSU가 필요합니다.

여러 MSU 기기를 사용하는 경우 하나의 MSU 기기를 마스터로 설정하고 다른 모든 MSU 기기를 클라이언트로 설정합니다.

5-041-958-23(1) Copyright 2022 Sony Corporation

항목 하위 항목 설정
공장 기본

값
설명

CNS Mode
Off / Bridge / MCS / PC
Control

Off RCP/MSU에 대한 연결 모드를 설정합니다.

Master IP
Address

IPv4 주소 0.0.0.0
LAN 기반 멀티 카메라 시스템을 구축할 때 마스터 장치의 IP
주소를 설정합니다.

Camera No. Camera No.(1~96) 1 LAN 기반의 멀티 카메라 시스템을 구축할 때 시스템 내 고유
카메라 번호를 설정합니다.

396



도움말 안내

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Lens Controller

연결된 렌즈 제어기(옵션)에 대한 설정을 지정합니다.
자세한 내용은 "렌즈 제어기 연결"을 참조하십시오.

참고 사항

[Setting]이 변경되면 기기가 재부팅됩니다. 웹 브라우저에서 페이지를 다시 로드합니다.

5-041-958-23(1) Copyright 2022 Sony Corporation

항목
하위 항목
설정

공장 기
본값

설명

Setting On / Off Off 렌즈 제어기(옵션) 사용 여부를 설정합니다.

Mode 0~15 0
렌즈 제어기(옵션)의 작동 모드를 설정합니다.
0~15 범위의 값을 사용할 수 있지만 선택할 수 있는 실제 값은 렌즈 제어기(옵션)에 따
라 다릅니다. 자세한 내용은 렌즈 제어기의 사용 설명서를 참조하십시오.

Reverse On / Off Off 렌즈 제어기(옵션)의 회전 방향을 반대로 바꿉니다.

Initialize – – 렌즈 제어기(옵션)를 초기화합니다.
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Camera Name

카메라 이름(기기 이름)과 관련된 설정을 지정합니다.

Camera Name에는 다음 문자 중 최대 8자(0~8)를 입력할 수 있습니다.
영숫자
기호(공백 !#$`*+-./;<=>?@[\]^_`{|})

5-041-958-23(1) Copyright 2022 Sony Corporation

항목 하위 항목 설정 공장 기본값 설명

Camera Name – FR7 카메라 이름을 설정합니다.
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User

기기의 사용자 액세스와 관련된 설정을 지정합니다.

관리자 사용자(Administrator) 관련 설정(필수)

일반 사용자(User 1~User 9) 관련 설정(선택 사항)

5-041-958-23(1) Copyright 2022 Sony Corporation

항목 하위 항목 설정 공장 기본값 설명

User Name – admin 사용자 이름을 설정합니다.

Current Password – – 암호 변경 시 현재 암호를 입력합니다.

New Password – – 새 암호를 임력합니다.

Re-Type Password – – 확인을 위해 새 암호를 다시 입력합니다.

항목 하위 항목 설정 공장 기본값 설명

User Name – – 사용자 이름을 설정합니다.

Current Password – – 암호 변경 시 현재 암호를 입력합니다.

New Password – – 새 암호를 임력합니다.

Re-Type Password – – 확인을 위해 새 암호를 다시 입력합니다.
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Wired LAN

Status
네트워크 상태를 표시합니다.

IPv4
IPv4 네트워크와 관련된 설정을 지정합니다.

IPv6
IPv6 네트워크와 관련된 설정을 지정합니다.

항목 하위 항목 설정 공장 기본값 설명

Host Name – – 호스트 이름을 표시합니다.

MAC Address – – 기기의 MAC 주소를 표시합니다.

Ethernet Status – – 현재 통신 속도를 표시합니다.

IP Address – – 기기의 IP 주소를 표시합니다.

Subnet Mask – – 기기의 서브넷 마스크를 표시합니다.

Gateway – – 기기의 IPv4 기본 게이트웨이를 표시합니다.

Primary DNS Server – – 기기의 기본 DNS 서버를 표시합니다.

Secondary DNS Server – – 기기의 보조 DNS 서버를 표시합니다.

IPv6 Address 1 – – 기기의 IPv6 주소 1을 표시합니다.

IPv6 Address 2 – – 기기의 IPv6 주소 2를 표시합니다.

IPv6 Gateway – – 기기의 IPv6 기본 게이트웨이를 표시합니다.

Link-local IPv6 Address – – 기기의 IPv6 링크 로컬 주소를 표시합니다.

항목 하위 항목 설정 공장 기본값 설명

DHCP On / Off On [DHCP] 기능을 켜거나 끕니다.

IP Address – – [DHCP]가 Off로 설정된 경우 IPv4 주소를 설정합니다.

Subnet Mask – – [DHCP]가 Off로 설정된 경우 서브넷 마스크를 설정합니다.

Gateway – – [DHCP]가 Off로 설정된 경우 IPv4 기본 게이트웨이를 설정합니다.
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Common
IPv4/IPv6 네트워크에 공통적인 설정을 지정합니다.

5-041-958-23(1) Copyright 2022 Sony Corporation

항목
하위 항목
설정

공장 기
본값

설명

Obtain an IP Address
Automatically

On / Off On 자동 IPv6 주소 획득을 켜거나 끕니다.

IP Address – –
[Obtain an IP Address Automatically]가 Off로 설정된 경우 IPv6
주소를 설정합니다.

Prefix Length – –
[Obtain an IP Address Automatically]가 Off로 설정된 경우 서브넷
마스크를 설정합니다.

Gateway – – [Obtain an IP Address Automatically]가 Off로 설정된 경우 IPv6
기본 게이트웨이를 설정합니다.

항목 하위 항목 설정
공장 기본

값
설명

HTTP Port
80,
1024~65534

80 HTTP 포트 번호를 설정합니다.

DNS Auto On / Off On DHCP 서버에서 DNS 주소를 가져올지 여부를 설정합니다.

Primary DNS Server IPv4/IPv6 주소 –
[DNS Auto]가 Off로 설정된 경우 기본 DNS 서버를 설정합니
다.

Secondary DNS
Server

IPv4/IPv6 주소 –
[DNS Auto]가 Off로 설정된 경우 보조 DNS 서버를 설정합니
다.
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File Transfer

파일 전송과 관련된 설정을 지정합니다.

5-041-958-23(1) Copyright 2022 Sony Corporation

항목 하위 항목 설정 공장 기본값 설명

Auto Upload
(Proxy)

On / Off Off 프록시 파일 자동 업로드를 켜거나 끕니다.

Default
Upload
Server

Server Settings1 ~
3 > Display Name

Server
Settings1

파일의 업로드 서버를 선택합니다. 여기에서 선택한 서버는 프록
시 파일의 자동 업로드 대상이 되고 썸네일 화면에서 파일의 업로
드 대상이 됩니다.
[Server Settings1~3]에 구성된 [Display Name] 설정을 표시합니
다.
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FTP Server 1 ~ 3

파일 FTP 전송과 관련된 설정을 지정합니다.
설정은 FTP Server 1~3에 대해 공통입니다.

5-041-958-23(1) Copyright 2022 Sony Corporation

항목 하위 항목 설정
공장 기본

값
설명

Display Name – – 전송 대상 설정 메뉴에 표시되는 표시 이름을 설정합니다.

Service – – 서버 유형을 표시합니다.

Host Name – – 전송 대상 서버의 호스트 이름을 설정합니다.

Port
21, 990,
1024~65534

21 전송 대상 서버의 포트 번호를 설정합니다.

User Name – – 전송 대상 서버 연결 인증을 위한 사용자 이름을 설정합니다.

Password – – 전송 대상 서버 연결의 인증 암호를 설정합니다.

Passive Mode On / Off Off 패시브 모드를 켜거나 끕니다.

Destination
Directory

– – 전송 대상 디렉터리의 이름을 설정합니다.

Using Secure
Protocol

On / Off Off
보안 FTP 전송을 사용할지(On) 또는 사용하지 않을지(Off)를
설정합니다.

Root Certificate – –

보안 FTP 전송을 위한 루트 인증서를 로드합니다.
[Load] 버튼을 누르고 표시된 화면에서 루트 인증서를 선택합
니다.
[Delete] 버튼을 눌러 로드된 루트 인증서를 삭제합니다.

Root Certificate
Status

– – 루트 인증서의 로드 상태를 표시합니다.

Reset – – [Server Settings] 설정을 기본값으로 재설정합니다.
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SSL

SSL과 관련된 설정을 지정합니다.

SSL
SSL 기능을 활성화/비활성화합니다.

SSL Server Authentication
SSL 서버 인증과 관련된 설정을 지정합니다.

항목 하위 항목 설정
공장 기본

값
설명

Function
Disable / Enable / Enable (Allow HTTP connection for
some clients)

Disable
SSL 기능을 활성화/비활성화합
니다.

항목 하위 항목 설정
공장
기본
값

설명

Certificate Options
Use a self-signed certificate
(For test use) / Use an
external certificate

– SSL 서버 인증서의 설치 방법을 설정합니다.

Status – –
[Certificate Options]이 [Use a self-signed certificate
(For test use)]으로 설정된 경우 SSL 서버 인증서의 유
효성을 표시합니다.

Issuer DN – –
[Certificate Options]이 [Use a self-signed certificate
(For test use)]으로 설정된 경우 SSL 서버 인증서 발급
자의 고유 이름을 표시합니다.

Subject DN – –
[Certificate Options]이 [Use a self-signed certificate
(For test use)]으로 설정된 경우 SSL 서버 인증서 주체
의 고유 이름을 표시합니다.

Available Period – –
[Certificate Options]이 [Use a self-signed certificate
(For test use)]으로 설정된 경우 SSL 서버 인증서의 유
효 기간을 표시합니다.

Extended Key
Usage

– –
[Certificate Options]이 [Use a self-signed certificate
(For test use)]으로 설정된 경우 확장 키 사용 방법을 표
시합니다.

Delete – –

이 버튼은 [Certificate Options]이 [Use a self-signed
certificate (For test use)]으로 설정된 경우에 표시됩니
다.
설치된 SSL 서버 인증서를 삭제합니다.

404



5-041-958-23(1) Copyright 2022 Sony Corporation

항목 하위 항목 설정
공장
기본
값

설명

Import – –
[Certificate Options]이 [Use an external certificate]으로
설정된 경우 목록에서 외부 SSL 서버 인증서를 설치합
니다.

Private Key
Password

– –
[Certificate Options]이 [Use an external certificate]으로
설정된 경우 SSL 서버 인증서의 개인 키 정보에 대한 암
호를 설정합니다.

Reset – –
이 버튼을 누르면 새 암호를 입력하기 위한 개인 키 암호
표시가 지워집니다.

Self-Signed
Certificate
Generation

– –
[Certificate Options]이 [Use a self-signed certificate
(For test use)]으로 설정된 경우 [Generate] 버튼을 눌러
자체 서명 인증서를 생성합니다.
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Referer Check

Referer 확인과 관련된 설정을 지정합니다.

Exception List
Referer 확인 예외 목록과 관련된 설정을 지정합니다.

5-041-958-23(1) Copyright 2022 Sony Corporation

항목 하위 항목 설정 공장 기본값 설명

Setting On / Off On Referer 확인 기능을 활성화/비활성화합니다.

항목
하위 항목 설

정
공장 기본

값
설명

No. 1~10 – 목록에서 예외 번호를 설정합니다.

Host Name – – 예외의 호스트 이름을 설정합니다.

Port
Number

– – 예외의 포트 번호를 설정합니다.

Set – – 구성된 예외를 예외 목록에 등록하려면 누릅니다.

Delete – –
삭제할 예외를 선택하고 버튼을 눌러 예외 목록에서 등록된 예외를 삭제
합니다.
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Brute Force Attack Protection

무차별 대입 공격 방지와 관련된 설정을 지정합니다.

공격자가 탐지되면 공격자 목록 정보가 표시됩니다.

5-041-958-23(1) Copyright 2022 Sony Corporation

항목
하위 항목 설

정
공장 기본

값
설명

Setting On / Off On [Brute Force Attack Protection] 기능을 켜거나 끕니다.

Count 3~100 8
공격으로 간주될 시도 횟수를 설정합니다.
[Setting]이 On으로 설정된 경우 활성화됩니다.

Release
Mode

Always /
Timer Timer

해제 조건을 설정합니다.
[Setting]이 On으로 설정된 경우 활성화됩니다.
Always: 공격자 목록에서 삭제되지 않습니다.
Timer: [Release Time]으로 설정한 해제 시간이 지나면 공격자 목록에서
삭제됩니다.

Release
Time

30~86400초 60

해제 시간을 설정합니다.
[Setting]이 On으로 설정된 경우 활성화됩니다.
Release Mode가 [Timer]로 설정된 경우 해제 시간이 지나면 공격자 목록에
서 항목이 삭제됩니다.

407



도움말 안내

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Stream

스트리밍 설정을 지정합니다("스트리밍 정보" 참조).

Stream Setting
스트리밍 프로토콜과 관련된 설정을 지정합니다.

참고 사항

RTMP를 사용하려면 [Stream] > [Audio Stream] > [Setting]을 미리 [On]으로 설정합니다.

RTSP
[Stream Setting]이 [RTSP]로 설정된 경우 다음 항목이 표시됩니다.
RTSP 스트리밍과 관련된 설정을 지정합니다.

RTMP
[Stream Setting]이 [RTMP]로 설정된 경우 다음 항목이 표시됩니다.
RTMP 스트리밍과 관련된 설정을 지정합니다.

항목 하위 항목 설정 공장 기본값 설명

Setting RTSP / RTMP / SRT-Caller / SRT-Listener / NDI|HX / Off RTSP 스트리밍 프로토콜을 선택합니다.

항목 하위 항목 설정
공장 기본

값
설명

Port Number
554,
1024~65534

554 RTSP 포트 번호를 설정합니다.

Time Out 0~600 60
RTSP 스트리밍에 대한 Keep Alive 명령의 시간 초과를 설정합니
다.

Authentication On / Off On RTSP 인증 기능을 켜거나 끕니다.

Video Port Number
1

1024~65534 51000
RTSP 유니캐스트 스트리밍을 위해 비디오 1을 전송하기 위한 포
트 번호를 설정합니다.

Video Port Number
2

1024~65534 53000
RTSP 유니캐스트 스트리밍을 위해 비디오 2를 전송하기 위한 포
트 번호를 설정합니다.

Audio Port Number 1024~65534 57000
RTSP 유니캐스트 스트리밍을 위해 오디오를 전송하기 위한 포트
번호를 설정합니다.

항목 하위 항목 설정 공장 기본값 설명

Server URL – – RTMP 또는 RTMPS 연결 대상 URL을 설정합니다.

Stream Key – – RTMP 서버 측에서 얻은 스트림 키를 설정합니다.
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SRT
[Stream Setting]이 [SRT-Caller] 또는 [SRT-Listener]로 설정된 경우 다음 항목이 표시됩니다.
SRT 스트리밍과 관련된 설정을 지정합니다.

NDI|HX
[Stream Setting]이 [NDI|HX]로 설정된 경우 다음 항목이 표시됩니다.
NDI|HX와 관련된 설정을 지정합니다.

항목 하위 항목 설정 공장 기본값 설명

Root Certificate – –

RTMP 서버와의 연결에 필요한 루트 인증서를 로드합니다.
[Load] 버튼을 누르고 표시된 화면에서 루트 인증서를 선택합니다.
[Delete] 버튼을 눌러 로드된 루트 인증서를 삭제합니다.
상태는 [Root Certificate Status]에 표시됩니다.

항목 하위 항목 설정
공장 기본

값
설명

Destination – – 기기가 호출자로 작동할 때 연결 대상 URL을 설정합니다.

Port
Number

1024~65534 4201
기기가 리스너로 작동할 때 리스닝을 위한 포트 번호를 설정합
니다.

Latency 20~8000ms 120 대기 시간을 설정합니다.

TTL 1~255 64 TTL 값을 설정합니다.

Encryption Off / AES128 / AES256 Off 암호화를 활성화/비활성화하고 암호화 방법을 설정합니다.

Passphrase
0 또는 10~79자의 문자
열

0
암호화에 사용되는 암호 문구를 설정합니다.
Reset을 눌러 입력한 암호 문구를 지웁니다.

ARC On / Off On Adaptive Rate Control 기능을 켜거나 끕니다.

항목 하위 항목 설정 공장 기본값 설명

License – – NDI 라이선스 키의 설치 상태를 표시합니다.

Source Name – – NDI 소스 이름을 표시합니다.

Group On / Off Off NDI 그룹화 기능을 켜거나 끕니다.

Group Name – –
NDI 그룹화 기능이 On으로 설정된 경우 표시됩니다.
그룹 이름을 설정합니다.

Discovery Server 1 – – NDI 검색 서버 1을 설정합니다.

Discovery Server 2 – – NDI 검색 서버 2를 설정합니다.

Multicast Mode On / Off Off 멀티캐스트 스트리밍을 켜거나 끕니다.

Multicast Prefix 239.255.0.0 239.255.0.0
[Multicast Mode]가 On으로 설정된 경우 표시됩니다.
멀티캐스트 스트리밍에 사용할 접두사를 설정합니다.

Multicast Netmask 255.255.0.0 255.255.0.0
[Multicast Mode]가 On으로 설정된 경우 표시됩니다.
멀티캐스트 주소 범위를 결정하는 넷마스크를 설정합니다.
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관련 항목

스트리밍 정보

5-041-958-23(1) Copyright 2022 Sony Corporation

항목 하위 항목 설정 공장 기본값 설명

Multicast TTL 1~256 3
[Multicast Mode]가 On으로 설정된 경우 표시됩니다.
멀티캐스트 스트리밍에 대한 TTL 값을 설정합니다.

Multi-TCP Mode On / Off Off Multi-TCP 모드를 켜거나 끕니다.

Unicast UDP Mode On / Off On Unicast UDP 모드를 켜거나 끕니다.
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도움말 안내

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Video Stream

스트리밍 비디오 코덱과 관련된 설정을 지정합니다.

Video Stream 1
비디오 코덱 1과 관련된 설정을 지정합니다.

Video Stream 2

항목 하위 항목 설정
공장 기본

값
설명

Codec 1 H.264 / H.265 H.264 이미지 1의 코덱을 설정합니다.

Size 1
4096×2160 / 3840×2160 / 2048×1080 /
1920×1080 / 1280×720 / 640×360

1920×1080
이미지 1의 영상 크기를 설정합니
다.

Frame Rate 1

지원되는 프레임 속도에 대한 자세한 내용
은 "스트리밍용 비디오 코덱 설정"을 참조
하십시오.

–
이미지 1의 프레임 속도를 설정합
니다.

I-Picture Mode 1 Time / Frame Time
이미지 1에 대한 IDR-Frame 삽입
간격을 시간 또는 프레임 수로 설정
합니다.

I-Picture Interval 1 1 / 2 / 3 / 4 / 5초 1

[I-Picture Mode 1]가 Time으로 설
정된 경우 표시됩니다.
H.264 및 H.265에 대한 IDR-Frame
삽입 간격을 시간으로 설정합니다.

I-Picture Ratio 1 15~300프레임 30

[I-Picture Mode 1]가 Frame으로 설
정된 경우 표시됩니다.
H.264 및 H.265에 대한 IDR-Frame
삽입 간격을 프레임 수로 설정합니
다.

Profile 1
H.264: high / main / baseline
H.265: main / main10

H.264:
high

H.264 또는 H.265 프로필을 설정
합니다.

Bit Rate
Compression
Mode 1

CBR / VBR VBR
이미지 1의 비트 전송률 압축 모드
를 설정합니다.

Bit Rate 1
512 / 768 / 1000 / 2000 / 3000 / 4000 / 5000 /
6000 / 7000 / 8000 / 16000 / 24000 / 32000 /
50000 / 64000 / 80000 kbps

16000

[Bit Rate Compression Mode 1]가
On으로 설정된 경우 표시됩니다.
비트 전송률 압축 모드가 CBR로
설정된 경우 비트 전송률 목표 값을
설정합니다.

Quality 1 1 / 2 / 3 / 4 / 5 / 6 / 7 / 8 / 9 / 10 6
H.264 또는 H.265 품질을 설정합
니다.
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비디오 코덱 2과 관련된 설정을 지정합니다.

Video Stream 3
비디오 코덱 3과 관련된 설정을 지정합니다.

항목 하위 항목 설정
공장 기본

값
설명

Codec 2 H.264 / H.265 / Off Off 이미지 2의 코덱을 설정합니다.

Size 2
4096×2160 / 3840×2160 / 2048×1080 /
1920×1080 / 1280×720 / 640×360 /
512×270

1920×1080 이미지 2의 영상 크기를 설정합니다.

Frame Rate 2

지원되는 프레임 속도에 대한 자세한
내용은 "스트리밍용 비디오 코덱 설
정"을 참조하십시오.

–
[Codec 2]가 Off으로 설정되지 않은 경우
표시됩니다.
이미지 2의 프레임 속도를 설정합니다.

I-Picture Mode 2 Time / Frame Time

[Codec 2]가 Off으로 설정되지 않은 경우
표시됩니다.
이미지 2에 대한 IDR-Frame 삽입 간격을
시간 또는 프레임 수로 설정합니다.

I-Picture Interval
2

1 / 2 / 3 / 4 / 5초 1

[Codec 2]가 Off로 설정되어 있지 않고 [I-
Picture Mode 2]가 [Time]으로 설정되어
있을 때 표시됩니다.
H.264 및 H.265에 대한 IDR-Frame 삽입
간격을 시간으로 설정합니다.

I-Picture Ratio 2 15~300프레임 30

[Codec 2]가 Off로 설정되어 있지 않고 [I-
Picture Mode 2]가 [Frame]으로 설정되
어 있을 때 표시됩니다.
H.264 및 H.265에 대한 IDR-Frame 삽입
간격을 프레임 수로 설정합니다.

Profile 2
H.264: high / main / baseline
H.265: main

– H.264 또는 H.265 프로필을 설정합니다.

Bit Rate
Compression
Mode 2

CBR / VBR VBR

[Codec 2]가 Off으로 설정되지 않은 경우
표시됩니다.
이미지 2의 비트 전송률 압축 모드를 설
정합니다.

Bit Rate 2

512 / 768 / 1000 / 2000 / 3000 / 4000 /
5000 / 6000 / 7000 / 8000 / 16000 /
24000 / 32000 / 50000 / 64000 / 80000
kbps

8000

[Codec 2]가 Off로 설정되어 있지 않고
[Bit Rate Compression Mode 2]가 [On]
으로 설정되어 있을 때 표시됩니다.
비트 전송률 압축 모드가 CBR로 설정된
경우 비트 전송률 목표 값을 설정합니다.

Quality 2 1 / 2 / 3 / 4 / 5 / 6 / 7 / 8 / 9 / 10 6

[Codec 2]가 H.264로 설정되어 있고 [Bit
Rate Compression Mode 2]가 Off로 설
정되어 있을 때 표시됩니다.
H.264 또는 H.265 품질을 설정합니다.
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관련 항목

스트리밍용 비디오 코덱 설정

5-041-958-23(1) Copyright 2022 Sony Corporation

항목 하위 항목 설정
공장 기본

값
설명

Codec 3 JPEG JPEG
이미지 3의 코덱을 설정
합니다.

Size 3 1280×720 / 1024×540 / 640×360 1280×720
이미지 3의 영상 크기를
설정합니다.

Frame
Rate 3

지원되는 프레임 속도에 대한 자세한 내용은 "스트리밍용 비
디오 코덱 설정"을 참조하십시오. –

이미지 3의 프레임 속도
를 설정합니다.

Quality 3 1 / 2 / 3 / 4 / 5 / 6 / 7 / 8 / 9 / 10 6 품질을 설정합니다.
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도움말 안내

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Audio Stream

스트리밍 오디오 코덱과 관련된 설정을 지정합니다.

5-041-958-23(1) Copyright 2022 Sony Corporation

항목 하위 항목 설정 공장 기본값 설명

Setting On / Off Off 오디오 스트리밍 출력을 켜거나 끕니다.

Codec AAC(128kbps) / AAC(256kbps) AAC(128kbps)
[Setting]이 On으로 설정된 경우 표시됩니다.
스트리밍용 오디오 코덱을 설정합니다.
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도움말 안내

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Language

표시 언어를 설정합니다.

참고 사항

사용 가능한 언어는 국가 또는 지역에 따라 다를 수 있습니다.

5-041-958-23(1) Copyright 2022 Sony Corporation

항목 하위 항목 설정 공장 기본값 설명

Language – – 표시 언어를 설정합니다.
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도움말 안내

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Accessibility

오디오 읽기(텍스트 음성 변환)와 관련된 설정을 지정합니다.

참고 사항

이 기능은 북미 지역에서 판매되는 모델에서만 사용할 수 있습니다. 스크린 리더 기능은 언어가 영어(출시일 기준)로 설정된 경우에
만 사용할 수 있습니다.

웹 앱을 실행하는 장치에서 웹 브라우저의 스크린 리더 기능을 활성화합니다.

5-041-958-23(1) Copyright 2022 Sony Corporation

항목 하위 항목 설정
공장 기본

값
설명

Screen
Reader

On / Off Off 
웹 앱의 카메라 이미지 패널에서 스크린 리더 기
능을 켜거나 끕니다.

Speech Rate
Slow2 / Slow1 / Normal / Fast1 / Fast2
/ Fast3 / Fast4

Normal
스크린 리더 기능의 속도를 설정합니다.
샘플 구절을 구성된 속도로 소리내어 읽습니다.

Speech
Volume 1~15 7

웹 앱의 스크린 리더 기능의 볼륨을 설정합니다.
샘플 구절을 구성된 볼륨으로 소리내어 읽습니
다.
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도움말 안내

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Clock Set

내부 시계 설정을 지정합니다.

5-041-958-23(1) Copyright 2022 Sony Corporation

항목 하위 항목 설정
공장 기
본값

설명

Current Date
& Time

– – 기기에 구성된 현재 시간을 표시합니다.

PC Clock – –
구성에 사용된 태블릿 또는 컴퓨터의 현재 시간을
표시합니다.

Date & Time
Format

yyyy-mm-dd hh:mm:ss / mm-dd-yyyy
hh:mm:ss / dd-mm-yyyy hh:mm:ss

yyyy-
mm-dd

날짜 및 시간의 표시 형식을 설정합니다.

12 h / 24 h 12 h / 24 h 24 h
시간을 12시간/24시간 표시 형식으로 설정합니
다.

Time Setting
Keep current setting / Synchronize with
PC / Manual setting / Synchronize with
NTP

– 날짜 및 시간의 구성 방법을 설정합니다.

yy-mm-dd
hh:mm:ss

yy: 19~37
mm: 01~12
dd: 01~31
hh: 00~23
mm: 00 ~59
ss: 00~59 (초)

–
[Time Setting]이 Manual setting으로 설정된 경우
표시됩니다.
날짜와 시간을 수동으로 설정합니다.

NTP Auto On / Off Off

[Time Setting]이 Synchronize with NTP로 설정된
경우 표시됩니다.
DHCP 서버에서 NTP 서버의 IP 주소를 가져올지
여부를 설정합니다.

NTP Server IPv4/IPv6 주소 또는 호스트 이름 –

[Time Setting]이 [Synchronize with NTP]로 설정
되어 있고 [NTP Auto]가 Off로 설정되어 있을 때
표시됩니다.
시간 동기화에 사용되는 NTP 서버를 지정합니다.

Time Zone UTC − 12:00 ~ UTC + 14:00 – 시간대를 선택합니다.
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도움말 안내

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Reset

기기를 초기화합니다.

Reboot
기기를 재부팅합니다.

Reset
기기의 설정을 재설정합니다.

5-041-958-23(1) Copyright 2022 Sony Corporation

항목 하위 항목 설정 공장 기본값 설명

Reboot Execute –

기기를 재부팅합니다.
Execute: 기능을 실행합니다.

참고 사항

재부팅 후 웹 브라우저에서 페이지를 다시 로드합니다.

항목
하위 항목
설정

공장 기
본값

설명

All Reset (except for
Network Settings)

Execute –

기기의 설정을 재설정합니다(네트워크 설정 제외).
Execute: 기능을 실행합니다.

참고 사항

가져온 기본 보기 및 LUT 파일은 삭제되지 않습니다.

Network Reset Execute –

기기의 네트워크 설정을 재설정합니다.
Execute: 기능을 실행합니다.

참고 사항

Network Reset을 실행한 후 기기가 재부팅됩니다. 재부팅 후 웹
브라우저에서 페이지를 다시 로드합니다.

Factory Default Execute –

기기의 설정을 공장 기본 상태로 되돌립니다.
Execute: 기능을 실행합니다.

참고 사항

Factory Default를 실행한 후 기기가 재부팅됩니다. 재부팅 후 웹
브라우저에서 페이지를 다시 로드합니다.
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도움말 안내

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Information

카메라 및 렌즈 정보를 표시합니다. 소프트웨어 업데이트에도 사용됩니다.

Camera
카메라 정보를 표시하고 소프트웨어를 업데이트합니다.

Lens
렌즈 정보를 표시하고 소프트웨어를 업데이트합니다.

항목
하위 항목 설

정
공장 기본

값
설명

Model Name – – 카메라의 모델명을 표시합니다.

Serial Number – – 카메라의 일련 번호를 표시합니다.

Version
Number

– – 카메라의 소프트웨어 버전을 표시합니다.

Version Up – –

[Choose File] 버튼을 누르고 화면의 지시에 따라 카메라 소프트웨어를 업
데이트합니다.

참고 사항

업데이트 후 기기가 재부팅됩니다. 재부팅 후 웹 브라우저에서 페이지를 다
시 로드합니다.

항목
하위 항목
설정

공장 기본
값

설명

Model Name – – 렌즈 모델명을 표시합니다.

Serial Number – – 렌즈의 일련 번호를 표시합니다.

Version
Number

– – 렌즈의 소프트웨어 버전을 표시합니다.

Version Up – –

[Choose File] 버튼을 누르고 화면의 지시에 따라 렌즈 소프트웨어를 업데
이트합니다.

자세한 내용은 "E-mount 렌즈 소프트웨어 업데이트"를 참조하십시오.

참고 사항

렌즈 업데이트 후 기기가 재부팅됩니다. 재부팅 후 웹 브라우저에서 페이지
를 다시 로드합니다.
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관련 항목

E-mount 렌즈 소프트웨어 업데이트

5-041-958-23(1) Copyright 2022 Sony Corporation
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도움말 안내

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

System Log

시스템 로그와 관련된 설정을 지정합니다.

획득한 로그는 아래와 같이 표시됩니다.

관련 항목

E-mount 렌즈 소프트웨어 업데이트

5-041-958-23(1) Copyright 2022 Sony Corporation

항목 하위 항목 설정 공장 기본값 설명

Log Level
Critical, Warning & Info /
Critical & Warning / Critical

Critical,
Warning & Info

시스템 로그에 녹화를 추가하기 위한 레벨을 설정합
니다.

Log Size 200~1024 1024 시스템 로그에 저장할 로그의 크기를 설정합니다.

Download as
File

– –
[Download] 버튼을 누르고 표시된 화면에서 시스템
로그를 태블릿이나 컴퓨터에 저장합니다.
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도움말 안내

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

HTTP Access Log

HTTP 액세스 로그와 관련된 설정을 지정합니다.

5-041-958-23(1) Copyright 2022 Sony Corporation

항목 하위 항목 설정 공장 기본값 설명

Log Level
Critical, Warning & Info /
Critical & Warning / Critical

Critical,
Warning & Info

HTTP 액세스 로그에 녹화를 추가하기 위한 레벨을
설정합니다.

Log Size 200~1024 1024
HTTP 액세스 로그에 저장할 로그의 크기를 설정합니
다.

Download as
File

– –
[Download] 버튼을 누르고 표시된 화면에서 HTTP 액
세스 로그를 태블릿이나 컴퓨터에 저장합니다.
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도움말 안내

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Service

기기에 대한 장치 정보를 획득합니다. Sony 서비스 담당자에게 문의할 때 사용하십시오.

5-041-958-23(1) Copyright 2022 Sony Corporation

항목
하위 항
목 설정

공장
기본
값

설명

I agree to download
device information.

– –

여기에 체크 표시를 하여 장치 정보 획득에 동의하고 [OK] 버튼을 누릅니
다.
표시된 [Download] 버튼을 누릅니다. 웹 브라우저는 deviceinformation.dat
이라는 파일을 잠시 다운로드합니다.

참고 사항

다운로드가 완료되면 기기가 재부팅됩니다. 기기가 자동으로 재부팅되지 않
으면 수동으로 재부팅하십시오. 재부팅 후 웹 브라우저에서 페이지를 다시
로드합니다.
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도움말 안내

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

EULA

최종 사용자 라이선스 계약(EULA)을 표시합니다.

5-041-958-23(1) Copyright 2022 Sony Corporation
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도움말 안내

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Software

소프트웨어 라이선스를 표시합니다.

5-041-958-23(1) Copyright 2022 Sony Corporation
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도움말 안내

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

외부 모니터 및 녹화 장치 연결

외부 모니터에 녹화/재생 영상을 표시하려면 외부 모니터의 비디오 출력 방식을 설정하고 연결할 모니터에 적합한 케이블
을 사용합니다.
또한 외부 녹화 장치를 연결하여 기기의 출력 신호를 녹화할 수도 있습니다.
상태 정보 및 메뉴와 같이 카메라 이미지 패널에 표시되는 것과 동일한 정보를 외부 모니터에 표시할 수 있습니다. 웹 메뉴
의 [Monitoring] > [Output Display]를 이용하여 화면 표시에 대해 원하는 시스템 종류를 On으로 설정합니다.

참고 사항

HDMI 커넥터에 연결된 모니터가 웹 메뉴 또는 카메라 메뉴의 [Monitoring] 메뉴를 사용하여 구성된 HDMI 출력 형식을 지원하지 않
으면 카메라 이미지가 웹 앱으로 출력되지 않습니다. 스트리밍 비디오도 출력할 수 없습니다.

[Output Display] > [SDI] 및 [HDMI/Stream]을 모두 [Off]로 설정할 수 있지만, 이렇게 하면 화면 표시에 따라 달라지는 카메라 메뉴
및 기능을 사용할 수 없습니다. 또한 기기의 오류 알림은 기기의 램프(켜짐 또는 깜박임)와 웹 앱의 오른쪽 상단에 있는 알림 마크가
표시되는 것으로 제한됩니다. 자세한 상태를 알 수 있도록 [Output Display]를 [On]으로 설정하십시오.

힌트

공장 기본값으로 [Output Display] > [SDI]는 [Off]로, [HDMI/Stream]은 [On]으로 설정되어 있습니다. 스트리밍을 메인 비디오로 사
용하려면 [SDI]를 [On]으로, [HDMI/Stream]을 [Off]로 설정하고 SDI 모니터에서 카메라 상태를 모니터링합니다.

SDI OUT 커넥터(BNC 유형)

웹 메뉴 또는 카메라 메뉴의 [Monitoring] 메뉴를 사용하여 출력 형식을 설정하십시오.
연결할 때 시중에서 구할 수 있는 75 Ω 동축 케이블을 사용합니다.

참고 사항

장치를 켜기 전에 기기와 외부 장치 사이의 연결이 접지되었는지 확인합니다.

75 Ω 동축 케이블을 연결한 후 기기를 외부 장치를 켜는 것이 좋습니다.
기기가 켜져 있는 동안 외부 장치가 기기에 연결되어야 하는 경우 먼저 75 Ω 동축 케이블을 외부 장치에 연결한 다음 기기
에 연결합니다.

기기와 외부 장치에서 동시에 녹화를 시작하려면

SDI 신호 출력이 활성화된 상태에서 카메라 메뉴의 [Project] > [SDI/HDMI Rec Control] > [Setting]을 [SDI/HDMI Remote
I/F] 또는 [Parallel Rec]로 설정하여 SDI OUT 커넥터에 연결된 외부 장치에 대한 REC 트리거 신호 출력을 활성화합니다.
이렇게 하면 외부 장치의 녹화가 기기와 동기화됩니다.

참고 사항

연결된 외부 장치가 REC 트리거 신호를 지원하지 않는 경우 장치를 작동시킬 수 없습니다.

카메라 메뉴에서 [Project] > [SDI/HDMI Rec Control] > [Setting]이 [SDI/HDMI Remote I/F]로 설정되어 있는 경우, 현재 삽입된 녹화
매체가 없고 녹화 START/STOP 버튼이 작동될 때 REC 트리거 신호만 출력됩니다.

HDMI OUT 커넥터(Type A 커넥터)

카메라 메뉴의 [Monitoring] 메뉴에서 출력 On/Off 설정 및 출력 형식을 설정합니다.

기기와 외부 장치에서 동시에 녹화를 시작하려면
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HDMI 신호 출력이 활성화된 상태에서 카메라 메뉴의 [TC/Media] > [HDMI TC Out] > [Setting]을 [On]으로, [Project] >
[SDI/HDMI Rec Control] > [Setting]을 [SDI/HDMI Remote I/F] 또는 [Parallel Rec]로 설정하여 HDMI OUT 커넥터에 연결된
외부 장치에 대한 REC 트리거 신호 출력을 활성화합니다. 이렇게 하면 외부 장치의 녹화가 기기와 동기화됩니다.

참고 사항

연결된 외부 장치가 REC 트리거 신호를 지원하지 않는 경우 장치를 작동시킬 수 없습니다.

카메라 메뉴에서 [Project] > [SDI/HDMI Rec Control] > [Setting]이 [SDI/HDMI Remote I/F]로 설정되어 있는 경우, 현재 삽입된 녹화
매체가 없고 녹화 START/STOP 버튼이 작동될 때 REC 트리거 신호만 출력됩니다.

5-041-958-23(1) Copyright 2022 Sony Corporation
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도움말 안내
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RCP/MSU와의 연결

RCP-3500/3501과 같은 원격 제어 패널(RCP) 또는 MSU-3500과 같은 마스터 셋업 유닛(MSU)을 LAN 케이블을 통해 기기
에 연결하여 기기의 일부 기능을 원격으로 제어할 수 있습니다.
연결 방법은 관련 장치의 구성과 애플리케이션에 따라 다릅니다.

기기와 RCP 간의 일대일 연결에 대한 자세한 내용은 "기기와 RCP 간의 일대일 연결"을 참조하십시오.
MSU 또는 카메라 제어 소프트웨어를 사용하여 여러 대의 카메라를 연결하는 것에 대한 자세한 내용은 "MSU/카메라
원격 제어 소프트웨어로 멀티 카메라 환경에서 기기 사용"을 참조하십시오.

관련 항목

기기와 RCP 간의 일대일 연결

MSU/카메라 원격 제어 소프트웨어로 멀티 카메라 환경에서 기기 사용

5-041-958-23(1) Copyright 2022 Sony Corporation
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기기와 RCP 간의 일대일 연결

참고 사항

"지원되는 기능 목록"을 참조하여 사용하려는 기능의 작동 조건을 충족하도록 기기를 구성한 후 다음 절차를 사용하여 RCP와의 연
결을 활성화합니다.

관련 항목

지원되는 기능 목록

5-041-958-23(1) Copyright 2022 Sony Corporation

각 장치를 켭니다.1

카메라의 웹 메뉴에서 [Technical] > [RCP/MSU] > [CNS Mode]를 [Bridge]로 설정합니다.2

RCP에서 다음 설정을 구성합니다.

구성에 대한 자세한 내용은 RCP의 사용 설명서를 참조하십시오.

3

연결 모드를 Bridge 모드로 설정합니다.1.
카메라의 IP 주소를 등록합니다.2.
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MSU/카메라 원격 제어 소프트웨어로 멀티 카메라 환경에서 기기 사용

MSU 또는 카메라 원격 제어 소프트웨어를 사용하여 여러 대의 카메라를 연결할 수 있습니다.

참고 사항

"지원되는 기능 목록"을 참조하여 사용하려는 기능의 작동 조건을 충족하도록 기기를 구성한 후 다음 절차를 사용하여 MSU 또는
카메라 원격 제어 소프트웨어와의 연결을 활성화합니다.

관련 항목

지원되는 기능 목록

5-041-958-23(1) Copyright 2022 Sony Corporation

각 장치를 켭니다.1

MSU 또는 카메라 원격 제어 소프트웨어를 사용하여 시스템 네트워크 설정을 구성합니다.

구성에 대한 자세한 내용은 MSU 또는 카메라 원격 제어 소프트웨어의 사용 설명서를 참조하십시오.

2

카메라의 웹 메뉴에서 [Technical] > [RCP/MSU]를 사용하여 다음 설정을 구성합니다.3

MSU를 사용하는 경우 [CNS Mode]를 [MCS]로 설정합니다. 카메라 원격 제어 소프트웨어를 사용하는 경우
[CNS Mode]를 [PC Control]로 설정합니다.

1.

[Master IP Address]에서 마스터 MSU 또는 카메라 원격 제어 소프트웨어의 IP 주소를 설정합니다.2.
[Camera No.]에 카메라를 등록할 카메라 번호를 설정합니다.3.
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지원되는 기능 목록

다음 표는 지원되는 기능과 해당 작동 조건을 보여줍니다.

작동 패널 기기의 기능 작동 조건

IRIS 조리개를 수동으로 조정 –

AUTO IRIS Auto Iris 켜기/끄기 –

ND
ND 필터 사전 설정 위치 전환(Clear/Preset1
~ Preset3)

이 기능은 카메라 메뉴에서 [Shooting] > [ND Filter] >
[Mode]가 [Preset]으로 설정된 경우 활성화됩니다.

MASTER
GAIN

게인을 수동으로 조정(3 dB 단위)
카메라 메뉴에서 촬영 모드가 Custom 모드로 설정되고
[Shooting] > [ISO/Gain/EI] > [Mode]가 [dB]로 설정된
경우 활성화됩니다.

WHITE (R/B)
화이트 밸런스(R Gain/B Gain)를 수동으로
조정

[White Mode]가 [Memory A(R/B)] 또는 [Memory
A(T/T)]로 설정된 경우 활성화됩니다.WHITE (Color

Temp)

화이트 밸런스(색온도/색조)를 수동으로 조
정

RCP – [Color Temp]: 화이트 밸런스 색온
도
RCP – [Balance]: 화이트 밸런스 색조 값

ATW
ATW(자동 추적 화이트 밸런스) 기능 켜기/끄
기

촬영 모드가 Custom 모드로 설정된 경우 활성화됩니
다.

BLACK R/B 블랙 밸런스 조정
촬영 모드가 Custom 모드로 설정된 경우 활성화됩니
다.
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참고 사항

사용하려는 기능의 작동 조건을 충족하도록 기기를 구성한 후 RCP/MSU와의 연결을 활성화합니다. 연결이 활성화된 후 작동 조건
을 조정하면 의도하지 않은 동작이 발생할 수 있습니다.

5-041-958-23(1) Copyright 2022 Sony Corporation

작동 패널 기기의 기능 작동 조건

MASTER
BLACK

마스터 검정 레벨 조정

촬영 모드가 Custom 모드로 설정된 경우 활성화됩
니다.
카메라 메뉴에서 [Paint/Look] > [Detail] > [Manual
Setting]이 [On]으로 설정된 경우 H/V Ratio 및
Crispening이 활성화됩니다.

DETAIL

세부적인 기능 켜기/끄기
세부적인 레벨 설정
설정 H/V Ratio
설정 Crispening

User Matrix

사용자 매트릭스 보정 기능 켜기/끄기
매트릭스 보정 값 설정(R-G/R-B/G-R/G-
B/B-R/B-G)

Multi Matrix

멀티 매트릭스 보정 기능 켜기/끄기
멀티 매트릭스 보정에 사용되는 색상의
색조 및 채도 설정

Knee
Knee 보정 기능 켜기/끄기
자동 Knee 기능 켜기/끄기
Knee 포인트 및 Knee 경사 설정

BARS 컬러 바 켜기/끄기

SHUTTER

셔터 기능 켜기/끄기
셔터 속도 값 설정
(자동 셔터 켜기/끄기 전환, 셔터 앵글 설
정, 슬로우 셔터 설정, ECS 설정은 지원
되지 않습니다.)

참고 사항

구성된 셔터 속도 값에 따라 RCP 셔터
설정이 표시되지 않을 수 있습니다.

RCP에서 셔터를 조작할 수 없는 경우
RCP 셔터 설정이 올바르게 표시되지
않을 수 있습니다.

자동 셔터가 켜져 있으면 셔터를 켜고 끄거나 RCP에서
셔터 속도 값을 변경하더라도 자동 셔터가 계속 작동합
니다.
셔터가 [Angle]로 설정된 경우 RCP에서 셔터를 켜고 끄
거나 셔터 속도 설정을 변경할 수 없습니다.
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RM-IP500 원격 제어기(옵션)을 사용한 작업 정보

소프트웨어 버전 2.2 이상을 실행하는 Sony RM-IP500 원격 제어기를 사용하여 기기를 조작할 수 있습니다. 장치는 VISCA
over IP(LAN)를 사용하여 통신합니다.
작업할 대상 항목에 따라 기기의 화면 표시를 볼 필요가 있을 수 있습니다. 화면 표시를 확인하는 데 사용할 수 있는 모니터
를 준비합니다.
다음 작업은 RM-IP500 원격 제어기에서 지원됩니다.

대상 카메라 선택
프레이밍 조정(팬, 틸트, 줌)
초점 조정(터치 조작 제외)
사전 설정 위치 등록 및 불러오기
기기의 메뉴 조작(웹 메뉴 제외)
밝기 조정
화이트 밸런스 조정
블랙 밸런스 조정
오디오 입력 레벨 조정
녹화 시작/중지
기기의 할당 가능 버튼 기능 실행

RM-IP500 작업에 대한 자세한 내용은 RM-IP500 사용 설명서를 참조하십시오.

힌트

RM-IP500을 사용하는 경우 RM-IP500과 함께 제공되는 본 기기용 패널 시트를 사용하십시오.

RM-IP500(본 기기용 패널 시트 사용)
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RM-IP500 원격 제어기 연결

기능 할당에 대한 자세한 내용은 RM-IP500의 사용 설명서를 참조하십시오.

5-041-958-23(1) Copyright 2022 Sony Corporation

기기의 SETUP 스위치 3을 ON 위치로 설정하여 VISCA over IP 통신을 활성화합니다.

참고 사항

스위치 설정은 다음에 기기를 켤 때 적용됩니다.

1

RM-IP500을 기기와 동일한 네트워크에 연결합니다.2

RM-IP500 사용 설명서의 절차에 따라 RM-IP500에서 VISCA over IP(LAN) 연결을 구성합니다.

RM 메뉴 > AUTO IP SETUP > ASSIGN CAM을 사용하여 본 기기를 할당합니다.

3

RM-IP500의 다음 RM 메뉴 항목을 사용하여 필요에 따라 본 기기의 기능을 버튼과 노브에 할당합니다.

SW ASSIGN
AE CONFIG2
WB MODE

4
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외부 장치와의 동기화 정보

여러 기기를 사용하여 촬영하는 경우 기기의 GENLOCK 커넥터를 통해 기기를 특정 기준 신호 또는 타임코드에 동기화할
수 있습니다.

젠록에 대한 자세한 내용은 "비디오 신호의 위상 동기화(Genlock)"를 참조하십시오.
타임코드 동기화에 대한 자세한 내용은 "다른 장치에 타임코드 잠그기"를 참조하십시오.

관련 항목

비디오 신호의 위상 동기화(Genlock)

다른 장치에 타임코드 잠그기

5-041-958-23(1) Copyright 2022 Sony Corporation
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비디오 신호의 위상 동기화(Genlock)

GENLOCK 커넥터에 기준 신호를 제공하여 젠록을 활성화할 수 있습니다.
사용할 수 있는 입력 기준 신호는 선택한 녹화 형식의 시스템 주파수에 따라 달라집니다.

카메라 메뉴의 [Technical] > [Genlock] > [Reference]을 사용하여 외부 동기화 상태를 확인할 수 있습니다.

참고 사항

기준 신호가 불안정하면 젠록을 달성할 수 없습니다.

부반송파는 동기화되지 않습니다.

5-041-958-23(1) Copyright 2022 Sony Corporation

녹화 형식의 시스템 주파수 지원되는 입력 기준 신호

59.94P
1920×1080 59.94i
720×486 59.94i

50P
1920×1080 50i
720×576 50i

29.97P
1920×1080 59.94i
720×486 59.94i

25P
1920×1080 50i
720×576 50i

24P
1920×1080 24PsF
1920×1080 24P

23.98P
1920×1080 23.98PsF
1920×1080 23.98P

59.94i
1920×1080 59.94i
720×486 59.94i

50i
1920×1080 50i
720×576 50i
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도움말 안내

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

다른 장치에 타임코드 잠그기

타임코드를 제공하는 장치를 타임코드 출력이 계속 실행되는 모드(예: Free Run 또는 Clock)로 설정합니다.

참고 사항

제공된 기준 타임코드와 기준 비디오 신호가 SMPTE 타임코드 표준을 준수하는 위상 관계에 있는지 확인합니다.

외부 잠금으로 작동할 때 타임코드는 외부 타임코드로 즉시 잠기고 외부 타임코드 값이 시간 데이터 표시 영역에 나타납니다. 그러
나 즉시 녹화를 시작하지 마십시오. 녹화 전에 타임코드 생성기가 안정화 될 때까지 몇 초 동안 기다립니다.

기준 비디오 신호 주파수와 기기의 프레임 주파수가 동일하지 않으면 잠기지 않아 기기가 올바르게 작동할 수 없습니다. 이러한 경
우 타임코드는 외부 타임코드를 사용하여 성공적으로 잠기지 않습니다.

외부 타임코드 소스의 연결이 끊어지면 타임코드는 기준 타임코드에 대해 시간당 한 프레임씩 이동할 수 있습니다.

외부 잠금을 해제하려면

카메라 메뉴의 [TC/Media] > [Timecode] 설정을 변경합니다.
시스템 주파수가 변경되고 특수 녹화 모드(Slow & Quick Motion 또는 Interval Rec)로 녹화를 시작하면 외부 동기화가 해제
됩니다.

5-041-958-23(1) Copyright 2022 Sony Corporation

카메라 메뉴의 [TC/Media] > [Timecode]에서 다음을 설정합니다.

[Mode]를 [Preset]으로 설정합니다.
[Run]를 [Free Run]으로 설정합니다.

1

[DURATION/TC/U-BIT] 기능이 할당된 할당 가능 버튼을 눌러 화면에 타임코드를 표시합니다.2

HD 또는 SD 기준 비디오 신호를 GENLOCK 커넥터에 공급하고 기준 타임코드를 TC IN 커넥터에 공급합니다.

기기의 타임코드 생성기가 기준 타임코드로 잠기고 화면에 "EXT-LK"가 나타납니다.
타임코드가 잠기고 약 10초가 지나면 외부 기준 타임코드 소스 연결이 끊어지더라도 외부 잠금 상태가 유지됩니다.

3
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외부 마이크 또는 외부 오디오 장치 연결

외부 마이크 또는 외부 오디오 장치에서 신호를 입력하고 기기의 녹화된 비디오 또는 출력 비디오에 오디오를 삽입할 수
있습니다.

XLR 케이블을 사용하여 외부 마이크 또는 외부 오디오 장치를 연결합니다.

카메라 메뉴에서 [Audio] > [Audio Input] > [AUDIO IN Select]를 사용하여 오디오를 [LINE]으로 설정하면 AUDIO IN
커넥터가 AUDIO IN CH-1 커넥터 및 AUDIO IN CH-2 커넥터로 작동합니다.

1

핀 번호 기능

1 GND

2 AUDIO IN CH-1+ (HOT)

3 AUDIO IN CH-1− (COLD)

4 AUDIO IN CH-2+ (HOT)

5 AUDIO IN CH-2− (COLD)

기기의 전원을 끄고 XLR 케이블을 AUDIO IN 커넥터에 연결합니다.2

SETUP 스위치 2를 설정하여 필요에 따라 팬텀 전원 공급 장치를 활성화합니다.

아래 설명에 따라 +48V 전원 공급 장치(팬텀 전원)를 전환합니다.
스위치 2
오디오 입력 장치가 연결된 경우 +48V 전원 공급 장치(팬텀 전원)를 켜거나 끌지 여부를 설정합니다.

3

설정 설명

OFF(기본
값)

이렇게 하면 +48V 팬텀 전원 공급 장치가 꺼지고 LINE 또는 MIC 입력이 CH-1 및 CH-2 오디오 소스
로 설정됩니다.
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참고 사항

이 스위치를 ON 위치로 설정하고 +48V 소스와 호환되지 않는 마이크를 연결하면 연결된 장치가 손상될 수 있습니다. 장치를
연결하기 전에 설정을 확인하십시오.

설정 설명

ON
이렇게 하면 +48V 팬텀 전원 공급 장치가 켜지고 팬텀 전원 공급 장치 호환 마이크가 CH-1 및 CH-2
오디오 소스로 설정됩니다.

기기의 전원을 켜고 카메라 메뉴의 [Audio] > [Audio Input] > [AUDIO IN Select]을 사용하여 연결된 장치의 유형을
설정합니다.

4
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컴퓨터를 사용하여 클립 관리/편집

컴퓨터를 사용하여 클립을 관리/편집할 수 있습니다.

카드 리더를 사용하여 클립 가져오기(옵션)

CFexpress Type A 카드 리더 또는 SD 카드 리더를 컴퓨터에 연결하고 Catalyst Browse와 같이 본 기기의 녹화 형식을 지
원하는 소프트웨어를 사용하여 클립을 가져옵니다.

비선형 편집 시스템 사용

비선형 편집 시스템에서 기기로 녹화한 형식을 지원하는 편집 소프트웨어(옵션)가 필요합니다.

5-041-958-23(1) Copyright 2022 Sony Corporation
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광섬유 신호 출력

SFP+ 모듈(옵션)을 기기의 OPTICAL 커넥터에 연결하여 광신호로 변환된 SDI 신호를 출력할 수 있습니다. 각 형식의 신호
대역과 일치하는 SFP+ 모듈을 사용하십시오.
신호 대역

4K(59.94p, 50p): 12G
4K(59.94p, 50p 제외): 6G
HD(59.94p, 50p): 3G
HD(59.94p, 50p 제외): 1.5G

참고 사항

다음 표준을 준수하는 모듈을 사용하십시오.

SFF 표준
SFF-8083/SFF-8418/SFF-8419*/SFF-8432/SFF-8433/SFF-8071/SFF-8472

SDI 표준
ST297/ST292/ST424/ST425/ST2081/ST2082

SDI 출력 커넥터와 동일한 신호가 SFP+ 모듈로 출력됩니다.

본 기기는 광섬유 신호 입력을 지원하지 않습니다.

광섬유 신호 출력에는 SFP+ 모듈을 사용하십시오. 검증된 SFP+ 모듈에 대한 자세한 내용은 대리점이나 Sony 서비스 담당자에게
문의하십시오.

5-041-958-23(1) Copyright 2022 Sony Corporation

* 전력 레벨 I(1.0W)
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기록 신호 연결

이 항목에서는 기록 신호 제어에 대해 설명합니다.

원격 제어기의 신호를 사용하여 기록 램프 켜기

RM-IP500과 같은 외부 장치에서 VISCA over IP 명령을 사용하여 기록 램프를 켤 수 있습니다.
웹 메뉴 또는 카메라 메뉴에서 [Technical] > [Tally] > [Tally Control]을 [External]로 설정합니다.

외부 장치에서 기록 램프 켜기

RM-IP500 또는 스위처와 같은 외부 장치에서 기기의 기록 램프를 빨간색 또는 녹색으로 켤 수 있습니다. 네트워크를 통해
전송된 명령을 사용하거나 기기의 OPTION 커넥터에 입력된 기록 신호를 사용하여 기록을 제어할 수 있습니다.
웹 메뉴 또는 카메라 메뉴에서 [Technical] > [Tally] > [Tally Control]을 [External]로 설정합니다.
OPTION 커넥터에 기록 신호를 입력할 때 핀 7을 GND(핀 4 또는 5)로 단락하여 기록 램프를 녹색으로 켜거나 핀 8을
GND(핀 4 또는 5)로 단락하여 기록 램프를 빨간색으로 켭니다.

참고 사항

[Tally Control]이[External]로 설정되어 있으면 기기의 녹화 상태가 기록 램프로 표시되지 않습니다.

빨간색 기록과 녹색 기록이 동시에 입력되면 기기의 기록 램프가 빨간색으로 켜집니다.

OPTION 커넥터 핀 사양

핀 번호 신호 방향 신호 사양

1 – RS-232C TX 신호(렌즈 제어기용)

2 – RS-232C RX 신호(렌즈 제어기용)

3 OUT

녹색 기록 램프 출력
녹색 기록 램프가 켜져 있을 때 로우 레벨 출력.
녹색 기록 램프가 켜져 있지 않을 때 Hi-Z(오픈 드레인 출력).

4 – GND(접지)

5 – GND(접지)
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기기의 신호를 사용하여 외부 장치의 기록 램프 켜기

아래와 같이 OPTION 커넥터의 핀 3과 핀 6을 연결하여 기기의 신호를 사용함으로써 외부 장치의 기록 램프를 켤 수 있습
니다.
OPTION 커넥터 핀 3 및 6 연결 예

참고 사항

핀 7과 8에 전압을 인가하지 마십시오.

OPTION 커넥터에 전압을 인가할 수 있는 외부 장치를 연결하지 마십시오.

핀 3 또는 핀 6에 정격을 초과하는 돌입 또는 역전압을 인가하면 오작동, 연기, 또는 화재의 원인이 될 수 있습니다.

웹 메뉴 또는 카메라 메뉴의 [Technical] > [Tally] > [Tally Control]을 사용하여 출력 신호를 설정합니다.
[Internal]: 기기의 녹화 작동 상태
[External]: IN 신호 또는 원격 제어기를 통해 기기가 수신한 빨간색/녹색 기록 신호의 논리적 AND.

5-041-958-23(1) Copyright 2022 Sony Corporation

핀 번호 신호 방향 신호 사양

6 OUT

빨간색 기록 램프 출력
빨간색 기록 램프가 켜져 있을 때 로우 레벨 출력.
빨간색 기록 램프가 켜져 있지 않을 때 Hi-Z(오픈 드레인 출력).

7 IN
녹색 기록 외부 제어 입력
접지에 대한 단락(핀 4 또는 5)으로 인해 기기의 기록 램프가 녹색으로 켜집니다.

8 IN
빨간색 기록 외부 제어 입력
접지에 대한 단락(핀 4 또는 5)으로 인해 기기의 기록 램프가 빨간색으로 켜집니다.
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추적 데이터 출력(free-d)

기기는 팬/틸트/줌, 초점 및 조리개 추적 정보를 동기화 신호와 동기화할 수 있습니다.
데이터 출력은 산업 표준인 free-d 프로토콜을 준수합니다. 출력 방법(일정한 출력과 클라이언트 요청 시 출력 중 하나를
선택)을 선택할 수 있습니다. VR/AR 시스템에 따라 출력 방법을 선택합니다.

데이터 출력 형식

힌트

기술적인 세부 사항은 "free-d의 통합 매뉴얼"에 제공됩니다. Sony 영업 담당자에게 문의하십시오.

기기에 의해 출력되는 추적 데이터는 free-d 프로토콜의 Type D0/D1에 지정된 형식에 따라 다음 데이터로 구성됩니다.
Type D0 – poll/command

Type D1 – camera position/orientation data

기기가 켜져 있는지 확인합니다.1

추적 데이터 출력 방법을 설정합니다.

일정한 출력의 경우

클라이언트 요청 시 출력의 경우

2

웹 메뉴에서 [Technical] > [Tracking Data Output] > [Transfer Mode]를 [Always]로 설정합니다.1.
[Camera ID]에서 기기의 ID를 설정합니다.2.
[Destination Address]에서 출력 대상 IP 주소를 지정합니다.3.
[Destination Port]에서 출력 대상 포트 번호를 지정합니다.4.
[OK] 버튼을 누릅니다.5.

웹 메뉴에서 [Technical] > [Tracking Data Output] > [Transfer Mode]를 [On Demand]로 설정합니다.1.
[Camera ID]에서 기기의 ID를 설정합니다.2.
[Listen Port]에서 클라이언트의 요청을 수신하기 위해 포트 번호를 지정합니다.3.
[OK] 버튼을 누릅니다.4.

기호 내용 설명

<D0> Message type

<CA> Camera ID

<CD> command

다음 명령을 지원합니다.

00 Stop stream mode
01 Start stream mode

<CK> Checksum
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참고 사항

추적 데이터가 지연되거나 다음 상황에서는 값이 업데이트되지 않을 수 있습니다.

RAW 비디오를 출력하는 경우
S&Q Motion이 켜진 경우
카메라 메뉴를 표시하는 경우
썸네일 화면을 표시하는 경우
녹화된 클립을 재생하는 경우
웹 메뉴를 표시하는 경우

5-041-958-23(1) Copyright 2022 Sony Corporation

기호 내용 설명

<D1> Message type

<CA> Camera ID

<PH><PM><PL> Camera Pan Angle 팬 각도(−170° ~ +170°)

<TH><TM><TL> Camera Tilt Angle 틸트 각도(−30° ~ +195°)

<RH><RM><TL> Camera Roll Angle 지원되지 않음(항상 0)

<XH><XM><XL> Camera X-Position 지원되지 않음(항상 0)

<YH><YM><YL> Camera Y-Position 지원되지 않음(항상 0)

<HH><HM><HL> Camera Height 지원되지 않음(항상 0)

<ZH><ZM><ZL> Camera Zoom 초점 길이

<FH><FM><FL> Camera Focus 초점 거리

<SH><SL> Spare/User Defined 조리개 위치

<CK> Checksum
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렌즈 제어기 연결

이 기기와 호환되는 상용 렌즈 제어기(옵션)를 연결하여 웹 앱, RM-IP500 (옵션) 또는 적외선 리모컨에서 수동 줌 렌즈의
줌을 작동할 수 있습니다.
렌즈 제어기 연결에 대한 자세한 내용은 렌즈 제어기의 사용 설명서를 참조하십시오.
렌즈 제어기를 사용한 줌 조정에 대한 자세한 내용은 "렌즈 제어기를 사용하여 줌 조정"을 참조하십시오.

참고 사항

렌즈 제어기를 사용하기 전에 렌즈 제어기의 사용 설명서를 주의 깊게 읽고 사용법을 완전히 이해하는지 확인하십시오. Sony는 렌
즈 제어기 사용으로 인한 모든 종류의 청구에 대해 책임을 지지 않습니다.

렌즈 제어기가 활성화된 경우 Clear Image Zoom을 사용할 수 없습니다. Clear Image Zoom 비율을 1.0배로 설정하거나 Clear
Image Zoom을 비활성화하는 것이 좋습니다.

렌즈 제어기가 활성화되면 카메라 프레이밍 작업을 녹화하거나 재생할 수 없습니다.

관련 항목

렌즈 제어기를 사용하여 줌 조정

5-041-958-23(1) Copyright 2022 Sony Corporation
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렌즈 제어기를 사용하여 줌 조정

다음 절차를 사용하여 렌즈 제어기(옵션)를 부착하고 줌을 조정하십시오.

렌즈 제어기 상태를 확인하려면

웹 앱 화면의 공통 영역에서 (카메라 상태) 버튼을 눌러 카메라 상태 화면을 표시합니다.

렌즈 제어기를 기기의 커넥터 블록의 OPTION 커넥터에 연결합니다.

부착에 대한 자세한 내용은 렌즈 제어기의 사용 설명서를 참조하십시오.

1

줌 렌즈용 렌즈 제어기를 설정합니다.

자세한 내용은 렌즈 제어기의 사용 설명서를 참조하십시오.

2

기기의 팬/틸트를 잠그고 줌 렌즈를 부착합니다.

자세한 내용은 "렌즈 부착"을 참조하십시오.

3

줌 렌즈를 조작할 수 있도록 렌즈 제어기를 조정합니다.4

슬라이드 베이스가 수평이 되도록 카메라 헤드의 전후 균형을 유지합니다.

자세한 내용은 렌즈 제어기의 사용 설명서 및 "렌즈 부착"을 참조하십시오.

5

웹 메뉴에서 [Technical] > [Lens Controller] > [Setting]을 [On]으로 설정하고 [OK] 버튼을 누릅니다.

기기가 재부팅됩니다. 팬/틸트 재설정 작업이 완료될 때까지 기다립니다.

6

웹 앱의 라이브 작동 화면의 카메라 제어 패널의 (Others) 탭에서 (렌즈 제어기 초기화) 버튼을 누
릅니다.

렌즈 제어기는 줌 범위를 감지하기 위해 움직입니다. 자세한 내용은 렌즈 제어기의 사용 설명서를 참조하십시오.
카메라 이미지 패널의 왼쪽 상단에서 (렌즈 제어기 오류) 표시가 (렌즈 제어기 준비)로 변경되면 준비가 완료됩
니다.

참고 사항

렌즈 제어기를 초기화 할 때 렌즈의 작동 범위에 유의하십시오.

7

웹 앱에서 [Zoom] 슬라이더를 사용하여 줌을 조정하거나 적외선 리모컨의 줌 제어 버튼을 조정합니다.8
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이 화면에서 렌즈 제어기 상태를 확인할 수 있습니다.

참고 사항

렌즈를 교환할 때 렌즈 제어기를 초기화합니다.

렌즈 제어기가 활성화된 경우 Clear Image Zoom을 사용할 수 없습니다. Clear Image Zoom 비율을 1.0배로 설정하거나 Clear
Image Zoom을 비활성화하는 것이 좋습니다.

5-041-958-23(1) Copyright 2022 Sony Corporation

상태 설명

Off E-mount 렌즈의 파워 줌을 사용합니다.

Communication
Error

기기와 렌즈 제어기 간에 통신 오류가 발생했습니다.
기기와 렌즈 제어기 간의 연결을 확인한 다음 렌즈 제어기 사용 설명서를 참조하고 렌즈 제어기를
초기화합니다.

Uninitialized 초기화를 실행합니다.

Initializing 초기화가 완료될 때까지 기다립니다.

Initialization Failed
기기와 렌즈 제어기 간의 연결을 확인한 다음 렌즈 제어기 사용 설명서를 참조하고 렌즈 제어기를
초기화합니다.

Working 렌즈 제어기를 사용하여 줌을 제어합니다.

Rotation Error
저장된 줌 이동 범위와 렌즈 이동 범위가 일치하지 않을 수 있습니다. 렌즈 제어기를 초기화합니
다.

System Error 기기와 렌즈 제어기 사이의 연결을 확인하고, 렌즈 제어기 사용 설명서를 참조하여 렌즈 제어기를
초기화하거나 기기와 렌즈 제어기의 전원을 껐다가 켜십시오.Unknown Error
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사용 주의 사항

운반 및 포장 시 주의사항

본 기기를 운반하거나 포장할 때 다음 조건을 유지하고 강한 진동이나 충격을 가하지 마십시오.

렌즈를 제거하고 바디 캡을 부착합니다.
카메라 헤드(A)를 앞으로 이동시킨 후 카메라 헤드 잠금 레버(B)를 화살표 방향으로 돌려 카메라 헤드를 잠급니다.

카메라 헤드의 방향이 전면을 향하도록 하고 팬/틸트 잠금 레버를 사용하여 잠급니다.

연결 케이블을 제거합니다.

응결

이 장치를 추운 곳에서 따뜻한 곳으로 갑자기 가져오거나 주변 온도가 갑자기 높아진 경우에는 물방울이 장치의 외부 표면
및/또는 내부에 생길 수 있습니다. 이 현상을 응결이라고 합니다. 응결이 발생하면 장치를 끄고 응결이 제거될 때까지 기다
린 후 장치를 작동시키십시오. 응결이 있는 상태에서 장치를 작동시키면 장치가 손상될 수 있습니다.

카메라 CMOS 이미지 센서 현상

참고 사항

이미지에서 발생할 수 있는 다음 현상은 이미지 센서에만 해당합니다. 이는 오동작이 아닙니다.

흰색 반점
이미지 센서는 정밀도가 높은 기술로 제작되지만 드물게 우주선 등으해 화면에 미세한 흰색 반점이 발생할 수 있습니
다.
이는 이미지 센서의 원리와 관련된 것으로 오작동이 아닙니다. APR을 정기적으로 실행합니다.
특히 다음과 같은 경우에 흰색 반점이 나타날 수 있습니다.

높은 환경 온도에서 작동할 때
게인(감도)을 올렸을 때

450



깜박임
형광등, 나트륨 램프, 수은등 또는 LED 조명에서 촬영하면 화면이 깜박이거나 색상이 다를 수 있습니다.

렌즈 및 팬/틸트 드라이브 기기

렌즈와 팬/틸트 드라이브 메커니즘을 장기간 작동하지 않으면 내부에 도포된 그리스의 점도가 증가하여 메커니즘이 움직
이지 않을 수 있습니다. 렌즈 및 팬/틸트 메커니즘을 정기적으로 작동시키십시오.

소모품

팬과 내장 충전식 배터리는 주기적 교체가 필요한 소모품입니다.
실내 온도에서 작동 시 일반적인 교체 주기는 약5년입니다. 하지만 이 교체 주기는 일반적인 지침일 뿐이며 이러한 부
품의 기대 수명을 보장한다는 것을 의미하지는 않습니다.
부품 교체에 대한 자세한 내용은 Sony 서비스 센터나 해당 대리점에 문의하십시오.

정상 작동 온도에서 정상적으로 사용(하루 8시간, 1개월에 25일 사용)하는 경우 AC 어댑터와 전해 콘덴서의 기대 수명
은 5년 정도입니다. 정상 사용 빈도를 초과하여 사용하면 기대 수명이 단축될 수 있습니다.

장치가 제대로 작동되도록 유지하고 장치의 사용 가능한 수명을 연장하기 위해 정기점검을 실시하는 것이 좋습니다. 점검
에 대한 자세한 내용은 Sony 서비스 담당자에게 문의하십시오.

내장 충전식 배터리 정보

기기에는 기기가 꺼져도 날짜, 시간 및 기타 설정을 저장할 수 있는 충전식 배터리가 내장되어 있습니다. 내장 충전식 배터
리는 기기를 켜거나 끄는 것에 관게없이 AC 어댑터를 사용하여 전원 콘센트에 기기를 연결하거나 PoE++를 통해 전원을
공급하는 경우 24시간이 지나면 충전됩니다. 충전식 배터리는 AC 어댑터가 전원 공급 장치에 연결되어 있지 않은 경우 약
2개월 후에 완전히 방전됩니다. 배터리를 충전한 후 기기를 사용하십시오. 그러나 충전식 배터리가 충전되어 있지 않아도
날짜를 기록할 필요가 없는 한 기기 작동에 영향을 주지 않습니다.

사용 및 보관 위치

평평하고 통풍이 잘 되는 장소에 보관하십시오.
다음과 같은 장소에서 장치를 사용하거나 보관해서는 안 됩니다.

비나 물이 닿는 장소(처마 밑 포함)
실외 및 40 °C를 초과하는 장소
더운 기후의 여름에는 창문을 닫은 차량 내부의 온도가 50 °C를 쉽게 초과할 수 있음을 기억하십시오.
0 °C보다 추운 장소
습기나 먼지가 많은 장소 장치가 비를 맞을 수 있는 장소
진동이나 충격이 있는 장소
방사선, X선 및 강한 자기장이 생성되는 장소
강한 전자기장을 형성하는 라디오 또는 TV 송신기 근처
장시간 직사광선이 비치는 장소나 히터 근처

레이저 빔에 대한 참고 사항

레이저 빔은 CMOS 이미지 센서를 손상시킬 수 있습니다. 레이저 빔이 포함된 장면을 촬영하는 경우 레이저 빔이 카메라
의 CMOS 이미지 센서로 향하지 않도록 주의하십시오. 의료 장비나 기타 장치에서 나오는 고출력 레이저 빔은 반사광과
산란광으로 인해 손상을 일으킬 수 있습니다.

휴대용 통신 장치의 전자기 간섭 방지

이 기기 근처에서 휴대폰과 기타 통신 장치를 사용하면 오동작이 발생하고 오디오 및 비디오 신호에 간섭이 일어날 수 있
습니다. 이 기기 근처에 있는 휴대용 통신 장치의 전원을 끄는 것이 좋습니다.

이 제품을 의료 기기 가까이에 두지 마십시오

이 제품(부속품 포함)은 심장박동기, 수두증 치료를 위한 프로그램가능 차단밸브 또는 기타 의료 기기의 작동을 방해할 수
있는 자석을 포함하고 있습니다. 해당 의료 기기를 사용하는 사람들 가까이에 이 제품을 놓지 마십시오. 해당 의료 기기를
사용하는 경우, 이 제품을 사용하기 전에 의사와 상담하십시오.

보안 주의 사항
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SONY는 전송 장치에 대한 적절한 안전 대책 구축 실패로 인해 발생하는 어떤 종류의 피해, 전송 사양에 따른 불가피한
데이터 누출 또는 어떠한 종류의 보안 문제에 대해서도 책임을 지지 않습니다.
운영 환경에 따라 승인되지 않은 제3자가 네트워크를 통해 제품에 액세스할 수 있습니다. 제품을 네트워크에 연결할
때 네트워크가 안전하게 보호되고 있는지 확인하십시오.
안전을 위해, 네트워크 연결 장치를 사용할 때는 웹 브라우저를 통해 Control 창에 액세스하고 출하 시 사전 설정된 액
세스 제한 설정 값을 변경하시기 바랍니다. 또 암호는 타인이 추측하기 어려운 충분한 길이의 문자열을 설정하여 안전
하게 보관하는 것이 좋습니다.
이 제품을 네트워크에 연결할 때는 라우터나 방화벽과 같은 보호 기능이 있는 시스템을 통해 연결하십시오. 이러한 보
호 기능 없이 연결하면 보안 문제가 발생할 수 있습니다.

전원 공급 장치

이 기기에는 전원 스위치가 장착되어 있지 않습니다. 기기를 끄려면 모든 작업이 종료되고 기기가 전원 대기 상태인지
확인한 다음 AC 어댑터를 분리하십시오. PoE++ 전원 공급을 사용하는 경우 LAN 케이블을 분리하십시오.
가능하면 전원 플러그를 삽입하고 분리하기 쉬운 곳에서 전원을 사용하십시오.
먼지가 많은 곳에서 콘센트를 사용하는 경우 콘센트 주변을 정기적으로 청소하여 추적을 방지하십시오.
사용하지 않을 때는 전원 공급 장치를 분리하십시오.

움직이는 부품에 대한 주의사항

움직이는 부품에 이물질이 들어가지 않도록 하십시오.
손으로 부품을 움직일 때 무리한 하중을 가하지 마십시오. 오동작이 발생할 수 있습니다.
이동 중 움직이는 부품의 작동을 방해하지 마십시오. 부상이나 오동작이 발생할 수 있습니다.
장기간 사용하지 않는 경우 움직이는 부품이 정상적으로 작동하지 않을 수 있습니다. 기기의 팬/틸트 기능을 정기적으
로 작동시키십시오.

연속 작동 시 주의사항

본 기기는 1년 365일 하루 24시간 동안 전원을 공급받을 수 있습니다(전원 대기 상태).
항상 촬영 테스트를 수행하고 기기가 정상적으로 작동하는지 확인하십시오.

24시간을 초과하는 연속 촬영은 보장되지 않습니다.
24시간 이상 촬영하는 경우 기기를 전원 대기 상태로 두고 기기를 다시 시작하십시오.

본 기기를 사용하는 동안 오작동으로 인해 촬영할 수 없는 경우 Sony는 이미지 내용에 대해 어떠한 종류의 보상도 책
임지지 않습니다.
사용 전에는 항상 정상적으로 작동하는지 확인하십시오. SONY는 본체의 오류로 인한 현재 또는 장래 이익의 손실에
대한 손해에 대해서 보증기간 중이거나 보증기간 경과 후 또는 어떠한 이유에도 배상 또는 변상하지 않습니다.
SONY는 이 장치에 의해 발생했거나 제3자가 제기한 어떠한 종류의 보상 청구에 대해서도 책임을 지지 않습니다.
SONY는 어떤 상황이든 상관 없이 이 장치와 관련하여 발생할 수 있는 서비스의 해지 또는 중단에 대해 책임을 지지 않
습니다.

녹화 기능에 대한 주의사항

사용 전에는 항상 테스트 기록을 실시하여 정상적으로 기록되는지 확인하십시오. SONY는 본체, 기록 매체, 어떤 형식
의 내용을 기록하는 기타 매체 또는 기타 기억장치 시스템의 오류로 인한 손해에 대해서 배상이나 변상에 대한 일체의
책임을 지지 않습니다.
사용 전에는 항상 정상적으로 작동하는지 확인하십시오. SONY는 본체의 오류로 인한 현재 또는 장래 이익의 손실에
대한 손해에 대해서 보증기간 중이거나 보증기간 경과 후 또는 어떠한 이유에도 배상 또는 변상하지 않습니다.
SONY는 이 장치에 의해 발생했거나 제3자가 제기한 어떠한 종류의 보상 청구에 대해서도 책임을 지지 않습니다.
SONY는 내부 기억장치 시스템, 기록 매체 또는 기타 매체나 기억장치 시스템에 기록된 데이터의 손실, 복원 또는 복제
에 대해 책임을 지지 않습니다.
SONY는 어떤 상황이든 상관 없이 이 장치와 관련하여 발생할 수 있는 서비스의 해지 또는 중단에 대해 책임을 지지 않
습니다.

5-041-958-23(1) Copyright 2022 Sony Corporation
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도움말 안내

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

출력 형식 및 제한

이 항목에서는 출력 형식 및 제한에 대해 설명합니다.

참고 사항

출력 형식의 해상도는 웹 메뉴 또는 카메라 메뉴의 [Project] > [Rec Format] > [Frequency], [Codec] 및 [Video Format] 설정에 의해
제한됩니다.

출력 형식의 해상도는 S&Q 프레임 속도와의 조합으로도 제한됩니다. 아래에 있는 SDI OUT/HDMI OUT 커넥터 출력 형식 표와는
별개로 다음 조건이 충족되면 HDMI 출력이 Full HD 이하로 변경됩니다.

[Shooting] > [S&Q Motion] > [Setting]이 [On]으로 설정
[Shooting] > [S&Q Motion] > [Frame Rate]가 60fps 이상

위 조건이 충족되는 경우 [Monitoring] > [Output Format] > [SDI/HDMI]에 대한 HDMI 출력 4096×2160P 및 3840×2160P 선택 옵션
이 회색으로 표시되어 선택할 수 없습니다.

재생 이미지 해상도보다 높은 해상도가 구성된 경우 이미지가 출력되지 않습니다.

SDI OUT/HDMI OUT 커넥터 출력 형식

시스템 주파수가 50/59.94Hz인 경우

설정 선택 가능한 출력 형식

녹화/재생 모드
RAW 출력 해상도/
내부 녹화 해상도

SDI HDMI

RAW
RAW & XAVC-I

4096×2160
(RAW)

(4096×2160 RAW)

4096×2160P
3840×2160P
1920×1080P(기본값)
1920×1080i

3840×2160
(RAW)

(3840×2160 RAW)
3840×2160P
1920×1080P(기본값)
1920×1080i
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시스템 주파수가 25/29.97 Hz인 경우

설정 선택 가능한 출력 형식

녹화/재생 모드
RAW 출력 해상도/
내부 녹화 해상도

SDI HDMI

XAVC-I
XAVC-L

4096×2160

4096×2160 (2SI)1)
4096×2160P
1920×1080P
1920×1080i

3840×2160 (2SI)
3840×2160P
1920×1080P
1920×1080i

1920×1080P (Level A)(기본값)
1920×1080P(기본값)
1920×1080i

1920×1080P (Level B)
1920×1080P
1920×1080i

3840×2160

3840×2160 (2SI)
3840×2160P
1920×1080P
1920×1080i

1920×1080P (Level A)(기본값) 1920×1080P(기본값)
1920×1080i

1920×1080P (Level B)
1920×1080P
1920×1080i

1920×1080i 1920×1080i

1920×1080

1920×1080P (Level A)(기본값)
1920×1080P(기본값)
1920×1080i

1920×1080P (Level B)
1920×1080P
1920×1080i

1920×1080i 1920×1080i

(출력 중지됨)
720×480P2)

720×576P3)

화면 표시는 오버레이될 수 없습니다.1)

시스템 주파수가 59.94인 경우2)

시스템 주파수가 50인 경우3)

설정 Output Format(출력 해상도)

녹화/재생 모드
RAW 출력 해상도/
내부 녹화 해상도

SDI HDMI

RAW
RAW & XAVC-I

4096×2160
(RAW)

(4096×2160 RAW)

4096×2160P
3840×2160P
1920×1080P
1920×1080i(기본값)

3840×2160
(RAW)

(3840×2160 RAW)
3840×2160P
1920×1080P
1920×1080i(기본값)
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시스템 주파수가 23.98Hz인 경우

시스템 주파수가 24Hz인 경우

설정 Output Format(출력 해상도)

녹화/재생 모드
RAW 출력 해상도/
내부 녹화 해상도

SDI HDMI

XAVC-I
XAVC-L

4096×2160

4096×2160 (2SI)
4096×2160P
1920×1080P

3840×2160 (2SI)
3840×2160P
1920×1080P

1920×1080P 1920×1080P

1920×1080PsF(기본값) 1920×1080i(기본값)

3840×2160

3840×2160 (2SI)
3840×2160P
1920×1080P

1920×1080P 1920×1080P

1920×1080PsF(기본값) 1920×1080i(기본값)

1920×1080
1920×1080P
1920×1080PsF

1920×1080P
1920×1080i

설정 Output Format(출력 해상도)

녹화/재생 모드
RAW 출력 해상도/
내부 녹화 해상도

SDI HDMI

RAW
RAW & XAVC-I

4096×2160
(RAW)

(4096×2160 RAW)
4096×2160P
3840×2160P
1920×1080P(기본값)

3840×2160
(RAW)

(3840×2160 RAW)
3840×2160P
1920×1080P(기본값)

XAVC-I
XAVC-L

4096×2160

4096×2160 (2SI)
4096×2160P
1920×1080P

3840×2160 (2SI) 3840×2160P
1920×1080P

1920×1080P(기본값) 1920×1080P(기본값)

3840×2160
3840×2160 (2SI)

3840×2160P
1920×1080P

1920×1080P(기본값) 1920×1080P(기본값)

1920×1080 1920×1080P(기본값) 1920×1080P(기본값)
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설정 Output Format(출력 해상도)

녹화/재생 모드
RAW 출력 해상도/
내부 녹화 해상도

SDI HDMI

RAW
RAW & XAVC-I

4096×2160
(RAW)

(4096×2160 RAW)
4096×2160P
1920×1080P(기본값)

XAVC-I 4096×2160
4096×2160 (2SI)
1920×1080P(기본값)

4096×2160P
1920×1080P(기본값)
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도움말 안내

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

문제 해결

전원 공급 장치

이미지 출력

증상 원인 해결책

기기의 전원이
켜지지 않습니
다.

AC 어댑터가 DC IN 커넥터에 단단히 연결되어 있지
않습니다.

전원 코드를 끝까지 단단히 삽입합니다.

AC 전원 코드가 AC 어댑터나 AC 콘센트에 단단히 삽
입되어 있지 않습니다.

전원 코드를 끝까지 단단히 삽입합니다.

LAN 케이블이 PoE++ 전원 공급 장치와 기기 사이에
단단히 연결되어 있지 않습니다.

케이블이 잠길 때까지 삽입되었는지 확인합
니다.

LAN 케이블이 OPTION 커넥터에 연결되어 있지만
LAN 커넥터에는 연결되어 있지 않습니다.

LAN 케이블을 LAN 커넥터에 올바르게 연결
합니다.

기기가 PoE++(IEEE802.3bt, Type 4, Class 8 준수)를
지원하지 않는 전원 공급 장치에 연결되어 있습니다.

PoE++(IEEE802.3bt, Type 4, Class 8 준수)
를 지원하는 전원 공급 장치에 연결합니다.

총 전력 소비량이 PoE++ 전원 공급 장치의 최대 정격
을 초과합니다.

PoE++ 전원 공급 장치의 사용 설명서를 참조
하십시오.

PoE++ 전원 공급을 지원하지 않는 카테고리 등급의
네트워크 케이블이 연결되어 있습니다.

LAN 커넥터에 연결된 카테고리 5e 이상의 네
트워크 케이블을 사용합니다.

카메라, PoE++ 전원 공급 장치 및 주변 장치가 접지에
연결되어 있지 않습니다.

카메라, PoE++ 전원 공급 장치 및 주변 장치
를 접지에 연결합니다.

증상 원인 해결책

이미지가 출력되지 않습
니다.

연결된 장치가 올바르게 연결되지 않았습니다.
연결된 장치를 올바르게 연결
하십시오.

초기 설정이 완료되지 않았습니다.
웹 앱을 사용하여 초기 설정을
완료하십시오.

HDMI 커넥터에서 이미
지가 출력되지 않습니
다.

HDMI 출력 대상 장치에서 지원하지 않는 신호가 구성되었
습니다.

HDMI 출력 형식 설정을 변경
하거나 출력 신호를 지원하는
장치를 사용하십시오.

출력 HDMI 표준을 지원하지 않는 케이블이 사용되고 있습
니다.

사용 중인 출력 HDMI 표준을
지원하는 케이블을 사용하십
시오
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원격 제어기

적외선 리모컨

증상 원인 해결책

SDI 커넥터에서 이미지
가 출력되지 않습니다.

출력 SDI 표준을 지원하지 않는 케이블이 사용되고 있습니
다.

사용 중인 출력 SDI 표준을 지
원하는 케이블을 사용하십시
오.

SDI 커넥터에 연결된 모니터가 출력 신호를 지원하지 않습
니다.

출력 SDI 표준을 지원하는 모
니터를 사용하십시오.

녹화 형식이 RAW 출력으로 설정되어 있습니다.
RAW 출력 이외의 설정으로 녹
화 형식을 변경하십시오.

HDMI 출력이 SD 해상도로 설정되어 있습니다. HDMI 출력을 SD 이외의 해상
도로 설정하십시오.

광섬유에서 이미지가 출
력되지 않거나 이미지가
왜곡됩니다.

사용 중인 모듈이 SFF 또는 SMPTE 표준을 준수하지 않거
나 전력 레벨 I(1.0W)을 충족하지 않습니다.

"광섬유 신호 출력"을 참조하
십시오.

외부 동기화를 사용할
때 이미지가 출력되지
않거나 왜곡됩니다.

구성된 비디오 신호 형식에 적합한 외부 동기 신호가 입력
되지 않습니다.

구성된 비디오 신호 형식에 적
합한 외부 동기 신호를 입력합
니다.

오디오에 노이즈가 있습
니다.

카메라, PoE++ 전원 공급 장치 및 주변 장치가 접지에 연결
되어 있지 않습니다.

기기, PoE++ 전원 공급 장치
및 주변 장치를 접지에 연결합
니다.

기기가 강한 전기장과 자기장을 생성하는 장치(예: TV/라디
오 송신기 안테나, 아마추어 라디오 송신기, 에어컨 모터, 전
원 공급 장치 변압기)가 있는 환경에서 사용됩니다.

강한 전기장과 자기장을 발생
시키는 장치로부터 멀리 떨어
지십시오.

렌즈, 렌즈 지지대, 드라이브 기기가 주변 환경의 기기나 물
체에 닿아 비정상적인 소음이 발생합니다.

렌즈를 올바르게 부착하십
시오.

카메라 근처에 장애물이
없는지 확인하십시오.

증상 원인 해결책

적외선 리모컨을 눌러도 작동
하지 않습니다.

적외선 원격 제어 작동이 비활성
화되었습니다.

웹 메뉴에서 [Technical] > [IR Remote] > [Setting]
을 [On]으로 설정합니다.

배터리가 방전되었거나 배터리
극성이 잘못되었습니다.

기기의 IR 센서 근처에서 적외선 리모컨을 조작합
니다. 전원 LED가 깜박이면 배터리를 교체합니다.

초기 설정이 완료되지 않았습니
다.

웹 앱을 사용하여 초기 설정을 완료하십시오.

팬/틸트 작업 속도가 느립니
다.

적외선 리모컨의 팬/틸트 속도가
일반 모드로 설정되어 있습니다.

SETUP 스위치 4를 기기의 커넥터 블록의 ON 위치
로 설정합니다.

작업이 의도한 카메라가 아닌
다른 카메라를 대상으로 했습
니다.

적외선 신호가 의도한 카메라가
아닌 다른 카메라에서 수신되었
습니다.

제어를 원하지 않는 카메라의 웹 메뉴에서
[Technical] > [IR Remote] > [Setting]을 [Off]로 설
정합니다.
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웹 앱

증상 원인 해결책

RM-IP500 원격 제어기로 카메라를 조
작할 수 없습니다.

카메라의 전원 공급 장치가
연결되지 않았습니다.

기기의 POWER 램프가 녹색 또는 주황색으로 켜
지는지 확인합니다.

카메라 또는 원격 제어기가
네트워크에 연결되어 있지
않습니다.

기기와 원격 제어기의 연결을 확인합니다.

카메라의 초기 설정이 완료
되지 않았습니다.

웹 앱을 사용하여 초기 설정을 완료하십시오.

VISCA over IP 통신이 활성
화되지 않았습니다.

기기의 커넥터 패널의 SETUP 스위치 3을 ON 위
치로 설정하고 기기를 재부팅하십시오.

카메라의 IP 주소가 변경되
었습니다.

웹 메뉴 또는 카메라 메뉴에서 [Network] >
[Wired LAN]을 사용하여 카메라의 IP 주소를 확
인하십시오.

RM-IP500 원격 제어기에서 AUTO IP
SETUP을 사용하여 카메라의 IP 주소
를 변경했습니다.

카메라가 시작된 후 최소
20분이 경과했습니다.

기기를 재부팅합니다. IP 주소는 기기를 시작한
후 처음 20분 이내에 AUTO IP SETUP을 사용하
여 변경할 수 있습니다.
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웹 브라우저를 사용하여 연결
할 수 없습니다.

카테고리 5e 이상의 LAN
케이블이 연결되어 있지 않
습니다.

카테고리 5e 이상의 LAN 케이블을 연결하십시오.

LAN에 올바르게 연결되지
않았거나 연결된 네트워크
가 정상적으로 작동하지 않
습니다.

LAN 커넥터의 Link LED가 켜져 있는지 확인하십시오.
Link LED가 켜져 있지 않으면 네트워크 관리자에게 문의
하십시오.

카메라의 전원 공급 장치가
연결되지 않았습니다.

위의 "전원 공급 장치" 섹션을 참조하십시오.

기기에 대해 유효한 IP 주
소가 구성되지 않았습니다.

네트워크 재설정을 수행하십시오.

구성된 IP 주소가 다른 장
치에서 사용 중입니다.

주변 장치의 IP 주소가 고유한지 확인하십시오.

구성된 서브넷 마스크가 사
용된 네트워크 서브넷과 일
치하지 않습니다.

네트워크 재설정을 수행하십시오.

기기가 프록시 서버를 통해
동일한 로컬 네트워크에서
액세스되고 있습니다.

프록시 서버가 사용되지 않도록 구성을 변경하십시오.

기기에 대해 구성된 기본
게이트웨이가 올바르지 않
습니다.

네트워크 재설정을 수행하십시오.

입력한 URL이 올바르지 않
습니다.

올바른 URL을 입력하고 다시 시도하십시오.

HTTP 포트가 올바르지 않
습니다.

카메라 메뉴를 외부 모니터에 표시하고 [Network] >
[Wired LAN] > [HTTP Port] 설정을 확인하십시오. 80 이외
의 값이 구성된 경우 웹 브라우저에서 입력한 호스트 이름
이나 IP 주소에 HTTP 포트 번호를 추가하십시오.
예: HTTP 포트가 8080으로 설정된 경우 http://<IP 주소
>:8080 입력

기기의 HTTP 포트 번호가
필터링되거나 차단됩니다.

기기의 HTTP 포트 번호를 필터링되거나 차단되지 않는
포트로 변경하십시오.

웹 브라우저의 오래된 캐시
가 악영향을 미치고 있습니
다.

웹 브라우저에서 캐시를 삭제하십시오.

2D 코드(QR 코드)를 사용하
여 웹 앱에 연결할 수 없습니
다.

사용 중인 장치가 mDNS를
지원하지 않습니다.

mDNS를 지원하는 장치를 사용하십시오.
mDNS를 지원하지 않는 장치를 사용하는 경우 웹 브라우
저에 직접 IP 주소를 입력하십시오.

태블릿 또는 컴퓨터가 카메
라와 다른 네트워크에 연결
되어 있습니다.

태블릿 또는 컴퓨터를 기기와 동일한 로컬 네트워크에 연
결하십시오.
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수동으로 URL을 입력하여 웹
앱에 연결할 수 없습니다.

사용 중인 장치가 mDNS를
지원하지 않습니다.

mDNS를 지원하는 장치를 사용하십시오.

태블릿 또는 컴퓨터가 카메
라와 다른 네트워크에 연결
되어 있습니다.

태블릿 또는 컴퓨터를 기기와 동일한 로컬 네트워크에 연
결하십시오.

인증 화면이 계속 표시됩니
다.

올바른 사용자 이름 또는
암호를 입력하지 않았습니
다.

등록된 사용자 이름과 암호를 입력하십시오. 등록된 사용
자 정보를 잊어버린 경우 "커넥터 블록"의 "RESET 스위
치"를 참조하여 네트워크 연결을 위한 사용자 정보를 초기
화하십시오.

다른 웹 브라우저를 사용하
여 로그인한 사용자가 사용
자 이름 및 암호를 변경했
을 수 있습니다.

기기 관리자에게 올바른 사용자 이름과 암호를 확인하십
시오.

카메라 이미지가 웹 앱에 표
시되지 않습니다.

카메라의 HDMI 출력이
720×480 또는 720×576으
로 설정되어 있습니다.

기기의 HDMI 출력 해상도를 변경하십시오.

카메라의 HDMI 출력 신호
를 지원하지 않는 HDMI 모
니터가 연결되어 있습니다.

HDMI 모니터를 제거하거나 HDMI 출력 설정을 지원하는
HDMI 모니터를 사용하십시오.

기기가 재부팅되고 세션 연
결이 끊어졌습니다.

약 1분 정도 기다린 후 웹 브라우저를 다시 로드하십시오.

웹 브라우저의 오래된 캐시
가 악영향을 미치고 있습니
다.

웹 브라우저에서 캐시를 삭제하십시오.

웹 앱에 표시되는 카메라 이
미지의 해상도가 낮습니다.

웹 앱에서 사용하는 비디오
스트림 3의 해상도가 낮게
설정되었습니다.

웹 메뉴의 [Stream] > [Video Stream] > [Size 3]을 사용하
여 값을 증가시킵니다.

[Menu] 버튼을 눌러도 카메라
메뉴가 표시되지 않습니다.

카메라 메뉴가 HDMI 출력
신호에 내장되지 않도록 구
성되어 있습니다.

웹 메뉴에서 [Monitoring] > [Output Display] >
[HDMI/Stream]을 [On]으로 설정합니다.

설정 화면의 설정 값이 제대
로 업데이트/표시되지 않습니
다.

웹 앱의 설정 화면에 다른
웹 앱에서 변경된 설정이
자동으로 반영되지 않습니
다.

웹 앱 설정 화면 하단의 [Reload] 버튼을 누르십시오. 표시
된 설정 화면의 설정 값이 다시 로드되고 업데이트됩니다.

임시 인터넷 파일의 설정이
영향을 미치고 있습니다.

웹 브라우저에서 캐시를 삭제하십시오.

구성 파일 또는 로그를 다운
로드할 수 없습니다.

웹 브라우저의 파일 다운로
드 기능이 비활성화되어 있
습니다.

웹 브라우저의 파일 다운로드 기능을 활성화하십시오.

웹 앱의 설정 화면에는 액세
스할 수 있지만, 라이브 작동
화면 및 재생 작동 화면에서
는 작업을 수행할 수 없습니
다.

웹 앱 작동 화면이 잠겨 있
습니다.

웹 앱의 우측 상단에 있는 작동 잠금 스위치를 (작동
잠금 해제) 위치로 설정하십시오.
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촬영

카메라

팬/틸트

증상 원인 해결책

웹 앱 화면이 표시되는 데 시
간이 걸립니다.

기기의 스트리밍 이미지를
여러 사용자가 동시에 보고
있습니다.

웹 앱에 동시에 액세스할 수 있는 사용자의 수를 줄이십시
오.

이미지가 왜곡되거나 흔들립
니다.

통신 경로의 혼잡으로 인해
비디오 정보가 제대로 전송
되지 않습니다.

스트리밍 비트 전송률을 낮추거나 [Video Stream 3] >
[Size]를 가장 작은 옵션으로 설정하거나 전송률을 낮춰
통신 대역에 여유를 만듭니다.

태블릿에서 여러 웹 브라우
저가 실행되고 메모리를 점
유하고 있습니다.

백그라운드에서 실행 중인 웹 브라우저를 모두 닫습니다.

웹 브라우저 탭이 너무 많
이 열려 있어 작동 속도가
느려집니다.

사용하지 않는 탭을 모두 닫습니다.

웹 브라우저 캐시 및 검색
기록이 과도하게 누적되면
작동 속도가 느려집니다.

웹 브라우저의 캐시를 삭제하십시오.

증상 원인 해결책

팬/틸트 작업 시작 및 종료 시 이미지가
왜곡되어 보입니다.

렌즈의 손떨림 보정 기능이 켜져 있으면 이미지
가 왜곡될 수 있습니다.

렌즈의 손떨림 보정 기능
을 끄십시오.

사용자 조작 없이 화각이 변경되었습니
다.

렌즈 브리딩이 발생했습니다.
"브리딩 보정"을 참조하십
시오.

초점, 줌 또는 조리개를 조작할 수 없습
니다.

렌즈의 스위치 설정이 올바르지 않을 수 있습니
다.

"렌즈 스위치 확인"을 참조
하십시오.

증상 원인 해결책

팬/틸트를 재설정할 수
없습니다.

팬/틸트 잠금 레버가
LOCK 위치에 있습니다.

팬/틸트 잠금 레버를 UNLOCK 위치로 밉니다.

카메라가 예상 위치에
서 멈추지 않습니다.

카메라 블록의 균형이 맞
지 않습니다.

카메라 블록을 "렌즈 부착"에 설명된 대로 적절한 위치로 앞/뒤로
이동한 다음 기기를 다시 켭니다.

팬/틸트를 지원하지 않는
렌즈가 부착되어 있습니
다.

렌즈 호환성 정보를 참조하여 팬/틸트를 지원하는 렌즈를 부착한
후 기기를 다시 켭니다.

팬/틸트 재설정을 실행할
수 없습니다.

"팬/틸트 재설정"의 설명에 따라 팬/틸트 재설정을 실행합니다.카메라 헤드에 예상치 못
한 힘이 가해져 팬/틸트 제
어 오류가 발생했습니다.
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(팬/틸트 홈) 버
튼을 눌렀을 때 카메라
가 전면으로 돌아가지
않습니다.

천장 장착 모드가 활성화
되었습니다.

실제 설치에 맞게 웹 메뉴에서 [Pan-Tilt] > [P/T Direction] >
[Ceiling]을 설정한 후 기기를 다시 켭니다. 천장에 장착할 경우
커넥터 블록이 카메라 전면에 있습니다.

팬/틸트 작업이 제한됩
니다.

팬/틸트 범위 제한이 구성
되었습니다.

"P/T Range Limit"에 설명된 대로 필요에 따라 팬/틸트 범위 제한
설정을 지웁니다.

카메라 헤드에 예상치 못
한 힘이 가해져 팬/틸트 오
류가 발생했습니다.

"팬/틸트 재설정"의 설명에 따라 팬/틸트 재설정을 실행합니다.

팬/틸트 작업이 반대 방
향으로 이동했습니다.

천장 장착 모드 설정이 실
제 장착 상태와 다릅니다.

실제 설치에 맞게 웹 메뉴에서 [Pan-Tilt] > [P/T Direction] >
[Ceiling]을 설정합니다.

팬/틸트 방향과 관련된 설
정이 변경되었습니다.

웹 메뉴의 [Pan-Tilt] > [P/T Direction] 설정을 확인하십시오.

팬/틸트 작업 시작 및
종료 시 이미지가 부드
럽게 움직이지 않습니
다.

팬/틸트 작업 가속/감속 설
정이 너무 높습니다.

웹 메뉴 또는 카메라 메뉴에서 [Pan-Tilt] > [P/T Acceleration] >
[Ramp Curve]를 사용하여 팬/틸트 작업 가속/감속 설정을 줄여
팬/틸트 작업 시작 및 종료 시 동작을 부드럽게 합니다. 이것은
렌즈가 최대 속도에 도달하는 데 더 오래 걸린다는 것을 의미합
니다.

팬/틸트 작업이 중지되
었습니다.

카메라 블록의 균형이 맞
지 않습니다.

카메라 블록을 "렌즈 부착"에 설명된 대로 적절한 위치로 앞/뒤로
이동한 다음 기기를 다시 켭니다.

램프 곡선(가속/감속) 설정
이 부착된 렌즈에 비해 너
무 높습니다.

대형 렌즈가 부착된 경우 웹 메뉴 또는 카메라 메뉴에서 [Pan-
Tilt] > [P/T Acceleration] > [Ramp Curve] 값을 낮추십시오.

대형 렌즈가 사용되고 있
습니다.

Sony 지원 담당자에게 문의하십시오.

팬/틸트 작업 시 기기가
막힙니다.

렌즈 지지대 받침대 부착
나사 클램프 레버가 카메
라에 닿습니다.

렌즈 지지대 받침대 부착 나사 클램프 레버가 위를 향하도록 돌
립니다.

렌즈 지지대 클램프 레버
가 카메라에 닿습니다.

렌즈 지지대 클램프 레버가 위를 향하도록 돌립니다.

카메라 헤드 잠금 레버가
카메라에 닿습니다.

카메라 헤드 잠금 레버가 완전히 LOCK 위치에 있는지 확인합니
다.

팬/틸트 작업 시 비정상
적인 소음이 발생합니
다.

카메라의 균형이 맞지 않
습니다.

슬라이드 베이스가 수평이 되도록 카메라 헤드를 앞/뒤 적절한
위치로 이동합니다.

램프 곡선(가속/감속) 설정
이 부착된 렌즈에 비해 너
무 높습니다.

대형 렌즈가 부착된 경우 웹 메뉴 또는 카메라 메뉴에서 [Pan-
Tilt] > [P/T Acceleration] > [Ramp Curve] 값을 낮추십시오.

카메라 헤드가 제자리에
고정되어 있지 않고 작동
중 이동 소음이 발생합니
다.

카메라 헤드 잠금 레버를 LOCK 위치로 설정합니다.

사전 설정 위치를 저장
할 수 없습니다.

Clear Image Zoom이 작동
중인 경우 사전 설정을 저
장할 수 없습니다.

Clear Image Zoom 비율을 다시 1배로 설정합니다. ( (줌 비
율)의 오른쪽에 비율이 표시되지 않는 상태)
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녹화/재생

증상 원인 해결책

사전 설정 위치를 재생
할 때 프레이밍이 오프
셋됩니다.

사전 설정 위치를 저장한
시점과 재생하는 시점 사
이에 환경 온도가 크게 변
했을 수 있습니다.

사전 설정 위치를 다시 저장합니다.

렌즈 보정이 수행되지 않
습니다.

카메라 메뉴의 [Technical] > [Lens] > [Lens Calibration]을 사용
하여 보정을 실행합니다.

사전 설정을 저장할 때 장
착된 렌즈와 다른 렌즈가
장착되었습니다. 또는 수
동 줌의 줌 위치가 다릅니
다.

사전 설정 위치를 다시 저장합니다.

웹 앱의 프레이밍 제어
패널이 회색으로 표시
되어 작동할 수 없습니
다.

썸네일 화면이 표시되는
동안 및 재생 중에 팬/틸트
작업을 사용할 수 없습니
다.

재생 제어 화면을 표시하고 썸네일 화면 표시를 종료하거나 재생
을 중지합니다.

카메라 이미지를 웹 앱에
표시할 수 없는 경우 팬/틸
트 작업을 사용할 수 없습
니다.

"문제 해결"의 "웹 앱"을 참조하십시오.

팬/틸트 잠금 레버가
LOCK 위치에 있습니다.

팬/틸트 잠금 레버를 UNLOCK 위치로 밉니다.

웹 앱의 프레이밍 제어
패널 아래에 "Execute
Pan-Tilt Reset"이 표시
됩니다.

카메라 헤드에 예상치 못
한 힘이 가해져 팬/틸트 오
류가 발생했습니다.

"팬/틸트 재설정"의 설명에 따라 팬/틸트 재설정을 실행합니다.

증상 원인 해결책

녹화 START/STOP 버튼을
눌러도 녹화가 시작되지 않습
니다.

메모리 카드가 꽉 찼습니다. 공간이 충분한 메모리 카드로 교체하십시오.

메모리 카드를 복원해야 합니다.
"메모리 카드 복원"에 설명된 대로 메모리 카드를 복
원합니다.

녹화/기록 램프가 기록 램프로 구
성되어 있어 램프로 녹화 상태를
확인할 수 없습니다.

"기록 신호 연결"에 설명된 대로 녹화/기록 램프가 녹
화 램프로 작동하도록 구성합니다.

오디오를 녹음할 수 없습니
다.

마이크가 연결되어 있지 않습니
다.

마이크 또는 오디오 장치를 커넥터 블록의 AUDIO
IN 커넥터에 연결합니다.

[Master Input Level] 설정이 최소
값입니다.

[Master Input Level]을 조정합니다.

녹음된 사운드가 왜곡됩니다. 오디오 입력 레벨이 너무 높습니
다.

[CH1 Input Level]을 [CH4 Input Level] 및 [Master
Input Level]로 조정합니다.

라이브 음악 공연장과 같이 시끄러운 환경에서 마이
크를 사용할 경우 먼저 [AUDIO IN CH1 MIC Ref.] 및
[AUDIO IN CH2 MIC Ref.]를 조정합니다.
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파일 전송

IP 스트리밍

증상 원인 해결책

녹음된 사운드의 노이즈 레벨
이 높습니다.

오디오 입력 레벨이 너무 낮습니
다.

[Audio Input Level] 및 [Audio] > [Audio] > [Audio
Input] > [AUDIO IN CH1 MIC Ref.] 또는 [AUDIO IN
CH2 MIC Ref.] 설정을 조정합니다.

클립을 재생할 수 없습니다.

클립이 편집 중입니다.
파일 이름이나 폴더를 수정했거나 컴퓨터에서 사용
중인 경우 클립을 재생할 수 없습니다. 이는 오동작
이 아닙니다.

본 기기가 아닌 다른 카메라를 사
용하여 클립을 녹화했습니다.

본 기기 이외의 카메라를 사용하여 녹화한 클립은 재
생되지 않거나 잘못된 크기로 표시될 수 있습니다.
이는 오동작이 아닙니다.

증상 원인 해결책

파일 업로드에 실패
했습니다.

서버의 사용자 이름과 암호가 잘
못되었습니다.

서버의 사용자 이름과 암호가 잘못되었을 수 있습니다. 올바
른 항목을 입력하십시오.

증상 원인 해결책

스트리밍을 사용할 수 없
습니다.

기기에서 스트리밍을 보기 위해 클
라이언트 애플리케이션에 입력한
사용자 이름 또는 암호가 올바르지
않습니다.

기기의 스트리밍 형식이 [RTSP], [SRT-Listener] 또
는 [NDI|HX]로 설정된 경우 클라이언트 애플리케이
션에서 이 기기에 대해 설정된 사용자 이름과 암호를
입력해야 합니다. 올바른 사용자 이름과 암호를 입력
합니다.

스트리밍 프로토콜이 설정되어 있
지 않습니다.

웹 메뉴에서 [Stream] > [Stream Setting]을 사용하여
대상 프로토콜을 선택합니다.

6개 이상의 RTSP 세션이 설정되었
습니다.

세션 수를 5개 이하로 설정합니다.

UDP 포트 번호가 올바르게 설정되
지 않았습니다.

웹 메뉴에서 [Stream] > [Stream] > [Stream Setting]
을 사용하여 대상 프로토콜에 대한 포트 번호 및 기
타 설정을 설정합니다.

UDP 통신이 차단되었습니다. 보안 소프트웨어 설정을 확인합니다.

오디오가 스트리밍되지 않
습니다.

오디오 출력 스트리밍이 [Off]로 설
정되었습니다.

웹 메뉴에서 [Stream] > [Audio Stream] > [Setting]을
[On]으로 설정합니다.

스트리밍 연결이 끊겼습니
다.

스트리밍 중에 프로토콜 설정 또는
스트리밍 코덱 설정이 변경되었습
니다.

스트리밍을 시작하기 전에 프로토콜 설정 및 스트리
밍 코덱 설정을 설정합니다.

[Video Stream 1]의 영상
크기를 4096×2160 또는
3840×2160으로 설정할 수
없습니다.

[Output Format]이 HDMI로 설정된
경우 영상 크기는 1920×1080입니
다.

스트리밍을 위한 영상 크기는 HDMI 영상 크기보다
높게 설정할 수 없습니다. 웹 메뉴에서 [Monitoring] >
[Output Format]을 사용하여 HDMI 영상 크기를 변경
합니다.

[Video Stream 1]의 프레
임 속도를 60 FPS 또는 50
FPS로 설정할 수 없습니
다.

스트리밍 프레임 속도가 29.97 이
하로 설정되어 있습니다.

스트리밍에 사용되는 프레임 속도는 시스템 주파수
에 의해 제한됩니다. 웹 메뉴에서 [Rec Format] >
[Frequency]를 사용하여 시스템 주파수를 변경합니
다.
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외부 장치와의 연결

외부 동기화

Tally

렌즈 제어기

증상 원인 해결책

[Video Stream 3] 스트림
에 액세스할 수 없습니다.

[Video Stream 3]이
RTSP/SRT/NDI를 지원하지 않습니
다.

[Video Stream 1] 또는 [Video Stream 2]를 사용하십
시오.

RTSP/SRT 화면이 올바르
게 업데이트/표시되지 않
습니다.

RTSP 또는 SRT에 사용되는 포트
번호가 필터링되거나 차단됩니다.

RTSP 또는 SRT 포트 번호를 스트림을 수신하는 장
치에서 필터링하거나 차단하지 않는 포트로 변경합
니다. 또는 기기에서 RTSP 또는 SRT에 사용되는 포
트 번호를 변경합니다.

이미지가 왜곡되거나 흔들
립니다.

통신 경로의 혼잡으로 인해 비디오
정보가 제대로 전송되지 않습니다.

스트리밍 비트 전송률을 낮추거나 [Video Stream 2]
코덱([Codec 2])을 [Off]로 설정하여 통신 대역에 여
유를 만듭니다.

통신 채널 내에서 비디오 패킷의 순
서가 변경되었습니다.

기기 측과 수신기 측 모두에 동일한 인터넷 서비스
공급업체를 사용합니다.

기기가 NDI 장치로 감지되
지 않습니다.

스트리밍 프로토콜이 NDI|HX로 설
정되어 있지 않습니다.

기기를 NDI 장치로 감지하려면 스트리밍 프로토콜을
NDI|HX로 설정해야 합니다. 웹 메뉴에서 [Stream] >
[Stream Setting]을 [NDI|HX]로 설정합니다.

기기를 NDI 장치로 사용할
수 없습니다.

NDI|HX 라이선스가 설치되어 있지
않습니다.

NDI|HX 라이선스를 설치합니다. NDI|HX 라이선스
보유 여부는 웹 메뉴는 [Stream] > [Stream] >
[Stream Setting] > [NDI|HX] > [License]에서 확인할
수 있습니다.

증상 원인 해결책

외부 소스와 동기
화할 수 없습니다.

구성된 비디오 신호 형식에 적합한
외부 동기 신호가 입력되지 않습니
다.

구성된 비디오 신호 형식에 적합한 외부 동기 신호를 입력
합니다.

기기가 이중 종료되었습니다.
기기에는 75 Ω 터미네이터가 내장되어 있습니다. 신호 소
스(일대일)에 직접 연결하거나 분배기(분할기)를 사용합니
다.

증상 원인 해결책

기록 램프가 켜
지지 않습니다.

기록 램프 밝기가 Off로 설정되어 있습니다.
웹 메뉴에서 [Technical] > [Tally] > [Tally Lamp
Brightness]을 사용하여 적절한 밝기를 설정합니다.

녹화/기록 램프가 녹화 램프로 구성되어 있
습니다.

"기록 신호 연결"에 설명된 대로 녹화/기록 램프가 기
록 램프로 작동하도록 구성합니다.

RM-IP500이 연결되어 있고 VISCA over IP
가 비활성화되어 있습니다.

SETUP 스위치 3를 기기의 커넥터 블록의 ON 위치로
설정합니다.

OPTION 커넥터 연결이 올바르지 않거나 대
상 핀이 GND로 단락되지 않았습니다.

"기록 신호 연결"에 설명된 대로 OPTION 커넥터의 핀
7 또는 핀 8을 GND로 단락합니다.
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관련 항목

광섬유 신호 출력

커넥터 블록

브리딩 보정

렌즈 스위치 확인

렌즈 부착

팬/틸트 재설정

P/T Range Limit

메모리 카드 복원

기록 신호 연결

5-041-958-23(1) Copyright 2022 Sony Corporation

증상 원인 해결책

[Communication Error]가 
(카메라 상태)에 표시됩니다.

카메라가 렌즈 제어
기와 통신할 수 없습
니다.

기기와 렌즈 제어기 사이의 연결을 확인한 다음 기기와 렌즈
제어기의 전원을 껐다 켜십시오.

[Rotation Error]가  (카메라
상태)에 표시됩니다.

렌즈 제어기에서 회
전 오류가 발생했습
니다.

저장된 줌 이동 범위와 렌즈 이동 범위가 일치하지 않을 수 있
습니다. 렌즈 제어기를 초기화합니다.
문제가 지속되면 렌즈 제어기 제조업체 담당자에게 문의하십
시오.

[System Error]가  (카메라 상
태)에 표시됩니다.

렌즈 제어기에서 시
스템 오류가 발생했
습니다.

기기와 렌즈 제어기 사이의 연결을 확인하고, 렌즈 제어기 사
용 설명서를 참조하여 렌즈 제어기를 초기화하거나 기기와 렌
즈 제어기의 전원을 껐다가 켜십시오.
문제가 지속되면 렌즈 제어기 제조업체 담당자에게 문의하십
시오.

[Unknown Error]가  (카메라
상태)에 표시됩니다.

렌즈 제어기에서 알
수 없는 오류가 발생
했습니다.

기기와 렌즈 제어기 사이의 연결을 확인하고, 렌즈 제어기 사
용 설명서를 참조하여 렌즈 제어기를 초기화하거나 기기와 렌
즈 제어기의 전원을 껐다가 켜십시오.
문제가 지속되면 렌즈 제어기 제조업체 담당자에게 문의하십
시오.
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도움말 안내

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

오류/경고 메시지

기기에 경고, 주의 또는 확인이 필요한 작동 조건이 발생하면 카메라 이미지 패널에 메시지가 표시되고 전면 패널의
POWER 램프 및 NETWORK 램프와 녹화/기록 램프가 깜박이기 시작합니다.

참고 사항

녹화/기록 램프 깜박임 표시는 웹 메뉴 또는 카메라 메뉴에서 [Technical] > [Tally] > [Tally Control]이 [Internal]로 설정되어 있고
[Tally Lamp Brightness]가 [Off]로 설정된 경우에만 활성화됩니다.

오류 메시지

POWER 램프와 NETWORK 램프가 아래 설명과 같이 깜박이면 다음 조치를 취하십시오.

다음과 같은 화면에서는 기기가 작동을 중지합니다.

경고 메시지

다음 화면이 표시되면 제공된 지침을 따르십시오.

POWER 램프
NETWORK 램

프
주의 및 해결책

주황색으로
천천히 깜박
임

녹색으로 천천
히 깜박임

기기가 정상적으로 작동할 수 없습니다. 자세한 내용은 웹 메뉴의 [Maintenance] >
[System Log]을 참조하십시오. 기기를 대기 모드로 전환하거나 전원을 껐다가 다시
켠 후에도 문제가 지속되면 Sony 서비스 담당자에게 문의하십시오.

주황색으로
빠르게 깜박
임

녹색으로 빠르
게 깜박임

기기에 오동작이 발생했습니다. Sony 서비스 담당자에게 문의하십시오.

메시지
표시

녹화/기
록 램프

주의 및 해결책

E + 오
류 코
드

빠르게
깜박임

기기에 이상이 있음을 나타냅니다. 카메라 이미지 패널에 ●REC가 표시되어 있어도 녹화가 중지됩
니다.
기기를 끄고 연결된 장치, 케이블 또는 매체에 문제가 있는지 확인합니다. 기기를 다시 켰을 때 오류
가 지속되면 Sony 서비스 담당자에게 문의하십시오. 기기의 상태에 따라 오류 화면이 표시되지 않
거나 경고음이 울리지 않을 수 있습니다.

메시지 표시
녹화/기록 램

프
주의 및 해결책

Temperature High 깜박임
내부 온도가 높습니다.
캠코더를 끄고 식힌 후 다시 작동하십시오.

Media Temperature
High

깜박임
CFexpress 카드의 온도가 높습니다.
카드를 교체하거나 식힌 후 다시 사용하십시오.

Voltage Low 깜박임 DC IN 전압이 낮습니다(레벨 1). 전원을 확인하십시오.
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주의 및 작동 메시지

화면 중앙에 다음과 같은 주의 및 작동 메시지가 나타날 수 있습니다. 문제를 해결하려면 제공된 지침을 따르십시오.

메시지 표시
녹화/기록 램

프
주의 및 해결책

Insufficient Voltage
빠르게 깜박
임

DC IN 전압이 너무 낮습니다(레벨 2). 녹화할 수 없습니다.
다른 전원에 연결하십시오.

Media Near Full 깜박임
메모리에 남은 용량이 점점 줄어들고 있습니다.
가능한 한 빨리 교체하십시오.

Media Full
빠르게 깜박
임

메모리 카드에 남은 용량이 없어 클립을 녹화하거나 복사할 수 없습니다.
즉시 교체하십시오.

Clips Near Full 깜박임
메모리 카드에 녹화할 수 있는 추가 클립 수가 점점 줄어들고 있습니다.
가능한 한 빨리 교체하십시오.

Clips Full
빠르게 깜박
임

메모리 카드에 녹화할 수 있는 최대 클립 수에 도달했습니다.
더 많은 클립을 녹화하거나 복사할 수 없습니다. 즉시 교체하십시오.

Last Clip Recording 깜박임
최대 클립 수에 도달했으므로 현재 녹화 중인 클립이 녹화할 수 있는 마지막
클립입니다.
새 메모리 카드를 준비하십시오.

Media(A) Life Near
End1) 깜박임 메모리 카드 수명이 거의 다 되었습니다. 가능한 한 빨리 교체하십시오.

Media(A) Life End1) 빠르게 깜박
임

메모리 카드 수명이 끝났습니다. 즉시 교체하십시오.

Media(A) Near Full1) 깜박임 Simul Rec 기능을 사용할 때

Media(A) Full1) 빠르게 깜박
임

Simul Rec 기능을 사용할 때

Media(A) Clips Near
Full1) 깜박임 Simul Rec 기능을 사용할 때

Media(A) Clips Full1) 빠르게 깜박
임

Simul Rec 기능을 사용할 때

Media(A) Last Clip
Rec1) 깜박임 Simul Rec 기능을 사용할 때

(표시 없음) 깜박임
렌즈 제어기에서 알 수 없는 오류가 발생했습니다.
웹 앱의 카메라 상태에서 상태를 확인하십시오.
자세한 내용은 웹 앱의 시스템 로그를 확인하십시오.

슬롯 B에 있는 카드에 "(B)"가 표시됩니다.1)

표시 메시지 주의 및 해결책

Backup Battery End
Please Change

백업 배터리의 남은 용량이 부족합니다.
백업 배터리를 충전하려면 최소 24시간 동안 기기를 전원 공급
장치에 연결하십시오.
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RTMP 스트리밍 오류 정보

다음 오류 정보가 기기에 표시될 수 있습니다. 필요에 따라 다음 작업을 수행합니다.

표시 메시지 주의 및 해결책

Unknown Media(A)1)

Please Change

파티션으로 나뉜 메모리 카드 또는 기기에서 처리할 수 있는 더
많은 클립이 포함된 메모리 카드가 삽입되었습니다.
기기에서 카드를 사용할 수 없으므로 교체해야 합니다.

Cannot Use Media(A)1)

Unsupported File System

다른 파일 시스템을 사용하거나 포맷되지 않은 카드가 삽입되었
습니다.
기기에서 카드를 사용할 수 없으므로 교체하거나 기기를 사용하
여 포맷해야 합니다.

Media Error
Media(A) Needs to be Restored1)

메모리 카드에서 오류가 발생해 카드를 복원해야 합니다.
메모리 카드를 복원하십시오.

Media Error
Cannot Record to Media(A)1)

메모리 카드가 손상된 것 같아 더 이상 녹화에 사용할 수 없습니
다.
재생은 가능하므로 복사 후 메모리 카드를 교체하는 것이 좋습니
다.

Media Error
Cannot Use Media(A)1)

메모리 카드가 손상된 것 같아 더 이상 녹화 또는 재생에 사용할
수 없습니다.
기기에서 카드를 사용할 수 없으므로 교체해야 합니다.

Media(A) Error1)

Recording Halted
Playback Halted

메모리 카드 사용 중 오류가 발생하여 녹화 및 재생이 중지되었
습니다.
문제가 지속되면 메모리 카드를 교체하십시오.

Media Reached Rewriting Limit
Change Media(A)1)

메모리 카드 수명이 끝났습니다.
백업하고 카드를 즉시 교체하십시오. 카드를 계속 사용하면 카드
가 녹화 또는 재생되지 않을 수 있습니다.
자세한 내용은 메모리 카드의 사용 설명서를 참조하십시오.

The specified address is invalid.
지정된 주소가 잘못되었습니다.
설정이 올바른지 확인하십시오.

Cannot Use Specified Port Number
지정된 포트 번호가 잘못되었습니다.
설정이 올바른지 확인하십시오.

Lens I/F Error(xx:xx)

E-mount 렌즈가 부착되었을 때 렌즈 I/F 통신에서 렌즈 오류가 감
지되었습니다.
E-mount 렌즈와의 연결 상태를 확인하십시오.
문제가 지속되면 오류 코드(괄호 안의 5자)와 함께 Sony 서비스
담당자에게 문의하십시오.

Cannot add auto upload job of Proxy file because
maximum number of upload jobs was reached.

전송 작업의 최대 개수에 도달했습니다.
원하지 않는 작업을 지우십시오. 프록시 파일의 자동 업로드 대
상 설정도 올바르지 않을 수 있습니다. 설정이 올바른지 확인하
십시오.

Fan Stopped

팬이 작동을 멈췄습니다.
먼지나 이물질이 없는지 확인하십시오.
먼지나 이물질을 제거한 후에도 오류가 지속되면 Sony 서비스
담당자에게 문의하십시오.

슬롯 B에 있는 카드에 "(B)"가 표시됩니다.1)
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SRT 스트리밍 오류 정보

다음 오류 정보가 기기에 표시될 수 있습니다. 필요에 따라 다음 작업을 수행합니다.

5-041-958-23(1) Copyright 2022 Sony Corporation

오류 코드
설명 해결책

RTMP RTMPS

1002
1004

2002
2004

RTMP 서버에 연결할 수 없습니
다.

서버 URL 설정이 올바른지 확인하십시오.
네트워크 연결을 확인하십시오.

1003 2003
도메인 이름을 확인할 수 없습니
다.

서버 URL 설정이 올바른지 확인하십시오.
DNS 서버 연결을 확인하십시오.

–
2005
2008

CRL 오류
서버 URL 설정이 올바른지 확인하십시오.
연결 대상이 신뢰할 수 있는 사이트인지 확인하십시오.

2006 CA 인증서 오류
시계 설정이 올바른지 확인하십시오.
CA 인증서가 올바른지 확인하십시오.

– 2007
CA 인증서가 설치되지 않았습니
다.
서버 인증서 인증 오류입니다.

CA 인증서를 설치합니다.
연결 대상이 신뢰할 수 있는 사이트인지 확인하십시오.

4002 RTMP 세션 연결이 끊어졌습니다.
RTMP 서버 측에서 기기의 연결이 끊어졌을 수 있습니다.
설정이 서비스의 권장 코덱 매개변수와 일치하는지 확인하십시
오.

4003 네트워크 연결 품질이 낮습니다. 네트워크 연결을 확인하십시오.

기타 기타 오류입니다.

오류 코드

설명 해결책SRT-
Caller

1001 예기치 않은 오류
기기가 정상적으로 작동하지 않을 수 있습니다. 장치의 전원을 껐다 켜십
시오.

1002
설정 변경으로 인해 통신 끊
김

설정이 변경되어 통신이 끊어졌습니다.
연결을 다시 설정하십시오.

5001 예기치 않은 오류
기기가 정상적으로 작동하지 않을 수 있습니다. 장치의 전원을 껐다 켜십
시오.

5005 연결 실패 연결 대상 설정이 올바른지 확인하십시오.

5006 암호화 오류 암호화 설정이 올바른지 확인하십시오.

5007 예기치 않은 오류 기기가 정상적으로 작동하지 않을 수 있습니다. 장치의 전원을 껐다 켜십
시오.5008 예기치 않은 오류

5009 전송 실패
통신 중에 기기 연결이 끊어졌습니다.
네트워크 연결을 확인하십시오.
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도움말 안내

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

메뉴 항목 목록

다음 표에는 기기의 메뉴 항목이 나열되어 있습니다.

범례

"카메라 메뉴" 및 "웹 메뉴"
●: 사용 가능
▲: 일부 항목 사용 가능
–: 사용할 수 없음

"All File" 및 "Scene File"
예: ALL 파일 또는 장면 파일에 항목이 저장됨
아니요: 항목이 저장되지 않음

"All Reset (except for Network Settings)"
웹 메뉴의 [Reset]> [Reset] > [All Reset (except for Network Settings)]이 실행된 경우:
예: 초기화된 항목(네트워크 설정 제외)
아니요: 해당 없음

"Network Reset"
웹 메뉴의 [Reset]> [Reset] > [Network Reset]이 실행된 경우:
예: 초기화된 항목(네트워크 설정)
아니요: 해당 없음

"Factory Default"
예: 항목이 공장 기본값으로 재설정됨
아니요: 해당 없음

Shooting

항목
(레벨 2)

카메라
메뉴

웹 메
뉴

All
File

Scene
File

All Reset (except for
Network Settings)

Network
Reset

Factory
Default

ISO/Gain/EI ● – 예 예 예 예 예

ND Filter ● – 예 예*1 예 아니요 예

Shutter ● – 예 예 예 아니요 예

Iris ● – 예 예 예 아니요 예

Auto Exposure ● – 예 예*2 예 아니요 예

White ● – 예 예*3 예 아니요 예

White Setting ● – 예 아니요 예 아니요 예

Offset White ● – 예 아니요 예 아니요 예

Focus ● ▲ 예 아니요 예 아니요 예

S&Q Motion ● – 예 아니요 예 아니요 예
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Project

Paint/Look

항목
(레벨 2)

카메라
메뉴

웹 메
뉴

All
File

Scene
File

All Reset (except for
Network Settings)

Network
Reset

Factory
Default

LUT On/Off ● – 예 아니요 예 아니요 예

Noise
Suppression

● – 예 예 예 아니요 예

Flicker Reduce ● – 예 아니요 예 아니요 예

SteadyShot ● – 예 아니요 예 아니요 예

[Mode] 해당 없음*1

[Clip High light], [Detect Window], [Average Peak Level Ratio], [Custom Width], [Custom H Position], [Custom V Position] 해당 없음*2

[Preset White] 해당 없음*3

항목
(레벨 2)

카메라
메뉴

웹 메
뉴

All
File

Scene
File

All Reset (except for
Network Settings)

Network
Reset

Factory
Default

Base Setting ● ● 예 아니요 예 아니요 예

Rec Format ● ● 예 아니요 예*1 아니요 예

Cine EI/Flex.ISO
Set

● – 예 아니요 예 아니요 예

Simul Rec ● ● 예 아니요 예 아니요 예

Proxy Rec ● ▲ 예 아니요 예 아니요 예

Interval Rec ● ● 예*2 아니요 예 아니요 예

Picture Cache
Rec

● ● 예*2 아니요 예 아니요 예

SDI/HDMI Rec
Control

● – 예 아니요 예 아니요 예

Assignable
Button

● – 예 아니요 예 아니요 예

All File – ●
아니
요

아니요 아니요 아니요 아니요

[Frequency] 해당 없음*1

[Setting] 해당 없음*2

항목
(레벨 2)

카메라
메뉴

웹 메
뉴

All
File

Scene
File

All Reset (except for
Network Settings)

Network
Reset

Factory
Default

Scene File ● –
아니
요

아니요 아니요 아니요 아니요

Base Look ● ▲ 예*1 아니요 예*1 아니요 예*1
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Pan-Tilt

TC/Media

항목
(레벨 2)

카메라
메뉴

웹 메
뉴

All
File

Scene
File

All Reset (except for
Network Settings)

Network
Reset

Factory
Default

Reset Paint
Settings

● –
아니
요

아니요 아니요 아니요 아니요

Black ● – 예 예 예 아니요 예

Knee ● – 예 예 예 아니요 예

Detail ● – 예 아니요 예 아니요 예

Matrix ● – 예 예 예 아니요 예

Multi Matrix ● – 예*2 예*2 예 아니요 예

기본 보기로 가져온 LUT 데이터는 해당 없음*1

[Axis] 해당 없음*2

항목
(레벨 2)

카메라
메뉴

웹 메
뉴

All
File

Scene
File

All Reset (except for
Network Settings)

Network
Reset

Factory
Default

P/T Speed – ●
아니
요

아니요 예 아니요 아니요

P/T
Acceleration

● ●
아니
요

아니요 예 아니요 아니요

P/T Range
Limit

– ●
아니
요

아니요 예 아니요 아니요

P/T Direction – ●
아니
요

아니요 예 아니요 아니요

P/T Preset – ●
아니
요

아니요 예 아니요 아니요

항목
(레벨 2)

카메라
메뉴

웹 메
뉴

All
File

Scene
File

All Reset (except for
Network Settings)

Network
Reset

Factory
Default

Timecode ● – 예*1 아니요 예 아니요 예

TC Display ● – 예 아니요 예 아니요 예

Users Bit ● – 예*1 아니요 예 아니요 예

HDMI TC Out ● – 예 아니요 예 아니요 예

Clip Name
Format

● – *2 아니요 예 아니요 예

Update Media ● –
아니
요

아니요 아니요 아니요 아니요
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Monitoring

Audio

Thumbnail

항목
(레벨 2)

카메라
메뉴

웹 메
뉴

All
File

Scene
File

All Reset (except for
Network Settings)

Network
Reset

Factory
Default

Format Media ● –
아니
요

아니요 아니요 아니요 아니요

Media Life ● –
아니
요

아니요 아니요 아니요 아니요

[Setting] 해당 없음*1

[Auto Naming] 해당 없음, [Camera ID] 해당 없음*2

항목
(레벨 2)

카메라
메뉴

웹 메
뉴

All
File

Scene
File

All Reset (except for
Network Settings)

Network
Reset

Factory
Default

Output Format ● ● 예 아니요 예 아니요 예

Output Display – ● 예 아니요 예 아니요 예

Display On/Off ● – 예 아니요 예 아니요 예

Video Signal
Monitor

● – 예 아니요 예 아니요 예

Marker ● – 예 아니요 예 아니요 예

항목
(레벨 2)

카메라
메뉴

웹 메
뉴

All
File

Scene
File

All Reset (except for Network
Settings)

Network
Reset

Factory
Default

Audio
Input

● ▲ 예 아니요 예 아니요 예

Audio
Output

● ▲ 예 아니요 예 아니요 예

항목
(레벨 2)

카메라
메뉴

웹 메
뉴

All
File

Scene
File

All Reset (except for
Network Settings)

Network
Reset

Factory
Default

Display Clip
Properties

● –
아니
요

아니요 아니요 아니요 아니요

Set Clip Flag ● –
아니
요

아니요 아니요 아니요 아니요

Lock/Unlock Clip ● –
아니
요

아니요 아니요 아니요 아니요

Delete Clip ● –
아니
요

아니요 아니요 아니요 아니요

Transfer Clip ● –
아니
요

아니요 아니요 아니요 아니요
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Technical

Network

항목
(레벨 2)

카메라
메뉴

웹 메
뉴

All
File

Scene
File

All Reset (except for
Network Settings)

Network
Reset

Factory
Default

Transfer Clip
(Proxy)

● –
아니
요

아니요 아니요 아니요 아니요

Filter Clips ● –
아니
요

아니요 아니요 아니요 아니요

Customize View ● – 예 아니요 예 아니요 예

항목
(레벨 2)

카메라
메뉴

웹 메
뉴

All
File

Scene
File

All Reset (except for Network
Settings)

Network
Reset

Factory
Default

Color Bars ● – *1 아니요 *1 아니요 예

Genlock ● –
아니
요

아니요 아니요 아니요 아니요

Tally ● ● 예 아니요 예 아니요 예

Rec
Review

● – 예 아니요 예 아니요 예

Zoom ● – 예 아니요 예 아니요 예

IR Remote – ●
아니
요

아니요 예 아니요 예

Lens ● – 예 아니요 예 아니요 예

APR ● –
아니
요

아니요 아니요 아니요 아니요

[Type] 해당, [Setting] 해당 없음*1

항목
(레벨 2)

카메라
메뉴

웹
메뉴

All
File

Scene
File

All Reset (except for
Network Settings)

Network
Reset

Factory
Default

Camera Name – ●
아니
요

아니요 아니요 아니요 예

User – ●
아니
요

아니요 아니요 예 예

Wired LAN*1 ▲ ●
아니
요

아니요 아니요 예 아니요

File Transfer ● ▲ 예 아니요 예 예 예

FTP Server 1 – ●
아니
요

아니요 예 아니요 예

FTP Server 2 – ●
아니
요

아니요 예 아니요 예
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Stream

Maintenance

항목
(레벨 2)

카메라
메뉴

웹
메뉴

All
File

Scene
File

All Reset (except for
Network Settings)

Network
Reset

Factory
Default

FTP Server 3 – ●
아니
요

아니요 예 아니요 예

SSL – ●
아니
요

아니요 아니요 예 예

Referer Check – ●
아니
요

아니요 아니요 예 예

Brute Force Attack
Protection

– ● 아니
요

아니요 아니요 예 예

카메라 메뉴를 사용하여 구성할 수 없음(디스플레이 전용)*1

항목
(레벨 2)

카메라
메뉴

웹 메
뉴

All
File

Scene
File

All Reset (except for
Network Settings)

Network
Reset

Factory
Default

Stream
Setting

– ●
아니
요

아니요 예*1 아니요 예*1

Video
Stream

– ● 예 아니요 예 아니요 예

Audio
Stream

– ● 예 아니요 예 아니요 예

[NDI|HX] > [License] 해당 없음*1

항목
(레벨 2)

카메라
메뉴

웹 메
뉴

All
File

Scene
File

All Reset (except for
Network Settings)

Network
Reset

Factory
Default

Language ● ● 예 아니요 예 아니요 예

Accessibility – ● 예 아니요 아니요 아니요 예

Clock Set ● ● 예*1 아니요 예*2 아니요 예

Reset – ●
아니
요

아니요 아니요 아니요 아니요

Hours Meter ● –
아니
요

아니요 아니요 아니요 아니요

Information – ●
아니
요

아니요 아니요 아니요 아니요

System Log – ●
아니
요

아니요 아니요 아니요 예

HTTP Access
Log – ●

아니
요

아니요 아니요 아니요 예
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항목
(레벨 2)

카메라
메뉴

웹 메
뉴

All
File

Scene
File

All Reset (except for
Network Settings)

Network
Reset

Factory
Default

Service – ●
아니
요

아니요 아니요 아니요 아니요

EULA – ●
아니
요

아니요 아니요 아니요 아니요

Software – ●
아니
요

아니요 아니요 아니요 아니요

날짜 및 시간 정보 해당 없음*1

[Time Zone], 날짜 및 시간 정보 해당 없음*2
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도움말 안내

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

사전 설정 위치 저장 항목

"예"는 사전 설정 위치에 대해 저장된 설정을 나타내고 "아니요"는 저장되지 않은 설정을 나타냅니다.

팬/틸트 항목

줌 항목

초점 항목

표시 위치 항목 대상 저장

라이브 작동 화면의 프레이밍 제어 패널
팬/틸트 위치 예

[Pan-Tilt Speed] 아니요

웹 메뉴의 [Pan-Tilt]

[P/T Speed] 아니요

[P/T Acceleration] 아니요

[P/T Range Limit] 아니요

[P/T Direction] 아니요

[P/T Preset] > [Pan-Tilt] 아니요

[P/T Preset] > [Default] > [Pan-Tilt Speed] 예1)

사전 설정 위치를 저장할 때의 설정 값은 해당 사전 설정 위치의 값으로 저장됩니다. 값을 저장한 후 각 사전 설정 위치별로 값을 변경할 수 있습니
다. 자세한 내용은 "웹 앱을 사용하여 사전 설정 위치의 전환 속도(팬-틸트/줌/초점) 변경"을 참조하십시오.

1)

표시 위치 항목 대상 저장

라이브 작동 화면의 프레이밍 제어 패널
줌 위치(초점 거리) 예

[Zoom Speed] 아니요

웹 메뉴의 [Pan-Tilt] > [P/T Preset] > [Default]
[Zoom Sync] 예1)

[Zoom Speed] 예1)

카메라 메뉴의 [Technical] > [Zoom] [Zoom Type] 아니요

사전 설정 위치를 저장할 때의 설정 값은 해당 사전 설정 위치의 값으로 저장됩니다. 값을 저장한 후 각 사전 설정 위치별로 값을 변경할 수 있습니
다. 자세한 내용은 "웹 앱을 사용하여 사전 설정 위치의 전환 속도(팬-틸트/줌/초점) 변경"을 참조하십시오.

1)

표시 위치 항목 대상 저장

라이브 작동 화면의 카메라 이미지 패널
실시간 추적 AF에 대해 지정된 추적 대상 아니요

스팟 초점에 대해 지정된 좌표 아니요
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관련 항목

사전 설정 위치 복원 시 전환 속도(팬-틸트/줌/초점) 변경

5-041-958-23(1) Copyright 2022 Sony Corporation

표시 위치 항목 대상 저장

라이브 작동 화면의 (Focus) 탭

[Touch Focus] 전환 아니요

[Auto Focus] 전환 예

[Focus Hold] 버튼 상태 아니요

[Push AF/MF] 버튼 상태 아니요

[Face/Eye Detection AF] 예

[AF Subj. Shift Sens.] 예

[AF Transition Speed] 예

초점 위치 예1)

웹 메뉴의 [Shooting] > [Focus]

[Push AF Mode](할당 가능 버튼을 사용한 설정 포함) 아니요

[Touch Function in MF] 아니요

[AF Assist Control] 아니요

웹 메뉴의 [Pan-Tilt] > [P/T Preset] > [Default]
[Focus Recall] 예2)

[MF Speed] 예2)

카메라 메뉴의 [Shooting] > [Focus]
[Focus Area]를 사용하여 설정한 초점 영역 크기 및 위치 예

[Focus Area (AF-S)]를 사용하여 설정한 초점 영역 위치 예

[Auto Focus] 스위치가 On 위치로 설정되어 있으면 복원되지 않습니다. Off로 설정되면 복원됩니다.1)

사전 설정 위치를 저장할 때의 설정 값은 해당 사전 설정 위치의 값으로 저장됩니다. 값을 저장한 후 각 사전 설정 위치별로 값을 변경할 수 있습니
다. 자세한 내용은 "사전 설정 위치 복원 시 전환 속도(팬-틸트/줌/초점) 변경"을 참조하십시오.

2)
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도움말 안내

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

블록 다이어그램

Audio Input

Audio Output

5-041-958-23(1) Copyright 2022 Sony Corporation
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도움말 안내

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

E-mount 렌즈 소프트웨어 업데이트

기기를 사용하여 E-mount 렌즈 소프트웨어를 업데이트할 수 있습니다.
업데이트할 수 있는 렌즈와 해당 소프트웨어는 렌즈 웹 사이트를 참조하십시오.
소프트웨어는 웹 메뉴를 사용하여 업데이트됩니다.

참고 사항

업데이트가 완료될 때까지 다음 작업을 수행하지 마십시오.

네트워크 연결 끊기
렌즈 제거
전원 끄기

업데이트 실패를 알리는 메시지가 표시되면 표시된 설명을 확인하고 업데이트를 다시 시도하십시오.

5-041-958-23(1) Copyright 2022 Sony Corporation

기기에 E-mount 렌즈를 장착합니다.1

웹 메뉴에서 [Maintenance] > [Information] > [Lens] > [Model Name] 및 [Version Number]를 확인하십시오.

E-mount 렌즈의 소프트웨어 버전 번호가 측면에 표시됩니다.
소프트웨어 버전 번호를 확인한 다음 필요에 따라 소프트웨어를 업데이트합니다.

2

Windows용 렌즈 소프트웨어 업데이트 파일(.exe 확장자)을 웹 앱을 실행하는 장치에 다운로드합니다.3

[Maintenance] > [Information] > [Lens] > [Version Up]에서 [Choose File] 버튼을 눌러 다운로드한 업데이트 파일
을 선택합니다.

4

화면의 지침을 따릅니다.5
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도움말 안내

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

렌즈 분리 버튼 커버 부착

CIB-PCM1 천장 브래킷(옵션)과 함께 제공된 렌즈 분리 버튼 커버를 렌즈 분리 버튼에 부착하여 의도하지 않은 렌즈 분리
를 방지할 수 있습니다.

참고 사항

이렇게 해도 렌즈가 완전히 분리되는 것은 아닙니다.

관련 항목

렌즈 부착

5-041-958-23(1) Copyright 2022 Sony Corporation

렌즈를 부착합니다.

렌즈 부착에 대한 자세한 내용은 "렌즈 부착"을 참조하십시오.

1

팬/틸트 잠금 레버를 LOCK 위치로 밀어 카메라 헤드의 팬/틸트를 잠급니다.2

렌즈 배출 커버를 부착할 수 있는 위치로 카메라 블록을 옮깁니다.3

렌즈 배출 커버를 부착하여 렌즈 분리 버튼을 덮도록 합니다.4

렌즈 배출 커버 고정 나사를 사용하여 렌즈 배출 커버를 고정합니다.5
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도움말 안내

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

라이선스

MPEG-4 AVC 특허 포트폴리오 라이선스

이 제품은 AVC 특허 포트폴리오 라이선스에 따라 소비자의 개인적 사용 또는 보상이 없는 기타 용도에 따라 라이선스가
부여됩니다.
(i) AVC 표준("AVC VIDEO")에 따른 비디오 인코딩 및/또는
(ii) 개인 활동에 참여한 소비자가 인코딩한 AVC 비디오 및/또는 AVC 비디오를 제공하기 위해 허가된 비디오 제공업체에게
서 확보한 비디오 녹화.
다른 용도로 라이선스가 부여되지 않으며 이를 암시하지도 않습니다. 추가 정보는 MPEG LA, L.L.C.에서 구할 수 있습니
다. HTTP://WWW.MPEGLA.COM을 참조하십시오.

GPL/LGPL 라이선스에 따라 소프트웨어 받기

이 제품은 GPL/ LGPL이 적용되는 소프트웨어를 사용합니다. 이는 사용자에게 GPL/LGPL 조건에 따라 이러한 소프트웨어
프로그램의 소스 코드에 액세스, 수정 및 재배포할 권리가 있음을 나타냅니다.
소스 코드는 인터넷에서 제공됩니다. 다음 URL을 사용하고 다운로드 지침을 따르십시오.
https://oss.sony.net/Products/Linux/
소스 코드 내용에 관해서는 당사에 문의하지 않는 것이 좋습니다.

μT-Kernel 소스 코드

본 제품은 TRON Forum(www.tron.org)에서 부여한 T-License 2.1에 따라 μT-Kernel의 소스 코드를 사용합니다.

5-041-958-23(1) Copyright 2022 Sony Corporation
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도움말 안내

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

사양

일반

질량

약 4.6 kg(본체만)
약 6.0 kg(SELP28135G 렌즈 포함)

치수

"외형 치수"를 참조하십시오.

전력 요구 사항

19.5 V DC
PoE++(IEEE802.3bt, Type 4, Class 8 준수)

전력 소비

19.5 V DC: 80.0 W(최대)
PoE++: 71.3 W(최대)　

작동 온도

0 °C~40 °C

기억장치 온도

−20 °C~+60 °C

녹화 형식(비디오)
XAVC Intra
XAVC-I 4K/QFHD 모드: VBR, 600 Mbps(최대) 비트 전송률, MPEG-4 AVC/H.264
XAVC-I HD 모드: CBG, 223 Mbps(최대), MPEG-4 AVC/H.264

XAVC Long
XAVC-L QFHD 모드: VBR, 150 Mbps(최대) 비트 전송률, MPEG-4 H.264/AVC
XAVC-L HD 50 모드: VBR, 50 Mbps(최대), MPEG-4 H.264/AVC
XAVC-L HD 35 모드: VBR, 35 Mbps(최대), MPEG-4 H.264/AVC

녹화 형식(오디오)
LPCM 24비트, 48 kHz, 4채널

녹화 프레임 속도

XAVC Intra
XAVC-I 4K 모드: 4096×2160/59.94P, 50P, 29.97P, 25P, 24P, 23.98P
XAVC-I QFHD 모드: 3840×2160/59.94P, 50P, 29.97P, 25P, 23.98P
XAVC-I HD 모드: 1920×1080/59.94P, 50P, 29.97P, 25P, 23.98P

XAVC Long
XAVC-L QFHD 모드: 3840×2160/59.94P, 50P, 29.97P, 25P, 23.98P
XAVC-L HD 50 모드: 1920×1080/59.94P, 50P, 29.97P, 25P, 23.98P
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XAVC-L HD 35 모드: 1920×1080/59.94P, 50P, 29.97P, 25P, 23.98P

녹화/재생 시간

XAVC Intra
XAVC-I QFHD 모드: 59.94P, 약 30분(CEA-G160T 사용)
XAVC-I HD 모드: 59.94P, 약 78분(CEA-G160T 사용)

XAVC Long
XAVC-L QFHD 모드: 59.94P, 약 115분(CEA-G160T 사용)
XAVC-L HD 50 모드: 59.94P, 약 155분(CEA-G80T 사용)
XAVC-L HD 35 모드: 59.94P, 약 210분(CEA-G80T 사용)

참고 사항

녹화/재생 시간은 사용 조건 및 메모리 특성에 따라 다를 수 있습니다. 녹화 및 재생 시간은 단일 클립으로의 연속 녹화 기준입니다.
녹화되는 클립 수에 따라 실제 시간이 더 짧은 수 있습니다.

팬/틸트 드라이브 섹션

최소 팬 속도: 0.02°/s
최소 틸트 속도: 0.02°/s
최대 팬 속도: 60°/s
최대 틸트 속도: 60°/s
팬 범위: −170° ~ +170°
틸트 범위: −30° ~ +195°
소음 기준 등급: NC35 이하
사전 설정 위치: 100

카메라 섹션

이미징 장치

35mm 풀 프레임(35.6 × 23.8 mm), Exmor R CMOS 센서

픽셀 수
약 12.9메가픽셀(총 픽셀)
약 10.3메가픽셀(유효 픽셀)

자동 초점

감지 방법: 위상 감지/콘트라스트 감지

내부 ND 필터

CLEAR: OFF
1: 1/4ND
2: 1/16ND
3: 1/64ND
선형 가변 ND: 1/4ND~1/128ND

ISO 감도

ISO 800/12800 (Cine EI 모드, D55 광원)

렌즈 장착

E-mount

위도

15 이상 스톱
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셔터 속도

64F~1/8000초(23.98P)

셔터 각도

5.6°~360°, 2~64프레임

Slow & Quick Motion
XAVC QFHD: 1 fps~120 fps
XAVC HD: 1 fps~240 fps
XAVC 4K: 1 fps~60 fps
XAVC HD(S35): 1 fps~120 fps

화이트 밸런스

2000 K~15000 K

게인

−3 dB~+30 dB(1 dB 증가)

기본 보기

S-Cinetone, Standard, Still, ITU709, 709tone, s709, 709(800%), S-Log3, HLG Live, HLG Natural

오디오 섹션

샘플링 주파수

48 kHz

양자화

24비트

주파수 응답

XLR 입력 MIC 모드: 20 Hz~20 kHz(±3 dB 이하)
XLR 입력 LINE 모드: 20 Hz~20 kHz(±3 dB 이하)

동적 범위

XLR 입력 MIC 모드: 80 dB(일반)
XLR 입력 LINE 모드: 90 dB(일반)

왜곡

XLR 입력 MIC 모드: 0.08% 이하(−40 dBu 입력 레벨)
XLR 입력 LINE 모드: 0.08% 이하(+14 dBu 입력 레벨)

입력/출력 섹션

입력

DC IN

EIAJ 준수, 19.5 V DC

AUDIO IN

XLR 유형, 5핀, 암
LINE/MIC/MIC+48V 전환 가능
MIC: 기준 −30 dBu~−80 dBu
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GENLOCK IN

BNC 커넥터, 1.0 Vp-p, 75 Ω

TC IN

BNC 커넥터

출력

SDI OUT

BNC 커넥터, 12G-SDI, 6G-SDI, 3G-SDI (Level A/B), HD-SDI

HDMI

Type-A 커넥터

OPTICAL 출력 커넥터

SFP+ 준수
* 본 기기는 광신호 입력을 지원하지 않습니다.

입력/출력

LAN 커넥터

RJ-45, 1000BASE-T

OPTION 커넥터

RJ-45 기록 입력/출력 커넥터

매체 슬롯 섹션

CFexpress Type A/SD 카드 슬롯 (2)

제공되는 액세서리

AC 어댑터 (1)
전원 코드 (1)
적외선 리모컨 (1)
바디 캡(기기에 부착됨) (1)
HDMI 케이블 고정 플레이트 (1)
본 기기를 사용하기 전에 (1)
품질 보증서 (1)

외형 치수

치수는 대략적인 값입니다.
단위: mm

카메라 본체
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천장 브래킷
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디자인 및 사양은 고지 없이 변경될 수 있습니다.

5-041-958-23(1) Copyright 2022 Sony Corporation
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도움말 안내

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

상표

는 Sony Group Corporation의 상표입니다.
XAVC 및 는 Sony Group Corporation의 등록 상표입니다.
용어 HDMI 및 HDMI High-Definition Multimedia Interface 그리고 HDMI 로고는 미국 및 기타 국가에서 사용되는HDMI
Licensing Administrator, Inc.의 상표 또는 등록상표입니다.
Microsoft 및 Windows는 미국 및/또는 기타 국가에서 Microsoft Corporation의 상표 또는 등록 상표입니다.
Mac 및 macOS는 미국 및 기타 국가에서 Apple Inc.의 등록 상표입니다.
"Catalyst Browse" 로고는 Sony Group Corporation의 상표 또는 등록 상표입니다.
IOS는 미국 및 기타 국가에서 Cisco의 상표 또는 등록 상표이며 라이선스 하에 사용됩니다.
iPadOS, Safari 및 iPad는 미국 및 기타 국가 및 지역에 등록된 Apple Inc.의 상표입니다.
Android 및 Google Chrome은 Google LLC의 상표 또는 등록 상표입니다.
Wi-Fi는 Wi-Fi Alliance의 등록 상표입니다.
SDXC 로고는 SD-3C, LLC의 상표입니다.
CFexpress 및 CFexpress Type A 로고는 CompactFlash Association의 상표입니다.
NewTek™ 및 NDI®는 NewTek, Inc.의 상표 또는 등록 상표입니다.
JavaScript는 Oracle 및/또는 그 계열사의 등록 상표입니다.
Intel, Intel 로고 및 Intel Core는 Intel Corporation 또는 그 자회사의 상표입니다.
QR 코드는 Denso Wave Inc.의 상표입니다.
기타 모든 회사 이름 및 제품 이름은 해당 소유자의 등록 상표 또는 상표입니다. 이 문서에서 상표 항목은 ™ 또는 ® 기
호로 표시되지 않습니다.

5-041-958-23(1) Copyright 2022 Sony Corporation

491




